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Audience for This Guide

Welcome to Release 11i of the Oracle XML Gateway User’s Guide.

This guide assumes the following:

• You understand the principles of XML messaging and XML
standards

• You know how to read a Document Type Definition (DTD)

• You are familiar with the Oracle E–Business Suite graphical user
interface.

To learn more about the Oracle E–Business Suite graphical user
interface, read the Oracle Applications User’s Guide.

See Other Information Sources for more information about Oracle
E–Business Suite product information.

Structure

This guide contains the information you need to understand and use
Oracle XML Gateway.

• Chapter 1, ”Oracle XML Gateway Overview,” describes the XML
Gateway features and architecture and provides an introduction
to each of the components.

• Chapter 2, ”Message Designer,”describes how to use the
Message Designer to create XML message maps.

• Chapter 3, ”XML Gateway Setup,” describes the steps required
to set up Oracle XML Gateway.

• Chapter 4, ”Execution Engine,” describes the XML Gateway
envelope and trading partner validation for inbound and
outbound messages.

• Chapter 5, ”Message Queues,” describes the queues used by the
XML Gateway.

• Chapter 6, ”Integration with Oracle Workflow Business Event
System,” describes how XML Gateway integrates with Oracle
Workflow BES.

• Chapter 7, ”Oracle Transport Agent,” describes the Oracle
Transport Agent.
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• Chapter 8, ”Web Services,” describes how to exchange your XML
transactions as Web services.

• Appendix A, ”Map Analysis Guidelines,” gives step–by–step
instructions for performing a map analysis.

• Appendix B, ”XML Gateway Seeded Code Categories,” lists the
code categories seeded in XML Gateway.

• Appendix C, ”XML Gateway Supported Actions,” lists the
actions that can be defined as part of the element mapping
process.

• Appendix D, ”XML Gateway Naming Conventions Summary,”
lists references to all of the naming conventions recommended
throughout the guide.

• Appendix E, ”XML Gateway Valid Time Zone Values,” lists the
valid values for the profile option ECX: Server Timezone.

• Appendix F, ”XML Gateway APIs,” lists the special purpose
procedures and functions for use with the Message Designer and
the Execution Engine.

• Appendix G, ”Troubleshooting,” provides tips and procedures
for troubleshooting your XML Gateway installation.

Documentation Accessibility

Our goal is to make Oracle products, services, and supporting
documentation accessible, with good usability, to the disabled
community. To that end, our documentation includes features that
make information available to users of assistive technology. This
documentation is available in HTML format, and contains markup to
facilitate access by the disabled community. Standards will continue to
evolve over time, and Oracle is actively engaged with other
market–leading technology vendors to address technical obstacles so
that our documentation can be accessible to all of our customers. For
additional information, visit the Oracle Accessibility Program Web site
at http://www.oracle.com/accessibility/

Accessibility of Code Examples in Documentation

JAWS, a Windows screen reader, may not always correctly read the
code examples in this document. The conventions for writing code
require that closing braces should appear on an otherwise empty line;
however, JAWS may not always read a line of text that consists solely
of a bracket or brace.
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Accessibility of Links to External Web Sites in Documentation

This documentation may contain links to Web sites of other companies
or organizations that Oracle does not own or control. Oracle neither
evaluates nor makes any representations regarding the accessibility of
these Web sites.

Other Information Sources

You can choose from many sources of information, including online
documentation, training, and support services, to increase your
knowledge and understanding of Oracle XML Gateway.

If this guide refers you to other Oracle E–Business Suite
documentation, use only the Release 11i versions of those guides.

Online Documentation

All Oracle E–Business Suite documentation is available online (HTML
or PDF).

• PDF Documentation – See the Online Documentation CD for
current PDF documentation for your product with each release.
This Documentation CD is also available on OracleMetaLink and
is updated frequently.

• Online Help – You can refer to Oracle Applications Help for
current HTML online help for your product. Oracle provides
patchable online help, which you can apply to your system for
updated implementation and end user documentation. No
system downtime is required to apply online help.

• Release Content Document – This document lists new features
available by release. It is available on OracleMetaLink.

• About Document – Refer to the About Document for
information about your release, including feature updates,
installation information, and new documentation or
documentation patches that you can download. The About
Document is available on OracleMetaLink.
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Related User’s Guides

Oracle XML Gateway shares business and setup information with other
Oracle E–Business Suite products. Therefore, you may want to refer to
other user’s guides when you set up and use XML Gateway.

You can read the guides online by choosing Library from the
expandable menu on your HTML help window, by reading from the
Oracle E–Business Suite Document Library CD included in your media
pack, or by using a Web browser with a URL that your system
administrator provides.

If you require printed guides, you can purchase them from the Oracle
Store at http://oraclestore.oracle.com.

Guides Related to All Products

Oracle Applications User’s Guide

This guide explains how to enter data, query, run reports, and navigate
using the graphical user interface (GUI). This guide also includes
information on setting user profiles, as well as running and reviewing
reports and concurrent processes.

You can access this user’s guide online by choosing ”Getting Started
with Oracle Applications” from any Oracle E–Business Suite help file.

User Guides Related to This Product

Oracle Workflow Administrator’s Guide

This guide explains how to complete the setup steps necessary for any
Oracle Applications product that includes workflow–enabled
processes, as well as how to monitor the progress of runtime workflow
processes.

Oracle Workflow Developer’s Guide

This guide explains how to define new workflow business processes
and customize existing Oracle Applications–embedded workflow
processes. It also describes how to define and customize business
events and event subscriptions.
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Oracle Workflow User’s Guide

This guide describes how Oracle Applications users can view and
respond to workflow notifications and monitor the progress of their
workflow processes.

Oracle Workflow API Reference

This guide describes the APIs provided for developers and
administrators to access Oracle Workflow.

Oracle Applications System Administrator’s Guide

This guide provides planning and reference information for the Oracle
Applications System Administrator. It contains information on how to
define security, customize menus and online help, and manage
concurrent processing.

Oracle eTechnical Reference Manuals

Each eTechnical Reference Manual (eTRM) contains database diagrams
and a detailed description of database tables, forms, reports, and
programs for a specific Oracle E–Business Suite product. This
information helps you convert data from your existing applications,
integrate Oracle E–Business Suite data with non–Oracle applications,
and write custom reports for Oracle E–Business Suite products. Oracle
eTRM is available on Metalink.

Do Not Use Database Tools to Modify Oracle Applications Data

Oracle STRONGLY RECOMMENDS that you never use SQL*Plus,
Oracle Data Browser, database triggers, or any other tool to modify
Oracle Applications data unless otherwise instructed.

Oracle provides powerful tools you can use to create, store, change,
retrieve, and maintain information in an Oracle database. But if you use
Oracle tools such as SQL*Plus to modify Oracle Applications data, you
risk destroying the integrity of your data and you lose the ability to
audit changes to your data.

Because Oracle Applications tables are interrelated, any change you
make using Oracle Applications can update many tables at once. But
when you modify Oracle Applications data using anything other than
Oracle Applications, you may change a row in one table without
making corresponding changes in related tables. If your tables get out
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of synchronization with each other, you risk retrieving erroneous
information and you risk unpredictable results throughout Oracle
Applications.

When you use Oracle Applications to modify your data, Oracle
Applications automatically checks that your changes are valid. Oracle
Applications also keeps track of who changes information. If you enter
information into database tables using database tools, you may store
invalid information. You also lose the ability to track who has changed
your information because SQL*Plus and other database tools do not
keep a record of changes.
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Oracle XML Gateway
Overview

his chapter introduces the Oracle XML Gateway.  Specifically, this
chapter describes the

• Oracle XML Gateway features

• Oracle XML Gateway Architecture

• Oracle XML Gateway components: Message Designer, XML
Gateway Setup, and Execution Engine
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Overview of XML Gateway

XML Standards

Many standards bodies (for example, OAG, Rosettanet, SOAP, and iFX)
exist with published Document Type Definitions (DTDs).  Some
standards are strong at managing the message content while others
excel at managing both the message content and its related processes.

As a provider of broad–based business application solutions to support
all industries, Oracle XML Gateway supports all DTD based XML
standards.  The majority of messages delivered with the Oracle
E–Business Suite are mapped using the Open Application Group
(OAG) standard.  Any prebuilt message can be remapped to any
standard of choice using the XML Gateway Message Designer.

XML Gateway Introduction

Oracle XML Gateway is a set of services that allows easy integration
with the Oracle E–Business Suite to support XML messaging.

The Oracle E–Business Suite utilizes the Oracle Workflow Business
Event System to support event–based XML message creation and
consumption.

Oracle XML Gateway consumes events raised by the Oracle E–Business
Suite and subscribes to inbound events for processing.  Oracle XML
Gateway uses the message propagation feature of Oracle Advanced
Queuing to integrate with the Oracle Transport Agent to deliver
messages to and receive messages from business partners.

Oracle XML Gateway supports both Business–to–Business (B2B) and
Application–to–Application (A2A) initiatives.  B2B initiatives include
communicating business documents and participating in industry
exchanges.  An example of an A2A initiative is data integration with
legacy and disparate systems.

With Oracle XML Gateway services, you are assured consistent XML
message implementation when integrating with the Oracle E–Business
Suite, thereby lowering integration costs and expediting message
implementation while supporting corporate e–business initiatives.
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XML Gateway Features

The Oracle XML Gateway offers the following features and
integrations:

• Message Designer

Use this wizard–guided tool to define message maps containing
the RDBMS–to–XML or XML–to–XML data transformations.

• Robust Execution Engine

The execution engine integrates with the Oracle Workflow
Business Event System for event–based message creation and
consumption.

• Flexible Trading Partner Directory Service

Use this service to define a hub, all trading partners exchanging
on a hub, or a specific business partner.  The definition includes
information on enabled messages, confirmation requests, and
message maps and message transport protocols.

• Flexible message setup

Flexible conversion of Oracle codes to recipient or
standards–based codes, including a cross–reference between the
Oracle internal and external transaction names.

• Integration with Oracle Workflow Error Handling

Oracle Workflow error handling process provides active error
notification to the XML Gateway system administrator or
Trading Partner contact with support for ”retry” and ”reprocess”
for failed processes.

• Integration with Oracle Advanced Queuing

Oracle AQ provides persistent storage and message propagation.

• Utilizes Servlet–Based Transport Agent

The servlet–based Transport Agent delivers and receives XML
messages using SMTP, HTTP, or HTTPS protocols.
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XML Gateway Architecture

XML Gateway Architecture Overview Diagram

The services supported by Oracle XML Gateway are grouped into four
functional areas as follows:

• Message Designer

• XML Gateway Setup

• Execution Engine

• Transport Agent
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XML Gateway Architecture Detail Diagram

Message Designer

The XML Gateway Message Designer is a wizard–guided,
repository–based tool used to define message maps.  A message map
represents the relationship between the source and target data
elements.

Use the XML Gateway Message Designer to perform the following
functions:

Define Data Source and Data Target

Each message map consists of a data source and data target
representing where the data is coming from and where it is mapped to.
The XML Gateway Message Designer supports the following
combinations of source and target data definitions:
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• Source RDBMS to Target XML

• Source XML to Target RDBMS

• Source XML to Target XML

RDBMS–based data definitions can be based on database tables,
database views, Application Open Interface tables, or Application
APIs.

XML–based data definitions can be based on an XML Document Type
Definition or a production XML message.  Using a production XML
message as a data source or data target is the recommended choice if
you are migrating from an existing implementation or legacy system
(where XML messaging is supported) to the Oracle E–Business Suite.

Map Source Data Structure to Target Data Structure

Once the data source and data target are defined, use the Message
Designer to relate the source data structure to the target data structure.

This process is especially important if the data structure of the business
document is different from the data structure of the application data
model.  For example, if an inbound business document is represented
in three levels but the application data model is represented in two
levels, the data in the business document must be collapsed to
accommodate the application data model.  The incoming data is
expanded if the opposite case occurs in which the inbound business
document is represented in two levels but the application data model is
represented in three levels.

The XML Gateway Message Designer supports both expanding and
collapsing hierarchies to ensure that data can be retrieved from or
populated into the Oracle E–Business Suite data model.

Map Source Data Element to Target Data Element

Once the data source, data target, and source–to–target hierarchy are
defined, use the Message Designer to map the source data elements to
the target data elements.

The Message Designer user interface displays the data source and the
data target in adjacent windows.  A simple drag and drop between the
source and target data elements creates a map relationship.  The source
data element name is noted next to the target data element name to
identify the map relationship.
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Identify Data Transformation and Process Control Functions

As part of the element mapping process, use the Message Designer to
identify data transformation and process control functions.  These
functions can be defined at the source or target as follows:

• To be applied at the data element, document, or root level

• To be applied before, during, or after the message is created or
consumed

The function may be qualified by a condition.  If no condition is
defined, the function will always be applied.  See Appendix C for a list
of the functions supported by the XML Gateway.

The common data transformation functions involve math functions and
string manipulation in addition to conversions between the Oracle and
OAG formats representing date, operating amount, quantity, and
amount values.

The common process control functions involve calling procedures or
database functions to extend the integration with the Oracle E–Business
Suite.  Other common process control functions allow you to inquire on
the status of a transaction and manage the process flow based on the
status.  For serious errors, the process may be aborted with error
notifications sent to the XML Gateway system administrator or Trading
Partner contact.

Once the message map is created, it is loaded along with its associated
DTDs into the XML Gateway repository for use by the Execution
Engine to create outbound or to consume inbound XML messages.

XML Gateway Setup

To implement a message with a trading partner, use the XML Gateway
setup features to define the Trading Partner or hub, code conversion
values, and internal–to–external transaction name cross–references.  In
addition, you can identify the XML Gateway system administrator to
notify for system or process errors.

Define Trading Partner or Hub

E–Business may be conducted directly with a business partner,
commonly known as a trading partner, or via a hub, such as Oracle
Exchange, where many buyers and sellers converge to conduct
electronic commerce.
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With Oracle XML Gateway, you can define the hub or the individual
business partner as a trading partner.  If you define the hub as the
trading partner, you can identify all the buyers and sellers who are
conducting business on the hub as Trading Partners to the hub.

Included in the Trading Partner or hub definition are the following:

• Define Trading Partner or Hub name

• Enable XML messages for the partner

• Enable request for message confirmation

• Define the message map to use for message creation or
consumption

• Define the e–mail address of the trading partner contact to notify
for data errors

• Define trading partner–specific code conversion values

• Define transport protocol: SMTP, HTTP, HTTPS with credential
and username and password as necessary

Define Code Conversion

With Oracle XML Gateway, you can cross–reference Oracle codes to
codes that are meaningful to your recipient.  Conversely, you can
cross–reference codes you receive from your partner to codes that are
meaningful to your Oracle Application.  Common examples of Oracle
E–Business Suite codes requiring code conversion are units of measure
and currency code.

Code conversion values can be defined to be applied universally for all
Trading Partners and all messages.  Additionally, code conversion
values can be defined for a specific XML standard or specific to a
Trading Partner.

Define Transactions

Use Oracle XML Gateway to define a cross–reference between the
Oracle transaction name and the external transaction name.  The
external transaction name will be based on what is meaningful per the
XML standard used by the recipient.  The external transaction name
will appear on the message envelope to support message transport.
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Execution Engine

The XML Gateway Execution Engine is responsible for interacting with
several Oracle technologies to process and transport XML messages to
and from Trading Partners for B2B integration, or other information
systems both within and outside the enterprise for A2A integration.

The Oracle technologies involved include the following:

• Oracle Workflow Business Event System

• Oracle E–Business Suite

• Oracle Advanced Queuing

• Oracle Workflow

Oracle Workflow Business Event System

Oracle XML Gateway leverages the Oracle Workflow Business Event
System to publish and subscribe to application business events of
interest to automatically trigger message creation or consumption.

Business events and event subscriptions to send outbound messages or
to consume inbound messages are delivered for all Oracle prebuilt
messages.  The seeded event subscriptions can be configured during
implementation to perform activities to address specific business
requirements.

Oracle E–Business Suite

The XML Gateway Execution Engine interfaces with the Oracle
E–Business Suite via business events and event subscriptions to
retrieve data from or populate data into the Oracle e–Business Suite
tables.

Oracle Advanced Queuing

The XML Gateway Execution Engine interfaces with Oracle Advanced
Queuing to stage outbound XML messages or receive inbound XML
messages for processing.

Oracle Workflow

The XML Gateway Execution Engine interfaces with Oracle Workflow
to actively notify the XML Gateway system administrator regarding
system or process errors, or the Trading Partner contact for data errors.
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The XML Gateway system administrator has the option to ”retry”
failed outbound processes, or ”reprocess” failed inbound processes.

Internal to the XML Gateway Execution Engine are the following functions:

Validate Trading Partner or Hub

Verify that the Trading Partner is defined and the required document is
enabled.

Retrieve Message Map from Repository

Retrieve the message map associated with the Trading Partner and
required document.

Retrieve and Populate Data to and from the Oracle E–Business Suite

For outbound messages, gather the application data from the Oracle
E–Business Suite using the information on the message map.

For inbound messages, process the data into the Oracle E–Business
Suite using the information on the message map.

Apply Data Transformations or Process Control Functions

Apply code conversions, data transformations, and process control
functions defined on the message map.

Validate Message Using the XML Parser

For outbound message, the XML Parser is used to validate the newly
created message to ensure that it is well–formed and valid.  Poorly
formed or invalid messages will not be enqueued for delivery.  An
error notification is sent to the XML Gateway system administrator.

Inbound messages dequeued from the inbound queue are validated
using the XML Parser to ensure that it is well–formed and valid.
Poorly formed or invalid messages will not be processed by the XML
Gateway Execution Engine.  An error notification is sent to the Trading
Partner contact.
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Enqueue and Dequeue XML Messages

Outbound messages are enqueued for delivery by the transport agent.
Inbound messages are dequeued for processing by the XML Gateway
Execution Engine.

Send and Receive Message Confirmations

An outbound confirmation is sent in response to an inbound request if
the outbound confirmation is enabled for the Trading Partner.

An inbound confirmation is received in response to an outbound
request if the inbound confirmation is enabled for the Trading Partner.

Direct Interaction with Execution Engine for A2A Integration

Seeded Workflow functions are provided for use in Workflow processes
to interact directly with the Execution Engine to generate outbound or
to consume inbound messages.

The outbound message generated by the XML Gateway Execution
Engine is made available to the downstream Workflow activity for
processing.  The Execution Engine consumes the inbound message
passed to it by a Workflow process.

The XML Gateway Execution Engine begins processing once it detects
the Workflow process to send or generate an XML message or that an
inbound message has arrived on the inbound queue.

Oracle Transport Agent

The Oracle Transport Agent interfaces with Oracle Advanced Queuing
to deliver outbound messages and to receive inbound messages.

The Transport Agent server is a Java–based servlet that uses the
Transport Agent Messaging Protocol to support the following:

• Guaranteed delivery, exactly once

• Message encryption

• Server–to–server certificate authentication

XML Messages and EDI Transactions

EDI transactions and XML messages are two forms of electronic
messaging based on their respective standards.  EDI transactions are
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more batch–oriented while their XML counterpart is event–based,
real–time, and tend to be based on a single transaction.

Oracle e–Commerce Gateway integrates with the Oracle E–Business
Suite to extract or to import traditional EDI transactions using a flat
ASCII file.  A third party EDI Translator is required to map the data
between the Oracle E–Business Suite and the EDI standard of choice
such as ASC X12 or EDIFACT.

Oracle XML Gateway  integrates with the Oracle E–Business Suite to
create or to consume XML messages based on application business
events.  Oracle XML Gateway creates and consumes
standards–compliant XML messages without the use of a translator.

Conclusion

Oracle XML Gateway is the XML message enabler for the Oracle
E–Business Suite.  It provides consistent XML message implementation
within and outside the enterprise in support of A2A and B2B
messaging initiatives.

Oracle XML Gateway leverages the publish and subscribe features of
the Oracle Workflow Business Event System to automate message
creation and consumption in addition to using Oracle Workflow to link
key business processes.  This combination enables seamless
collaboration, coordination, and communication of business–critical
data throughout the supply chain.
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Message Designer

his chapter describes how to use the XML Gateway Message
Designer to create new XML message maps or to modify Oracle
prebuilt XML message maps.  Specifically, this chapter describes how
to do the following:

• Create Data Definitions and Message Maps using the the Data
Definition Creation Wizard and the Map Creation Wizard

• Perform mapping from the source data definition to the target
data definition using the Transaction Map Window

• Apply actions using the Map Action Editor

• Extend DTDs

• Map to a Pass–Through Message

• Map to an API

• Load/Delete Message Maps and DTDs

• Load/Delete XSLT Style Sheets

• Implement Attachments in XML Messages
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Message Designer Overview

The Message Designer is a wizard–guided, repository–based tool used
to create XML message maps.  Map creation consists of defining the
data source and data target, defining hierarchy and data maps between
the source and target data, and defining actions for data transformation
and process control.

The Message Designer is independent of XML standards. It complies
with version 1.0 of the W3C XML specifications.

Note:  Information regarding the W3C XML Standards can be
found at www.w3.org/XML/Activity.

The Message Designer can support map creation for any business
document as long as the document conforms to a Document Type
Definition (DTD).

The Message Designer can be used to:

• Modify the Oracle prebuilt message maps

• Create new message maps

If you are using the Message Designer to create new message maps,
you must complete a map analysis before attempting to use the
Message Designer.  Refer to Map Analysis Guidelines: page A – 2 for
the details. The thoroughness of your map analysis will impact the
success of your map creation.

Load completed message maps and associated DTDs into the XML
Gateway repository.  The XML Gateway Execution Engine and the
XML Parser use the maps to create outbound messages and to consume
inbound XML messages.

Message Designer Menus

The Message Designer has the following menus: File, View, and Help.
Some of the menu functions can also be accessed by toolbar icons.

See: Message Designer Toolbar: page 2 – 4.

File Menu

Use the Message Designer to create new data definitions and
transaction maps or to modify existing data definitions and transaction
maps.
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The Message Designer supports the following file types:

• XGD for source or target data definitions

• XGM for transaction maps

The .XGD and .XGM files are XML files that can be opened and read
using a browser or any XML editor.  The XGD and XGM files are used
to describe the structure and content of a message.  The XML message
produced or consumed using the transaction map (XGM) contains the
actual business data.

The File menu options are listed in the following table:

Menu Option Description

New Create a new data definition file or a new transaction map
file.

Open Open an existing file.  Files can be either data definition
files with a XGD extension, or transaction map files with a
XGM extension.

Close Close the open transaction map or data definition file.

Save Save an open file.  Save the data definition files as XGD
files.  Save the transaction map files as XGM files.

Properties Provides access to key property values entered using the
Data Definition Creation Wizard or Map Creation Wizard.
Use this menu option to change any of the original key
values presented.  
See File > Properties Menu Option: page 2 – 6 for more
details regarding this menu option.

Exit Exit Message Designer.

View Menu

Use the View Menu to view the source or target definitions in tree
format only, table format only, or both tree and table formats.

The View menu options are listed in the following table:
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Menu Option Description

Tree View source or target definition in tree format only.

Table View source or target definition in table format only.

View Both View source or target definition in both tree and table
formats.  This is the default viewing option.

Help Menu

The Help menu options are listed in the following table:

Menu Option Description

Help Topics Displays Message Designer help.

About Displays the Message Designer version.

Message Designer Toolbar

The Message Designer toolbar uses the following icons to duplicate the
noted menu options:

Create New Map icon.  Invokes the Map Creation Wizard.

Open Map icon.  Opens an existing map.

Save Map Icon.  Saves the data definition as a XGD file.  Saves the
transaction map as a XGM file.

View Tree icon.  Displays the tree format only.

View Table icon.  Displays the table format only.

View Both Tree and Table icon.  Displays both the tree and table
formats.
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Help icon.  Invokes Message Designer Help.

Message Designer Buttons

The Add Sibling button adds a new element at the same hierarchy
level as the selected item on the map.

For additional information on this function see the following:

For Source Data Definitions see (Source Definition Tab) Add
Sibling: page 2 – 51.

For Target Data Definitions see (Target Definition Tab) Add Sibling:
page 2 – 61.

The Add Child button adds a new element at a lower hierarchy
level as the selected item on the map.

For additional information on this function see the following:

For Source Data Definitions see (Source Definition Tab) Add Child:
page 2 – 52.

For Target Data Definitions see (Target Definition Tab) Add Child:
page 2 – 61.

The Delete button deletes any element that has not been mapped.
Be careful not to delete required data elements.  Deleting required
elements will cause a parser violation.

If an item has child elements associated with it, a warning is
displayed before the delete occurs.

Attention:  If you are deleting any DTD extensions, be sure to
remove the DTD extensions from the corresponding extension
file created for the application or user.  The extra information
will not cause a parser violation, but it is a good practice to
ensure the extension files match the message maps.  Refer to
How to Extend DTDs: page 2 – 117 for the details.
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File > Properties Menu

The File > Properties menu option provides access to key property
values entered using the Data Definition Creation Wizard or the Map
Creation Wizard.  Use the Properties window to change any of the key
property values presented.

The Property Tabs and fields associated with each Tab vary depending
on where the File > Properties menu option is invoked.  The options
available from each window are:

• Main Message Designer  – General Tab, Database Tab

• Data Definition Window – General Tab, Database Tab, Data Tab

• Transaction Map Window– General Tab, Database Tab, Map Tab,
Source Tab, Target Tab

General Tab

The General Tab allows you to update the Output Directory.  This is the
default directory used to store the data definition and message map
files created using the Message Designer.

Use the Browse button to select a default directory
or enter a valid directory name.

Database Tab

Use the Database Tab to provide the default database connection
information.  The default values will be provided to the Data Definition
and Map Creation Wizards as well as to the Procedure Call action.

Output Directory
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The database connection fields prompted for are:

• Username

• Connect to Database

• Host

• Port

• Schema Name

Data Tab

The Data Tab allows you to update data values originally entered using
the Data Definition Creation Wizard.  The fields on the tab vary
depending on the type of data definition.
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The fields in the following table display for all data definitions:

Field Description

Data Definition Name Update the name entered.  Observe the naming conven-
tions recommended in the Data Definition and Map Cre-
ation Wizards.
See Select/Create a Source/Target Data Definition Name
and Type: page 2 – 27 for the naming convention details.

Data Definition Description Update the description.

Attention:  If the data definition changes affect any existing
maps, the maps must be changed and reloaded.  If the DTD
reference is changed, the new DTD must be reloaded.  Refer to
How to Load/Delete Message Maps and DTDs: page 2 – 121.

The fields in the following table display when the data definition type
is XML:
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Field Description

Root Element Update the Root Element entered.  The root element en-
tered must match the root element of the DTD entered
below.

Runtime DTD Location Update the Runtime DTD Location with the new subdi-
rectory name.  Observe the naming conventions recom-
mended in the Data Definition and Map Creation Wiz-
ards.
See Identify the Runtime Location of a DTD: page 2 – 42
for naming convention details.

DTD File Name Use the Browse button to select a DTD or enter a valid
DTD file name.  This will replace the file name originally
entered.  The root element defined in the DTD must match
the root element value entered above.

Attention:  Changes to any of these property values require
the message map to be reloaded.  Changing the DTD
associated with the message map requires the DTD to be
reloaded.  Refer to How to Load/Delete Message Maps and
DTDs: page 2 – 121 for details.

Map Tab

This tab displays only if you are viewing a map transaction file (.XGM).
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Field Description

Map Name Update the name entered.  Observe the naming conven-
tions recommended in the Map Creation Wizard.
See  Specify a Map Name: page 2 – 25 for naming conven-
tion details.

Map Description Update the description.

Attention:  If the map name change affects any existing
Trading Partner definitions, update the Trading Partner
definition with the new map name.   Refer to Trading Partner
Setup: page 3 – 25 for the details.

Attention:  The map containing the new name must be
reloaded into the XML Gateway repository.  Refer to How to
Load/Delete Message Maps and DTDs: page 2 – 121 for the
details.
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Source Tab

The fields in the following table display for all data definitions:

Field Description

Data Definition Name Update the name entered.  Observe the naming conven-
tions recommended in the Data Definition and Map Cre-
ation Wizards.
See Specify Source/Target Data Definition Name and
Type: page 2 – 29 for naming convention details.

Data Definition Description Update the description.

Attention:  If the data definition changes affect any existing
maps, the maps must be changed and reloaded.  If the DTD
reference is changed, the new DTD must be reloaded.  Refer to
How to Load/Delete Message Maps and DTDs: page 2 – 121.

The fields in the following table display when the data definition type
is XML:
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Field Description

Root Element Update the Root Element entered.  The root element en-
tered must match the root element of the DTD entered
below.

Runtime DTD Location Update the Runtime DTD Location with the new subdi-
rectory name.  Observe the naming conventions recom-
mended in the Data Definition and Map Creation Wiz-
ards.
See Identify the Runtime Location of a DTD: page 2 – 42
for naming convention details.

DTD File Name Use the Browse button to select a DTD or enter a valid
DTD file name.  This will replace the file name originally
entered.  The root element defined in the DTD must match
the root element value entered above.

Attention:  Changes to any of these property values require
the message map to be reloaded.  Changing the DTD
associated with the message map requires the DTD to be
reloaded.  Refer to How to Load/Delete Message Maps and
DTDs: page 2 – 121 for details.
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Target Tab

The fields in the following table display for all data definitions:

Field Description

Data Definition Name Update the name entered.  Observe the naming conven-
tions recommended in the Data Definition and Map Cre-
ation Wizards.
See Specify Source/Target Data Definition Name and
Type: page 2 – 29 for naming convention details.

Data Definition Description Update the description.

Attention:  If the data definition changes affect any existing
maps, the maps must be changed and reloaded.  If the DTD
reference is changed, the new DTD must be reloaded.  Refer to
How to Load/Delete Message Maps and DTDs: page 2 – 121.



☞

2 – 14 Oracle XML Gateway User’s Guide

The fields in the following table display when the data definition type
is XML:

Field Description

Root Element Update the Root Element entered.  The root element en-
tered must match the root element of the DTD entered
below.

Runtime DTD Location Update the Runtime DTD Location with the new subdi-
rectory name.  Observe the naming conventions recom-
mended in the Data Definition and Map Creation Wiz-
ards.
See Identify the Runtime Location of a DTD: page 2 – 42
for naming convention details.

DTD File Name Use the Browse button to select a DTD or enter a valid
DTD file name.  This will replace the file name originally
entered.  The root element defined in the DTD must match
the root element value entered above.

Attention:  Changes to any of these property values require
the message map to be reloaded.  Changing the DTD
associated with the message map requires the DTD to be
reloaded.  Refer to How to Load/Delete Message Maps and
DTDs: page 2 – 121 for details.
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Message Designer Wizards

The Message Designer contains two wizards to guide you through the
map creation process.  The two wizards are:

• Data Definition Creation Wizard

• Map Creation Wizard

The Data Definition Creation Wizard is used to define the data
definitions.

A data definition is a collection of data used to describe a business
object such as a customer profile or an invoice document.  A data
definition may be based on database views, database tables, application
open interface tables, an application API, an XML Document Type
Definition (DTD), or a production XML message.

A message map consists of a source data definition and a target data
definition graphically represented as follows:

The data definitions created using the Data Definition Creation Wizard
are used to create a preliminary message map.  The Data Definition
Creation Wizard is ideal for creating a master definition to use as the
basis for creating trading partner–specific message maps.

Three combinations of source and target data definitions are supported
by the Message Designer as described in the following table:
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Source Target Purpose

Database XML Outbound XML message

XML Database Inbound XML message

XML XML Transform one version of a DTD to the next ver-
sion of the same DTD.

Transform from DTD in one standard to DTD of
another standard as long as the DTDs are for the
same business function.

Pass–through XML message
   Refer to How to Map a Pass–Through 
   Message: page 2 – 119.

Mapping to an Application API
   Refer to How to Map to an API: page 2 – 120.

Database–based data definitions represent a description of the Oracle
data model required to support the XML message.

XML–based data definitions are based on an XML Document Type
Definition (DTD) or a production XML message.  XML to XML
transformations from one DTD to another DTD where the DTDs are for
different business purposes is done in two steps:

1. Database to XML

2. XML to database

The Map Creation Wizard is used to define the following:

• Source Definition

• Target Definition

• Preliminary Message Map

The source and target data definitions may be new or based on
definitions previously created using the Data Definition Wizard.  The
source and target data definitions form the basis of a preliminary
message map.

The Message Designer is used to define the following to complete the
message map:

• Level Mapping

• Element Mapping

• Actions
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Level mapping is the process of relating the source data structure to the
target data structure.  Element mapping is the process of relating a
source data element to a target data element.  Actions are data
transformation or process control functions that can be applied at the
data element, document, or root level.

Data Definition Creation Wizard Process Flow

Creating a Data Definition consists of two general steps:

Step 1: Name the data definition and select the type

Step 2: Identify data definition details

The tasks required to complete Step 2 vary depending on your
selections in Step 1.

The illustration below displays the flow of the screens presented to you
in the Data Definition Creation Wizard.  After you specify the data
definition name and type (Step 1), you are prompted to provide the
details based on whether you chose a type of database or XML.

When you have completed Step 2, you are presented with a summary
screen where you can either finish or return to previous steps to make
edits.  Clicking Finish will close the Wizard and open the Message
Designer Data Definition window.
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Data Definition Creation Wizard Process Flow

Map Creation Wizard Process Flow

There are three general steps to creating a map.  Each step consists of a
variable number of tasks depending on the selections you make in the
Wizard:

Step 1: Specify a Map Name

Step 2: Select/Create a Source Data Definition

Step 3: Select/Create a Target Data Definition

The illustration below displays the flow of the screens presented to you
in the Map Creation Wizard.  After you specify a map name (Step 1),
you are prompted to select or create a source data definition (Step 2).  If
you choose to create the data definition, you are guided through the
data definition creation steps (identical to the Data Definition Creation
Wizard steps).

After you create your source data definition, or if you chose to select
an existing data definition, you are prompted to select or create a target
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data definition (Step 3).  The target data definition steps are identical to
the source data definition steps.

When you have completed Step 3, you are taken to a summary screen
where you can either finish or return to previous steps to make edits.

Map Creation Wizard Process Flow
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Using the Data Definition Creation Wizard

The Data Definition Creation Wizard guides you through the data
definition creation process.  The data definition is saved as a .xgd file
and can be selected as a target or a source when you create a map.

Attention:  It is not necessary to create your data definitions
before you begin the map creation process.  The Map Creation
Wizard gives you the option of choosing an existing data
definition or creating a new one.  If you choose to create a new
one, you will be guided through the data definition creation
steps as part of your map creation process.  See Map Creation
Wizard: page 2 – 24.

Launch the Data Definition Creation Wizard by selecting

(M) File > New > Data Definition

The first window welcomes you to the wizard.
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The following buttons are available for all Wizard steps:

• Cancel

Exit the Wizard and cancel all completed Wizard steps.

• Back

 Return to the previous Wizard step.

• Next

Advance to the next Wizard step.  The Next button is enabled
only after the required information for the current Wizard step
has been entered.

Data Definition Creation Wizard Steps

Follow the instructions presented for the Map Creation Wizard to
complete each of the Data Definition Creation Wizard steps:

Specify Data Definition Name and Type

See Specify Source/Target Data Definition Name and Type: page 2 – 29.

If you selected Database...

Complete the following steps:

Specify Database Information

See Specify Source/Target Definition Database Information: page
2 – 31.

Select Tables or Views

See Select Source/Target Tables or Views: page 2 – 33

Select Columns

See Select Source/Target Columns: page 2 – 36

Specify Source/Target Levels

See Specify Source/Target Levels: page 2 – 38.
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If you selected XML...

If you selected XML as the data definition type, you will be prompted
for the XML information.

See Specify Source/Target XML File and Root Element: page 2 – 40.

Data Definition Creation Wizard: Summary

Click Finish to complete the Wizard steps.  If you wish to change any
selections you have made in defining your data definition, you can
used the Back button to return to the appropriate Wizard window.
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Message Designer Data Definition Window

The data definition you just created is displayed in the Data Definition
tab.  You can extend the definition using the Data Definition window to
perform the following:

• Provide default values

• Create additional nodes and elements using the Add Sibling
button

• Add fields using the Add Child button

• Enable code conversion

• Define conditional node mapping rules for additional nodes or
element (if source is DTD)

Once the data definition is complete, use the File > Save (Data
Definition) menu option or the Toolbar equivalent.  Use the File >
Properties menu to change the default directory if necessary.
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Using the Map Creation Wizard

The Map Creation Wizard guides you through the map creation
process.  A series of windows are presented to create a map based on
the source and target definitions.

Launch the Map Creation Wizard by selecting

(M) File > New > Transaction Map

or by clicking the Create New Map icon on the toolbar.  The first
window welcomes you to the wizard.
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The following buttons are available for all Wizard steps:

• Cancel

Exit the Wizard and cancel all completed Wizard steps.

• Back

 Return to the previous Wizard step.

• Next

Advance to the next Wizard step.  The Next button is disabled
until you supply all required data for a step.

Click Next to continue.  The Wizard will display the Specify a Map
Name window.

Specify a Map Name
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Specify a unique map name.  This is the name assigned to the message
map you are creating.  It is also the name to be used when associating a
message map to a Trading Partner.

Enter Map Name

Enter a unique map name.  This name is stored as the map code in the
map definition file.

In addition to being unique, the name should describe the intended use
of the map for easy identification.  The recommended naming
convention is as follows:

• Product mnemonic or user ID

• Transaction subtype as entered in the Define Transactions form

• XML standard and version used (for example, OAG, Rosettanet,
iFX)

• Inbound or outbound message

Examples of map names using the recommended naming convention
are:

• AR_INVO_OAG70_OUT_INVOICE

This map name is used for an Oracle Receivables outbound
invoice message that uses the OAG standard, version 7.0 DTD.

• USER_ACK_OAG70_IN

This name represents a user–developed map for an inbound
acknowledgment message that uses the OAG standard, version
7.0 DTD.

Note:  You can use the File > Properties menu option to change
the Map Name and Map Description as necessary.

Enter Map Description

Enter a description for the map.

Note:  You can use the File > Properties menu option to change
the Map Name and Map Description as necessary.

Click Next to continue.  The Wizard will display the Select/Create a
Source Data Definition window.
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Select/Create a Source/Target Data Definition

Select an existing data definition file or create a new data definition file.

Create a new source/target data definition

Select this option to create a new data definition.  The Wizard will
guide you through creating your new .XGD file.

Select an existing data definition

Existing definition files are stored on the file system as <filename>.XGD.
Use the Browse button to view the available data definition files.
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Click Next to continue

• If you are defining your Source data definition and you
selected...

– Create a new source data definition, proceed to  Specify
Source/Target Data Definition Name and Type: page 2 – 29.

– Select an existing Source data definition, repeat this step for
your Target Data Definition.

• If you are defining your Target data definition and you
selected...

– Create a new target data definition, proceed to  Specify
Source/Target Data Definition Name and Type: page 2 – 29.

– Select an existing Target data definition, proceed to Map
Creation Wizard Summary: page 2 – 43.
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Specify Source/Target Data Definition Name and Type

For a new data definition, enter a data definition name, description,
and type.

Enter Data Definition Name

Enter a name that describes the contents of the data definition to allow
easy identification.

This name is displayed in the Transaction Map window as the root
node, if you select database as the data definition type.  If you select
XML as the data definition type, the DTD root element is displayed in
the Transaction Map window as the root node instead of the data
definition name entered here.

The recommended naming convention is as follows:
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• Product mnemonic or User ID

• Transaction subtype as entered in the Define Transactions form

• XML standard and version used (for example, OAG, Rosettanet,
iFX)

• Database or XML data definition type

Examples of data definition names using the recommended naming
convention are:

• AR_INVO_OAG70_DB

This name describes an Oracle Receivables–developed outbound
invoice message that uses the OAG standard, version 7.0 DTD.
This data definition is for the Database data definition type
intended for use as the source data definition for an outbound
message.

• USER_ACK_OAG70_XML

This name describes a user–developed inbound
acknowledgement message that uses the OAG standard, version
7.0 DTD.  This data definition is for the XML data definition type
intended for use as the source data definition for an inbound
message.

Use the File > Properties menu option to change the Data Definition
Name as necessary.

Enter Data Definition Description

Enter a description for the data definition.

Use the File > Properties menu option to change the Data Definition
Description as necessary.

Select Data Definition Type

Select a data definition type from the following list of values:

• Database

• XML

Click Next to continue.

The wizard steps to follow will vary based on the data definition type
selected.
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• If you selected Database, proceed to Specify Source/Target
Definition Database Information: page 2 – 31.

• If you selected XML, proceed to Specify Source/Target XML File
and Root Element: page 2 – 40.

Specify Source/Target Definition Database Information

The default database access information is displayed from the Database
tab (see: page 2 – 6) of the File > Properties menu.  Enter the password
and make changes to the database access information if necessary.

Note:  Changes made on this screen are not copied back to the
Properties file.  Entries on this screen are used for the current
session only.

This step does not apply if the source/target is a DTD because database
access is not required.
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User Name

Enter the user name for the database schema to be accessed.

Password

Enter the password for your User Name.

Connect String

Enter the connect string for the database.

Host

Enter the host name for the database.

Port

The default value of ”1521” is displayed.  Enter another valid port
value (if necessary) for the database to be accessed.

Click Next to continue.  The Wizard will display the Select
Source/Target Tables or Views window.
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Select Source/Target Tables or Views

If you selected a Data Definition Type of Database, you will be
prompted for the database schema, database views, and tables required
by the message.

All application database views are defined in the APPS schema. The
associated database tables are defined in the application–specific
database schema.  Access to application–specific database tables must
be granted by defining a synonym in the APPS schema.

For applications with database views or tables shared across multiple
hierarchical levels of the data model representing the business
document, a database view or table alias is required for the second and
each subsequent use of the view or table.  This is necessary because this
wizard step deletes a database view or table from the Available
Tables/Views list once it has been selected.
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This step does not apply if the source/target is a DTD, because
database information is not necessary.

Available Tables/Views

Expand the APPS database schema tree to view all the available
database tables and views.

Selected Tables/Views

Select the desired database views and tables from the left window, click
on the right shuttle to move the selected database view or table from
Available Tables/Views to Selected Tables/Views.  Continue this
process until you have selected all the required database views and
tables for each schema selected.
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Once you have selected all the database views and tables required by
the message, select any special XML Gateway database views you may
have defined to support the specific requirements of the XML standard
you are using.

For example, select the ECX_OAG_CONTROLAREA_TP_V (formerly
ECX_OAG_CONTROLAREA_V) database view to map to the OAG
CNTROLAREA data type.

Note:  The ECX_OAG_CONTROLAREA_TP_V view is an
upgraded version of the ECX_OAG_CONTROLAREA_V view.
Oracle XML Gateway supports both versions of the database
view.

The upgraded view includes new fields for USERNAME,
SOURCE_TP_LOCATION_CODE, PARTY_ID,
PARTY_SITE_ID, and PARTY_TYPE as well as changes to the
following existing fields:

REFERENCE_ID is based on the system name, event name,
and event key defined by the application business event.
REFERENCE_ID was previously defaulted to ”1” with
recommendations to use the ECX_REFERENCE_ID sequence
to get a unique number.  The use of this field varies by message
map.

You must add the ECX_EVENT_MESSAGE item attribute to
your Workflow item type to have access to the event details.

CONFIRMATION is based on the setting defined for the
Trading Partner and business document entered using the
Define Trading Partners window.  CONFIRMATION was
previously defaulted to ”0”.

COMPONENT is based on the internal transaction type
entered on the Define Transactions window for the business
document.  COMPONENT was previously based on the
external transaction type.

TASK is based on the internal transaction subtype entered on
the Define Transactions window for the business document.
TASK was previously based on the external subtype.

TRANSACTION_SUBTYPE is based on the internal
transaction subtype entered on the Define Transactions
window.  TRANSACTION_SUBTYPE was previously
defaulted to the TRANSACTION_TYPE if no value was found
in the database.

To deselect a selected database view or table, select the desired
database view/table from the right window, click on the left shuttle
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button to move the selection from the Selected Tables/Views back to
Available Tables/Views.

Click Next to continue.  The Wizard will display the Select
Source/Target Columns window.

Select Source/Target Columns

This window prompts you for the columns required from each of the
database views or tables selected in the previous step.

This step does not apply if the source/target is a DTD because database
information is not necessary.

Available Columns

Expand each of the database views and tables to view all the available
database view and table columns.
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Selected Columns

Select the desired database view or table column from the left window,
click on the right shuttle button to move the selected database view or
table column from Available Columns to Selected Columns.  To move
all the columns from a view or table, select the table or view and click
the double right shuttle button to move all its columns from Available
Columns to Selected Columns.  Continue this process until all the
required database view and table columns are selected.

You cannot proceed to the next wizard step until you have selected at
least one column from each of the selected database views and tables.
If necessary, return to the previous wizard step to deselect a database
view or table and then resume the column selection process.

To deselect a selected database view or table column, highlight the
desired column from the right window and click the left shuttle button
to move the highlighted column from Selected Columns back to
Available Columns.  To deselect all the columns from a table or view,
highlight the table or view name under Selected Columns and click the
double left shuttle button to move all the columns back to the Available
Columns area.

Click Next to continue.  The Wizard will display the Specify
Source/Target Levels window.
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Specify Source/Target Levels

If you selected a Data Definition Type of Database, you will be
prompted to identify the hierarchy of the source or target data
definition.  This step is necessary only if your source/target data
definition contains more than one level.

A level represents a collection of data that repeats.  For example,
Purchase Order lines represent a level within a Purchase Order because
there are multiple PO lines to a single PO.

The purpose of this step is to identify the parent and child relationships
of each database view.  The source hierarchy will be used to relate to
the target hierarchy as part of the map creation process.

This step does not apply if the source/target is a DTD because database
information is not necessary.
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Available Tables/Views

The available database views and tables are displayed for your
selection.

Selected Tables/Views

This window allows you to define the parent and child relationships of
the selected database views and tables along with the special database
views necessary to relate the database data model to the DTD data
model.

Start by identifying the parent node.  For OAG, the parent node is the
ECX_OAG_CONTROLAREA_TP_V view (formerly
ECX_OAG_CONTROLAREA_V).  Related to the parent node are
sibling or child nodes.

Note:  The ECX_OAG_CONTROLAREA_TP_V view is an
upgraded version of the ECX_OAG_CONTROLAREA_V view.
Oracle XML Gateway supports both versions of the database
view.  For more information see the Note: page 2 – 35.

Sibling and child relationships are defined by first identifying the
parent node in the Selected Tables/Views window (right).  The
database view or table you move from the the Available window to the
Selected window will always be added as the last child of the parent
node selected.

Therefore, to specify a sibling relationship to a specific node, select its
parent node in the Selected Tables/Views column (right window).
Next select the database view or table in the Available Tables/Views
(left window) that you want to define as its sibling.  Click on the right
shuttle.  The selected database view or table will be displayed as the
last child of the parent node selected, or as a sibling to the desired
node.

To specify a child relationship to a specific node, select the node in the
Selected Tables/Views column (right window).  Next select the
database view or table in Available Tables/Views (left window) that
you want to define as its child, and click on the right shuttle.  The
selected database view or table will be displayed as the last child of the
selected parent node.

Continue this process until all available database views and tables have
been moved to Selected Tables/Views.

This completes the data definition process.
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Click Next to continue

If you have just finished your Source Data Definition, return to
Select/Create a Source/Target Data Definition: page 2 – 27 to define
your Target Data Definition.

If you have just finished your Target Data Definition, proceed to Map
Creation Wizard Summary: page 2 – 43.

Specify Source/Target XML File and Root Element

If you selected XML as the data definition type, you will be prompted
for the XML information.  You can use a DTD or a production XML
message as the data definition.
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XML Standard

Enter the XML standard used.

”OAG” (Open Application Group XML Standard) is the default.

Select a DTD/XML File

Select the DTD from the list of available DTDs presented when you
click on the Browse button, or enter a specific DTD including the file
path.  The selected DTD and its file path are displayed.

To base the data definition on a production XML message, enter the file
path and file name of the XML message.

The DTD or production XML message is used to create the definition
tree for the Message Designer.

This step assumes that the required DTD and the associated external
reference DTD files are available on the file system and are accessible
by the Message Designer.  For example, the OAG definition files are

– oagis_domains.dtd

– oagis_resources.dtd

– oagis_fields.dtd

– oagis_segments.dtd

Identify the XML Root Element

Enter the XML root element.  Open the DTD or production XML
message using a browser or XML editor to determine the root element
name if you do not know it.

Note:  Because  the representation of root element varies by
XML standard, this step is required to inform the Execution
Engine where to begin reading the DTD.

Use the File > Properties menu option to change the Root Element as
necessary.

Enter DTD File Name

If you entered a DTD above, the DTD file name will display
automatically.

If you entered a production XML message above, click the Browse
button to select the corresponding DTD from the list of available DTDs,
or enter a specific DTD if available.
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The DTD file name entered is used to validate a message to ensure that
it is well–formed and valid before placing an outbound message on the
outbound queue or processing a message dequeued from the inbound
queue.

In addition, the primary DTD and its associated definition files must be
loaded into the XML Gateway repository for access by the XML
Gateway Execution Engine.

Note:  Refer to How to Load/Delete Message Maps and DTDs:
page 2 – 121 for more details.

Use the File > Properties menu option to change the DTD File Name as
necessary.

Identify the Runtime Location of a DTD

Enter the subdirectory name using the following naming convention:

<application code>/xml/<standard><standards version>

Examples:

ar/xml/oag62

ap/xml/oag70

Note:  Do not use a period (.) when referencing a standards
version.

The combination of the runtime DTD location and the DTD file name
provides a unique identifier for the DTD required.

Use the File > Properties menu option to change the Runtime Location
of a DTD as necessary.

Click Next to continue

If you have just finished your Source Data Definition, return to
Select/Create a Source/Target Data Definition: page 2 – 27 to define
your Target Data Definition.

If you have just finished your Target Data Definition, proceed to Map
Creation Wizard Summary: page 2 – 43.
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Map Creation Wizard Summary

Click Finish to exit the Map Creation Wizard.  If you wish to change
any selections you have made in defining your map, use the Back
button to return to the appropriate Wizard window.

Before proceeding to the level and element mapping process, the XML
Gateway, in conjunction with the XML Parser, performs the following
validations:

• When the DOCTYPE tag is present in an XML message, verify
that the DTD referenced is accurate.

• Verify that the XML root element matches the DTD identified.
When a production XML message is identified, verify that the
root element and DTD identified match the production XML
message.
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• Verify that external DTDs referenced by the primary DTD are
available.

• Check for circular DTD references.  Process the first occurrence,
truncate the remainder and warn user to manually add the
necessary repeating occurrences.
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Transaction Map Window

Upon exiting the Map Creation Wizard, the source and target
definitions are presented in the Transaction Map window.

The Transaction Map window will also be presented if you select an
existing map with a version number compatible with the version
number of Message Designer.

The version number of the map (.xgm file) is stored in the
<ECX_MAJOR_VERSION> and <ECX_MINOR_VERSION> tags.  The
Message Designer version number is available in the Help > About
menu.  Maps are compatible with Message Designer if the major
version is the same and the minor version is the same or lower.

The Transaction Map window is divided into four tabs as follows:

• Source Definition

• Target Definition

• Level Mapping

• Element Mapping (this tab appears only after a Level has been
mapped)

Source Definition

The source definition selected or created using the Map Creation
Wizard is displayed in the Source Definition tab.  You can extend the
source definition to perform the following:

• Provide default values

• Enable code conversion

• Create duplicate nodes or elements using the Add Sibling button

• Add fields using the Add Child button

• Define conditional node mapping rules for duplicate nodes or
elements (if the source is a DTD)

Once the source data definition is complete, it can be saved for reuse in
other message maps.  Use the File > Save (Data Definition) menu
option or the Toolbar equivalent.  Use the File > Properties menu to
change the default directory or data definition property values if
necessary.
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If you do not wish to save the source data definition as an entity
independent of the message map, then continue with the mapping
process and save the transaction map at the end of the Element
Mapping process.

Source Definition Considerations

1. Refer to How to Map a Pass–Through Message: page 2 – 119, for
guidelines related to developing a pass–through transaction.

2. Discontinuous nodes:

A discontinuous node is a non–level node that follows a level and is a
sibling of that level.  It can be represented graphically as follows:
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In this example, the levels LINE DETAILS and LINE TERMS are
children of the level LINE, and are siblings of each other.  Inserted
between LINE DETAILS and LINE TERMS is a new element of the
LINE node.  The new element is a continuation of the LINE node that
creates a break between LINE DETAILS and LINE TERMS.

The ideal placement of the new element is as the last element of the
LINE node before the LINE DETAILS node.  However, some standards
bodies do not have the flexibility to restructure an existing DTD, or
may not wish to for backwards compatibility reasons.  Regardless of
the reason, the condition exists, and XML Gateway supports it.

For data definitions based on the Oracle data model, use the Add Child
or Add Sibling button in the Message Designer, Transaction Map
window to define a discontinuous node.  Any new node introduced on
the source and distributed across multiple target levels (expanded) or
consolidated into a single target level (collapsed) will be grouped with
the parent node and mapped according to the target definition.  The
rules against level cross–over still apply.

For data definitions based on a DTD, use the Transaction Map window,
Item Type column to explicitly identify the data levels.  This exercise
may create a discontinuous node, which is not a problem unless you
define the invalid scenario described below.   The only user extensions
supported for OAG DTDs are in the USERAREA.  If you modify the
DTD (using the Add Child or Add Sibling buttons) outside of the
USERAREA, a parsing error will be triggered.

Message Designer will allow you to define a discontinuous node
anywhere in the source or target definition.  You will not know until
runtime if the definition is valid or not.  Therefore you should avoid
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introducing a discontinuous node for a node which also contains a
child node.

The following graphic illustrates an invalid definition:

In the example above, HEADER.element3 is a continuation of the
HEADER node.  HEADER.element3 is also defined as a child of the
LINE node.  HEADER.element3 has a child node called LINE
DETAILS.  This is an invalid definition.

3. Refer to How to Implement Attachments in XML Messages: page
2 – 127 for details on how to include attachments with your XML
documents.

Source Definition Tab

Field

Field identifies the name of the element, document, or root.  The names
are based on the database column names or DTD element names.

The field name may be changed if necessary, however, consider what
this change implies.  Because the field is based on the database column
name or a DTD element name, corresponding changes may be
necessary in the Oracle E–Business Suite or the DTD.  The only changes
allowed to a DTD are to the USERAREA.  Refer to How to Extend
DTDs: page 2 – 117 for details.
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The first row is reserved for the Data Definition name (if the source is
based on database views or tables) or root element name (if the source
is a DTD).

Additional field names are displayed when sibling or child elements
are added using the Add Sibling or Add Child buttons.

Item Type

Item type identifies the field as either a Level or an Element.  Level
represents the parent in a parent–child relationship.  Element represents
the child in a parent–child relationship.

The Item Type of the first row is defaulted to ”Level”.  You cannot
change this value.

If the source is based on database views or tables, the Item Type for the
database view or table is defaulted to ”Level”.  The Item Type for each
database view or table column is defaulted to ”Element”.

If the source is based on a DTD or a production XML message, the
default Item Type is ”Element”.  DTDs do not support levels, therefore
any levels must be explicitly defined by setting the Item Type to
”Level”.

Any node that represents a collection of data that repeats (for example,
Purchase Order lines or shipment lines) represents a level.  The Item
Type for the node must be set to Level.

For the OAG standard, change the Item Type of the following to Level
to support Level Mapping:

• Root

• CNTROLAREA

• DATAAREA

Make the same change for all other DTD data types identified as data
levels during the map analysis process.

The Item Type for a new sibling or child element is defaulted to
”Element”.  Change the Item Type setting when appropriate.

Default

Enter a default value for the field as appropriate.  This value is used in
the outbound message or an inbound message if the incoming value is
null.
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If the default value is based on a condition, set the default using the
Assign Variable Value action.  See Assignments: Assign Variable Value:
page 2 – 80 .

If Item Type is ”Level”, this column is disabled.

Category

Enable the field for code conversion by entering a valid code category.
Validation of code category is performed at runtime because the
database used to define the map may not be the database where the
transaction is executed.  Refer to Seeded Code Categories: page B – 2
for a list of seeded code categories.

Universal or standards–specific code conversion values are defined
using the Define Code Conversion Values form.  Trading
Partner–specific code conversion values are defined using the Trading
Partner Code Conversion form.

The execution engine will search for code conversion values in the
following sequence:

– Trading Partner

– Standard–specific

– Universal list

Use the Get Predefined Variable Value action to determine the status of
the code conversion process for the source column enabled for code
conversion.

See Get Predefined Variable Value: page 2 – 105 for details regarding the
code conversion return status and possible actions to take if the code
conversion cross–reference value is not found.

Code conversion is applied before any Actions are applied.  Consider
the code conversion return status when you define Actions for the
source column enabled for code conversion.  Actions are applied to the
code–converted value only when the code conversion process is
successful.

If Item Type is Level, this column is disabled.

Data Type

Each field is defined with a data type.  The data types supported by the
XML Gateway Execution Engine are VARCHAR2, DATE, NUMBER,
CHAR, and CLOB.
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The CLOB data type is used to support large objects up to 4 GB in size.
The CLOB is displayed between CDATA tags to escape parsing.

If the source is based on database views or tables, the data types are
defaulted to the data types defined for the view or table columns.

If the source is based on a DTD or a production XML message, the data
type is defaulted to VARCHAR2.

Attention:  It is not necessary to change the DTD element’s
data type until XML schemas are supported by the XML
standards bodies which will make data types more meaningful.

The Data Type for a new sibling or child element is defaulted to
VARCHAR2.  Change the data type if necessary.

If the Item Type is Level, the Data Type column is disabled.

DB Column

The DB Column is available only when the source is based on database
views or tables.

A check mark indicates the column is defined in the Oracle E–Business
Suite data model.  This setting informs the XML Gateway Execution
Engine whether to validate the element against the Oracle E–Business
Suite data model or not.

If Item Type is Level, the DB Column is disabled.

Node Type

Node Type is available only when the source is a DTD.  The default is
the DTD setting.

The valid values are Element or Attribute.  Elements contain the
business data.  Attributes contain qualifiers for the business data to
indicate its intended meaning.

The Node Type for a new sibling or child element is defaulted to
Element.  Change the Node Type setting where appropriate.

If Item Type is Level, this column is disabled.

Add Sibling (button)

The Add Sibling button allows you to add new fields required to
complete the map.  This feature is also used to create duplicate DTD
nodes such as PARTNER.
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When the source is based on a DTD or production XML message, and
you are adding a sibling between two attributes, set the Node Type for
the new field to ”Attribute”.  The default Node Type of ”Element” will
cause a parser violation.

Attention:  You cannot add a sibling to the root node.

Note:  Refer to How to Extend DTDs: page 2 – 117 for details on
how to extend a DTD.  Included are the naming conventions
that must be followed for the XML Parser to recognize the DTD
extensions.

Add Child (button)

The Add Child button adds child elements to an existing sibling or
child.  In addition, Add Child can be used to define an attribute for the
root element if the source or target is a DTD.

This function may be used if the source is database views or tables or a
DTD.

If Node Type is ”Attribute”, the Add Child button is disabled.  You
cannot define an attribute for an attribute.

Note:  Refer to How to Extend DTDs: page 2 – 117 for details on
how to extend a DTD.  Included are the naming conventions
that must be followed for the XML Parser to recognize the DTD
extensions.

Delete (button)

The Delete button allows you to delete any sibling or child element that
has not been mapped.

If a sibling or child has child elements associated with it, a warning is
displayed before the delete occurs.

Attention:  If you are deleting any DTD extensions, be sure to
remove the DTD extensions from the corresponding extension
file created for the application or user.  The extra information
will not cause a parser violation, but it is a good practice to
ensure the extension files match the message maps.  Refer to
How to Extend DTDs: page 2 – 117 for the details.
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Conditional Node Mapping Window

Condition.../Delete Condition

If the source definition is based on a DTD with duplicate nodes or
elements of the same name, use Conditional Node Mapping to ensure
that the source–to–target mappings are performed correctly.  This is
required because the sequence of duplicate nodes and elements is not
fixed.

Examples of duplicate nodes that occur frequently in a DTD are
DATETIME, AMOUNT, OPERAMT, and QUANTITY.  Using a
purchase order as an example, the first DATETIME occurrence is for
the Order Date and the second occurrence is for the Promise Date.

Conditional node mapping allows you to define the relationship of the
source node to the target node based on the value of key elements.  The
key elements are identified by the Tag Name and Node Value
combination.  For the purchase order example above, the Tag Name is
”qualifier” and the Node Value is ”PO” for the first DATETIME
occurrence representing the order date.  The Tag Name for the second
DATETIME occurrence is also ”qualifier” with a Node Value of
”PROMDELV” for promise date.

To define the key values, select the source DTD node and click the right
mouse button to invoke the Conditional Node Mapping window.  You
will be prompted for the following:

Select Tag Name from the list of values.

Using the above example, this is the ”qualifier”
attribute associated with the DATETIME segment
that uniquely identifies the node and its intended
meaning.

Tag Name
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Enter the node value.

Using the above example, this is either ”PO” or
”PROMDELV”.

Repeat this process for each of the duplicate nodes and elements.
Message Designer supports one condition per node or element.

To delete the Conditional Node Mapping instruction for a node, select
the node and click the right mouse button to invoke the Delete
Condition function.

Conditional node mapping is applicable to source data definitions that
are based on a DTD or a production XML message.  It does not apply
when the source data definitions are based on database views or tables.

Transaction Map – Target Definition

The target definition selected or created using the Map Creation
Wizard is displayed in the Target Definition Tab.  The target definition
can be extended to perform the following:

• Provide default values

• Create duplicate nodes and elements using the Add Sibling
button

• Add fields using the Add Child button

• Delete unused and unmapped DTD elements to prevent parser
violations

Once the target data definition is complete, it can be saved for reuse in
other message maps.  Use the File > Save (Data Definition) menu
option or the toolbar equivalent.  Use the File > Properties menu option
to change the default directory or data definition property values if
necessary.

If you do not wish to save the target data definition as an entity
independent of the message map, then continue with the mapping
process and save the transaction map at the end of the Element
Mapping process.

Target Definition Considerations

1. Refer to How to Map a Pass–Through Message: page 2 – 119, for
guidelines related to developing a pass–through transaction.

Node Value
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2. Refer to How to Map to an API: page 2 – 120 for guidelines for
mapping an inbound message to an Application API (as opposed to
mapping to Application Open Interface tables).

3. For DTD elements defined using ”|” as the occurrence indicator,
make sure you select one element from the choice list and delete
the unused elements.  The parser will validate that only one
element is used.

4. Delete optional DTD data types and elements that are not used and
therefore not mapped.  If not deleted, these elements will appear as
empty tags in the resulting message.

5. If you decide not to delete DTD data types and elements that are
not used and not mapped, default the data type or element
attribute to ”OTHER”.  The parser requires the attribute even
though the data type or element is optional.

6. Refer to How to Implement Attachments in XML Messages: page
2 – 127 for details on how to include attachments with your XML
documents.

7. Discontinuous nodes:

A discontinuous node is a non–level node that follows a level and is a
sibling of that level.  It can be represented graphically as follows:

Discontinuous Node

In this example, the levels LINE DETAILS and LINE TERMS are
children of the level LINE, and are siblings of each other.  Inserted
between LINE DETAILS and LINE TERMS is a new element of the
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LINE node.  The new element is a continuation of the LINE node that
creates a break between LINE DETAILS and LINE TERMS.

The ideal placement of the new element is as the last element of the
LINE node before the LINE DETAILS node.  However, some standards
bodies do not have the flexibility to restructure an existing DTD, or
may not wish to for backwards compatibility reasons.  Regardless of
the reason, the condition exists, and XML Gateway supports it.

For data definitions based on the Oracle data model, use the Add Child
or Add Sibling button in the Message Designer, Transaction Map
window to define a discontinuous node.  Any new node introduced on
the source and distributed across multiple target levels (expanded) or
consolidated into a single target level (collapsed) will be grouped with
the parent node and mapped according to the target definition.  The
rules against level cross–over still apply.

For data definitions based on a DTD, use the Transaction Map window,
Item Type column to explicitly identify the data levels.  This exercise
may create a discontinuous node, which is not a problem unless you
define the invalid scenario described below.   The only user extensions
supported for OAG DTDs are in the USERAREA.  If you modify the
DTD (using the Add Child or Add Sibling buttons) outside of the
USERAREA, a parsing error will be triggered.

Message Designer will allow you to define a discontinuous node
anywhere in the source or target definition.  You will not know until
runtime if the definition is valid or not.  Therefore you should avoid
introducing a discontinuous node for a node which also contains a
child node.

The following graphic illustrates an invalid definition:

Invalid Discontinuous Node Definition
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In the example above, HEADER.element3 is a continuation of the
HEADER node.  HEADER.element3 is also defined as a child of the
LINE node.  HEADER.element3 has a child node called LINE
DETAILS.  This is an invalid definition.
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Target Definition Tab

Field

Field identifies the name of the element, document, or root.  The names
are based on the Application Open Interface table column names or
DTD element names.

The field name can be changed if necessary, however, consider what
this change implies.  Because the field is based on the database column
name or a DTD element name, corresponding changes may be
necessary in Oracle E–Business Suite or the DTD.  The only changes
allowed to a DTD are to the USERAREA.  Refer to How to Extend
DTDs: page 2 – 117 for details.

The first row is reserved for the Data Definition name (if target is based
on Application Open Interface) or DTD root element name (if target is a
DTD).
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Additional field names are displayed when sibling or child elements
are added using the Add Sibling or Add Child buttons.

Item Type

Item type identifies the field as either a Level or an Element.  Level
represents the parent in a parent–child relationship.  Element represents
the child in a parent–child relationship.

The Item Type of the first row is defaulted to Level.  The default value
cannot be changed.

If the target is based on Application Open Interface tables, the Item
Type for the tables is defaulted to ”Level”.  The Item Type for the
columns is defaulted to ”Element”.

If the target is based on a DTD or a production XML message, the
default Item Type is ”Element”.  DTDs do not support levels and
therefore the levels must be explicitly defined by setting the Item Type
to ”Level”.

Any node that represents a collection of data that repeats (for example,
PO lines or shipment lines) represents a level.  The Item Type for the
node must be set to ”Level”.

For the OAG standard, change the Item Type of the following to
”Level” to support Level Mapping:

• Root

• CNTROLAREA

• DATAAREA

Make the same change for all other DTD data types identified as data
levels during the map analysis process.

The Item Type for a new sibling or child element is defaulted to
”Element”.  Change the Item Type setting where appropriate.

Default

Enter a default value for the field as appropriate.  This value is used in
the outbound message.  The default value will be used in an inbound
message if the incoming value is null.

If the target is a DTD, use the Default column to set the DTD attribute
values.  The values will be displayed with the corresponding attribute
tags when the message is created.
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If the default value is based on a condition, set the default using the
Assign Variable Value action.  See Assignments: Assign Variable Value:
page 2 – 80.

If Item Type is Level, this column is disabled.

Data Type

Each field is defined with a data type.  The data types supported by the
XML Gateway Execution Engine are VARCHAR2, DATE, NUMBER,
CHAR, and CLOB.

The CLOB data type is used to support large objects up to 4 GB in size.
The CLOB is displayed between CDATA tags to escape parsing.

If the target is based on Application Open Interface tables, the data
type is defaulted to the data type defined for the database column.

If the target is based on a DTD or a production XML message, the data
type is defaulted to VARCHAR2.

Attention:  It is not necessary to change the DTD element’s
data type until XML schemas are supported by the XML
standards bodies which will make data types more meaningful.

The Data Type for a new sibling or child element is defaulted to
VARCHAR2.  Change the data type if necessary.

If Item Type is Level, the Data Type column is disabled.

DB Column

DB Column is available only when the target is based on Application
Open Interface tables.

A check mark indicates the column is defined in the Oracle E–Business
Suite data model.  This setting informs the XML Gateway Execution
Engine whether to validate the element against the Oracle E–Business
Suite data model or not.

If the Item Type is Level, the DB Column is disabled.

Node Type

Node Type is available only when the target is a DTD.  The default is
the DTD setting.

The valid values are Element or Attribute.  Elements contain the
business data.  Attributes contain qualifiers for the business data to
indicate the intended meaning of the data.
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The Node Type for a new sibling or child element is defaulted to
”Element”.  Change the Node Type setting if appropriate.

If Item Type is Level, the Node Type column is disabled.

Add Sibling (button)

The Add Sibling button allows you to add new fields required to
complete the map.  This feature is also used to create duplicate DTD
nodes such as PARTNER.

The same can be done if the target is Application Open Interface tables.

When the target is based on a DTD or production XML message, and
you are adding a sibling between two attributes, set the Node Type for
the new field to ”Attribute”.  The default Node Type of ”Element” will
cause a parser violation.

Attention:  You cannot add a sibling to the root node.

Note:  Refer to How to Extend DTDs: page 2 – 117 for details on
how to extend a DTD.  Included are the naming conventions
that must be followed for the XML Parser to recognize the DTD
extensions.

Add Child (button)

The Add Child button adds child elements to an existing sibling or
child.  In addition, Add Child can be used to define an attribute for the
root element if the source or target is a DTD.

This function can be used if the target is Application Open Interface
tables or a DTD.

If Node Type is ”Attribute”, the Add Child button is disabled.  You
cannot define an attribute for an attribute.

Note:  Refer to How to Extend DTDs: page 2 – 117 for details on
how to extend a DTD.  Included are the naming conventions
that must be followed for the XML Parser to recognize the DTD
extensions.

Delete (button)

The Delete button deletes any sibling or child element that has not been
mapped.

If a sibling or child has child elements associated with it, a warning is
displayed before the delete occurs.
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Attention:  If you are deleting any DTD extensions, be sure to
remove the DTD extensions from the corresponding extension
file created for the application or user.  The extra information
will not cause a parser violation, but it is a good practice to
ensure the extension files match the message maps.  Refer to
How to Extend DTDs: page 2 – 117 for the details.

Transaction Map – Level Mapping Tab

In the Level Mapping tab, the source definition is presented in the left
window and the target definition in the right window.  Use the Level
Mapping tab to relate the source hierarchy to the target hierarchy.  All
entities defined as a level are displayed in bold.
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Select the source level and drag it to the desired target level.  The
source level name and the mapped icon will appear to the right of the
target level name indicating the level is mapped.

If this does not occur as described, you have not set the DTD entity
Item Type to ”Level”.  Return to the Source or Target Definition tab and
set the Item Type accordingly, then resume with Level Mapping.

To unmap a mapped level, simply select the mapped level on the target
window and drag it back to the source level.

Level Mapping Guidelines for OAG DTDs

1. For the outbound messages using the OAG standard, map the
ECX_OAG_CONTROLAREA_TP_V view (formerly
ECX_OAG_CONTROLAREA_V) to the DTD CNTROLAREA data
type.  This step is not required for inbound messages because the
content of the DTD CNTROLAREA is not stored in the Oracle
E–Business Suite.

Note:  The ECX_OAG_CONTROLAREA_TP_V view is an
upgraded version of the ECX_OAG_CONTROLAREA_V view.
Oracle XML Gateway supports both versions of the database
view.  For a detailed description of the differences, see the
Note: page 2 – 35, presented earlier in this chapter.

2. If you anticipate multiple documents in a message, map the
database header view to the OAG document header data type.  If
you anticipate a single document in a message, map the database
header view to the OAG DATAAREA data type.

Level Mapping Guidelines to Collapse Levels

Multiple source levels can be mapped to the same target level.  This is
commonly referred to as collapsing levels.  For example, if your source
is 3 levels and your target is 2 levels you can collapse the levels as
shown in the following figure:
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Correct Way to Collapse Levels               Incorrect Way to Collapse Levels

In the correct example above, there are three source levels and two
target levels.  Source Level 1 is mapped to Target Level 1.  Source
Levels 2 and 3 are mapped to Target Level 2.  The result of collapsing
levels is that the data in Source Levels 2 and 3 are consolidated and
mapped to Target Level 2.  If there are two rows in Source Level 2 and
three rows in Source Level 3, a total of six rows will be created in Target
Level 2.

In the example showing the incorrect collapsing of levels, Source Level
3 is mapped over Target Level 2 to Target Level 1.

Another option shown below is to relate Source Levels 1 and 2 to
Target Level 1 and relate Source Level 3 to Target Level 2.  (Do not map
Source Levels 1 and 3 to Target Level 1, crossing over Target Level 2.)

Correct Way to Collapse Levels               Incorrect Way to Collapse Levels

Whichever option you choose, consider what it means to promote
lower level detail data to a higher level.  The lower level data may need
to be aggregated to be meaningful at the higher level.



2 – 65Message Designer

Level Mapping Guidelines to Expand Levels

One source level can be mapped to multiple target levels.  This is
commonly referred to as expanding levels.  For example, if your source
is two levels and your target is three levels you can expand the levels as
shown in the following figure:

Correct Way to Expand Levels                 Incorrect Way to Expand Levels

In the correct example above, Source Level 1 is mapped to Target Level
1 and Source Level 2 is mapped to Target Levels 2 and 3.  The result of
expanding levels is that the data in Source Level 2 is distributed and
mapped to Target Levels 2 and 3.  If there are two rows in Source Level
2, two rows will be created in Target Level 2 and Target Level 3.

In the example showing the incorrect expansion of levels, Source Level
1 is mapped to Target Level 1 and Target Level 3, crossing over Target
Level 2.

Another option, shown below, is to distribute Source Level 1 to Target
Levels 1 and 2 and map Source Level 2 to Target Level 3.  (Do not map
Source Level 1 to Target Levels 1 and 3, crossing over Target Level 2.)
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Correct Way to Expand Levels                Incorrect Way to Expand Levels

Whichever option you choose, consider what it means to demote data
from a higher level to a lower level of detail.  The higher level data may
need to be deaggregated to be meaningful at the lower level.

Level Expansion for Discontinuous Nodes

Level expansion is supported if the target expanded levels are all
siblings of each other or if they are all children of the previous node.

Example of Valid Level Expansion

In the example above, Target Level 2 and Target Level 3 are siblings to
each other and children of Target Level 1.

Example of Invalid Level Expansion
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In the example of invalid level expansion above, Target Level 2 and
Target Level 3 are siblings to each other and children of Target Level 1.
Target Level 4 is a sibling of Target Level 1, with no relationship to
Target Levels 2 and 3.

See Discontinuous Nodes: page 2 – 55 for more information on
discontinuous nodes.
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Transaction Map – Element Mapping

If the Element Mapping tab is not available, it is an indication that you
have not completed at least one level mapping in the Level Mapping
process.

Once the Level Mapping process is complete, the source definition is
presented on the left window and the target definition is presented on
the right window.  The source and target hierarchies defined in the
Level Mapping tab are displayed in bold font.  Use the Element
Mapping tab to create the message map.

Select the source element and drag it to the target element.  Pay special
attention to any predefined node conditions (such as Conditional Node
Mapping) to ensure that duplicate nodes are mapped to the correct
target entities.  The source element name and mapped icon will appear
next to the target element name indicating the element is mapped.
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To unmap a mapped element, select the mapped element on the target
window and drag it back to the source element.

Element Mapping Guidelines

1. Do not map a lower level element to a higher level element.  The
lower level element values are not available until the header level
elements are completely processed.

2. A higher level element can be mapped to a lower level element.
However, you may need to manipulate the higher level element
value to make it meaningful in the context of a detail level element.

For example, if the the header level element is invoice total and the
line level element is invoice line total, the header invoice total must
be distributed across the invoice lines based on the line quantity for
it to be meaningful in the context of invoice lines.

3. One source element can be mapped to multiple target elements.

4. Review the source elements containing Conditional Node Mapping
instructions.  Map the source element to the target element
associated with the condition.

For the outbound messages (where the source is the database and
the target is a DTD) using the OAG standard, map the
ECX_OAG_CONTROLAREA_TP_V view (formerly
ECX_OAG_CONTROLAREA_V) columns to the DTD
CNTROLAREA data type elements.  This step is not required for
inbound messages (where the source is a DTD and the target is the
database) because the content of the DTD CNTROLAREA is not
stored in the Oracle E–Business Suite.

Note:  The ECX_OAG_CONTROLAREA_TP_V view is an
upgraded version of the ECX_OAG_CONTROLAREA_V view.
Oracle XML Gateway supports both versions of the database
view.  For a detailed description of the differences, see the
Note: page 2 – 35, presented earlier in this chapter.

The view column names are similar to the DTD CNTROLAREA
data type element names, so this is one–to–one mapping.  Add the
following required Actions to complete the map:

• Use the Convert to OAG DATETIME action to convert the
Oracle date to the CNTROLAREA DATETIME element.

• Use the Append Where Clause action to bind the transaction
type and transaction subtype to the
ECX_OAG_CONTROLAREA_V view.  Or if you are using the
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ECX_OAG_CONTROLAREA_TP_V view, use the Append
Where Clause to bind the transaction type, transaction subtype,
party ID, party site ID, and party type to the view.

Note:  The ECX_OAG_CONTROLAREA_TP_V view is an
upgraded version of the ECX_OAG_CONTROLAREA_V view.
Oracle XML Gateway supports both versions of the database
view.  For a detailed description of the differences, see the
Note: page 2 – 35, presented earlier in this chapter.

Use the Define Transactions form to define the transaction and
transaction subtype that represent the Oracle name for the message.
Associated with the internal name for the message are the external type
and subtype that represent the message name in the XML standard of
choice.

For OAG, the external subtype corresponds to the BSR VERB and the
external type corresponds to the BSR NOUN.  The names entered on
the Define Transactions form are stored in the database and accessed
by the ECX_OAG_CONTROLAREA_TP_V view.  The values are
displayed in the Message Designer as default values for the BSR VERB
and BSR NOUN elements.

Element Mapping Icons

Message Designer uses an icon group to help you determine the status
of a map at a glance.  The components of the icon group are as follows:

Mapped Element icon. 

Action Defined icon. 

Code Conversion Enabled icon. 

The components will be displayed as on or off (grayed out) within the
group icon to indicate if the element is mapped, has an action defined,
and/or is enabled for code conversion.

Element Mapping and Actions

As part of the element mapping process, Actions for data
transformation and process control can be defined.

The following three sections are available for your reference.  First time
users should read all three sections.  Experienced users should use the
Map Action Editor section and reference the action type of interest.
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• Transaction Map – Actions: page 2 – 72

– Summary of XML Gateway Supported Actions: page C – 2

– Source or Target Action: page 2 – 72

– Action Levels: page 2 – 72

– XML Gateway Execution Engine processing sequence: page
2 – 73

• Map Action Editor – Overview: page 2 – 74

– How to Invoke the Map Action Editor: page 2 – 74

– Map Action Editor Components: page 2 – 74

• Map Action Editor – Available Actions: page 2 – 75

At the completion of the element mapping process, use the File > Save
(Transaction Map) menu option or the Save icon to save the map onto
the file system.  The name of the map (.xgm) file should be the same as
the map name for easy reference.  Follow the map naming conventions
as follows:

• Product mnemonic or user ID

• Transaction subtype as entered in the Define Transactions form

• XML standard and version used (such as OAG, Rosettanet, iFX)

• Outbound or inbound message

Given a map name of:

AR_INVO_OAG70_OUT

the map file name is:

AR_INVO_OAG70_OUT.xgm

Use the File > Properties menu option to change the default directory
or map name if necessary.

The transaction map and the associated DTDs are now ready to load
into the XML Gateway repository.  The message maps will be used by
the XML Gateway Execution Engine to create or to consume XML
messages.

Refer to How to Load/Delete Message Maps and DTDs: page 2 – 121 for
details on loading a message map created by the Message Designer and
its associated DTDs into the XML Gateway repository.
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Transaction Map – Actions

As part of the element mapping process, Actions for data
transformation or process control can be defined.

Actions are similar to prebuilt functions in that they may be called to
perform a specific activity.

Oracle XML Gateway supports actions for data transformation
involving math functions, string manipulation, and data conversion
between Oracle’s data format and OAG’s data format.

Oracle XML Gateway supports a set of predefined actions for process
control.  This includes user–defined procedure and function calls to
extend the integration with the Oracle E–Business Suite.  Other
common process control actions allow you to inquire on the status of a
transaction and to manage the process flow based on the status.  For
serious errors, the transaction can be aborted with error messages
returned to the sender via an Oracle Workflow process.

The actions supported by Oracle XML Gateway are listed in Appendix
C.

Source or Target Action

Most Actions are defined on the target side of the Element Map with
the exception of the Append Where Clause action type, which is
defined on the source side of the Element Map if the source is based on
database views or tables.

See Map Action Editor – Append Where Clause: page 2 – 83 for a
detailed description of this action and how to define it.

Action Levels

An Action may be defined for any of the following entities:

• Element

An element is the smallest unit of a message.  An action defined
at the element level is applied to that element only.

• Document

A document is a collection of elements representing a business
document.  An action defined at the document level is applied to
the document.

• Root
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A root represents a collection of documents.  An action defined
at the root level is applied to all documents contained by the
root.

Some actions are designed to be applied to the element only, while
others are intended for the document only.

XML Gateway Execution Engine Processing Sequence

The processing sequence of a three–level document by the XML
Gateway Execution Engine is described in the following table.

Refer to Pre Process, In Process, and Post Process Tabs: page 2 – 75, for
a description of process stages.

Level Stage

Root Preprocess

Root In–Process

Header Preprocess

Header In–Process

Header Postprocess

Line Preprocess

Line In–Process

Line Postprocess

Line Detail Preprocess

Line Detail In–Process

Line Detail Postprocess

Root Postprocess

Given the processing sequence described above, header data is
processed before line data and line data is processed before detail data.
Any upper level data element that has a dependency on lower level
data elements (for example, sum of invoice lines) must be processed
using an API call at the upper level.  Once the upper level data is
processed, it cannot be updated, although it can always be accessed.
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Map Action Editor

How to Invoke the Map Action Editor

In the Element Mapping tab, select the entity (element, document, root)
and click the right mouse button to invoke the Map Action Editor
pop–up window.  The prompts presented by the Map Action Editor
will vary based on the Action type selected.

Overview

The Map Action Editor has the following common components:

• Pre Process, In Process, Post Process Tabs
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• Available Actions

• Selected Actions

• Shuttle Buttons

• Arrows for the Selected Actions Window

• Optional Conditional Expression

• Result Variable

• Action Operands – Element Window

Pre Process, In Process and Post Process Tabs

An Action can be applied at any of the following stages of message
creation or consumption:

• Pre Process

A preprocess action is executed before the message is created or
consumed.

The Create Global Variable action is an example of a preprocess
action.  The variable must be defined before you can use it.

• In Process

An in–process action is executed during message creation or
consumption.

The Math and String Functions are examples of in–process
actions used to perform a computation or to manipulate a value.

• Post Process

A postprocess action is executed after the message is created or
consumed.

The Insert into Database Table action is an example of a
postprocess action.  The row cannot be inserted into the database
until all the data for the row has been processed.

Select the appropriate Map Action Editor Window Tab for the map
entity (element, document, root) selected.

Available Actions

The available action categories for the selected process stage and
selected map entity are displayed.  Expand each category to view all
the available action types.
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The following table summarizes all action types sorted by Action Level
and Action Stage.  A ”Y” indicates the action type is available for the
Action Level and Action Stage combination.  An ”N” indicates the
action type is not available for the Action Level and Action Stage
combination. 

Action Category & 
Description

Element 
In Process

Document
Pre Process

Document
In Process

Document
Post Process

Root 
Pre Process

Root 
In & Post
Process

Assignment: Assign variable
value

Y Y Y Y N Y

Assignment: Create global
variable

N N N N Y N

Database Function: Assign
next sequence value

Y Y Y Y N Y

Database Function: Append
where clause

N DB Source N N N N

Database Function: Insert into
database table

N N N Y N N

Derivations Y N N N N N
Function Call Y Y Y Y N Y
Math Functions Y Y Y Y N Y
OAG Standard Conversions Y N N N N N

Other: Exit Program Y Y Y Y N Y

Predefined Variable Y Y Y Y N Y
Procedure Call Y Y Y Y N Y

Return Error Message Y Y Y Y N Y
String Functions Y Y Y Y N Y

XSLT Transformation N N N N N Y(Post)

Selected Actions

To move an action type from Available Actions to Selected Actions,
select the desired action type and click the shuttle button.

To deselect a selected action type, select the desired action type and
click the shuttle button to move the selected action type from Selected
Actions back to Available Actions.
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Up and Down Arrows for the Selected Actions Window

A given entity (element, document, root) may have one or more
Actions defined for it.  The XML Gateway Execution Engine processes
the Actions in the sequence defined, from the beginning of the list
proceeding downward to the last action type on the list.  Use the up
and down arrows within the Selected Actions Window to change the
sequence of the Actions defined for a given entity.  Use the left shuttle
button to deselect a Selected Action if necessary.

Optional Condition Expression: 
If <Operand 1><Operator><Operand 2>

Each Action may be defined as a conditional action (except the Append
Where Clause and Create Global Variable).  The condition is expressed
as two operands.  An operand may be a variable (source, target, or
global variable) whose value is determined at runtime, or a literal
value.

For each condition operand, click on the (...) icon to the right of the
operand field to invoke the Element window.  The Element window
allows you to select a variable or provide a literal value.

Refer to Action Operands – Element Window: page 2 – 79 for details
regarding the Element window.
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The operators supported by Oracle XML Gateway are listed in the
following table:

Operator Description

= Equal

!= Not Equal

> Greater Than

< Less Than

>= Greater Than or Equal To

<= Less Than or Equal To

Is NULL Null

Is NOT NULL Not Null

Enter the two operands and select the operator if a condition
expression is required.

Compound conditions can be defined by comparing two operands and
storing the result in a variable (source, target, or global).  You then
compare the value in the variable with the next condition operand.

Result Variable

Some Actions have result variables defined and some do not.  Those
that do not have a result variable defined will use one of the action
operands as the result variable.

The result variable is the left–most field of the action operand.  The
only exception occurs in the Convert To actions where the result
variable is the right–most field.  Per user interface standards, the result
variable field is greyed, but is enabled for data entry.

For element–level Actions, the selected source or target variable is
displayed as the default result variable.  You can change the variable
name as necessary.

For document–level or root–level actions, the result variable is blank.
Click on the (...) icon to invoke the Element window.  Select the source,
target, or global variable as the result variable.  The value of the result
variable is determined at runtime.

The result variable cannot be a literal value.
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Refer to Action Operands – Element Window: page 2 – 79 for details
regarding the Element window.

Action Operands – Element Window

An Action may or may not have operands associated with it.

For Actions that do have operands associated with them, the number
of operands varies by action type.  Click on the (...) icon to the right of
the operand field to invoke the Element window.

The Element window allows you to select a variable or provide a literal
value.  The Element window is presented in four parts as follows:

• Radio button for Literal, Variable, or Global Variable

• Operands displayed in gray indicate literal values are not
allowed

• Field for literal value (available only when Literal radio button is
selected)

• Window display for source and target variables

The default radio button setting is Variable.  You can change the default
by selecting a Literal (if available for the action type selected), or Global
Variable (if defined).
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The Literal radio button is enabled only if a literal value is applicable
for the action type selected and the Element Window was not invoked
from a Result Variable.  Enter the literal value and click OK.

When the Variable radio button is enabled, you are presented with the
source and target variables.  Select the source or target variable name
and click OK.  The value for the selected variable is determined at
runtime.

The Global Variable radio button is enabled only if global variables are
defined for the message map.  Select the Global Variable from the list of
values and click OK.  The value for the selected global variable is
determined at runtime.

Map Action Editor – Assignments: Assign Variable Value

The Assign Variable Value action assigns a value to the result variable
identified.  The value may be based on another variable (source, target,
or global variable) or a literal value.

If you are assigning a literal value as a default value to be applied
universally (without a condition expression), you have the option to set
the default value in the Transaction Map form using the Source or
Target Definition tab.

See Map Action Editor – Overview: page 2 – 74 for details on the
common components of the window.

Result Variable

Select the source, target, or global variable to store the assigned value.
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Action Operands

Select the variable (source, target, or global variable) or enter the literal
value to assign to the result variable.

Map Action Editor – Assignments: Create Global Variable

The Create Global Variable action allows you to define a variable
available to both the source and target.  A default value may be
assigned to the variable or the variable may get its value from the
Assign Variable Value action.

Once a global variable is defined, it is included in the Element window
Global Variable Name list of values.

Note:  The following are reserved names for global variables:

– TRANSACTION_TYPE

– TRANSACTION_SUBTYPE

– DOCUMENT_ID

– TP_SITE_ID (also known as PARTY_SITE_ID)

– TP_ID (also known as PARTY_ID)

– TP_TYPE (also known as PARTY_TYPE)

– PARAMETER1, PARAMETER2, PARAMETER3,
PARAMETER4, and PARAMETER5

See Map Action Editor – Overview: page 2 – 74 for details on the
common components of the window.
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The Optional Conditional Expression is not available for the Create
Global Variable action because the action is a preprocess action and
therefore data is not available yet.

Global Variable Name

Enter a global variable name and select the data type for the variable.
The valid data types supported by the XML Gateway Execution Engine
are VARCHAR2, NUMBER, DATE, and CHAR.

Attention:  Define a unique and meaningful name that does
not contain a reserved word and is not a predefined variable.
Once the variable name is defined and stored for the map, it
cannot be changed.

However, if necessary, you can delete the Create Global
Variable action containing the incorrect variable name and then
add a new action containing the correct name.

Note:  The CLOB data type defined to support large objects (up
to 4GB) is supported by the XML Gateway execution engine,
but not by the Create Global Variable action.

Default Value

Enter a default value if applicable.

Map Action Editor – Database Functions: Assign Next Sequence Value

Oracle E–Business Suite defines database sequences to maintain
counters for document numbers such as PO or invoice number.  When
inserting documents into the Oracle Application Open Interface tables,
the next available document number is required.

The Assign Next Sequence Value action retrieves the next available
sequence number from the database sequence identified and assigns it
to the result variable.
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See Map Action Editor – Overview: page 2 – 74 for details on the
common components of the window.

Result Variable

Select the source, target, or global variable to store the next value of the
sequence identified.

Next Value of Sequence

Identify the database sequence name.  The function will assign the next
value from the sequence to the result variable.

Map Action Editor – Database Functions: Append Where Clause

The Append Where Clause action is used for outbound messages only.
It is used to pass the document selection criteria to the database views
used in the transaction map.

The Append Where Clause action is defined in the source at the
document level as a preprocess activity.  The bind variables and bind
values are set up in advance of the document being processed.  The
actual bind to the database views occurs as an in–process activity when
the data becomes available.  The default where clause of ”where 1=1” is
appended at runtime to dynamically construct the where clause based
on the selection criteria provided.

Each Append Where Clause action accepts one set of a bind variable
and a bind value.  To pass multiple selection criteria, you must define
multiple Append Where Clause actions.

The document selection criteria are identified in the event and event
subscription.
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If you are using the ECX_OAG_CONTROLAREA_V view in your map,
you will need to bind to the TRANSACTION_TYPE and
TRANSACTION_SUBTYPE columns for this view to execute properly.

If you are using the ECX_OAG_CONTROLAREA_TP_V view in your
map, you will need to bind to the TRANSACTION_TYPE,
TRANSACTION_SUBTYPE, PARTY_ID, PARTY_SITE_ID, and
PARTY_TYPE columns for this view to execute properly.

Note:  You must add the ECX_EVENT_MESSAGE item
attribute to your Workflow item type to have access to the
event details stored in the REFERENCE ID column of the
ECX_OAG_CONTROLAREA_TP_V view.

The following table shows an example:

Where Clause Bind
Variable

Bind Value

and ECX_OAG_CONTROLAREA_TP_V.TRANSACTION_TYPE=:TTYPE TYTPE TRANSAC-
TION_TYPE

and ECX_OAG_CONTROLAREA_TP_V.TRANSACTION_SUBTYPE=:SUBTYPE SUBTYPE TRANSAC-
TION_SUBTYPE

and ECX_OAG_CONTROLAREA_TP_V.PARTY_ID=:PARTY_ID PARTY_ID TP_ID

and ECX_OAG_CONTROLAREA_TP_V.PARTY_SITE_ID=:PARTY_SITE_ID PARTY_SITE_
ID

TP_SITE_ID

and ECX_OAG_CONTROLAREA_TP_PARTY_TYPE=:PARTY_TYPE PARTY_TYPE TP_TYPE

and <APPS_HEADER_V>.<document id> =:DOCID DOCID document_id

Note:  For this method, use the Create Global Variable action to
define variables to store the bind value.  The global variables
must be defined with the exact spelling of the parameters.  In
this example, the global variables are TRANSACTION_TYPE,
TRANSACTION_SUBTYPE, TP_ID, TP_SITE_ID, TP_TYPE,
and DOCUMENT_ID.

Note:  The following are reserved names for global variables:

– TRANSACTION_TYPE

– TRANSACTION_SUBTYPE

– DOCUMENT_ID

– TP_SITE_ID (also known as PARTY_SITE_ID)

– TP_ID (also known as PARTY_ID)
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– TP_TYPE (also known as PARTY_TYPE)

– PARAMETER1, PARAMETER2, PARAMETER3,
PARAMETER4, and PARAMETER5

Other source variables not related to the event triggering process can
be used as bind values to ensure that the correct document is selected
from the Oracle E–Business Suite database.

If you know the key values, you can define them in your where clause.
With this method, you do not have to use the Bind Variable and Bind
Value.  The following table shows an example:

Where Clause Bind
Variable

Bind Value

and ECX_OAG_CONTROLAREA_TP_V.TRANSACTION_
TYPE =’POO’

N/A N/A

and ECX_OAG_CONTROLAREA_TP_V.TRANSACTION_
SUBTYPE =’POOB’

N/A N/A

and ECX_PO_HEADER_V.PO_NUMBER =’A754739’ N/A N/A

Note:  Literal strings must be bound by single quotes.

See Map Action Editor – Overview: page 2 – 74 for details on the
common components of the window.

The Optional Conditional Expression is not available for the Append
Where Clause action because it is a preprocess action and therefore the
data is not available yet.

Where Clause

Identify the where clause to bind the database views used for the
outbound message.  This where clause will be appended to the default
where clause of ”where 1=1”.
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If you have multiple selection criteria based on the same database view,
define an Append Where Clause action for each of the criteria.  Define
all fields for the first Append Where Clause action (Where Clause, Bind
Variable, and Bind Value).  For the subsequent Append Where Clause
actions, define only the Bind Variable and Bind Value (leaving the
Where Clause blank).

Bind Variable

Identify the bind variable to be used by the where clause.

Bind Value

Identify the bind value to be assigned to the bind variable used by the
where clause.

The bind value is a global variable whose value is determined at run
time, or a literal value.

Map Action Editor – Database Functions: Insert into Database Table

The Insert into Database Table action is a postprocess action used for
inbound messages to insert the data into Application Open Interface
tables identified in the message map.  This action is available only if the
target is database.

This action must be executed once for each target level identified in the
Transaction Map – Level Mapping tab.  If the target has three levels
(header, line, and line detail), then it must be executed three times.

You can identify a condition for the Insert into Database Table action.
The action does not require any operands.

The inserts are performed by the XML Gateway Execution Engine but
are not committed to the database until the entire document is
processed.  This eliminates the possibility of inserting a partial
document into the database.

Note:  An alternate way to insert data is to use the Procedure
Call action to execute an Application API.  See How to Map to
an API: page 2 – 120 for details.

See Map Action Editor – Overview: page 2 – 74 for details on the
common components of the window.
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Map Action Editor – Derivations: Derive Address ID from Location Code

The Derive Address ID from Location Code action is used for inbound
messages only.  It uses the source location code and associated address
type to derive the address and organization ID meaningful to the target
Oracle E–Business Suite module.

The IDs are meaningful in the context of Oracle E–Business Suite only.
The sender is not expected to know a valid address or organization ID.

If the parent table ID for the customer or supplier site is also required
by the Application Open Interface, use the Derive Parent ID from
Location Code action to derive it.

Location code is commonly used to refer to the address site represented
by the physical address.  Using location codes eliminates the need to
include the physical address in an XML message.  For OAG messages,
the location code is commonly found in the PARTNRID element of the
PARTNER data type.

The Derive Address ID from Location Code action will access all
trading partner locations across all organizations to derive the address
ID.  If the source location code is found in multiple organizations, the
action will produce an error because it cannot uniquely identify an
address ID.

See Map Action Editor – Overview: page 2 – 74 for details on the
common components of the window.

Derive Target Address ID

Identify the target variable to store the address ID derived from the
source location code.  The value for the target variable is determined at
runtime.
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The target variable cannot be a global variable unless you are using it
as a temporary variable to populate multiple application columns with
the same value.  The target variable cannot be a literal value.

Derive Target ORG ID

Identify the target variable to store the organization ID derived from
the source location code.  The value for the target variable is
determined at runtime.

The target variable cannot be a global variable unless you are using it
as a temporary variable to populate multiple application columns with
the same value.  The target variable cannot be a literal value.

From Source Location Code

Identify the source variable containing the location code.  The source
variable can be a global variable, whose value is determined at
runtime, or a literal value.

With the Address Type of

Select the address type from the list of values.  The valid address types
are as follows:

• Customer

• Supplier

• Internal Location

• Bank Branch

This address type is used by the XML Gateway Execution Engine to
determine the appropriate Oracle address data model to access to
derive the address ID.

Map Action Editor – Derivations: Derive Parent ID from Location Code

The Derive Parent ID from Location Code action is used for inbound
messages only.  It derives the Parent ID associated with the site level
source location code.

For example, given a SOLD–TO site in the XML message, this action
will derive the parent customer associated with it.



2 – 89Message Designer

Keep in mind that IDs are meaningful in the context of Oracle
E–Business Suite only.  The sender is not expected to know a valid
parent ID.

See Map Action Editor – Overview: page 2 – 74 for details on the
common components of the window.

Derive Target Parent ID

Identify the target variable to store the parent ID derived from the site
level source location code.  The value for the target variable is
determined at runtime.

The target variable cannot be a global variable unless you are using it
as a temporary variable to populate multiple application columns with
the same value.  The target variable cannot be a literal value.

From Source Location Code

Identify the source variable containing the location code.  The source
variable can be a global variable, whose value is determined at
runtime, or a literal value.

With the Address Type of

Select the address type from the list of values.  The valid address types
are as follows:

• Customer

• Supplier

• Internal Location

• Bank Branch
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This address type is used by the XML Gateway Execution Engine to
determine the appropriate Oracle address data model to access to
derive the address ID.

Map Action Editor – Function Call: Execute Function Call

The Execute Function action calls a system function (for example,
FND_GLOBAL.USER_ID) or any application function to perform an
activity and return the result to the result variable.

Function calls with parameters are not supported by the Execute
Function Call action.

See Appendix F, XML Gateway APIs for a list of special purpose
functions.

Note:  Procedure calls are not supported by the Execute
Function Call action.  See Map Action Editor – Procedure Call:
Execute Procedure: page 2 – 108 for details on how to enable a
procedure.

See Map Action Editor – Overview: page 2 – 74 for details on the
common components of the window.

Result Variable

Select the source, target, or global variable to store the function return
value.

Value Returned by Function

Identify the name of the Function.  The value returned by the function
will be assigned to the result variable.
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Map Action Editor – Math Functions

Oracle XML Gateway supports the four basic math functions: addition,
subtraction, multiplication, and division.

Each math function supports two operands.  The example below shows
the division function.  The Add, Subtract, Divide, and Multiply
functions will each display the appropriate operators.

If the mathematical expression requires more than two operands,
compute the expression two operands at a time, store the result in a
temporary variable (source, target, or global), and then join the values
in the temporary variables.

Note:  Use the Function Call or Procedure Call action to utilize
database level functions for complex mathematical
computations.

See Map Action Editor – Overview: page 2 – 74 for details on the
common components of the window.

Result Variable

Select the source, target, or global variable to store the result of the
mathematical computation.

Action Operands

Identify the two operands and the math function desired.

Each operand may be a variable (source, target, or global variables if
defined) whose value is determined at runtime, or a numeric literal
value.



2 – 92 Oracle XML Gateway User’s Guide

OAG Conversions

The availability of the OAG Conversion actions depends on the source
and target.  The following table summarizes when the actions are
enabled:

Source Target OAG Actions

xml/dtd (OAG) xml/dtd (OAG) Both From and To actions are enabled.

xml/dtd (OAG) db Only From actions are enabled.

db xml/dtd (OAG) Only To actions are enabled.

xml/dtd (OAG) xml/dtd (cXML) Only From actions are enabled.

xml/dtd (cXML) xml/dtd (OAG) Only To actions are enabled.

xml/dtd (cXML) db None of the OAG actions are enabled.

db xml/dtd (cXML) None of the OAG actions are enabled.

Map Action Editor – Convert to OAG DATETIME

The Convert To OAG DATETIME action converts the Oracle
E–Business Suite representation for date to the OAG representation for
date.  This action is disabled if the target is database.

The OAG representation for date is as follows:

DATETIME (qualifier, type, index, YEAR, MONTH, DAY, HOUR,
MINUTE, SECOND, SUBSECOND, TIMEZONE)

The Convert to OAG DATETIME action converts the single column
Oracle E–Business Suite date to the OAG DATETIME segment as
follows:

• The DATETIME attributes for qualifier, type, and index must be
set as default values in the Target Definition tab of the
Transaction Map window.

• The DATETIME elements for YEAR, MONTH, DAY, HOUR,
MINUTE, SECOND, and SUBSECOND are derived based on the
Oracle Application date value.

• The DATETIME element for TIMEZONE is determined as
follows: The date and time data retrieved from the database,
along with the value specified in the ECX: Server Time Zone
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profile option, are used to determine the Greenwich Mean Time
(GMT) deviation.  The deviation is used in the XML message
generated by XML Gateway.  No conversion is performed.

See XML Gateway Valid Time Zone Values: page E – 2 for more
information.

Note:  The source and target elements are implicitly mapped
via the Action.  Additional element mapping will overwrite the
original Action instructions.

See Map Action Editor – Overview: page 2 – 74 for details on the
common components of the window.

Convert Source Datetime

Identify the source date/time element to be converted into the OAG
DATETIME format.  The source can be a literal value defined using a
numeric format (such as 20020808 for 08–Aug–2002). Literal dates
entered using a character format (such as 08–Aug–2002) are not valid.

Target and variables do not apply although they are available in the
Element window.

The converted value will be assigned to the target DATETIME element
selected when the action was invoked.

Map Action Editor – Convert to OAG OPERAMT

The Convert To OAG OPERAMT action converts the Oracle E–Business
Suite representation for operating amount to the OAG representation
for operating amount.

The OAG representation for operating amount is as follows:
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OPERAMT (qualifier, type, VALUE, NUMOFDEC, SIGN, CURRENCY,
UOMVALUE, UOMNUMDEC, UOM)

The Convert to OAG OPERAMT action converts the single column
Oracle E–Business Suite operating amount to the OAG OPERAMT
segment as follows:

• The OPERAMT attributes for qualifier and type must be set as
default values in the Target Definition tab of the Transaction Map
window.

• The OPERAMT elements for VALUE, NUMOFDEC, SIGN,
UOMVALUE, and UOMNUMDEC are derived based on the
Oracle E–Business Suite operating amount value.

• The OPERAMT elements for CURRENCY and UOM are
prompted for.  If the appropriate Oracle E–Business Suite
module columns are available, the values from the columns can
be mapped to the CURRENCY and UOM elements.

Note:  The source and target elements are implicitly mapped
via the Action.  Additional element mapping will overwrite the
original Action instructions.

See Map Action Editor – Overview: page 2 – 74 for details on the
common components of the window.

Convert Source Operating Amount

Identify the source operating amount element to be converted into the
OAG OPERAMT format.  The source can be a literal value or based on
a global variable.  The literal or variable must be numeric.

Target variables do not apply although they are available in the
Element window.

The converted value is assigned to the target OPERAMT element
selected when the Action was invoked.



2 – 95Message Designer

Source Currency

Identify the source currency code element if available or a literal value
to be used by the Convert To OAG Action.

If an Oracle application column is available, the value from the column
can be mapped to the CURRENCY element.

If no Oracle application column is available, the XML Gateway
Execution Engine will leave the element blank.

Target and global variables do not apply although they are available in
the Element window.

Source Unit of Measure

Identify the source unit of measure code element if available or a literal
value to be used by the Convert To OAG Action.

If an Oracle application column is available, the value from the column
can be mapped to the UOM element.

If no Oracle application column is available, the XML Gateway
Execution Engine will default the unit of measure code to EACH as
recommended by OAG.

Target and global variables do not apply although they are available in
the Element window.

Map Action Editor – Convert to OAG QUANTITY

The Convert To OAG QUANTITY action converts the Oracle
E–Business Suite representation for quantity to the OAG representation
for quantity.

The OAG representation for quantity is as follows:

QUANTITY (qualifier, VALUE, NUMOFDEC, SIGN, UOM)

The Convert to OAG QUANTITY action converts the single column
Oracle E–Business Suite quantity to the OAG QUANTITY segment as
follows:

• The QUANTITY attribute for qualifier must be set as a default
value in the Target Definition tab of the Transaction Map
window.

• The QUANTITY elements for VALUE, NUMOFDEC, and SIGN
are derived based on the Oracle E–Business Suite quantity value.
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• The QUANTITY element for UOM is prompted for.  If the
appropriate Oracle E–Business Suite module column is available,
the value from the column can be mapped to the UOM element.

Note:  The source and target elements are implicitly mapped
via the Action.  Additional element mapping will overwrite the
original Action instructions.

See Map Action Editor – Overview: page 2 – 74 for details on the
common components of the window.

Convert Source Quantity

Identify the source quantity element to be converted into the OAG
QUANTITY format.  The source can be a literal (numeric) value or
based on a global variable.

Target variables do not apply although they are available in the
Element window.

The converted value is assigned to the target QUANTITY element
selected when the action was invoked.

Source Unit of Measure

Identify the source unit of measure code element if available, or a literal
value to be used by the Convert To OAG Action.

If an Oracle application column is available, the value from the column
can be mapped to the UOM element.

If no Oracle application column is available, the XML Gateway
Execution Engine will leave the element blank.

Target and global variables do not apply although they are available in
the Element window.
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Map Action Editor – Convert to OAG AMOUNT

The Convert To OAG AMOUNT action converts the Oracle E–Business
Suite representation for amount to the OAG representation for amount.

The OAG representation for amount is as follows:

AMOUNT (qualifier, type, index, VALUE, NUMOFDEC, SIGN,
CURRENCY, DRCR)

The Convert to OAG AMOUNT action converts the single column
Oracle E–Business Suite amount to the OAG AMOUNT segment as
follows:

• The AMOUNT attribute for qualifier, type, and index must be
set as default values in the Target Definition tab of the
Transaction Map window.

• The AMOUNT elements for VALUE, NUMOFDEC, and SIGN
will be derived based on the Oracle E–Business Suite amount
value.

• The AMOUNT element for CURRENCY and DRCR are
prompted for.  If the appropriate Oracle E–Business Suite
columns are available, the values from the columns can be
mapped to the CURRENCY and DRCR elements.

Note:  The source and target elements are implicitly mapped
via the Action.  Additional element mapping will overwrite the
original Action instructions.

See Map Action Editor – Overview: page 2 – 74 for details on the
common components of the window.

Convert Source Amount

Identify the source amount element to be converted into the OAG
AMOUNT format.  The source can be a literal (numeric) value or based
on a global variable.
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Target variables do not apply although they are available in the
Element window.

The converted value is assigned to the target AMOUNT element
selected when the action was invoked.

Source Currency

Identify the source currency code element if available or a literal value
to be used by the Convert To OAG Action.

If an Oracle application column is available, the value from the column
can be mapped to the CURRENCY element.

If no Oracle application column is available, the XML Gateway
Execution Engine will leave the element blank.

Target and global variables do not apply although they are available in
the Element window.

Source Credit/Debit

Identify the source credit/debit flag if available or a literal value to be
used by the Convert To OAG Action.

If an Oracle application column is available, the value from the column
can be mapped to the DRCR element.

If no Oracle application column is available, the XML Gateway
Execution Engine will derive the setting based on the amount value.

Target and global variables do not apply although they are available in
the Element window.

Map Action Editor – Convert from OAG DATETIME

The Convert From OAG DATETIME action converts the OAG
representation for date to the Oracle E–Business Suite representation
for date. This action is disabled if the source is database.

The OAG representation for date is as follows:

DATETIME (qualifier, type, index, YEAR, MONTH, DAY, HOUR,
MINUTE, SECOND, SUBSECOND, TIMEZONE)

The Convert From OAG DATETIME action converts the OAG
DATETIME segment to the single Oracle E–Business Suite date column
as follows:
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• The DATETIME qualifier attribute can be used to determine the
appropriate Oracle E–Business Suite date column to use.

• The DATETIME attributes for type and index are not used by
Oracle E–Business Suite.

• The DATETIME elements for YEAR, MONTH, DAY, HOUR,
MINUTE, SECOND, and SUBSECOND are used to construct the
Oracle E–Business Suite date value.

• The DATETIME element for TIMEZONE is determined as
follows: if the time zone of the incoming message is different
from the time zone specified in the profile option ECX: Server
Time Zone, the incoming date and time are converted.

See XML Gateway Valid Time Zone Values: page E – 2 for more
information.

Note:  The source and target elements are implicitly mapped
via the Action.  Additional element mapping will overwrite the
original Action instructions.

See Map Action Editor – Overview: page 2 – 74 for details on the
common components of the window.

Convert OAG Datetime

Identify the source DATETIME element to be converted into the Oracle
E–Business Suite format.  The source can be a literal value.

Target variables do not apply although they are available in the
Element window.

The converted value is assigned to the application (target) date element
selected when the action was invoked.
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Map Action Editor – Convert from OAG OPERAMT

The Convert From OAG OPERAMT action converts the OAG
representation for operating amount to the Oracle E–Business Suite
representation for operating amount.

The OAG representation for operating amount is as follows:

OPERAMT (qualifier, type, VALUE, NUMOFDEC, SIGN,
CURRENCY, UOMVALUE, UOMNUMDEC, UOM)

The Convert From OAG OPERAMT action converts the OAG
OPERAMT segment to the single Oracle E–Business Suite operating
amount column as follows:

• The OPERAMT qualifier attribute can be used to determine the
appropriate Oracle Application E–Business Suite module
operating amount column to use.

• The OPERAMT type attribute is not used by Oracle E–Business
Suite.

• The OPERAMT elements for VALUE, NUMOFDEC, SIGN,
UOMVALUE, and UOMNUMDEC are used to construct the
Oracle E–Business Suite operating amount value.

• The OPERAMT elements for CURRENCY and UOM can be
stored in Oracle E–Business Suite if the appropriate columns are
available.

Note:  The source and target elements are implicitly mapped
via the Action.  Additional element mapping will overwrite the
original Action instructions.

See Map Action Editor – Overview: page 2 – 74 for details on the
common components of the window.
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Convert OAG Operating Amount

Identify the source OPERAMT element to be converted into the Oracle
E–Business Suite format.  The source can be a literal value.

Target variables do not apply although they are available in the
Element window.

The converted value is assigned to the application (target) operating
amount element selected when the action was invoked.

Target Currency

The source OPERAMT value is represented as a collection of
subcomponents.  Identify the application (target) element to store the
currency code.  Literal values are not allowed.

If an application (target) element is identified, the Convert From OAG
Action will move the source currency code to it.

If no application (target) element is identified, the source currency code
will be ignored.

Target Unit of Measure

The source OPERAMT value is represented as a collection of
subcomponents.  Identify the application (target) element to store the
unit of measure code.  Literal values are not allowed.

If an application (target) element is identified, the Convert From OAG
Action will move the source unit of measure code to it.

If no application (target) element is identified, the source unit of
measure code will be ignored.

Map Action Editor – Convert from OAG Quantity

The Convert From OAG QUANTITY action converts the OAG
representation for quantity to the Oracle E–Business Suite
representation for quantity.

The OAG representation for quantity is as follows:

QUANTITY (qualifier, VALUE, NUMOFDEC, SIGN, UOM)

The Convert From OAG QUANTITY action converts the OAG
QUANTITY segment to the single Oracle Application quantity column
as follows:
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• The QUANTITY qualifier attribute can be used to determine the
appropriate Oracle E–Business Suite quantity column to use.

• The QUANTITY elements for VALUE, NUMOFDEC, and SIGN
are used to construct the Oracle E–Business Suite quantity value.

• The QUANTITY element for UOM may be stored in Oracle
E–Business Suite if an appropriate column is available.

Note:  The source and target elements are implicitly mapped
via the Action.  Additional element mapping will overwrite the
original Action instructions.

See Map Action Editor – Overview: page 2 – 74 for details on the
common components of the window.

Convert OAG Quantity

Identify the source QUANTITY element to be converted into the Oracle
E–Business Suite format.

Target variables do not apply although they are available in the
Element window.

The converted value is assigned to the application (target) quantity
element selected when the action was invoked.

Target Unit of Measure

The source QUANTITY value is represented as a collection of
subcomponents.  Identify the application (target) element to store the
unit of measure code.  Literal values are not allowed.

If an application (target) element is identified, the Convert From OAG
Action will move the source unit of measure code to it.

If no application (target) element is identified, the source unit of
measure code will be ignored.
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Map Action Editor – Convert from OAG AMOUNT

The Convert From OAG AMOUNT action converts the OAG
representation for amount to the Oracle E–Business Suite
representation for amount.

The OAG representation for amount is as follows:

AMOUNT (qualifier, type, index, VALUE, NUMOFDEC, SIGN,
CURRENCY, DRCR)

The Convert From OAG AMOUNT action converts the OAG
AMOUNT segment to the single Oracle E–Business Suite amount
column as follows:

• The AMOUNT qualifier attribute can be used to determine the
appropriate Oracle E–Business Suite amount column to use.

• The AMOUNT attributes for type and index are not used by
Oracle E–Business Suite.

• The AMOUNT elements for VALUE, NUMOFDEC, and SIGN
are used to construct the Oracle E–Business Suite amount value.

• The AMOUNT elements for CURRENCY and DRCR can be
stored in Oracle E–Business Suite if appropriate columns are
available.

Note:  The source and target elements are implicitly mapped
via the Action.  Additional element mapping will overwrite the
original Action instructions.

See Map Action Editor – Overview: page 2 – 74 for details on the
common components of the window.
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Convert OAG Amount

Identify the source AMOUNT element to be converted into the Oracle
E–Business Suite format.  The source can be a literal value.

Target variables do not apply although they are available in the
Element window.

The converted value is assigned to the application (target) amount
element selected when the action was invoked.

Target Currency

The source AMOUNT value is represented as a collection of
subcomponents.  Identify the application (target) element to store the
currency code.  Literal values are not allowed.

If an application (target) element is identified, the Convert From OAG
Action will move the source currency code to it.

If no application (target) element is identified, the source currency code
will be ignored.

Target Credit/Debit

The source AMOUNT value is represented as a collection of
subcomponents.  Identify the application (target) element to store the
credit/debit flag.  Literal values are not allowed.

If an application (target) element is identified, the Convert From OAG
Action will move the source credit/debit flag to it.

If no application (target) element is identified, the source credit/debit
flag will be ignored.

Map Action Editor – Other: Exit Program

The Exit Program action can be executed based on the result of
executing a Procedure call, Function call, or retrieving the value of a
Predefined Variable.

The Exit Program action rolls back the current transaction and exits the
XML Gateway Execution Engine.

The Exit Program action has no additional operands.

See Map Action Editor – Overview: page 2 – 74 for details on the
common components of the window.
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Map Action Editor – Get Predefined Variable Value

The Get Predefined Variable Value action maintains predefined
variables for the following:

• Inbound message envelope

• Code conversion status

• Transaction status

The values of these predefined variables are maintained by the XML
Gateway Execution Engine and are available for inquiry and mapping
to the Application Open Interface table column or Application API
parameter.

You can control the process flow based on the values found in the
predefined variables.

See Map Action Editor – Overview: page 2 – 74 for details on the
common components of the window.

Result Variable

Select the source, target, or global variable to store the value of the
predefined variable selected.

Predefined Variables

Select the predefined variable whose value you are interested in.  The
variables exposed by the XML Gateway Execution Engine are as
follows:

Code Conversion Return Status for

Select the source column enabled for code conversion.  The code
conversion process will search the trading partner–specific code
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conversions and then the standard–specific list, followed by the
universal list.

The status of the code conversion is assigned to the result variable.  The
return status codes are shown in the following table:

Return
Status Code

Description

0 Code conversion was successful.

1 Code conversion process failed to find a match for the source column, the
source value is copied to the target column.    

This is a warning only.  It will not stop the XML Gateway Execution En-
gine.  However, you may wish to take some action to control the process
flow based on this status.    

The possible causes of this failure are: invalid code category passed to the
code conversion API or code conversion cross–reference not found.    

Verify that the code category identified for the source column is valid
(Refer to Seeded Code Categories: page B – 2) and that a code conversion
cross–reference is defined in the trading partner–specific list, the stan-
dard–specific list, or the universal list.  Make the necessary corrections to
prevent this error from occurring again.

2 Code conversion process encountered unexpected error, session is termi-
nated.

Check the process log file for the details, make the necessary correction,
and reprocess the message.

Internal Control Number

The Internal Control Number is a system–generated number that
uniquely identifies the XML message being processed.  This number is
useful for sending acknowledgments, for document audits, for
document archival, and for troubleshooting.

The value for the Internal Control Number is assigned to the result
variable identified for the action.

The Internal Control Number can be used to get envelope information.
Refer to ECX_TRADING_PARTNER_PVT.getEnvelopeInformation
API: page F – 18 for more information.

Return Code

The Return Code is the error code associated with the error message.
The error message may be returned to the trading partner contact or
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the XML Gateway system administrator using the Send Error Message
action.

Multiple return codes can be concatenated in a single predefined
variable.  The value for the the Return Code is assigned to the result
variable.

The possible return codes are shown in the following table:

Return Code Description

0 Success

1 Warning.  The XML Gateway Execution Engine will not be stopped.

2 Failure.  Check the process log file for the details, make the necessary
corrections, and reprocess the message.

Return Message

The Return Message is the text associated with the return code.  The
error message may be returned to the trading partner contact or the
XML Gateway system administrator using the Send Error Message
action.

Multiple return messages can be concatenated in a single predefined
variable.  The value for the Return Message is assigned to the result
variable.

Receiver Trading Partner ID

The Receiver Trading Partner ID is a unique identifier for the receiver
of the XML message.  The ID can be used to derive the trading partner
name and other pertinent data.

Use the ECX_TRADING_PARTNER_PVT.get_receivers_tp_info
procedure to derive the Party ID, Party Site ID, Organization ID, and
Administrator e–mail Address associated with the Receiver Trading
Partner ID.  Refer to XML Gateway APIs: page F – 16 for more
information.

The Receiver Trading Partner ID is maintained for outbound messages
and pass–through messages.

The value for the Receiver Trading Partner ID is assigned to the result
variable.
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Sender Trading Partner ID

The Sender Trading Partner ID is a unique identifier for the sender of
the XML message.  The ID may be used to derive the trading partner
name and other pertinent data.

Use the ECX_TRADING_PARTNER_PVT.get_senders_tp_info
procedure to derive the Party ID, Party Site ID, Organization ID, and
Administrator e–mail Address associated with the Sender Trading
Partner ID.  Refer to XML Gateway APIs: page F – 16 for more
information.

The Sender Trading Partner ID is maintained for inbound messages
and pass–through messages.

The value for the Sender Trading Partner ID is assigned to the result
variable.

Organization ID

The Execution Engine derives the organization ID associated with the
Sender or Receiver Trading Partner ID.  The combination of the
organization ID and the Sender or Receiver Trading Partner ID
uniquely identifies a trading partner in the Oracle E–Business Suite.

Map Action Editor – Procedure Call: Execute Procedure

The Execute Procedure action calls a procedure to perform an activity.
Some procedures have input (send) parameters as well as output
(return) parameters, while others have no parameters at all.

The Execute Procedure action connects to the database to provide a list
of available procedures for selection.  Once you select the procedure,
you will be prompted for the parameter values.

Function calls are not supported by the Execute Procedure action.

See Message Designer APIs: page F – 6 for a list of special purpose
procedures for use with the Message Designer.
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See Map Action Editor – Overview: page 2 – 74 for details on the
common components of the window.

Click the Assign Parameter Value button to invoke the Get Procedure
Parameters... window.

This window requests database connection information.  The default
database access information is displayed from the Database tab (see:
page 2 – 6) of the File > Properties menu.  The defaults can be
overwritten on this screen.  Changes made on this screen are not copied
back to the Properties file.  Changes are used for the current session
only.

Enter the Schema Name, Package Name, and Procedure Name and
click OK.
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After connecting to the database, the window displays all signatures
for the procedure.  Expand all the signatures by clicking the ”+”.  Select
the procedure from the expanded list and click OK.
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Enter the parameter values in this window.  A parameter value may be
a literal value,  from a source or target, or a  global variable.

Regardless of how the parameters are defined in the procedure, a value
is required (by the XML Gateway Execution Engine) for each parameter
with a Parameter Type of IN unless a default value is provided by the
procedure.  The value can be based on a source variable, target
variable, global variable (if defined), or a literal value.  The value for
the source, target, or global variable is determined at run time.

For procedures with return variables (Parameter Type of OUT), define
temporary variables or use existing variables (source, target, or global)
to store the return values.  Status return values can be used to redirect
the process flow based on severity.  Return error codes and messages
can be sent to the XML Gateway system administrator or Trading
Partner contact using the Send Error Message action.

The XML Gateway Execution Engine supports parameters with a data
type of VARCHAR2, DATE, NUMBER, CHAR, and CLOB.  If the
required procedure contains parameters of unsupported data types, the
parameter values must be converted to a supported data type in order
to utilize this action.

For parameters defined with default values, you can provide another
variable or literal value if you wish to overwrite the default value.

Once you have entered all the required parameter values, click OK to
return to the Map Action Editor window.
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The procedure selected is displayed in the Procedure Name field.  Click
on the View Parameters button to review the parameter values entered.
Verify the parameter values, make any necessary corrections, and click
OK to return to the Map Action Editor window.

Map Action Editor – Return Error Message: Send Error Message

The Send Error Message action sends an error message to either the
Trading Partner contact or the XML Gateway system administrator
identified in the ECX_SYS_ADMIN_EMAIL system profile.

The Send Error Message Action is used for warnings that do not
require the process to be terminated.  For more serious errors requiring
termination of the process, use the
ECX_ACTIONS.set_error_exit_program API.  See
set_error_exit_program: page F – 24 for more information about its
usage.

Error messages can be obtained from the following sources:

• Return parameter of a procedure call

• Status of a function call

A Workflow notification containing the error message is sent to the
party identified in the To prompt.

This action is provided to augment the standard error handling and
notification process.  
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See Map Action Editor – Overview: page 2 – 74 for details on the
common components of the window.

Send Error Message

Identify the variable containing the error message to be sent.  The error
message can be represented as a literal.

When using this action in conjunction with the Procedure Call action,
the variable may be a return parameter or a literal value.

When using this action in conjunction with the Function Call action,
the variable may be the function return value or the value contained in
the Return Message variable maintained by the XML Gateway
Execution Engine.

You can concatenate several strings such as the value in Return
Message with a literal value to form a complete message.

To

Identify the recipient of the error message.  The valid options are the
Trading Partner contact or the XML Gateway system administrator,
identified in the ECX_SYS_ADMIN_EMAIL system profile.

Map Action Editor – String Functions: Perform Concatenation

The Perform Concatenation action concatenates the values in two
operands.  The operands can be based on variables whose values are
determined at runtime, or based on literal values.

To concatenate more than two operands, start with the first two
operands and store the result in a variable (source, target, or global).
Then concatenate the value in the variable with the next operand.
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The Perform Concatenation action can be applied to fields of any data
type because the XML Gateway Execution Engine will convert the
value to VARCHAR2 before performing the action.

See Map Action Editor – Overview: page 2 – 74 for details on the
common components of the window.

Result Variable

Select the source, target, or global variable to store the resulting
concatenated string.

First Operand

Identify the first operand.

The operand can be a variable (source, target, or global variable if
defined) whose value is determined at runtime, or a literal value.

Concatenated With

Identify the second operand to be concatenated with the first operand.

The operand can be a variable (source, target, or global variable if
defined) whose value is determined at runtime, or a literal value.

The concatenated value is assigned to the result variable.

Map Action Editor – String Functions: Perform Substring

The Perform Substring action parses a given string from a start position
and includes the characters within the length specified.  The resulting
substring is returned.
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The Perform Substring action can be applied to fields of any data type
because the XML Gateway Execution Engine will convert the value to
VARCHAR2 before performing the action.

Refer to ECX_CONDITIONS Package APIs: page F – 14 for additional
substring functions.

See Map Action Editor – Overview: page 2 – 74 for details on the
common components of the window.

Result Variable

Select the source, target, or global variable to store the resulting
substring.

Element

Identify the operand requiring substring action.

The operand can be a variable (source, target, or global variable if
defined) whose value is determined at runtime, or a literal value.

Start Position

Enter a start position greater then 0 but less than the maximum length
of the Element.

With Length

Enter a length greater than 0 but less than or equal to the maximum
length of the Element minus the start position.

The substring function will process the element identified from the
start position up to the length specified and assign the resulting
substring to the result variable.
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Map Action Editor – XSLT Transformation

XML Gateway supports XSLT transformations for both inbound and
outbound messages.  An XSLT style sheet can be applied to an XML
message before it is enqueued for delivery to a Trading Partner.
Similarly for inbound messages, a stylesheet can be applied after the
message is dequeued but before it is processed to the Oracle e–Business
Suite.

The file containing the XSLT style sheet must be stored in the directory
defined by the ECX_UTL_XSLT_DIR system profile.  The XML Parser
applies the transformation as the last activity performed before an
outbound message is sent, or as the first activity before an inbound
message is processed.

See Map Action Editor – Overview: page 2 – 74 for details on the
common components of the window.

XSLT Style Sheet

The XSLT Stylesheet name can be a literal file name (such as ABC.xsl)
or a Global Variable (such as PARAMETER6).
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How to Extend DTDs

The XML Gateway Message Designer supports mapping to and from a
DTD or an existing XML message.  The use of an existing production
XML message provides visibility to all the DTD extensions as well as
duplicate nodes and elements necessary to support the actual business
document.  The use of a DTD is necessary if an existing XML message
is not available.  Using a DTD may require adding duplicate nodes,
new segments, or elements to accommodate additional data.

When modifying an Oracle prebuilt message map or when creating a
new message map that requires DTD extensions, follow the DTD
extension guidelines outlined below.  The Open Applications Group
(OAG) has very strict guidelines regarding DTD extensions.

The only DTD extensions allowed are in the USERAREA.  You can add
elements in the appropriate OAG defined USERAREA or create new
USERAREAs under the OAG defined USERAREA.

Refer to the OAG guidelines section 2.11 titled ”USERAREA
Extensions” in the Open Application Group’s Integration Specification
(available at http://www.openapplications.org).

Use USERAREAs to support descriptive flexfields as well as other
extensions.

The OAG guidelines are as follows:

Top Level Name <vendor.transaction.context.USERAREA>

Element Name <vendor.elementname>

Reference File Name <vendor prefix>_<product>_<version>.dtd

Oracle’s adaptation of the OAG guidelines is as follows:

Top Level Name for
Descriptive Flexfield
Extensions

<Oracle.transaction.name of flexfield.USERAREA>
 Example: Oracle.ARInvoice.ARLINES.USERAREA

Element Name <Oracle.attributen>
where n is the number of attributes defined for the table

Top Level Name for other
Extensions

<Oracle.transaction.product_prefix.USERAREA>
Example: Oracle.ARInvoice.AR.USERAREA

Element Name <Oracle.elementname>

Reference File Name Oracle_<application shortname>DTDExtensions_<ver-
sion>.dtd
Example: Oracle_ARDTDExtensions_001.dtd
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XML Gateway provides a template to be used as the basis to create the
application–specific DTD extensions.  The template contains a
definition for the generic flexfields named ”attribute*” where * is the
number of attributes defined for the table.  The application–specific
DTD extension files are source–controlled with the specific application.

The application–specific DTD extension file can be updated as follows:

• Top level USERAREA names representing the application table
containing the descriptive flexfields

• Descriptive flexfield names

• Top level USERAREA names for other extensions

• Element names for other extensions

The updates must be added after the existing USERAREA tag.

Use Conditional Node Mapping and key on Top Level USERAREA
name to ensure that you are mapping from and to the correct group of
flexfields or application extensions.

Be sure to remove extension definitions from the reference file if you
are removing them from the message map.

Update the message map to incorporate the new fields introduced as a
DTD extension.  The updated message map and DTD extension files
must be loaded in the XML Gateway repository for access by the XML
Gateway Execution Engine.  Refer to How to Load/Delete Message
Maps and DTDs: page 2 – 121 for the details.
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How to Map a Pass–Through Message

Pass–through messages are messages that are received by Oracle
Exchange for code conversion (if required) and then routed to a final
destination.  Oracle Exchange acts as a routing hub for these messages.

The map for a pass–through message is defined as follows:

Note:  In a pass–through message, the same DTD is used for
both the source and the target.  If different DTDs are used the
transaction is an XML–to–XML transformation, not a
pass–through.

• Map the highest level only.  The CNTROLAREA is the highest
level in an OAG DTD.

• Load the message map into the XML Gateway repository for
processing.  Refer to How to Load/Delete Message Maps and
DTDs: page 2 – 121 for details.

• Define the Exchange hub as the trading partner and enable the
XML message as a pass–through transaction.  See ”Trading
Partner Setup” in the Oracle XML Gateway User’s Guide.

• Define the necessary code conversions in Oracle XML Gateway
or Oracle Exchange.  See ”Code Conversion” in the Oracle XML
Gateway User’s Guide.
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How to Map to an API

This section describes how to map to an API instead of an Application
Open Interface Table.  Data for an inbound XML message is copied to a
set of staging tables known as Application Open Interface tables.  The
data in these staging tables are validated using an Application Open
Interface API containing the business rules.  Valid data is moved to the
Application base tables.  Invalid data is marked for review.

In the case where the staging table and the validation rules are
embedded in the same code (commonly referred to as the Application
API), data for an inbound XML message is mapped to the parameters
of the Application API.

To map directly to an Application API, the map must be defined as
follows:

• The data definition type for the source and target must be XML.

• The source and target DTD and version must be the same.

• Map the source levels to the target levels.

• Define a target action for Execute Procedure referencing the
Application API as the procedure name.  The action is defined at
the document level as a postprocess activity.  Map the source
variables to the API parameters.  Include an action to check the
API return status.

Apply this approach for each level of the document.  If the
document has three levels, this approach is applied three times.

• Load the message map and corresponding DTDs into the XML
Gateway repository for processing.  Refer to How to
Load/Delete Message Maps and DTDs: page 2 – 121 to load the
maps into the XML Gateway repository.

• Define the trading partner and enable the XML message.

• Define any necessary code conversions.

Message Designer does not support Application APIs consisting of
multiple document levels.  Message Designer is designed to process
data one document level at a time.
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Loading and Deleting Message Maps and DTDs

Loading/Deleting a Map

Oracle message maps are delivered and installed on the $APPLTOP
directory.  They are automatically loaded into the XML Gateway
repository using the LoadMap program.  A map can be deleted using
the DeleteMap program.

If you modified an Oracle prebuilt message map or created a new
message map using the Message Designer, these maps are saved on
your local file system.  Perform the following steps to load the maps
into the XML Gateway repository for use by the XML Gateway
Execution Engine:

1. Move <mymap>.xgm file from the local file system to the middle
tier.  The apps.zip file containing the maps that were installed on
the $APPLTOP is installed on the middle tier.

2. Execute java LoadMap<DB username><DB
password><Hostname>:<Port>:<SID><mymap.xgm> to load
the message map into the XML Gateway repository.  LoadMap will
replace existing maps with the same name.

Example: java LoadMap User1 welcome
ap999sun.us.oracle.com:1521:ORA1151<mymap.xgm>

Note:  The LoadMap process will load a map if the map
version is compatible with the engine version.  The map
version is stored in the <ECX_MAJOR_VERSION> and the
<ECX_MINOR_VERSION> tags of the map file (.xgm).  The
engine version is stored in WF_RESOURCES.  Maps are
compatible with the engine if the major version is the same and
the minor version is the same or lower.

A map can be deleted using the DeleteMap program as follows:

1. Execute java DeleteMap <DB username><DB
password><Hostname><:<Port>:<SID><mapcode> to delete a
message map from the XML Gateway repository.  LoadMap will
replace existing maps with the same name, but obsolete maps with
a different name must be deleted manually.

<mapcode> is the map name entered in the Message Designer.

Example: java DeleteMap User1 welcome
ap222sun.us.oracle.com:1521:ORA1151<mapcode>



2 – 122 Oracle XML Gateway User’s Guide

Loading and Deleting a DTD

Each message map is associated with a set of DTDs: the main and its
reference DTDs.  Similar to message maps, the DTDs associated with
the Oracle prebuilt message maps are delivered and installed on the
$APPLTOP.  They are automatically loaded into the XML Gateway
database using the LoadDTDToClob program.  A DTD can be deleted
using the DeleteDTDFromClob program.

To change a DTD referenced in an existing message map, use the File >
Properties menu option of the Message Designer to make the necessary
change.  The updated message map must be loaded into the XML
Gateway repository using LoadMap (refer to Loading/Deleting a Map:
page 2 – 121).  In addition, the new DTD used must be loaded into the
XML Gateway database as follows:

1. Move <mydtd>.dtd file from the local file system to the middle tier.
The apps.zip file containing the DTDs that were installed on the
$APPLTOP is on the middle tier.

2. Execute java LoadDTDToClob<DB username><DB
password><Hostname>:<Port>:<SID><mydtd.dtd>
<RootElementName><Location> to load the DTD into the XML
Gateway database.  LoadDTDToClob will replace existing DTDs
with the same name.

<RootElementName> is the XML Root Element entered in the
Message Designer.

<Location> is the subdirectory name entered in the Specify XML
File and Root Element window of the wizard.

A DTD can be deleted using the DeleteDTDFromClob program as
follows:

Execute java DeleteDTDFromClob <DB username> <DB
password> <Hostname>:<Port>:<SID><mydtd.dtd>
<RootElementName><Location> to delete a DTD from the XML
Gateway database.  LoadDTDToClob will replace existing DTDs
with the same name, but obsolete DTDs with a different name must
be manually deleted.

<RootElementName> is the XML Root Element entered in the
Message Designer.

<Location> is the subdirectory name entered in the Specify XML
File and Root Element window of the wizard.

LoadMap and LoadDTDToClob are provided as two separate
programs to support various combinations of changes.  To ensure that
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the maps and DTDs are synchronized, always execute LoadMap and
LoadDTDToClob as a pair.
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Downloading a Map

You can download a map from the ECX table to produce the
corresponding XGM file. Use the DownloadMap.java utility to
download the map to the log directory.

The usage is as follows:

java DownloadMap <DB username><DB
password><Hostname>:<Port>:<SID><MAP_CODE>

Note that there will be differences between the original map and the
downloaded map.

Differences Between the Downloaded Map and the Original Map

The downloaded map and original map will differ as follows:

• If the original map has a code category that is not present in
ecx_xref_hdr, the downloaded map will not show the code
category.

• If the original map uses variables of data type other than
VARCHAR2, CHAR, NUMBER, CLOB, or DATE, the download
map will default it to VARCHAR2.

• If the original map was created with a Message Designer version
other than 2.6.0.X, the DownloadMap utility will default it to
2.6.3.0.0.

• If the original map was created with a version of Message
Designer that did not include the dbdrv hints, these hints will be
present in the downloaded map.
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Loading and Deleting an XSLT Style Sheet

XSLT style sheets are used to transform an XML message for rendering.
The style sheets are created using an XSL editor.  The xsl file can be
staged in the file system or loaded into the database.

Note:  The XML parser does not support nested style sheets
using the xsl: import function.  Define individual style sheets
instead.

The ECX:XSLT File Path profile option identifies the file system
directory where XSLT style sheets are staged.  The engine checks the
database first for the stylesheet, then if necessary, checks the file
system.

Style sheets can be used by XML Gateway in one of two ways:

1. To be applied to an XML message generated or received by Oracle
XML Gateway.  This is accomplished by defining the XSLT
Transformation action in the message map to reference a valid style
sheet.  Refer to XSLT Transformation: page 2 – 116 for details on
how to define this action.

2. Passed with a well–formed and valid XML message to the
ECX_STANDARDS.perform_xslt_transformation API to process
and return a transformed XML message for further processing by
the calling environment.  Refer to
ECX_STANDARDS.perform_xslt_transformation API: page F – 3 
for details regarding this API.

Because the engine will look for the style sheet in the database or the
file system, you have the option of either loading or staging the
stylesheet.  To prevent accidental overwrite, a style sheet should reside
in only one place.

Style sheets can be loaded into the database as follows:

1. Move <myxsl>.xsl file from the local file system to the middle tier.

2. Execute java LoadXSLTToClob <DB username> <DB
password> <Hostname>:<Port>:<SID> <myxsl.xsl>
<Application_code> <Version>

<Application_code> is the subdirectory where the XSLT style
sheet is source–controlled (for example: ar/xml/xslt)

If <Version> is not specified, the file with the highest version that
matches the file name, application code, and file type is loaded into
the ecx_files table.  If a matching style sheet is found in the
ecx_files table, the row is updated.  If the specified style sheet is
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not found in the ecx_files table, a new row is added to the table
with version number 0.

Style sheets can be deleted from the database as follows:

Execute java DeleteXSLTToClob <DB username> <DB
password> <Hostname>:<Port>:SID> <myxsl.xsl>
<Application_code> <Version>

<Application Code> is the name of the subdirectory where the
XSLT style sheet is source–controlled (for example: ar/xml/xslt).

If version is not specified, the file  with the highest version that matches
the file name, application code, and file type is deleted from the
ecx_files table.  Execute this program multiple times to delete multiple
versions of a style sheet.
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How to Implement Attachments in XML Messages

This topic consists of the following sections:

• Attachments and Oracle e–Business Suite: page 2 – 127

• Attachments and OAG Standard: page 2 – 127

• Attachments and Oracle Transport Agent: page 2 – 128

• Attachments and Outbound Documents: page 2 – 129

• Enable Attachments for Unit Test (Outbound): page 2 – 130

• Attachments and Inbound Documents: page 2 – 131

• Enable Attachments for Unit Test (Inbound): page 2 – 132

Attachments and Oracle e–Business Suite

The Oracle Foundation module offers the ability to define attachments.
An attachment may be defined as short text, long text, long RAW, or
BLOB data type.  When the attachment is defined in FND, unique
identifiers are provided so that the attachment may be correlated to the
business document.  Example uses of attachments are terms and
conditions associated with a purchase order or images associated with
catalog items.

Attachments and OAG Standard

With OAG version 7.X, the ATTCHREF data type is used to associate
large objects with a business document.  Attachments are associated to
an XML message by FILENAME.  The ATTCHREF data type is defined
as follows:

(Required) The name of a file for reference
purposes.

For XML Gateway message maps, the CID is
mapped to the FILENAME element.

(Optional) Identifies the method used to compress
or minimize the size, if a file is attached to the
document.  This enables the receiving application
to process the file appropriately.

FILENAME

CMPRSNTYPE
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For Oracle Foundation module, the compression
type is determined when the attachment is
deposited.

(Optional) Identifies the name of the compressed
file.  This enables the receiving application to find
the file within the compressed package.

For XML Gateway, the physical file is not passed.
The CID identified in the message map is used by
OTA to construct the message payload with its
associated attachments.

(Optional) The creation date of the attachment.

(Optional) A free–form description of the
transaction or any portion of the transaction.

(Optional) Identifies the application source or
format of the data within the file.  Examples are
MS Excel, CSV, and AutoCAD.

(Optional)

(Optional) File size of the attachment.

(Optional) Describes the formal name of ”title” of
the item, person, or object.

Note:  The URL option supported by OAG 7.3 is not supported
by XML Gateway at this time.

The ATTCHREF data type is not required if the attachment is a text
string.  These attachments can be associated with an XML data type or
element for text strings.  Textual attachments will be in–line with the
business document.  Large attachments of the BLOB data type will be
associated off–line to the business document using the ATTCHREF
data type as the reference.

Attachments and Oracle Transport Agent (OTA)

The OTA component of Oracle XML Gateway is used to deliver
business documents containing large objects of type BLOB in a
Multipurpose Internet Mail Extension (MIME) payload over HTTP or
HTTPS to a Trading Partner.  Similarly, inbound documents containing
attachments may be sent by a Trading Partner’s OTA servlet and
received by the Oracle e–Business Suite user’s OTA servlet.

CMPRSNID

DATETIME

DESCRIPTN

FILETYPE

NOTES1–
NOTES99
QUANTITY

TITLE
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Note:  As of the 11.5.9 release, support for large object
attachments is limited to Business–to–Business document
exchanges with Trading Partners delivered/received using
OTA.

An example of the MIME payload over HTTP is as follows:

MIME_boundry

Content Type:text/xML; charset=UTF–8

Content ID:CID0

....business document

MIME_boundry

Content Type:image/tiff

Content ID:CID1

....binary TIFF image

MIME_boundry

Content Type:image/gif

Content ID:CID2

....binary GIF image

OTA is responsible for the following:

• Construction of the outbound XML message with valid MIME
message containing the message payload and associated
attachments.

• Extraction of the message payload and associated attachments
from the inbound MIME message.

Attachments and Outbound Documents

For outbound documents, it is assumed that an attachment has been
defined in the Oracle Foundation (FND) module and that it has been
associated with a business document.  A given business document can
have any number of attachments defined at any level of the document.

To include an attachment in the generated XML message, the XML
Gateway must be informed of the relationship between the attachment
and the business document.  This is accomplished by adding a
Procedure Call action to the message map to call the register
attachment API at every point in the business document where an
attachment is identified.
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The relationship data is maintained in the ECX_ATTACHMENT_MAPS
table, which is used by OTA to construct the outbound XML message
with a valid MIME message containing the message payload and
associated attachments.  The register_attachment API returns a unique
content ID (referred to as CID) that is mapped to the OAG ATTCHREF
data type, FILENAME element, or other standards–specific equivalent.

See register_attachment API: page F – 25 for more information.

Because the attachment, with its unique identifiers defined for it in
FND, has a direct relationship with the map for the business document,
any changes to the attachment (such as deletion) or to the attachment
identifiers must be reflected in the message map to maintain data
integrity.

Attachment content changes are reflected in the next usage of the
attachment on a business document.  The change will not be
retroactively applied to previously generated business documents.

Enable Attachments for Unit Test for Outbound Documents

The following outlines the steps necessary to set up attachments for
outbound documents:

• Define attachments in the Oracle Foundation module.

• Associate the attachment with the business document.

• Create/update the message map to call the register_attachment
API for every off–line attachment associated with the business
document.

• Map the off–line attachment (that is, BLOB data type) CID to the
ATTCHREF data type, FILENAME element, or other
standards–specific equivalent.

• Map the in–line attachment (that is, SHORT_TEXT,
LONG_TEXT, or LONG_RAW data type) to the appropriate
XML data type or element for text strings.

• Load the map and DTD to the XML Gateway repository.

• Define the Trading Partner, enable the transaction for the Trading
Partner, and use protocol type OTAH–ATCH, OTAHS–ATCH,
HTTP–ATCH, or HTTPS–ATCH.  The OTAH–ATCH and
OTAHS–ATCH protocol types are used when an OTA envelope
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is required.  The HTTP–ATCH and HTTPS–ATCH protocol types
are used when an OTA envelope is not required.

Attachments and Inbound Documents

For inbound documents, OTA will extract the business document from
the multi–part message and enqueue it onto the ECX_INBOUND
queue.  It will also extract the associated attachments (if any) and
deposit them into the FND module of the receiving instance.  For each
attachment deposited into the receiving instance, an entry is written to
the ECX_ATTACHMENT_MAPS table to record the relationship
between the attachment and the business document.

If the inbound business document contains a reference to an attachment
via the OAG ATTCHREF data type, FILENAME element, or other
standards–specific equivalent, and the Oracle e–Business Suite module
is interested in the attachment, the attachment content can be retrieved
from the FND module of the receiving instance.  This is accomplished
by adding a Procedure Call action to the message map at every point of
the business document where an attachment of interest is identified.
There is no requirement to retrieve every attachment associated with an
inbound business document unless the application module is interested
in them.

Because the BLOB data type is handled at the database layer, the Oracle
e–Business Suite module must define an API that internally calls the
XML Gateway retrieve_attachment API.  The BLOB attachment content
is passed from the retrieve_attachment API x_file_data OUT parameter
to the IN parameter of the application API.  The application module is
responsible for storing the attachment content in the appropriate
column of the application table.

The receiving Oracle e–Business Suite module may change the FND
attributes associated with the attachment originally deposited by OTA.
This is accomplished by calling the retrieve_attachment API to retrieve
the original attachment, and then calling the reconfig_attachment API
to reset the FND attributes for the attachment with the
application–specific identifiers.

See retrieve_attachment: page F – 26 and reconfig_attachment: page
F – 27 for more information about these APIs.
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Enable Attachments for Unit Test for Inbound Documents

The following outlines the steps necessary to set up attachments for
inbound documents:

• Create an application–specific API which internally calls the
retrieve_attachment API.  This API is responsible for storing the
retrieved attachment in the application column.

• Create/update the message map to check for the attachment
reference (that is, OAG ATTCHREF data type, FILENAME
element) and if the reference is present, call the
application–specific API to retrieve each off–line attachment
associated with the business document that the Oracle
e–Business Suite module is interested in.

• Optionally create/update the message map to call
reconfig_attachment API for previously retrieved attachments to
reset the FND attributes.

• Load the map and DTD to the XML Gateway repository.

• Define the Trading Partner, enable the transaction for the Trading
Partner, and use protocol type OTAH–ATCH, OTAHS–ATCH,
HTTP–ATCH, or HTTPS–ATCH.  The OTAH–ATCH and
OTAHS–ATCH protocol types are used when an OTA envelope
is required.  The HTTP–ATCH and HTTPS–ATCH protocol types
are used when an OTA envelope is not required.
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XML Gateway Setup

his chapter explains the implementation steps required to set up
XML Gateway.  Topics includes descriptions of all required forms as
well as conceptual discussions of setup options.
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Setup Overview

Implementation Checklist

There are ten setup steps for the XML Gateway as shown in the
following table:

Step Completed Task

1 Define System Profile Options: page 3 – 3

2 Assign XML Gateway Responsibility: page 3 – 5

3 Define the utl_file_dir parameters: page 3 – 6 (per-
formed by a DBA)

4 Define Hubs: page 3 – 8

5 Define XML Standards: page 3 – 11

6 Define Transactions: page 3 – 13

7 Define Lookup Values: page 3 – 22

8 Define Trading Partners: page 3 – 25

9 Set up Trading Partner Code Conversion: page 3 – 54

10 Define Standard Code Conversion: page 3 – 50

Note:  Additional setup steps are required for Web services.
See the Web Services chapter for details.

XML Gateway Forms

There are seven forms in the XML Gateway that you will use to
complete the setup steps:

• System Profile Options: page 3 – 3

• Hub Definitions: page 3 – 8

• Define XML Standards: page 3 – 11

• Define Transactions: page 3 – 13

• Oracle XML Gateway Lookups: page 3 – 22

• Define Trading Partner Setup: page 3 – 25

• Define Code Conversion: page 3 – 50
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Define System Profile Options

The XML Gateway uses profile options to define the following for your
system:

• The directory path for XML messages and processing log files

• The directory path for XSLT style sheets

• The XML Gateway System Administrator’s e–mail address

• The sender’s information system

• The time zone for the database server

• The maximum size an outbound document may reach before
validating whether parsing should continue

To define these profile options, you must sign on to Oracle
Applications as the System Administrator responsibility.  Navigate to
the System Profile Values form using the path (N) Profile > System.

The following table lists the XML Gateway system profile options:

Profile Option Description Required Default
Value

ECX: Log File Path Log File Path where the XML
messages and runtime log are
stored

YES None

ECX: XSLT File Path XSLT Path where XSLT style
sheets are stored

YES None

ECX: System
Administrator Email
Address

XML Gateway System Adminis-
trator e–mail address

YES None

ECX: OAG_LOGICALID Identifier for Sender’s Informa-
tion System

NO None

ECX: Server Time Zone The time zone in which the data-
base server is running.  See
Attention below.

YES Null

Table 3 – 1   XML Gateway Profile Options (Page 1 of 2) 
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Default
Value

RequiredDescriptionProfile Option

ECX: Maximum XML
Size

Specifies the maximum size of an
outbound XML document (in
characters) beyond which pars-
ing is performed based on the
value of ECX: XML Validate Flag.
If the size is not set, the docu-
ment will be parsed by default.
See Note below.

NO 2 MB

ECX: XML Validate Flag Specifies whether an outbound
document should continue to be
parsed by the engine after the
ECX: Maximum XML Size has
been met.  See Note below.

NO Y

Table 3 – 1   XML Gateway Profile Options (Page 2 of 2) 

Attention:  The valid values for ECX: Server Time Zone are
listed in Appendix E.  If this profile option is not set, the time
zone ID will default to Greenwich Mean Time (GMT).

Note:  Setting the ECX: XML Validate Flag value to anything
other than ”Y” will turn off parser validation for a document
once the maximum size has been parsed.  Turning off the
validation avoids Out of Memory errors for large documents.

If validation is turned off, the XSLT Transformation action
cannot be performed.  For more information on the XSLT
Transformation action, see perform_xslt_transformation: page
F – 3.

For outbound Web services this validation must be turned off.
See Web Services Setup: page 8 – 7.

Additional Information:  For more information on setting
Profile Options see: Oracle Applications System Administrator’s
Guide.
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Assign XML Gateway Responsibility

Use the System Administrator responsibility to assign the Oracle XML
Gateway responsibility to a user to access the Oracle XML Gateway
database and forms.  Use standard procedures to assign the
responsibility.

Additional Information:  See Oracle Applications System
Administrator’s Guide.
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Define UTL_FILE_DIR Parameter

Perform this step in cooperation with a Database Administrator (DBA).

Define UTL_FILE_DIR Parameter in the INIT.ORA File

To use Oracle XML Gateway, you must first create directories where
the XML message process log and XSLT style sheets will be stored.
Oracle XML Gateway uses the UTL_FILE package to read and write to
the server.

UTL_FILE can only write to accessible directories.  The directories are
defined by the utl_file_dir parameter in the init<SID>.ora file.
This file is usually found in the $ORACLE_HOME/dbs directory.  Within
this file, each accessible directory is indicated by a line such as

utl_file_dir = directory_name

The specification of directory_name will vary, depending on the
operating system.  If the operating system is case–sensitive, then
directory_name is case sensitive.

The value for directory_name must be a physical directory.  It cannot be
a variable, a logical, or an alias.  In addition, the value for
directory_name must match the value defined in the Oracle XML
Gateway profile for ECX_UTL_LOG_DIR File Path (ECX: Log File
Path) and ECX_UTL_XSLT_DIR File Path (ECX: XSLT File Path).

Refer to Define Profile System Values: page 3 – 3 for details.

Example: UNIX Operating System

The following is an example of an entry for a UNIX operating system:

utl_file_dir = /d1/XML/logs/d1/XML/xslt

In addition to this form of database security, operating system security
must also be considered.  The file I/O operations performed with
UTL_FILE will be done by the Oracle user (the Oracle user is the
owner of the files that are used to run the database, and also the owner
of the processes that make up a database instance).  Consequently, the
Oracle user has to have operating system privileges to read from and
write to all of the accessible directories.  If the Oracle user does not
have privileges for an accessible directory, then any operations in that
directory will be prohibited by the operating system.

To ensure that operating system security allows the Oracle user to
create, delete, rename, read, and write files in the specified directories,
the DBA must grant directory and file access privileges by issuing the
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CHMOD 777 command at the operating system level.  This is a UNIX
example only, so use appropriate operating system commands for your
environment.

The Oracle instance must be brought down and back up for the
changes in the init<SID>.ora file to be effective.
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Hub Definitions Form  

Navigate to the Hub Definitions form from the XML Gateway
Responsibility by selecting Setup > Define Hubs.

A hub is an integration point within your network (either your intranet
or the internet).  Hubs are typically used to route documents to and
from trading partners.  Oracle Exchange is an example of a hub.  You
may also decide to create a private hub within your intranet through
which all your ERP systems communicate.

The Hub Definitions form is used to define the hub and the authorized
users conducting business via the hub.  The hub users entered in this
form will appear on the Trading Partner Setup form: page 3 – 25.
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Name (Required)

Enter the Hub name.

Protocol Type (Required)

Protocol Type is the communication protocol associated with the hub,
such as SMTP or HTTP.  Select a value from the seeded list of values.
The description for the protocol type is displayed.

Protocol Address

When protocol type is HTTP or HTTPS, protocol address is prompted.

Protocol Address is the complete URL (including service/servlet)
where the Transport Agent will attempt to post the XML Document.

If the Protocol type is SMTP, the protocol address is an e–mail address.

Hub Users

Username (Required)

Enter the user name of the trading partner conducting business via the
hub.

Password (Required)

Enter the password for this user.  The encrypted password is stored in
the database. The password is not echoed when it is entered.  You will
be prompted on the same field to confirm the password.

Hub Entity Code (Required)

Enter the hub entity code for this user.

Hub Entity Code has the same function as the Source Trading Partner
Location Code: page 3 – 32 in the Trading Partner Setup form: page
3 – 25.  It is the code found in the XML envelope to identify the source
of the message.

If you are sending and receiving messages from a trading partner, you
will have a mixture of your location codes and your trading partner’s
location codes depending on the direction of the message.  For
example, if you are sending messages out, the Source Trading Partner
Location Code is your location code because you are the source of the
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XML message.  If you are receiving messages, the Source Trading
Partner Location Code is your trading partner’s location code because
they are the source of the XML message.

This code is examined for inbound messages during Trading Partner
validation.  When placed on an outbound message, the recipient will
validate it as a valid source location code.

The Hub Entity Code is placed in the PARTY ID field in the XML
Gateway envelope: page 4 – 7.
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Define XML Standards Form  

Navigate to the Define XML Standards form from the XML Gateway
Responsibility by selecting Setup > Define XML Standards.

This form defines standards bodies for XML messages, such as OAG.

The Standard Code entries made in this form will appear in a list of
values for the Standard Code field in the following forms:

• Define Transactions form: page 3 – 13

• Trading Partner Code Conversion form: page 3 – 54 (accessed via
the Trading Partner Setup form)

• Standard Code Conversion form: page 3 – 50

The Define Transactions form identifies the creating organization of the
DTD, and hence, the XML message structure.  The values entered in
the Define XML Standards form will be the list of values for the
Standard Code field in the Define Transactions form.

In the Trading Partner Code Conversion form and the Standard Code
Conversion form, this value is used as part of the search key to access
the code conversion tables.

Standard Code will also be the default standard code used in Standard
Code Conversion table searches, when the Standard Code is assigned
to the entries in the Define Transactions form.



3 – 12 Oracle XML Gateway User’s Guide

Standard Code (Required)

This field is the name or code for the standard’s body for the XML
messages.

Only XML Standards are entered in this form with the exception of the
value UNIVERSAL.  The seeded value UNIVERSAL is needed for the
Standard Code Conversion form to identify universally used codes,
such as ISO codes.

Standard Type

Standard Type is any appropriate value that you choose.

Description

Enter a description of the standard.
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Define Transactions Form  

Navigate to the Define Transactions form from the XML Gateway
Responsibility by selecting Setup > Define Transactions.

Use the Define Transactions form to define the transactions that will be
used by the XML Gateway Execution Engine.  You will then associate
these transactions will with a trading partner in the Trading Partner
Setup form.

The Define Transactions form provides the following:

• A cross–reference between the external transaction identifiers
and the internal Oracle transaction identifiers.

• Identification of the queue from which to retrieve inbound
messages

Cross–Reference Transaction Identifiers

This form provides a cross–reference between internal Oracle
transaction identifiers, represented by the Transaction Type and
Transaction Subtype, and External Transaction Types and External
Transaction Subtypes.

Note:  The data element pair of External Transaction Type and
External Transaction Subtype, and the data element pair of
Transaction Type and Transaction Subtype are not a one–to–one
cross–reference by similar data element names.  It is the
combination of each pair that is significant to identify the
external representation of the XML message, or the internal
representation to identify the transaction to the Oracle
Application.

For example: The following is an inbound message with a Party Type of
”CUSTOMER”: OAG PROCESS_INVOICE_003.  The message has the
External Transaction Type ”PROCESS” and External Transaction
Subtype ”INVOICE.”  The inbound direction is determined by the XML
Gateway.

The External Transaction Type ”PROCESS” and External Transaction
Subtype ”INVOICE” will be matched to Transaction Type and
Transaction Subtype equal to AP and INI as they are defined in the
Define Transactions form.  For this trading partner, the message map
defines on which tables in Oracle Payables to place the inbound data.

Another example is an outbound message with a Party Type of
”SUPPLIER”:
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Invoice transaction from Oracle Receivables has the Transaction Type
”AR” and the Transaction Subtype ”INO.”  The outbound direction is
determined by the XML Gateway.

This Transaction Type and Transaction Subtype will be matched to the
External Transaction Type ”INVOICE” and External Transaction
Subtype ”PROCESS” as defined in the Define Transactions form for the
specified trading partner.  For this trading partner, the message map
identifies what data to extract from Oracle Receivables.

The Party Type, Transaction Type, and Transaction Subtype are key
codes used by Oracle E–Business Suite to integrate with the Workflow
Business Event System (BES) to trigger message creation or message
consumption.

Queues

Different queues can be defined for various transactions from the
application, or for XML messages to be transmitted.  The queue names
are assigned to the transactions via this form.

 See Message Queues: page 5 – 2.
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Party Type (Required)

Party Type defines the type of trading partner, such as Supplier,
Customer, Bank, or internal locations (such as warehouses).  Select a
value from the list of values.

Transaction Type (Required)

Transaction Type is the product short name for the base Oracle
Application associated with the transaction, such as ”AR” for Oracle
Receivables.  Refer to Transaction Type and Transaction Subtype
Naming Conventions: page 3 – 17.

If you are using OAG standards, refer to Setting VERB and NOUN in
OAG Standards: page 3 – 20.
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Transaction Subtype (Required)

Transaction Subtype is a code for a particular transaction within the
application specified by the Transaction Type.  The last position of the
code represents the direction of the transaction: ”I” for inbound, ”O”
for outbound.

See Transaction Type and Transaction Subtype Naming Conventions:
page 3 – 17.

The combination of the Transaction Type and the Transaction Subtype
identifies an Oracle transaction with which to associate this message.
This data will appear on the Trading Partner Setup form.

If you are using OAG standards, refer to Setting VERB and NOUN in
OAG Standards: page 3 – 20.

Transaction Description

Enter a description for the transaction.

Standard Code (Required)

The XML standard to be used for this transaction. The Standard Codes
are set up in the Define XML Standards form: page 3 – 11.  Choose the
code from the list of values.

Direction (Required)

Direction indicates if the message is inbound or outbound.  Select ”IN”
for inbound messages, or ”OUT” for outbound messages from the list
of values.

External Transaction Type (Required)

External Transaction Type is the primary external identifier for the
XML message.

The combination of the External Transaction Type and the External
Transaction Subtype should cross–reference this message to the Oracle
internal transaction identified by the Transaction Type and the
Transaction Subtype.

External Transaction Subtype (Required)

External Transaction Subtype is the secondary external identifier for the
XML message.
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The combination of the External Transaction Type and the External
Transaction Subtype should cross–reference this message to the Oracle
internal transaction identified by the Transaction Type and the
Transaction Subtype.

Queue (Required for Inbound Messages)

A queue is a table in a database where transactions are staged for
processing.  Default queues are defined during installation.  Select a
queue from the list of values.

The field is disabled for outbound messages.

 See Message Queues: page 5 – 2.

Note:  Only queues with a prefix of ECX will display in the list
of values.

Transaction Type and Transaction Subtype Naming Conventions

Naming conventions for Transaction Type and Transaction Subtype are
necessary to facilitate the reading of audit trails and for troubleshooting
across applications.

The Transaction Type and Transaction Subtype codes should not focus
on naming conventions based on the standard XML message that is
implemented.  A given transaction from an application may be mapped
to several XML standards based on the trading partner agreements,
likewise for inbound messages.

The following naming conventions are recommended:

Transaction Type

The Transaction Type is the product short name for the base Oracle
Application.  Examples of Oracle Application product short names are
shown in the following table:
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Transaction Type Application

AP Payables

AR Receivables

OM Order Management

PO Purchasing

SS Supplier Scheduling

RLM Release Management

CUSTOM (for user–defined messages)

Transaction Subtype

The Transaction Subtype is a code for a particular transaction within
the application specified by the Transaction Type.  The last position of
the subtype code represents the direction of the transaction: ”I” for
inbound, ”O” for outbound.

The naming convention is XXXXI or XXXXO where XXXX is significant
to the application and its function, such as invoicing to Receivables and
Payables.

For custom transactions, add a prefix to distinguish custom
transactions from the Oracle supplied transactions.

The table below lists common combinations of Transaction Type and
Transaction Subtype:
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Transaction
Type
(Application)

Transaction
Subtype
(Transaction)

Transaction Type’s
Processing
Application

Transaction Type’s Processing
Application
(Transaction Code plus
Direction)

PO POCO Purchasing Purchase Order Change, Out-
bound

PO POO Purchasing Purchase Order, Outbound

PO POAI Purchasing Purchase Order Acknowledg-
ment, Inbound

OM POI Order Management Purchase Order, Inbound

OM POCI Order Management Purchase Order Change, In-
bound

OM POAO Order Management Purchase Order Acknowledg-
ment, Outbound

OM POCAO Order Management Purchase Order Change Ac-
knowledgment, Outbound

AR INO Receivables Invoices, Outbound

AP INI Payables Invoices, Inbound

The actual transaction detail is therefore recognized by its unique
combination of the Transaction Type and Transaction Subtype.  The
Transaction Subtype does not have to be unique across applications,
but only within the application specified by the Transaction Type.

Consequently, both the Purchasing and the Order Management
application can use the same Transaction Subtype (for example, POI)
because they may both import some type of purchase order.  For
example, Order Management will load orders from its customers;
Purchasing may load from another purchasing application.

Additional Suffix on Transaction Subtype

If different database views are used to extract different types of
transaction data, such as a blanket order versus a standard order, or
different XML messages are needed for transactions such as a blanket
order versus a standard order, then you can create different message
maps using the Message Designer.  You may also need to define
different Transaction Subtypes to distinguish between such transactions
in the Transaction setup.

When appropriate, a suffix can be attached to the base Transaction
Subtype following the XXXXI or XXXXO naming convention to further
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distinguish a transaction in the XML Gateway.  For queries in a form, it
is recommended to keep the same base Transaction Subtype XXXXI or
XXXXO, so the Transaction Subtypes will follow each other in queries.

The suffix naming convention is therefore XXXXI–yyyy and
XXXXO–yyyy where yyyy is the suffix.

The following table illustrates the Transaction Subtype naming
convention using a suffix:

Transaction
Type
(Application)

Transaction
Subtype
(Transaction)

Transaction
Type’s
Processing
Application

Transaction Type’s Processing
Application
(Transaction Code plus
Direction)

PO POO–BLK Purchasing Blanket Purchase Order, Out-
bound

PO POO–REL Purchasing Purchase Order Release, Out-
bound

PO POO–STD Purchasing Standard Purchase Order, Out-
bound

For example in a Purchasing application, all types of outbound
purchase orders can be initiated under the general subtype POO with
qualifiers for the various types of purchase orders such as blanket,
standard, and release.  Their subtype codes can be recognized as
POO–BLK, POO–STD, and POO–REL respectively by the process.
Avoid using long suffixes such as –BLANKET, –STANDARD, and
–RELEASE to keep the naming convention simple.  This sample is for
illustration only.

Setting VERB and NOUN in OAG Standards

The following topic discusses sources of data for the OAG
CNTROLAREA.

The VERB and NOUN are key values required in the OAG
CNTROLAREA data type.  XML Gateway provides a database view
that provides key data from the transaction table, while the attribute
values are default values from the DTD used to create the outbound
message map.

The purpose of the database view is to populate the VERB and NOUN
elements illustrated below.
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The Verb and Noun in OAG’s CNTROLAREA

<NOUN value = ”INVOICE”> INVOICE </NOUN>

<VERB value = ”PROCESS”> PROCESS </VERB>

When the External Transaction Type and External Transaction Subtype
are entered into the transaction table through the Define Transactions
form, they can be mapped to the NOUN and VERB value fields
respectively by using the database view
ECX_OAG_CONTROLAREA_TP_V (formerly
ECX_OAG_CONTROLAREA_V).  See Transaction Map – Element
Mapping: page 2 – 68.

Note:  The ECX_OAG_CONTROLAREA_TP_V view is an
upgraded version of the ECX_OAG_CONTROLAREA_V view.
Oracle XML Gateway supports both versions of the database
view.  For a detailed description of the differences, see the
Note: page 2 – 35, in the Message Designer chapter.

Attention:  Within the OAG CNTROLAREA, the sequence of
fields is VERB then NOUN in the message.  In the Define
Transactions form, the sequence of fields is NOUN in the
External Transaction Type, then VERB in the External
Transaction Subtype.  Be careful not to reverse the order of the
data.
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Define Lookup Values  

To navigate to the Oracle XML Gateway Lookups form from the XML
Gateway Responsibility select Setup > Define Lookup Values.

The Oracle XML Gateway Lookups form allows both entry and display
of seeded data.  This is a standard Oracle Application Object Library
form.

Once a Type is selected in the upper section, its seeded values are
displayed in the Lookup Details section of the form.

Type (Required)

Type is the key code for the element stored in the seeded table.

The XML Gateway seeded lookup types are listed in the following
table:
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Type Description Sample Values

COMM_METHOD Communications Method HTTP, HTTP–ATTCH, HTTP–OXTA, HTTP–
WM, HTTPS, HTTPS–ATTCH, HTTPS–OMB,
HTTPS–OXTA,  HTTPS–WM, IAS, ITG03,
SMTP, OTAH–ATCH, OTAHS–ATCH, NONE,
SOAP

CONFIRMATION_CODE Confirmation Code 0, 1, 2

DOCUMENT Documents/Transactions CBODI and CBODO are seeded by Oracle
XML Gateway.  CBODI is OAG’s inbound
confirmation.  CBODO is OAG’s outbound
confirmation.

MESSAGE_STANDARD XML Message Standard OAG, ORCL, RN, UNIVERSAL, PESC

MESSAGE_TYPE Message Type XML, EDI, FF (for flat file)

PARTY_TYPE Party Types B (for bank), C (for customer), S (for supplier),
I (for internal location), E for Exchange,
CARRIER (for Carrier)

TRANSACTION_CODE Transaction Code CBOD for confirmation BOD is the XML
Gateway seeded transaction code.

User Name (Required)

User name is defined by the user when data is entered.

Application (Required)

The text name for the application responsible for this Type.

Description

Description of the Type.

Access Level

The Access Level restricts changes that are possible to a lookup type.
The possible levels are:

• System – No changes to the lookup codes are allowed.

• Extensible – New lookup codes can be added.  However, you
cannot modify seeded lookup codes.

• User – You can change any lookup code.
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Lookup Details

Code (Required)

The seeded code for the lookup.

Meaning (Required)

The meaning of the lookup code.

Description

Description of the lookup code.

Tag

Not used.

From Effective Date

The starting effective date for the lookup code.

To Effective Date

The expiration date for the lookup code.  The ending date is optional.

Enabled Check Box

Check the box if the Code is enabled.  Remove the check to disable the
Code.
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Trading Partner Setup  

Navigate to the Define Trading Partner Setup form from the XML
Gateway Responsibility by selecting Setup > Define Trading Partners.

The Trading Partner Setup form is used to:

• Enable messages for the trading partner by identifying the
internal and external transaction type and transaction subtype
codes, and the XML standard associated with the message.

• Access the Trading Partner Code Conversion form.

• Select a message map for the trading partner.

• Identify the communications protocol and address for a message.
Optionally, the user can be selected from a hub.

This is the component that will enable a message to be processed
through the XML Gateway engine.  In the XML Gateway, the term
”Trading Partner” refers to an entity such as a customer, supplier, bank
branch, or internal locations at a particular address with which you
exchange messages.  Since a given entity may have several locations,
you must define one Trading Partner for each customer address,
supplier site, or bank branch as required for processing transactions by
the Oracle XML Gateway.

During message processing, Trading Partner data is used to:

• Link a particular address location in Oracle E–Business Suite to
the Trading Partner definition in the Gateway.

• Provide a means of telling the Execution Engine which Trading
Partner message map to use.

• Enable specific transactions for Trading Partners.

• Determine how to deliver the message.

Note:  Multi–Org Consideration  Trading Partner setup in
XML Gateway is organization–dependent.  The list of Trading
Partners and Trading Partner sites displayed is limited to those
trading partners defined to the organization of the logon
responsibility.

This form defines the parameters for the Trading Partner setup.  The
setup includes the identification of the trading partner site, the
messages enabled for that site, and the delivery mechanism.

The Trading Partner Setup form requires an entry for each Transaction
Type and Transaction Subtype associated with this trading partner.



3 – 26 Oracle XML Gateway User’s Guide

The Trading Partner Setup form includes the following data to define
the Trading Partner:

Trading Partner Type (Required)

Trading Partner Type defines the type of trading partner, such as
Supplier, Customer, Bank or internal location.  Once the Trading
Partner Type is selected from the list of values, the Trading Partner
Names and Trading Partner Sites associated with the Trading Partner
Type are displayed in the Trading Partner Name and Trading Partner
Site lists of values below.

Trading Partner Name (Required)

Given the selection in the Trading Partner Type, the appropriate
Trading Partner Names are displayed in the Trading Partner Name list
of values.  For example, if Partner Type is Customer, then customer
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names will be displayed.  These Trading Partners are limited to those
trading partners associated with the organization of your logon
responsibility.  Select the appropriate Trading Partner Name.

Trading Partner Site (Required)

Given the selection in the Trading Partner Name, the appropriate
Trading Partner Sites are displayed in the list of values.  Select the
appropriate Trading Partner Site.

Company Admin Email (Required)

This is the e–mail address of the administration contact to receive
e–mails regarding warnings and errors.  These notifications may be
initiated by Oracle Workflow or by an action defined in the message
map using the Message Designer.  Users should check the error log.

Code Conversion Button

Use the Code Conversion button to access the Trading Partner Code
Conversion form

See: Code Conversion: page 3 – 42

        Trading Partner Code Conversion Form: page 3 – 54

Trading Partner Details

The combination of Party Type (Trading Partner Type), Trading Partner
Name, Trading Partner Site, Transaction Type, and Transaction Subtype
uniquely identify an outbound transaction.

The combination of External Transaction Type, External Transaction
Subtype, Standard Code, and Source Trading Partner Location Code
uniquely identify an inbound transaction.

The Trading Partner Setup form includes the following detail for each
message:

Transaction Type (Required)

Transaction Type is the standard product short code for the base Oracle
Application.  These values are defined in the Define Transactions form.
The list of values will display the available combinations of Transaction
Type, Transaction Subtype, Standard Code, External Transaction Type,
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External Transaction Subtype, and Direction.  Select the desired
combination.

These values are only used internally to the XML Gateway.  Refer to the
Define Transactions Form: page 3 – 13 for details.

Transaction SubType

Transaction subtype is a code for a particular transaction within the
application specified by the Transaction Type.  The last position
represents the direction of the transaction: I for inbound,  O for
outbound.

The combination of Party Type (Trading Partner Type), Transaction
Type, and Transaction Subtype should identify an Oracle transaction
with which to associate this message. These values are defined in the
Define Transactions form.

These values are only used internally to the XML Gateway.  Refer to the
Define Transactions Form: page 3 – 13 for details.

Standard Code

The Standard Code associated with the Transaction Type selected
above is displayed.

Standard Codes are set up in the Define XML Standards form: page
3 – 11.

External Transaction Type

The External Transaction Type associated with the Transaction Type
selected above is displayed.

The External Transaction Type is the primary external identifier for the
XML message.  These values are defined in the Define Transactions
form: page 3 – 13 and they are found in the XML Gateway envelope:
page 4 – 7.

The combination of the External Transaction Type and the External
Transaction Subtype should identify this external message to the Oracle
E–Business Suite.

External Transaction Subtype

The External Transaction Subtype associated with the Transaction Type
selected above is displayed.
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The External Transaction Subtype is the secondary identifier for the
XML message.  These values are defined in the Define Transactions
form: page 3 – 13 and they are found in the XML Gateway envelope:
page 4 – 7.

The combination of the External Transaction Type and the External
Transaction Subtype should identify this external message to the Oracle
E–Business Suite.

Direction

The Direction associated with the Transaction Type selected above is
displayed.

This code identifies the direction of the transaction.  The value IN
identifies an inbound message, and the value OUT identifies an
outbound message.

Map (Required)

(Message) Map is the name of the map created using Message
Designer.

Select the appropriate map from the list of values.

The naming convention for message maps consists of the four
components: Transaction Type, Transaction Subtype, Standard and
Release, and Direction.  For example: ”PO_POO_OAG70_OUT” is the
outbound Oracle Purchasing Purchase Order in the OAG standard,
release 7.0.  The direction code OUT makes the message direction more
apparent in any list.

Refer to Message Designer: page 2 – 25 for more details on the naming
convention.

If the desired map does not appear in the list of values, then the map
has not been loaded into the XML Gateway database.  Refer to the How
to Load Message Maps and DTDs: page 2 – 121.
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Connection/Hub (Required for outbound messages only)

A DIRECT connect and a hub are the methods by which the message
can be communicated.  The XML message can be sent directly to a
trading partner, or sent to a trading partner via a hub.  The hub will
then communicate the message to the trading partner.

Select DIRECT to conduct business directly with a trading partner, or
select a hub from the list of values.  If a hub is selected, then select a
trading partner from that hub.

See the Hub Definition form: page 3 – 8 to define hubs.

Requirements for the entries for Protocol Type, Username, Password,
and Protocol Address depend on whether you select DIRECT or a hub.

If you select DIRECT, complete these fields as follows:



3 – 31XML Gateway Setup

• Protocol Type (Required)

Each message enabled for a Trading Partner includes a protocol
type (also known as communication method).  The associated
correlation ID is determined internally and is associated with the
message enqueued onto the agent (queue).  Listeners defined for
the agent will dequeue messages based on the correlation ID
defined for it.  For example, Oracle Transport Agent will only
dequeue messages with a correlation ID of OXTA.

The following table shows the Protocol Type, Correlation ID, and
Message System.

Protocol Type Correlation ID Message System

NONE N/A Message disabled

HTTP–WM, HTTPS–WM WebMethods Third party system

HTTP, HTTP–OXTA, HTTPS,
HTTPS–OXTA, SMTP

OXTA Oracle Transport Agent without
attachments

OTAH–ATCH, OTAHS–ATCH OXTA Oracle Transport Agent with at-
tachment using standard OTA en-
velope

HTTP–ATCH, HTTPS–ATCH OXTA Oracle Transport Agent with at-
tachment and no OTA envelope

ITG03 ITG03 Oracle iProcurement Connector

IAS IAS Oracle Integration Server

SOAP N/A Web Service Agent

Select the protocol type from the list of values.  This data is
seeded by the XML Gateway.

Protocol type NONE will disable the outbound message for this
trading partner.

• Username

Enter the destination Username used to log in to the receiving
server for the server that is identified in the server address.

For protocol types HTTP and HTTPS, Username and Password
are required fields.

• Password



3 – 32 Oracle XML Gateway User’s Guide

Enter the Password for the destination Username.  The password
is not echoed when it is entered.  You will be prompted on the
same field to confirm the password.

For protocol types HTTP and HTTPS, Username and Password
are required fields.

• Protocol Address

Protocol Address is the complete URL (including
service/servlet) where the Transport Agent will attempt to post
the XML Document.

For protocol type SMTP, the Protocol Address is an e–mail
address, and is required.

If you select a Hub, complete these fields as follows:

• Protocol Type

Protocol Type defaults from the Hub definition.

• Username

Select the Username from the list of values supplied by the Hub
definition.  If the Protocol Type is SMTP, the Username is not
required.  For all other Protocol Types, this field is required.

• Password

This field defaults to the password that is associated with the
Username selected.  The username and password combination is
supplied from the Hub definition.  If the Protocol Type is SMTP,
this field is not required.

• Protocol Address

Protocol Address defaults from the Hub definition.

Source Trading Partner Location Code (Required)

Source Trading Partner Location Code is the code found in the XML
Gateway Envelope  to identify the source of the message.  This is the
code for the source trading partner of the message.

If you are sending and receiving messages from a trading partner, you
will have a mixture of your location codes and your trading partner’s
location codes depending on the direction of the message.  For
example, if you are sending messages out, the Source Trading Partner
Location Code is your location code because you are the source of the
XML message.  If you are receiving messages, the Source Trading
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Partner Location Code is your trading partner’s location code because
they are the source of the XML message.

This code is examined for inbound messages for Trading Partner
validation.  When placed on an outbound message, the recipient will
validate it as a valid source or sending location.

This field is placed in the PARTY SITE ID in the XML Gateway
Envelope.

See: XML Gateway Envelope: page 4 – 7.

Destination Trading Partner Location Code

There are two types of routing in the XML Gateway: Static Routing and
Dynamic Routing.  Dynamic Routing allows the message to be rerouted
by the first recipient of the message to the final destination recipient.
Refer to the Routing field below for Static Routing.

Destination Trading Partner Location Code is the code for the final
recipient of the XML message.  This code is not needed by the XML
Gateway creating this message, but needed by the hub or the first
trading partner receiving the message to identify their final trading
partner to receive the message.  It is the hub’s or the first trading
partner’s code for that final destination trading partner.

For outbound messages, the final intended recipient location code
identified by the Destination Trading Partner Location Code will be
placed in ATTRIBUTE3 in the XML Gateway Envelope.

For inbound messages, this code is found in ATTRIBUTE3 in the XML
Gateway envelope.  Refer to Static and Dynamic Routing: page 3 – 35
for an illustration that explains how ATTRIBUTE3 is populated.

Document Confirmation

Document Confirmation is the indicator for the confirmation level that
this Trading Partner would like to send or receive a confirmation.

0   (Default value) means Never send a confirmation

1   means Send a confirmation only if there are errors

2   means Always send a confirmation

It defines the condition under which a confirmation XML message is
generated or received.  Outbound messages receive inbound
confirmations.  Inbound messages generate outbound confirmations.
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Routing

Use the Routing field to identify another trading partner to whom
messages will be routed.  You select a trading partner for outbound
transactions from the list of values.  The inbound message is forwarded
as an outbound message to the trading partner identified in the
Routing field.

The XML Gateway provides both Static Routing and Dynamic Routing.
Routing is the address to route the outbound message to when using
the Static Routing method.  Refer to the Destination Trading Partner
Location Code: page 3 – 33 field above for Dynamic Routing.

See: Static and Dynamic Routing: page 3 – 35 for more information.

Required Communications Data

Required Communications for Outbound Messages

Different data is required depending on whether DIRECT or a trading
partner is selected from a hub.

If DIRECT is selected, the following data fields are entered by the user
depending on the protocol type for outbound messages:

• Protocol Type (required)

• Protocol Address (required)

• User Name (depends on Protocol Type)

• Password (depends on Protocol Type)

• Source Trading Partner Location Code to identify the recipient of
the message (required)

If the message is sent via a hub, select the hub, then select a Username
from the presented list.  The following data fields are retrieved for
outbound messages:

• The following data fields are copied from the Username in the
hub definition:

– Protocol Type

– Protocol Address

– Hub Entity Code (acts like the Source Trading Partner
Location Code for DIRECT communication)
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– Password (optional and depends on Protocol Type)

If the message will be rerouted to another trading partner by the hub
using Dynamic routing, then the following data is needed.  It will be
placed in ATTRIBUTE3 in the XML Gateway Envelope:

• Destination Trading Partner Location Code

See: XML Gateway Envelope: page 4 – 7.

Required Communications Data for Inbound Messages

Inbound messages require the following:

• Source Trading Partner Location Code to identify the sender of
the message

Static and Dynamic Routing

Messages can be passed through a middle trading party by using the
static routing or dynamic routing feature.  This method is also called a
pass–through.

The following figure shows the routing flow of messages using the
dynamic or static routing feature.  The process starts with the review of
the Trading Partner detail associated with the inbound message.

If data is found in the ATTRIBUTE3 field of the XML Gateway
envelope, then the transaction is processed under the rules of Dynamic
Routing.  First the message is processed according to the inbound
message map for the trading partner, then the message is rerouted to
another trading partner who is the final recipient of the message.  The
trading partner detail for the final recipient is found in the Trading
Partner Detail as an outbound message for the trading partner
identified in the ATTRIBUTE3 field.

If there is no data in the ATTRIBUTE3 field of the XML Gateway
envelope and there is data in the Routing field in the Trading Partner
Detail for the inbound message, then the transaction is processed under
the rules of Static Routing.

In Static Routing the message is processed according to the inbound
message map for the trading partner, then the message is rerouted to
another trading partner who is the final recipient of the message.  The
trading partner detail for the final recipient is found in the Trading
Partner Detail as the trading partner identified in the Routing field for
that inbound message.
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If there is data in the ATTRIBUTE3 field of the XML Gateway envelope
and there is data in the Routing field in the Trading Partner Detail for
the inbound message, ATTRIBUTE3 will be used for the routing data.

If there is no data in the ATTRIBUTE3 field of the XML Gateway
envelope and there is no data in the Routing field in the Trading
Partner Detail for the inbound message, the message is not rerouted to
another trading partner.

In both dynamic and static routing, data in the message may have code
conversion applied at the trading partner level before constructing the
outbound message for the final recipient.  The retrieved code
conversion values will be substituted into the XML message so the final
trading partner receives the values that apply to them.
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To explain Static and Dynamic routing for pass through messages, the
following three trading partners are defined:

• Party 1:  Initiator of the Message

• Party 2:  First Recipient of the Message (This may be a hub)

• Party 3:  Final Destination of the Message

Party 1 will send the message to Party 2.  Then Party 2 will reroute it to
Party 3.
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Static Routing

Static routing allows you to select another XML Gateway Trading
Partner detail record from all your entries in the Trading Partner Setup
form.  You can select a trading partner within the same trading partner
or from any other displayed trading partner.  Every time a message is
received for that trading partner and that transaction, it will
automatically be routed to the trading partner defined in the ”Routing”
column.

Static Routing occurs under the following conditions:

• The originator of the message (Party 1) does not include the final
Destination Trading Partner Location Code in the message.

• For the given transaction and trading partner, the first recipient
of the message (Party 2) has selected a trading partner in the
Routing field to automatically forward that message to.

In order for this to happen, the following is necessary:

• Proper trading partner setup for the final recipient must be
entered in the Trading Partner Setup in Party 2’s environment.

Static Routing Illustration

The following illustration reviews the required trading partner setup
for each party in the example.

Party 1:  Initiator of the Message:

1. In Static Routing, the first initiator of the message does not indicate
the final Destination Trading Partner Location Code in their setup.
No data should appear in ATTRIBUTE3 of the XML Gateway
envelope.  This is illustrated in the following table:

Entry Trading
Partner

Direction External
Transaction
Type

External
Transaction
Subtype

Protocol Source TP
Location
Code

Routing Destination TP
Location Code (in
ATTRIBUTE3)

(1) Party 2 OUT INVOICE ADD HTTP Party 1 N/A N/A

Party 2:  First Recipient of the Message:

PARTY 2 must define the message for both the inbound trading partner
and the outbound trading partner to whom the message will be
rerouted.

2. Party 2 received the message from Party 1.  The message was an
inbound invoice to Party 2.  See entry (2) of the table below.
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3. Party 2 will reroute the message to Party 3, because the trading
partner setup for Party 3 was stored under the Routing field for
Party 2’s trading partner setup for Party 1.  The trading partner
setup data for the trading partner in the Routing field is used to
create the new message and the XML Gateway envelope. See entry
(3) of the table below.

Entry Trading
Partner

Direction External
Transaction
Type

External
Transaction
Subtype

Protocol Source TP
Location
Code

Routing Destination
TP Location
Code

(2) Party 1 IN INVOICE ADD N/A Party 1 (points to
Party 3 for
the out-
bound
message)

N/A

(3) Party 3 OUT
(will be set
to out)

INVOICE
(use the
same Ex-
ternal
Transaction
Type)

ADD 
(use the
same Ex-
ternal
Transaction
Subtype)

HTTP Party 2 N/A N/A

Dynamic Routing

The following method is dynamic because the first party originating
the message indicates the Destination Trading Partner Location Code
for the final destination trading partner to receive the message.

Dynamic Routing occurs under the following conditions:

• The originator of the message (Party 1) includes the final
Destination Trading Partner Location Code in ATTRIBUTE3 in
the XML Gateway envelope.

• The first recipient of the message (Party 2) can identify the
trading partner code in ATTRIBUTE3 in their own Trading
Partner setup.

In order for this to happen the following is necessary:

• Party 1’s XML process must be set up to write the final trading
partner to ATTRIBUTE3 of the XML Gateway envelope.  The
XML Gateway uses the Destination Trading Partner Location
Code field in the Trading Partner Setup form.

• The proper trading partner setup must be entered in Party 2’s
process to act on ATTRIBUTE3.  For the XML Gateway, this is in
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the Source Trading Partner Location Code field in the Trading
Partner Setup form.

Dynamic Routing Illustration

The following illustration reviews the required trading partner setup
for each party in the example.

Party 1:  Initiator of the Message:

1. In Dynamic Routing, the first initiator of the message (Party 1)
passes a Destination Trading Partner Code in ATTRIBUTE 3 to the
first message recipient (Party 2).

This code is defined by the first recipient of the message, so they
can identify the trading partner to whom the message will be
forwarded.  The Destination Trading Partner Code will be copied
to ATTRIBUTE3 in the XML Gateway envelope.  See the table
below:

Entry Trading
Partner

Direction External
Transaction
Type

External
Transaction
Subtype

Protocol Source TP
Location
Code

Routing Destination TP
Location Code (in
ATTRIBUTE3)

(1) Party 2 OUT INVOICE ADD HTTP Party 1 N/A Party 3

Party 2:  First Recipient of the Message:

This second party must define the message for both the inbound
trading partner and the outbound trading partner.

2. Party 2  received the message from Party 1.  The message was an
inbound invoice to Party 2.  See entry (2) in the Trading Partner
Setup for Party 2 table.

Party 2 will validate Party 1 as a trading partner for that inbound
message.  The data is shown in the following table:

Direction External
Transaction Type

External Transaction Subtype

IN INVOICE ADD

3. Party 2 will reroute the message to Party 3.  The message becomes
an outbound invoice from Party 2. See entry (3) below.
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Party 2 will also perform a trading partner lookup for  the trading
partner to whom the message is to be forwarded.  The direction is
changed to OUT.  External Transaction Type and External
Transaction subtype are copied from the inbound message.  The
lookup involves the data shown in the following table:

Direction External
Transaction Type

External Transaction Subtype

OUT INVOICE ADD

The Trading Partner Setup for Party 2, is shown in the following table:

Entry Trading
Partner

Direction External
Transaction
Type

External
Transaction
Subtype

Protocol Source TP
Location
Code

Routing Destination TP
Location Code (in
ATTRIBUTE3)

(2) Party 1 IN INVOICE ADD N/A Party 1 N/A N/A

(3) Party 3 OUT 
(set to
OUT)

INVOICE
(use the
same Ex-
ternal
Transaction
Type)

ADD
(Use the
same Ex-
ternal
Transaction
Subtype)

HTTP Party 2 N/A N/A

Party 3: Final Recipient of the Message:

4. Party 3 received the message from Party 2.  The message was an
inbound invoice.  The data is shown in the following table:

Entry Trading
Partner

Direction External
Transaction
Type

External
Transaction
Subtype

Protocol Source TP
Location
Code

Routing Destination TP
Location Code (in
ATTRIBUTE3)

(4) Party 3 IN INVOICE ADD N/A Party 2 N/A N/A
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Code Conversion

The Oracle XML Gateway code conversion function provides a method
to cross–reference the codes defined in Oracle E–Business Suite to
codes used by trading partners, the XML standard, or other standard
codes in the transactions.

For example, assume that the ABC Corporation transmits a purchase
order to the XYZ Corporation.  The XYZ Corporation processes the
incoming data using its own Oracle values (for example, unit of
measure, currency, or freight carriers), but XYZ is required to return
ABC’s codes.  In this way, the trading partner that created the original
transaction receives response transactions that use their own values.

The Code Conversion features include the following:

1. Define XML standard code conversion values defined by the XML
standard.  These codes are used by all trading partners.

2. Define universally used code conversion values that are defined by
other standard organizations such as ISO, X12, and EDIFACT.
These codes are used by all trading partners.

3. Define trading partner–specific code conversion values.  The
trading partner–specific code may override an XML standard or
the other universally used code conversion values.

Code Conversion Setup Across XML Gateway Forms

In the Define XML Standards form, Standard Codes such as OAG are
entered to represent a message standard. There is a special purpose
Standard Code called ”UNIVERSAL” that is described below.  See:
Define XML Standards Form: page 3 – 11.

Entries from the Define XML Standards form appear in a list of values
in the Define Transactions form that defines transactions to the XML
Gateway.  In this form, one Standard Code is associated with each
transaction listed under External Processes.  See: Define Transactions
Form: page 3 – 13.

The actual code conversion values are entered in the Standard Code
Conversion form and the Trading Partner Code Conversion form.  The
code conversion form provides a one–to–one code conversion from the
Oracle values to an external value. The external code may be the XML
standard codes such as OAG’s code, the universal code such as ISO
codes, or trading partner–specific codes.  These are discussed below.
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Code Conversion Values Marked for the Trading Partner

The trading partner code conversion values are accessed through the
Trading Partner Setup form.  Refer to Trading Partner Setup: page
3 – 25 for details.  Press the Code Conversion button to access the
Trading Partner Code Conversion form from the Trading Partner Setup
form.

The values associated with the trading partner’s code values are the
first set of codes to be examined during code conversion.

Before making entries in the trading partner specific table, first update
the Standard Code Conversion values if necessary.  This is important
because the entries in the Standard Code Conversion tables are
displayed and potentially overridden in the Trading Partner Code
Conversion form.

The following table illustrates the linking of a Trading Partner’s
message maps to Code Conversion:

Trading
Partner

Message Map Code Conversion
Values are created for
the Trading Partner?

The Message Map has a
Unit of Measurement
(UOM) field?

Accessed Trading Partner
Code Conversion Values
when the Message is
Processed

Acme Corp,
Atlanta

PROCESS_PO Yes, for Acme, Atlanta Yes, So Category UOM is
entered for Code Conver-
sion on the field

For UOM Category Code,
the Acme, Atlanta code con-
version values are accessed
for the message map PRO-
CESS_PO

Acme Corp,
Chicago

PROCESS_PO Yes, for Acme, Chicago Yes, So Category UOM is
entered for Code Conver-
sion on the field

For UOM Category Code,
the Acme, Chicago code
conversion values are ac-
cessed for the message map
PROCESS_PO

Acme Corp,
Atlanta

ADD_INVOICE Yes, for Acme, Atlanta Yes, So Category UOM is
entered for Code Conver-
sion on the field

For UOM Category Code,
the Acme, Atlanta code con-
version values are accessed
for the message map
ADD_INVOICE

Acme Corp,
Chicago

ADD_INVOICE Yes, for Acme, Chicago Yes, So Category UOM is
entered for Code Conver-
sion on the field

For UOM Category Code,
the Acme, Chicago code
conversion values are ac-
cessed for the message map
ADD_INVOICE
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• Message Map is assigned to this trading partner site in the
Trading Partner Setup form (under Trading Partner Details)

• Access Code Conversion through the Trading Partner Setup
form

• Data field is assigned the Category Code when the message map
is created in the Message Designer

Duplicate Entries Not Found

Since duplicate Oracle Values cannot be entered into the code
conversion tables, the trading partner must always use the same ”To
Trading Partner Value” for all the transactions that it has enabled.  The
following table illustrates this rule:

Oracle
Value

Description From Trading Partner
Value

To Trading Partner Value

Each Each EA EA

Piece Piece PC PC

Each Each PC PC

• Oracle Value – Cannot key on multiple occurrences of the value
”EACH”

• From Trading Partner Value – Cannot key on multiple
occurrences of the value ”PC”

• To Trading Partner Value – Cannot key on multiple occurrences
of the value ”PC”

Code Conversion Values Marked as a Standard Code

Given the Code Conversion setup discussed above, there is a standard
code associated with each message.  The standard code is the source
organization for the code value, such as OAG for the given XML
message to be processed.

The values associated with that standard organization’s code values are
the second set of codes to be examined during code conversion.

Code Conversion Values Marked UNIVERSAL

All other standards except the one that defined the XML message are
marked collectively as UNIVERSAL.  The XML Gateway does not store
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the other code conversion values under each standard such as the ISO
codes or the X12 codes.  It does not know which order the user wishes
to access those code sets.  For example, should the ISO codes be
accessed before the X12 Codes, or the reverse?  Hence, they are stored
under a generic name.

The values associated with the UNIVERSAL code values are the third
set of codes to be examined during code conversion.

The table below displays samples of ISO Country Codes that can be
used across all trading partners and entered only once in the Standard
Code Conversion forms.

Standard
Code

Oracle Value Description From
Trading
Partner
Value

To Trading
Partner
Value

UNIVERSAL United States United States US US

UNIVERSAL United King-
dom

United King-
dom

UK UK

If there is a conflict between two codes that must be entered as
UNIVERSAL, it may be resolved by entering the conflicting codes
under the Trading Partner code conversion for each trading partner
needing that code.

Only the conflicting or duplicate code values need to be entered under
each trading partner.  The entries that do not cause conflicts can be
entered under UNIVERSAL at the same time.

Code Categories

A Category Code is a label for a set of entries in the code conversion
table.  For example, CARRIER is the category code for code conversion
values associated with the carrier.

During transaction processing, only the code conversion table entries
with an assigned category code are accessed for the given data element.

See Appendix B for the seeded list.
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Accessing the Code Conversion Values

Key Access

Outbound and inbound transactions use different keys in the code
conversion tables to access the codes.

• For outbound transactions, ”Oracle Value” and the Standard
Code are keys to access this table to determine the ”To Trading
Partner Value” to write in the transaction.

• For inbound transactions, ”From Trading Partner Value” and the
Standard Code are keys  to access the table to determine the
”Oracle Value” to pass to Oracle Application tables.

Order of Table Search

The following table search order is performed for all transactions until
a code conversion value table entry is found:

1. Access the Trading Partner code conversion table.

If the code is not found in this table, perform a second search.

2. Access the Standard code conversion table using the XML
message’s Standard Code, such as OAG.  This Standard Code is
associated with the transaction in the transaction table as defined
via the Define Transactions form.

If the code is not found in this table, perform a third search.

3. Access the Standard code conversion table using the Standard
Code UNIVERSAL.  The universal entries may represent ISO codes
or other standards.

For inbound transactions:  If the code is not found in the tables
after the three searches described above, then the ”From Trading
Partner Value” is copied to the target field in the message map.

For outbound transactions: If the code is not found in the tables
after the three searches described above, then the ”Oracle Value” is
copied to the target field in the message map.

Attention:  If a code conversion value is not found in the table,
it is not an error.  There may be cases where only select values
for a data element need code conversion.  To require all values
to have a code conversion table entry may cause you to do an
excessive number of code conversion entries that are not
necessary.
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The following table illustrates the order that the tables and Standard
Code Values are searched:

Search
Order

Code Conversion Form STANDARD CODE Purpose

1 Trading Partner Code
Conversion

CUSTOM Define the trading partner–specific code conversion
values.
This includes any overrides to any standard’s or uni-
versal code conversion values that are displayed from
the Standard Code Conversion form.
The trading partner code conversion values are used
by all transactions for that trading partner.

2 Standard Code Conver-
sion

For example:
OAG
ROSETTANET
(ROS)

Define standard code conversion values for a given
XML standard that are used across all trading partners.
These values can be overridden for a specific trading
partner in the Trading Partner Code Conversion form.
The Standard Code field is the default XML standard
associated with the XML message.

3 Standard Code Conver-
sion

UNIVERSAL Define standard code conversion values that are used
across all trading partners and not associated with an
XML Standard.
These values can be overridden for a specific trading
partner in the Trading Partner Code Conversion form.
Those entries accommodate universally used code lists
such as ISO, X12, EDIFACT, that can be used by all
XML Messages.

Outbound Transaction Code Conversion Table Access

For outbound transactions, the ”Oracle Value” and the Standard Code
in the code conversion tables are keys to retrieve the ”To Trading
Partner Value” to place it in the transaction.  First the trading partner
codes are searched.  If an entry is not found, then the Standard code
conversion table is searched for the standard codes and the universal
codes.

If the code is not found in the tables after the three searches described
above, then the Oracle Value is copied to the target field in the message
map.  Otherwise, the ”To Trading Partner Value” will be copied to the
target field in the message map.

The following table illustrates the code conversion concepts for
outbound transactions using the category code UOM.  The Outbound
Search Key is comprised of the values for Conversion Table, Standard
Code, and Oracle Value.  The To Trading Partner Value is the data
retrieved.
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Conversion
Table

Standard Code Oracle
Value

Description From Trading
Partner Value

To Trading
Partner Value

Trading
Partner or
Standard

Appropriate Code
for the first, se-
cond, third search

Each Each (ignore the value
here – not rele-
vant for Out-
bound Transac-
tions)

EA 
(derive this code
to place in the
transaction)

The following table illustrates a sample outbound transaction code
conversion for the category code UOM.  The Outbound Search Key is
comprised of the values for Conversion Table, Standard Code, and
Oracle Value.  The To Trading Partner Value is the data retrieved.

Conversion
Table

Standard
Code

Oracle
Value

Description From Trading Partner
Value

To Trading
Partner
Value

Trading
Partner

Box Box (ignore the value here) BX

Trading
Partner

CUSTOM Each Each (ignore the value here) EA

Standard OAG Box Box (ignore the value here) BX

Standard OAG Each Each (ignore the value here) EA

Standard UNIVERSAL Box Box (ignore the value here) BX

Inbound Transaction Code Conversion Table Access

For inbound transactions, the ”From Trading Partner Value” and the
Standard Code in the code conversion tables are keys to retrieve the
”Oracle Value.”  First the trading partner codes are searched.  If an
entry is not found, the Standard code conversion table is searched for
the standard codes and then the universal codes.

If the code is not found in the tables after the three searches described
above, then the ”From Trading Partner Value” is copied to the target
field in the message map.  Otherwise, the ”Oracle Value” will be copied
to the target field in the message map.

The following table illustrates the code conversion concepts for
inbound transactions using the category code UOM.  The Inbound
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Search Key–1 is comprised of the values for Conversion Table and
Standard Code.  The Oracle Value is the retrieved data.  The From
Trading Partner Value is the Inbound Search Key–2.

Conversion Table
(Inbound Search
Key–1)

Standard Code
(Inbound Search
Key–1)

Oracle Value
(Retrieve)

Description From Trading
Partner Value
(Inbound Search
Key–2)

To Trading
Partner Value

Trading Partner
or Standard

Appropriate Code
for the first, se-
cond, third search

Each
(Derive this code
to place in the
Oracle table)

Each EA (Ignore the
value here –
Not relevant
for Inbound
Transactions)

The following table illustrates a sample inbound transaction code
conversion for the category code UOM.  The Inbound Search Key–1 is
comprised of the values for Conversion Table and Standard Code.   The
Oracle Value is the data retrieved.  The From Trading Partner Value is
the Inbound Search Key–2.

Conversion Table
(Inbound Search
Key–1)

Standard Code
(Inbound Search
Key–1)

Oracle Value
(Retrieve)

Description From Trading
Partner Value
(Inbound
Search
Key–2)

To Trading
Partner Value

Trading Partner Box Box BX (Ignore the value
here)

Trading Partner CUSTOM Each Each EA (Ignore the value
here)

Standard OAG Box Box BX (Ignore the value
here)

Standard OAG Each Each EA (Ignore the value
here)

Standard UNIVERSAL Box Box BX (Ignore the value
here)

Standard UNIVERSAL Each Each EA (Ignore the value
here)
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One Internal Code to Multiple External Codes

You can use the Action Assign Variable Value in Message Designer to
assign multiple external codes given the single Oracle internal code by
using conditions on the internal code.  You must update the message
in Message Designer as new codes are needed.

For example, the single Oracle internal carrier code stored in the
SHIP_VIA column may need to cross–reference to two external codes:
the carrier and the transportation mode.  For example,

If SHIP_VIA  = ’TRUCK–LAND’

move ’TRUCK’ to the CARRIER.

If SHIP_VIA  = ’TRUCK–LAND’

move  ’L’ to the TRANSPORTATION_METHOD.

If SHIP_VIA  = ’TRUCK–AIR’,

move ’TRUCK’ to the CARRIER.

If SHIP_VIA  = ’TRUCK–AIR’

move ’A’ to the TRANSPORTATION_METHOD.

Note:  For Outbound Transactions:

If you have the SHIP_VIA source data written twice to the file,
then code conversion could be performed to convert the two
fields separately: Once to derive the carrier code and once to
derive the transportation method.

Standard Code Conversion Form  

Navigate to the Standard Code Conversion form from the XML
Gateway Responsibility by selecting Setup > Define Code Conversion.

The Standard Code Conversion form displays a list of code values that
are used by all trading partners unless the codes are overridden by
trading partner specific code values.  For a discussion of trading
partner specific codes see Trading Partner Code Conversion Form:
page 3 – 54.
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Category Code

Select a category code to view its list of values in the Category Values
portion of the form.  A category code cannot be added or deleted.

Description

Description of the category code.
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Category Values

Standard Code (Required)

A Standard Code identifies one of the following:

• The source organization for the code value, such as OAG, for the
given XML message to be processed.

• The word UNIVERSAL, the seeded code to identify any other
organizations such as ISO, X12, EDIFACT.

Note:  Only XML standards and the single non–XML standard
UNIVERSAL should be defined in the Define Transactions
form.  The process would not recognize standard codes such as
ISO or EDIFACT though they can be entered into this form.

Select a standard code from the list of values.

Use the Define XML Standards form: page 3 – 11 to add new standard
codes as needed.

Oracle Value (Required)

The Oracle Value is a code defined in the Oracle E–Business Suite,
regardless if it is an inbound or outbound transaction.  The Oracle
Value is case–sensitive.

Description

Description of the Oracle Value.

From Trading Partner Value (Used with Inbound Transactions)

The ”From Trading Partner Value” is a code in the message that
represents data from the trading partner’s perspective.  This code is
found in the inbound source transaction.

To Trading Partner Value (Used with Outbound Transactions)

The ”To Trading Partner Value” is a code to be written in the outbound
message.  It represents data that the trading partner is expecting to
receive.  You cannot enter data in this field.  This code value is always
equal to and copied from the ”From Trading Partner Value.”
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Standard Check Box

The Standard check box is enabled for all entries made in the Standard
Code Conversion form.

If a code conversion value table entry has the Standard check box
checked, and the code conversion value is later overridden in the
Trading Partner Code Conversion table, this check box is switched
”off” (made blank) in the Trading Partner Code Conversion form.

The system controls setting this check box off and on.

Data Seeded Check Box

Data can be seeded into the database by the XML Gateway.  Seeded
data is indicated by a check mark in this check box.  If data is marked
as seeded, it cannot be modified in the forms.

REVERT ALL Button

The Revert All Button is disabled in this form.  It is used in the Trading
Partner Code Conversion form to revert all codes back to the standard
code value found in the standard Code Conversion table up to the last
saving of the entries.

All fields except the Standard check box, Data Seeded check box, and
the To Trading Partner Value can be changed.

REVERT Button

The Revert Button is disabled in this form.  It is used in the Trading
Partner Code Conversion form to revert the codes back to the standard
code value found in the standard Code Conversion table up to the last
saving of the entries.



3 – 54 Oracle XML Gateway User’s Guide

Trading Partner Code Conversion Form

The Trading Partner Code Conversion form allows the entry and
display of code values for a specific trading partner.

Navigate to this form by clicking the Code Conversion button on the
Define Trading Partner Setup form (XML Gateway Responsibility >
Setup > Define Trading Partners).

The Trading Partner Code Conversion form contains data from the
following sources:

• All trading partner–specific code values entered in this form

• All codes entered in the Standard Code Conversion form.  The
Standard check box on the form indicates if the data was entered
in the Standard Code Conversion form.  The standard code
conversion values can be changed.
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Category Code

Select a category code to view its list of values in the Category Values
portion of the form.  A code category cannot be added or deleted.

Description

Description of the category code.

Category Values

Standard Code

When adding Trading Partner–specific code conversion values, this
field defaults to CUSTOM.

Oracle Value

The Oracle Value is a code defined in the Oracle E–Business Suite,
regardless if it is an inbound or outbound transaction.  The Oracle
Value is case–sensitive.

Description

Description of the Oracle Value.

From Trading Partner Value (Used with Inbound Transactions)

The ”From Trading Partner Value” is a code in the message that
represents data from the trading partner’s perspective.  This code is
found in the inbound source transaction.

To Trading Partner Value (Used with Outbound Transactions)

The ”To Trading Partner Value” is a code to be written in the outbound
message.  It represents data that the trading partner is expecting to
receive.  You cannot enter data in this field.  This code value is always
equal to and copied from the ”From Trading Partner Value.”

Standard Check Box

The Standard check box is enabled for all entries made in the Standard
Code Conversion form.
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If a code conversion value table entry has the Standard check box
checked, and the code conversion value is later overridden in the
Trading Partner Code Conversion table, this check box is switched
”off” (made blank) in the Trading Partner Code Conversion form.

The system controls setting this check box off and on.

Data Seeded Check Box

Data can be seeded into the database by the XML Gateway.  Seeded
data is indicated by a check mark in this check box.  If data is marked
as seeded, it cannot be modified in the forms.

REVERT ALL Button

The Revert All Button in the Trading Partner Code Conversion form
reverts all codes back to the standard code value found in the standard
Code Conversion table up to the last saving of the entries.

All fields except the Standard check box, the Data Seeded check box,
and the To Trading Partner Value can be changed.

REVERT Button

The Revert Button in the Trading Partner Code Conversion form
reverts the codes back to the standard code value found in the standard
Code Conversion table up to the last saving of the entries.

Note:  The Revert Button applies to only the selected entry for
this specific trading partner.

What Can Be Updated

If you are adding a Custom code, all fields except the Standard check
box, and Data Seeded check box can be changed.

If the Standard Code is not ”CUSTOM” then only the From Trading
Partner Value and the To Trading Partner Value can be changed.  The
Standard check box will be enabled.
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Execution Engine

he functions of the Execution Engine are discussed in this chapter.
Specifically, this chapter:

• Presents an overview of how the Execution Engine processes a
message

• Describes the XML Gateway Envelope – where the XML
message is placed or found

• Describes how the Trading Partner is validated for the message

• Describes how to implement the OAG Confirm Business Object
Document
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Execution Engine Overview

The XML Gateway consists of three components: the Message
Designer, Setup, and the Execution Engine.  It interfaces with the
following Oracle products:

• Oracle Transport Agent for message delivery

• Oracle Advanced Queuing for message propagation, and queue
management

• Oracle Workflow Business Event System to publish and
subscribe to business events.  Workflow also provides an active
e–mail notification to report errors detected by the XML
Gateway Execution Engine, Advanced Queuing (AQ), or the
transport agent

The following diagram illustrates the process flow of XML messages
through the XML Gateway Execution Engine using all the components
mentioned above.  Details of the XML Gateway Execution Engine are
summarized below.
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The XML Gateway Execution Engine can process messages properly
after the following:

• Message maps are created and loaded into the repository along
with their associated DTDs.

• Trading Partners are defined.

• Code Conversions are defined.

• Transactions are defined.

• Oracle Workflow Business Event System events are published by
the Oracle E–Business Suite and subscriptions to those events are
defined.

• Engine and listeners are started.

The XML Gateway listeners are actively polling for interested
events.  The Execution Engine will begin processing once Oracle
Workflow Business Event System detects an outbound
transaction to be processed, or that an inbound message has
arrived on the queue.

The XML Gateway Execution Engine does the following during
processing:

• (Inbound Messages) Dequeue Message from Inbound Queue

• Validate Message via XML Parser

(Inbound Message) Uses the XML Parser to validate the inbound
message to determine if it is well–formed and valid (based on a
DTD stored in the DTD directory) before proceeding further.

(Outbound Message) Uses the XML Parser to validate the newly
created message to ensure that it is well–formed and valid.  A
poorly formed or invalid message (based on a DTD stored in the
DTD directory) will not be enqueued onto the Outbound Queue.

• Validate Trading Partner or Hub

If the inbound message is both well–formed and valid, the
Execution Engine proceeds to validate that the Trading Partner
and document are defined.  If the Trading Partner is not defined
or the document is not defined for the Trading Partner, the XML
message will not be processed further.

• Get Message Map from Repository

If the message map associated with the Trading Partner is not
available in the XML Gateway repository, the XML message will
not be processed further.
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• Execute the Message Map

– (Outbound Messages) Gather Application Data

If the Trading Partner is valid and the message map exists in
the repository, the Execution Engine gathers the application
data from the Oracle e–Business Suite using the database
views and columns identified in the message map.

– (Inbound Messages) Maps Data

If the Trading Partner is valid and the message map exists in
the repository, the Execution Engine maps the data in the
XML message to its target data fields in Oracle e–Business
Suite tables and columns identified in the message map.
These are often the Application Open Interface tables.

– Apply Code Conversion

Apply code conversion for source columns enabled for code
conversion.

– Apply Actions

Apply actions where defined (may be document, element,
or root level).

(Inbound Message) Action codes include inserting data into
the Application Open Interface tables, then executing the
Application Open Interface API to populate the base
application tables.

– (Outbound Messages) Create XML Message

Create XML message using the message map and the
application data as described above.

• Detect and Report Processing Errors

Errors may be detected by the Oracle XML Gateway Execution
Engine, Oracle Advanced Queuing, Oracle Workflow, or Oracle
Transport Agent.  Information regarding the error is enqueued
onto the Error Queue.  An e–mail notification is sent via Oracle
Workflow to notify the trading partner regarding data errors, or
the XML Gateway system administrator regarding system or
process errors.

In addition, for system or process errors, a copy of the XML
message is placed in the XML message directory for use in
troubleshooting the reported error.  For trading partner–related
data errors, the trading partner can refer to the copy of the XML
message.
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• Copy XML Message

For system or process errors, a copy of the XML message is
placed in the XML message directory for use in troubleshooting
the reported error.  For trading partner–related data errors, the
trading partner can refer to their copy of the XML message.

• (Outbound Messages) Enqueue Message to Outbound Queue

Enqueue well–formed and valid message onto the Outbound
Queue.  Oracle Transport Agent will dequeue the message from
the Outbound Queue and deliver it to the trading partner.

• Create or Consume Confirmation Messages

(Inbound Message) Receive confirmation message, if it is enabled
for the Trading Partner and confirmation is requested on the
outbound message, or a default is set up for the trading partner.

(Outbound Message) Create a confirmation message, if it is
enabled for the Trading Partner and confirmation is requested on
the inbound message, or a default is set up for the trading
partner.
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Protocol Type and Correlation ID

Each message enabled for a Trading Partner includes a protocol type
(also known as communication method) that identifies the message
delivery method.  The associated correlation ID is determined
internally and is associated with the message enqueued onto the agent
(queue).  Listeners defined for the agent will dequeue messages based
on the correlation ID defined for it.  For example, Oracle Transport
Agent will only dequeue messages with a correlation ID of OXTA.

The following table shows the Protocol Type, Correlation ID, and
Message System.

Protocol Type Correlation ID Message System

NONE N/A Message disabled

HTTP–WM, HTTPS–WM WebMethods Third party system

HTTP, HTTP–OXTA, HTTPS,
HTTPS–OXTA, SMTP

OXTA Oracle Transport Agent without
attachments

OTAH–ATCH, OTAHS–ATCH OXTA Oracle Transport Agent with at-
tachment using standard OTA en-
velope

HTTP–ATCH, HTTPS–ATCH OXTA Oracle Transport Agent with at-
tachment and no OTA envelope

ITG03 ITG03 Oracle iProcurement Connector

IAS IAS Oracle Integration Server

SOAP N/A Web Service Agent
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XML Gateway Envelope

In addition to the business document such as a purchase order or
invoice in the XML Payload, a set of message attributes are transmitted.
Collectively, these attributes are called the XML Gateway envelope.

This section discusses the XML Gateway envelope and its data in the
validation process for inbound messages, or its source of data for its
creation for outbound messages.  Data entered into the Trading Partner
Setup form is referred to as data in the trading partner table.  Data
entered into the Define Transactions form is referred to as data in the
transaction table.

Most of the data elements are copied from the Trading Partner tables or
the Transaction tables to the XML Gateway envelope.

Transaction direction is determined by the XML Gateway.  The
direction values used by the XML Gateway are the following:

• IN for inbound messages

• OUT for outbound messages

The XML Gateway envelope consists of the data presented in the
following table:
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Attribute Contents Sample Values Data Source

MESSAGE_TYPE Payload message format XML Defaults to ”XML”

MESSAGE_STAN-
DARD

Message format standard OAG Transaction table

TRANSAC-
TION_TYPE

External Transaction Type
for that business document

INVOICE Trading Partner table

TRANSACTION_SUB-
TYPE

External Transaction Sub-
type for that business docu-
ment

PROCESS Trading Partner table

DOCUMENT_NUM-
BER

Business document number
such as invoice number

(Not Used) N/A

PARTYID (Not Used) Trading Partner table.  This
is not used by the XML
Gateway.

SOURCE_TP_LOCA-
TION_CODE

Source Trading Partner
Location Code

ACME_CHICAGO SOURCE TP LOCATION (if
not recreated) or TARGET
TP LOCATION CODE (if
recreated) from Trading
Partner table

PARTY_TYPE (Not Used) (Not Used)

PROTOCOL_TYPE Transmission Protocol SMTP, HTTP, HTTP–
WM

Trading Partner table

PROTOCOL_AD-
DRESS

Transmission Address me@co.com,
http://www.co.com:5
555

Trading Partner table

USERNAME User Name User1 Trading Partner table if
Connection is ”DIRECT”;
Hub Definition if ”HUB”

PASSWORD password ****** Trading Partner table if
Connection is ”DIRECT”;
Hub Definition if ”HUB”

ATTRIBUTE1 (determined by application) N/A (determined by application)

ATTRIBUTE2 (determined by application) N/A (determined by application)

ATTRIBUTE3 Rerouting Location (used
only if the message is re-
routed)

TARGET TP LOCATION
CODE from Trading Partner
table

ATTRIBUTE4 (determined by application) N/A (determined by application)

ATTRIBUTE5 (determined by application) N/A (determined by application)

PAYLOAD XML business document (XML Message)

MESSAGE_TYPE

Payload message format. This defaults to ”XML”.
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MESSAGE_STANDARD

(Defaults to OAG.) Message format standard as displayed in the Define
Transactions form and entered in the Define XML Standards form.

TRANSACTION_TYPE

External Transaction Type for the business document from the Trading
Partner table.

TRANSACTION_SUBTYPE

External Transaction Subtype for the business document from the
Trading Partner table.

DOCUMENT_NUMBER

The document identifier used to identify the transaction, such as a
purchase order or invoice number.  This field is not used by the XML
Gateway, but it may be passed on inbound messages.

SOURCE_TP_LOCATION_CODE

Source Trading Partner Location Code if no data is found in the
Destination Trading Partner Location Code in the Trading Partner
table.

PROTOCOL_TYPE

Transmission Protocol as defined in the Trading Partner table.

PROTOCOL_ADDRESS

Transmission address as defined in the Trading Partner table.

USERNAME

USERNAME  as defined in the Trading Partner table.

PASSWORD

The password associated with the USERNAME defined in the Trading
Partner table.
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ATTRIBUTE3

For outbound messages, this field has the value from the Destination
Trading Partner Location Code in the Trading Partner table.

For inbound messages, the presence of this value generates another
XML message that is sent to the trading partner identified in the
Destination Trading Partner Location Code in the Trading Partner
table.  This value must be recognized by the hub to forward the XML
message to the final recipient of the XML Message.  Refer to XML
Gateway Setup: page 3 – 2 for details.

PAYLOAD

The XML message.

Parameters defined by the Application

The following parameters may be defined by the base application:

• ATTRIBUTE1

• ATTRIBUTE2

• ATTRIBUTE4

• ATTRIBUTE5

Parameters Not Used

The following parameters are not used:

• PARTYID

• PARTYTYPE



4 – 11Execution Engine

Trading Partner Validation for Inbound Messages

Events Raised in Oracle Workflow Business Event System

Oracle Workflow Business Event System is a tool used to integrate with
the Oracle e–Business Suite for event–based XML message creation and
consumption.

Before XML Gateway processes the message:

Messages sent by the trading partner are staged onto a message
queue.  An Oracle Workflow listener dequeues the message from
the message queue and raises an event to the XML Gateway to
begin processing.

Refer to Message Queues: page 5 – 2 for details.

After XML Gateway processes the message:

When XML Gateway completes processing the data according to
the instructions in the message map associated with the trading
partner, an event is published by XML Gateway to inform the
Oracle e–Business Suite that it has successfully processed the
inbound message.  Any Oracle e–Business Suite module
interested in this event may register a subscription to continue
with the transaction.

XML Gateway Processing

Inbound messages can take two paths:

• Standard XML Messages

If ATTRIBUTE3 in the XML Gateway envelope is NULL, the
XML message is processed according to the message map.

• ”Pass–Through” Messages

If ATTRIBUTE3 in the XML Gateway envelope has data, the
inbound message will be recreated as an outbound message
according to a message map for the trading partner identified in
ATTRIBUTE3.  This transaction is referred to as a
”pass–through” message and defined as a message with
”Dynamic Routing.”  Refer to Static and Dynamic Routing: page
3 – 35 for details.
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Standard XML Messages

The following table summarizes the required data in the XML Gateway
envelope to identify standard XML messages.  How this data is
validated for an inbound message is described below.

Attribute Sample Values Used in Trading
Partner Lookup

1 MESSAGE_STANDARD OAG YES

2 TRANSACTION_TYPE INVOICE YES

3 TRANSACTION_SUBTYPE PROCESS YES

4 PARTY_SITE_ID ACME_CHICAGO YES

5 ATTRIBUTE3 NULL NO

6 PAYLOAD (XML MESSAGE) N/A

Note:  USERNAME and PASSWORD can be placed in the XML
Gateway envelope by the system that created the XML
message.  The transport agent uses the USERNAME and
PASSWORD for delivery purposes.  These fields are not passed
to the XML Gateway from the transport agent software.

”Pass–Through” XML Messages

XML Gateway can recreate, then route messages to another trading
partner without loading the transaction into a base Oracle Application.
This case is recognized by the presence of a trading partner code in
ATTRIBUTE3 in the XML Gateway envelope in the inbound message.

If a trading partner location code is identified in ATTRIBUTE3 for an
inbound message the following happens:

• A Trading Partner Setup table entry for an outbound message for
this same TRANSACTION_TYPE and
TRANSACTION_SUBTYPE is found for the Trading Partner
identified in ATTRIBUTE3.  The values in ATTRIBUTE3 must
match an entry in the Destination Trading Partner Location Code
defined in the Trading Partner Setup form.

• If the entity in ATTRIBUTE3 is found in the Trading Partner
Setup tables, then another XML Gateway message is created
according to the message map for that trading partner.  This new
XML message is then routed to the trading partner identified in
the original ATTRIBUTE3.
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The following table summarizes the required data in the XML Gateway
envelope to identify these messages, and key data for the pass through
XML message.

Attribute
(Original XML Message)

Sample Inbound
Message Values

Pass–Through Message Created (Find its
corresponding Trading Partner Setup for an
OUTBOUND message where the Trading
Partner is identified in ATTRIBUTE3 of
the original message)

1 MESSAGE_STANDARD OAG OAG

2 TRANSACTION_TYPE INVOICE INVOICE

3 TRANSACTION_SUBTYPE PROCESS PROCESS

4 PARTY_SITE_ID ACME_CHICAGO BETA–LONDON (from original AT-
TRIBUTE3)

5 ATTRIBUTE3
(the DESTINATION TRAD-
ING PARTNER LOCATION
CODE in the Trading Part-
ner Setup table.  This be-
comes the PARTY_SITE_ID
for the outbound message.)

BETA–LONDON

6 PAYLOAD (XML Message) (XML Message)

Validation Against Data in the Trading Partner Setup Form

Inbound messages validate data only against data that was entered in
the Trading Partner Setup form.

Source Trading Partner Location Code

Source Trading Partner Location Code is the code found in the XML
envelope in PARTY_SITE_ID to identify the source of the message.
This field must contain a value stored in Source Trading Partner
Location Code in the Trading Partner setup table.

When a trading partner is entered into the Trading Partner Setup form,
the Trading Partner Name and Trading Partner Site are selected from a
list of values obtained from Oracle Receivables, Oracle Payables, or
Oracle HR Locations.  Associated with each Trading Partner site is a
table ID in the base Oracle Application.   See Derive Address ID from
Location Code action: page 2 – 87 and Get Predefined Variable Value
action: page 2 – 105 if you wish to use this table ID in a message map.
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The parameters listed in the table below compose a search key against
the Trading Partner table.  This key is used to determine if the Trading
Partner is enabled for that transaction, then to retrieve the message
map name to process the transaction.

Search Parameters Description Sample

1 PARTY_SITE_ID Source Trading Partner
Location Code

ACME_CHICAGO

2 TRANSACTION_TYPE External Transaction Type
for that business document

INVOICE

3 TRANSACTION_SUBTYPE External Transaction Sub-
type for that business docu-
ment

PROCESS

4 DIRECTION Determined by the XML
Gateway

IN

The following table shows data that is returned from a search against
data that was entered in the Trading Partner Setup form:

Returned Data Description Sample

1 Trading Partner Site en-
abled for the message

This data is stored in the
table given the trading
partner that was selected.
This data is not displayed.

12345 (a table ID)

2 Message Map to use for this
inbound transaction for the
given trading partner

OAG_IN_INVOICE

Note that transaction direction is determined by the XML Gateway.
The direction values used by the XML Gateway are the following:

• IN for inbound messages

• OUT for outbound messages
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Trading Partner Validation for Outbound Messages

Event Raised in Oracle Workflow Business Event System

Application business events for outbound messages are raised by the
Oracle e–Business Suite module responsible for the transaction.  The
raise occurs at an application point of interest, such as when a purchase
order is approved or an invoice is confirmed.

Event Subscription Defined in Oracle Workflow Business Event
System

A corresponding event subscription is defined to consume the event.
The event subscription may be based on the XML Gateway Rule
Function or the Workflow Default Rule Function.  Embedded in the
XML Gateway Rule Function is a check to determine if the Trading
Partner is defined and the message is enabled.

With the Workflow Default Rule Function, the Transaction Delivery
Required function activity is used to make the same evaluation.  The
outbound document is generated and sent only if the Trading Partner is
defined and the transaction is enabled.  Which approach is used
depends on what is known about the Trading Partner before the
subscription is executed.

See Integrating Oracle XML Gateway with Oracle Workflow Business
Event System: page 6 – 2.
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How to Implement the OAG Confirmation Business Object
Document

Purpose of the Confirmation Message

The purpose of the confirmation message is to communicate the status
of a business document.  In addition to providing general document
status information, details regarding any errors detected may be
included in the confirmation message.

The confirmation message is a general–purpose document that may be
used to acknowledge any business document.  It may be used in
addition to but not as a substitute for specific purpose
acknowledgements such as Purchase Order Acknowledgment or
Purchase Order Change Acknowledgment documents.

Refer to www.openapplications.org for details regarding the
Confirm Business Object Document (BoD) DTD.

Structure of the Confirmation Message

The confirmation message contains the following two parts:

• CONFIRM_BOD/CONFIRM

The CONFIRM data type is used to describe the business
document it is acknowledging.  Included are the document
status, description of the document, and an identifier for the
original business document.

• CONFIRM_BOD/CONFIRMMSG

The CONFIRMMSG data type is used to provide a detailed
description of the document status.  Included are the description
and any reason codes.  Each CONFIRM data type may have
many CONFIRMMSG data types associated with it.

XML Gateway Seeded Confirmation Message Maps

Oracle XML Gateway provides seeded maps for both the inbound and
outbound Confirm BoD message.  The names of the seeded message
maps are as follows:
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• ECX_CBODI_OAG72_IN_CONFIRM

• ECX_CBODO_OAG72_OUT_CONFIRM

The XML Gateway seeded maps are incorporated into the Oracle
E–Business Suite application business process where necessary.

E–Business Suite Seeded Events and Event Subscriptions

Usage of the Confirm BoD varies between application modules of the
Oracle E–Business Suite.  For application modules that have
incorporated the Confirm BoD into their business processes, the
process is modeled as follows:

Outbound Confirmation

Oracle XML Gateway sends an outbound confirmation message in
response to an inbound business document.

The inbound business document initiates the process (Step 1).  As with
all inbound messages, XML Gateway notifies the Oracle E–Business
Suite application that it has processed an inbound business document.

The application event subscription defined for the inbound document
is executed (Step 2) and is followed by a raise event (Step 3) to notify
XML Gateway to create and send the outbound confirmation (Step 4).

Steps 2 and 3 are defined separately to allow for application business
processes between the consumption of the inbound business document
and the creation and delivery of the outbound confirmation message.
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Inbound Confirmation

Oracle XML Gateway will process an inbound confirmation message
received from a the Trading Partner in response to an outbound
business document.  It will notify the Oracle E–Business Suite that it
has processed an inbound confirmation message.

The application event subscription defined for the inbound
confirmation message is executed.  The behavior of the event
subscription will vary by application module and is dependent on
whether the application module is interested in negative, positive, or
both types of confirmations.

How to Implement or Disable a Seeded Confirmation Message

The application event subscriptions to create and send an outbound
message or to consume an inbound message are delivered by the
Oracle E–Business Suite application modules.

The seeded event name for the inbound or outbound Confirm BoD
message is as follows:

ORACLE.APPS.<COMPONENT>.<TASK>.CONFIRM

COMPONENT is the internal transaction type entered on the Define
Transactions form.  It represents the product short name.

TASK is the internal transaction subtype entered on the Define
Transactions form.  It represents a description of the object.

An example of an event name for a confirmation event associated with
an outbound purchase order is: ORACLE.APPS.PO.POO.CONFIRM.

The corresponding seeded event subscription is defined as enabled.
Use the Oracle Workflow Administrator: Add Events/Event Group
window to view or disable the seeded events and event subscriptions if
you do not wish to implement the Confirm BoD message.   See
Configure or Delete Seeded Event Subscriptions: page 6 – 65 for more
details.
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To implement the seeded event subscriptions, define the Trading
Partner and enable the confirmation message as follows:

� Define the Trading Partner using the XML Gateway Define Trading
Partners window.

� Enable the business document and set the Document Confirmation
flag to one of the following:

1 = Send confirmation only if there are errors

2 = Always send confirmation

Attention:  Ensure that for an outbound business document
you enable an inbound confirmation document (Transaction
Subtype CBODI); and for an inbound business document you
enable an outbound confirmation document (Transaction
Subtype CBODO).
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Trading Partner Setup window, left side of scrolling region.

Trading Partner Setup window, right side of scrolling region.

Note:  Make sure that the value for Source Trading Partner
Location Code is the same for the original business document
and its corresponding confirmation document.

Refer to Trading Partner Setup: page 3 – 25 for more details on
setting up the Trading Partner to implement the confirmation
message.
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Message Queues

his chapter describes the queues used by the XML Gateway.
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Queues

Queues are tables on a database that are managed by Oracle Advanced
Queuing.

The XML Gateway uses queues specifically at two points in the
process, as well as employing a general error queue.  The first point is
at the transport agent level between the transport agent module and
the XML Gateway.  The second point is at the transaction level between
base Oracle E–Business Suite products or other source process, and the
XML Gateway.  Details about these queues are provided in the table
below.

Queue Name Description Level and Position in Process

ECX_INBOUND Inbound Message Queue:
Holds all messages that enter the
process through the Transport
Agent, or are placed directly on
the queue by an API.

Transport Agent Level
Between the Transport Agent and
the Inbound Transaction Queue

ECX_OUTBOUND Outbound Message Queue:
XML Gateway enqueues all out-
bound messages that it formatted
on this queue. 

Transport Agent Level
Between the XML Gateway and
the Transport Agent

ECX_IN_OAG_Q Inbound Transaction Queue:
Holds inbound messages that
originated from the
ECX_INBOUND queue, then en-
queued on this queue by Oracle
Workflow

These messages will be processed
by the XML Gateway.

Intermediate Level
After the message is received
through the Transport Agent
(Transport Agent Level above),
Oracle Workflow enqueues the
message in this queue for the
XML Gateway to process.

WF_ERROR Workflow Error Queue:
For errors detected by XML Gate-
way or WF BES.  Notifications
are sent to a Trading Partner con-
tact or the System Administrator.

Transaction Level

Refer to the Oracle 9i Database title Application Developer’s Guide –
Advanced Queueing for details, including topics on checking the status
and content of the queues.
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Outbound Queues

Outbound Message Queues

The outbound Message Queue is positioned between the XML
Gateway and the Transport Agent.

The XML Gateway creates XML messages, then enqueues them on this
queue.

Next Step:  The Transport Agent dequeues the message and delivers it
to the Trading Partner.

Inbound Queues

Inbound Message Queue

Inbound messages are first queued on the Inbound Message Queue.

The inbound Message Queue is positioned between the Transport
Agent and the Oracle Workflow Business Event System.

There are two methods for placing a message on the Inbound Message
Queue:

• The Transport Agent enqueues the message.

• An API writes directly to the queue.

Refer to the Oracle 9i Database title Application Developer’s Guide
– Advanced Queueing for details.



5 – 4 Oracle XML Gateway User’s Guide

The full message must be formatted according to the XML Gateway
envelope message format described in the Execution Engine section.
See  XML Gateway Envelope 4 – 7 for details.

Next Step:  Oracle Workflow Business Event System will copy the
inbound messages to the proper inbound Transaction Queue.  One
queue is seeded, but you may define other queues to meet your
business needs.  See information below.

Inbound Transaction Queue

This is the second queue for an inbound message.

After the message is received through the inbound Message Queue,
Oracle Workflow Business Event System enqueues the message to this
queue for the XML Gateway to process.

Next Step: The XML Gateway will process the inbound messages
placed in this queue.

Error Queue

When an error is detected by Oracle XML Gateway or Oracle Workflow
Business Event System the message is enqueued on to the error queue.
A Workflow listener dequeues the error and sends a notification to the
Trading Partner contact for data errors or to the System Administrator
contact for system or process errors.

Oracle Transport Agent Send Inbound HTML Page

To verify that a message can be placed on a queue after setup, use the
Oracle Transport Agent Send Inbound page.  This page allows you to
send an Inbound HTML document to the Oracle Transport Agent
running on the same Web server as the HTML page.

The ECXOTAInbound.html file included with the Oracle Transport
Agent allows you to send XML documents inbound from a Web server.
The document will be received by OTA and placed on the
ECX_INBOUND queue.  This HTML file is included for testing
purposes and should not be used in a production environment.

To use the ECXOTAInbound.htm page, open a Web browser and enter
the following URL:

http://<server
name>:<port>/OA_HTML/US/ECXOTAInbound.htm
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The page will prompt you for the input parameters used by the OTA
messaging protocol.  Refer to the OracleMetaLink document
”Understanding the OTA (Transport Agent) Protocol” for information
regarding the OTA messaging protocol parameters.
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Column Name Description

TRANSPORT_PROTOCOL Defaults to OXTA.

TRANSPORT_PROTO-
COL_VERSION

Defaults to 1.0.

REQUEST_TYPE Select ”SEND”

MESSAGE_ID Enter the unique reference number that identifies the
transaction.

MESSAGE_TYPE Defaults to XML.

MESSAGE_STANDARD Defaults to OAG.

TRANSACTION_TYPE (Required) Enter the type of transaction, such as PO for
Purchase Order Inbound.

TRANSACTION_SUBTYPE (Required) Enter the subtype of the transaction.

DOCUMENT_NUMBER Enter the document number.

PARTYID (Optional) Enter the Trading Partner ID for the sender.

SOURCE_TP_LOCA-
TION_CODE

(Required) Enter the Source Trading Partner Location
Code (should match the Trading Partner Details column
of the same name).

PROTOCOL_TYPE Not required for inbound messages.

PROTOCOL_ADDRESS Required only if REQUEST_TYPE is EME.

USERNAME (Required) Enter a valid user name for the receiving sys-
tem.

PASSWORD (Required) Enter the password corresponding to the user
name entered.

ATTRIBUTE1 Optional

ATTRIBUTE2 Optional

ATTRIBUTE3 Required for pass–through transactions only, such as In-
voice Inbound.

ATTRIBUTE4 Optional

ATTRIBUTE5 Optional

PAYLOAD Enter the message payload.

Table 5 – 1  Oracle Transport Agent Send Inbound HTML page fields
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XML Gateway Message Format

XML messages that are enqueued or dequeued for processing by XML
Gateway must conform to the system.ecxmsg data type.

The system.ecxmsg data type consists of the following:

Name Type

MESSAGE_TYPE VARCHAR2(80)

MESSAGE_STANDARD VARCHAR2(80)

TRANSACTION_TYPE VARCHAR2(80)

TRANSACTION_SUBTYPE VARCHAR2(80)

DOCUMENT_NUMBER VARCHAR2(80)

PARTYID VARCHAR2(80)

SOURCE_TP_LOCATION_CODE VARCHAR2(80)

PARTY_TYPE VARCHAR2(80)

PROTOCOL_TYPE VARCHAR2(200)

PROTOCOL_ADDRESS VARCHAR2(200)

USERNAME VARCHAR2(200)

PASSWORD VARCHAR2(200)

ATTRIBUTE1 VARCHAR2(200)

ATTRIBUTE2 VARCHAR2(200)

ATTRIBUTE3 VARCHAR2(200)

ATTRIBUTE4 VARCHAR2(200)

ATTRIBUTE5 VARCHAR2(200)

PAYLOAD CLOB

Refer to XML Gateway Envelope: page 4 – 7 for a description of each
field.

Non–Oracle messaging systems can enqueue an XML message for the
Oracle E–Business Suite to process.  This is done by defining an object
of the same data type, populating the object, then calling an Advanced
Queuing enqueue API to enqueue the object.  The Oracle E–Business
Suite Transport Agent will receive the object and deposit it onto the
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ECX_OUTBOUND agent.  From there, the standard inbound agent
listener assumes control of the process.
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Integrating Oracle XML
Gateway with Oracle
Workflow Business
Event System

his chapter describes the integration of the Workflow Business
Event System with the XML Gateway.  Specifically, this chapter
discusses

• Using the XML Gateway Standard Item Type and the XML
Gateway Error Processing Item Type

• Configuring Oracle Prebuilt Messages (Inbound and Outbound)

• Application to Application Integration

• Managing and Monitoring Workflow Processes

• Development Guidelines for Custom Messages for B2B
Integration
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Integrating Oracle XML Gateway with Oracle Workflow Business
Event System

Overview

Oracle Workflow is a process management tool used to seamlessly
integrate Oracle E–Business Suite business processes together.
Introduced with Oracle Workflow 2.6 is the Business Event System to
further support business process integration at the business event level.

Integral to the Business Event System is the ability to raise a business
event to signal that something of interest has occurred in the Oracle
E–Business Suite.  Using Oracle Purchasing as an example, an event of
interest would be the creation, change, confirmation, or deletion of a
purchase order.

Complementary to the raise event is an event subscription defined to
perform some activity when it detects an event of interest has occurred.
An example of an event subscription in our Oracle Purchasing scenario
is to send a message to the appropriate supplier when a new order is
created, or when an existing order is changed, confirmed, or deleted.

An event subscription is controlled by a rule function.  The result of the
rule function determines whether the associated Workflow process will
be executed.  The actual activity performed by the event subscription is
based on the Workflow process defined for it.

In the context of the integration between the Oracle Workflow Business
Event System and Oracle XML Gateway, business events and their
corresponding event subscriptions are seeded and deployed to the
Oracle E–Business Suite.  Once the Trading Partner is defined, the
seeded business events and event subscriptions may be implemented
as is, or they may be configured to perform specific activities relevant
to the business requirements.

Application business events for outbound messages are raised by the
Oracle E–Business Suite application module responsible for the
message and processed by the event subscription defined for it.  The
seeded event subscription for the B2B integration may be based on the
XML Gateway Rule Function or the Workflow Default Rule Function.

Embedded in the XML Gateway Rule Function is the Transaction
Delivery Required Function used to determine if the Trading Partner is
enabled for the transaction.  The XML Gateway Rule Function can
therefore be simply represented as follows:



Figure 6 – 1

Figure 6 – 2
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XML Gateway Rule Function

The Receive Event is followed by the Send Document function activity
which proceeds to End.

The Workflow Default Rule Function uses the Transaction Delivery
Required function as a process activity to determine if the Trading
Partner is enabled for the transaction.  This process consists of the
following steps:  The Receive Event is followed by the Transaction
Delivery Required function activity.  If it returns TRUE, the Send
Document function activity is executed.  If FALSE, the process
proceeds to End.  This process is shown below:

Workflow Default Rule Function

With either rule function, no message is sent if the Trading Partner is
not enabled for the transaction.

For efficiency, the XML Gateway Rule Function is the recommended
approach as it has already predetermined that the Trading Partner is
enabled for the transaction before it proceeds with generating the
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message.  However, the Workflow Default Rule function approach
provides a visual audit trail of the Workflow process.

With either approach, Oracle XML Gateway gathers the data from the
Oracle E–Business Suite, creates the XML message, and delivers it to
the Trading Partner for Business to Business (B2B) integration or to
another application module for Application to Application (A2A)
integration.

Inbound messages received from the Trading Partner for Business to
Business (B2B) integration are enqueued onto the inbound queue.
Inbound messages received from another application module for
Application to Application (A2A) integration are stored in the Event
Message attribute (of the Consume XML Document function) to be
accessed by the XML Gateway execution engine for processing.

An XML Gateway inbound rule function is executed in the B2B
integration to validate the Trading Partner and to identify the
transaction queue.  If the Trading Partner is valid, the message is
enqueued onto the transaction queue for processing by the XML
Gateway execution engine.

The XML Gateway execution engine processes the data according to
the instructions in the message map associated with the Trading
Partner and message.  If successful, the message map sets the Event
Details to inform the Oracle E–Business Suite of the Event.  It is the
application of the map to the message that enables you to determine
what the Event Details are.  The event is then processed by an
application event subscription interested in the inbound message.

Oracle Workflow Business Event System consists of three key
components that are used to integrate with the Oracle E–Business Suite
to create and consume XML messages:

• The Oracle Workflow Builder contains the Oracle Workflow
Standard Item Type and the Oracle XML Gateway Standard Item
Type.  The components of the standard item types can be used to
define Workflow processes.

• Oracle Workflow Administrator used to register new events and
event subscriptions as well as configure seeded event
subscriptions.

• The Oracle Workflow processing engine used to execute the
workflow processes.
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Oracle Workflow Builder – Item Types

Delivered with XML Gateway are two standard item types:

• XML Gateway Standard Item Type

• XML Gateway Error Processing Item Type

An Item Type is a group of components of a particular category that
share the same set of item attributes (also known as variables).

Both the XML Gateway Standard Item Type and XML Gateway Error
Processing Item Type can be accessed using the Oracle Workflow
Builder.

Components of an Item Type

Common to all item types are the following components:

• Attributes

• Process Activity

• Notification Activity

• Function Activity

• Event Activity

• Messages

• Lookup Types

A Workflow process may be made up of event activities, function
activities, notification activities, or process activities.  A message is the
information sent in a notification activity.  Lookup types represent a list
of valid values.  Attributes represent variables used to share data
between activities in the Workflow process.

See the Oracle Workflow User’s Guide for more information.

XML Gateway Standard Item Type

The XML Gateway Standard Item Type is a toolkit consisting of
attributes, processes, functions, and event activities.  Configure the
seeded events and event subscriptions delivered by the Oracle
E–Business Suite for prebuilt XML messages in support of B2B
integration requirements.
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In addition, the function activities can be used to define Workflow
processes in support of A2A integration requirements.

See XML Gateway Standard Item Type: page 6 – 8 for details
regarding the function and event activities.

XML Gateway Error Processing Item Type

The XML Gateway Error Processing Item Type contains error handling
processes to manage errors detected by Oracle Workflow Business
Event System or Oracle XML Gateway.

Oracle Workflow sends a notification to the Trading Partner contact for
data errors or to the XML Gateway system administrator for system or
process errors.  For errors that require collaboration between the
Trading Partner contact and the XML Gateway system administrator, a
notification is sent to both parties to encourage discussion and to
expedite problem resolution.
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Refer to XML Gateway Error Processing Item Type: page 6 – 30 for
details regarding the error handling process.

E–Business Suite Application Module–Specific Item Type

The seeded event subscription delivered for Oracle prebuilt messages is
delivered in an Oracle E–Business Suite application module–specific
item type.  The seeded event subscription may be configured using the
function activities defined in the XML Gateway Standard Item Type or
customized to support the application–specific requirement.

See Configure Oracle Prebuilt Inbound Messages: page 6 – 57 or
Configure Oracle Prebuilt Outbound Messages: page 6 – 59 for details
on how to configure a seeded event subscription.
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XML Gateway Standard Item Type

The XML Gateway Standard Item Type is a toolkit consisting of
attributes, processes, functions, and event activities.  These are
provided to implementers to build Workflow processes to configure the
seeded event subscriptions delivered by the Oracle E–Business Suite
for prebuilt XML messages in support of B2B integration requirements.

In addition, the function activities can be used to define Workflow
processes in support of A2A integration requirements.

The Notifications and Messages are contained in the Oracle E–Business
Suite application module–specific item type and are defined using the
XML Gateway Error Processing Item Type.

See XML Gateway Error Processing Item Type: page 6 – 30.

Attributes

Attributes, also known as variables, are used to support the function,
event, notification, and process activities defined for the XML Gateway
Standard Item Type.

Processes

The XML Gateway Standard Item Type supports the following process:

• Create Trading Partner Message (for ECX internal use only)

The Create Trading Partner Message is a rule function available from
the Workflow Event Subscription page.
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Functions

The XML Gateway Standard Item Type includes five function activities
as shown in the following table:
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Function Display Name A2A/
B2B

Inbound /
Outbound

Purpose

Consume XML Document A2A Inbound Trigger XML Gateway to process inbound
message on the Event Message attribute.

Generate XML Document A2A Outbound Create XML message and store in Event
Message attribute.  Trading Partner verifica-
tion is not required.

Generate Trading Partner XML Document B2B Outbound Verify transaction is enabled for the Trading
Partner, create XML message, and store in
Event Message attribute.

Send Document B2B Outbound Create and enqueue XML message onto out-
bound queue.

Transaction Delivery Required B2B Outbound Verify transaction is enabled for the Trading
Partner.

Transform XML A2A
/B2B

Inbound/
Outbound

Enable XML to XML transformations

Table 6 – 1   XML Gateway Standard Item Type Function Activities 

Application–to–Application (A2A) exchange of data is conducted
within and outside your enterprise to share or synchronize data
between information systems.  There is no Trading Partner involved in
an A2A integration.  An example of an A2A exchange is to move data
from the Oracle Payables module to Oracle General Ledger for GL
consolidation.

Business–to–Business (B2B) exchange of data is conducted with a
Trading Partner outside of your enterprise for which Trading Partner
validation is required.  Data will not be sent to or received from an
invalid Trading Partner.  An example of a B2B exchange is to send a
purchase order to a supplier.

There is not a controlling Workflow process for inbound B2B
exchanges.  The XML Gateway execution engine subscribes directly to
the inbound queue.

Functions will be referred to by their function display names.  The
internal function names are provided for reference in the following
table:



6 – 11Integrating Oracle XML Gateway with Oracle Workflow Business Event System

Function Display Name Internal Name

Consume XML Document PROCESSXML

Generate XML Document GETXML

Generate Trading Partner XML Document GETTPXML

Send Document DOCUMENT_SEND

Transaction Delivery Required DELIVREQUIRED

Transform XML XMLTOXML

Table 6 – 2  Display Names of the XML Gateway Standard Item
Type Functions 

The following is a description of each function supported by the XML
Gateway Standard Item Type.

Consume XML Document (applies to A2A for inbound messages)

The Consume XML Document function triggers the XML Gateway
Execution Engine to process the inbound message in the Event Message
attribute.  The XML Gateway execution engine will process the
message according to the message map associated with the message,
and will conclude by raising a business event to indicate that it has
successfully processed the inbound message.

See Procedure Call: Execute Procedure: page 2 – 108 for details
regarding the Procedure Call action to raise a business event.

The Consume XML Document function is for inbound messages in the
A2A scenario only.  The XML Gateway execution engine is
automatically triggered in a B2B scenario when an inbound message
arrives on the inbound queue.
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The attributes for the Consume XML Document function are shown in
the following table.  The values for the attributes are provided by the
business event, another function activity, or are set as constants.

Attribute Name Attribute Description

Map Code This is the Map Code defined in the Message Designer
and associated to the Trading Partner that uniquely identi-
fies the message map associated with the business docu-
ment enabled for the Trading Partner.

Event Message Event Message contains the event data as well as header
properties for the event name, event key, and error data.
The Event Message attribute is required to store the in-
bound message for processing by the XML Gateway
execution engine.

Table 6 – 3  Attributes for the Consume XML Document Function 



PL/SQL Syntax

Arguments (input)
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Generate XML Document (applies to A2A for outbound messages)

The Generate XML Document function is used to retrieve data from the
Oracle E–Business Suite.  The data for the XML message retrieved from
the Oracle E–Business Suite is stored in the Event Message attribute.
The Event Message is then processed according to the subsequent
Workflow instruction, which may be to send it to another Oracle
E–Business Suite application module or to the WF_OUT agent.

The difference between the Generate XML Document function and the
Generate Trading Partner XML Document function is that this function
does not require Trading Partner validation since there is no Trading
Partner involved in A2A integration.

The Generate XML Document function activity is provided for use in
Workflow processes.  For environments where a Workflow process
does not exist, the ECX_STANDARD.generate function can be called
from the Workflow Define Event window, Generate Function field.  The
details of the function are as follows:

ECX_STANDARD

function generate

(p_event_name in varchar2,

 p_event_key in varchar2,

 p_parameter_list in wf_parameter_list_t)

return CLOB;

Unique identifier for the business event associated
with the transaction.

Unique identifier for the business document from
the Oracle e–Business Suite associated with the
business event.

Parameter list containing the document selection
criteria.

p_event_name

p_event_key

p_parameter_list
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The attributes for the Generate XML Document function are shown in
the following table.  The values for the attributes are provided by the
business event, another function activity, or are set as constants.



6 – 15Integrating Oracle XML Gateway with Oracle Workflow Business Event System

Attribute Name Attribute Description

Document ID This is the unique identifier for the business document.  It
can be the document number or its associated database
key, whichever is guaranteed to be unique for the transac-
tion.  
The Document ID is optional for the Generate XML Docu-
ment function unless it is used in the message map as a
selection criterion.

Map Code This is the Map Code defined in the Message Designer
and associated to the Trading Partner that uniquely identi-
fies the message map associated with the business docu-
ment enabled for the Trading Partner.
The Map Code is required for the Generate XML Docu-
ment function.

Event Name This is a unique identifier for the business event.  The
naming convention is 
oracle.apps.<product code>.<compo-
nent>.<object>.<event>
The Event Name is required for the Generate XML Docu-
ment function to store the value returned.

Event Key This is a unique identifier for an instance of an event.  The
combination of event name, event key, and event data
fully describe what occurred in the event.
The Event Key is required for the Generate XML Docu-
ment function activity to store the value returned.

Parameter 1 Optional variable.  This attribute is used if it is used in the
message map.

Parameter 2 Optional variable.  This attribute is used if it is used in the
message map.

Parameter 3 Optional variable.  This attribute is used if it is used in the
message map.

Parameter 4 Optional variable.  This attribute is used if it is used in the
message map.

Parameter 5 Optional variable.  This attribute is used if it is used in the
message map.

Event Message Event Message contains the event data as well as header
properties for the event name, event key, and error data.
The Event Message is required for the Generate XML Doc-
ument function to store the value returned.

Table 6 – 4  Attributes for the Generate XML Document Function 
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Generate Trading Partner XML Document (applies to B2B for
outbound messages)

The Generate Trading Partner XML Document function is used to
retrieve data from the Oracle E–Business Suite.  The data for the XML
message retrieved from the Oracle E–Business Suite is stored in the
Event Message attribute.  The Event Message is then processed
according to the subsequent Workflow instruction, which may be to
send it to another Oracle E–Business Suite application module or to the
WF_OUT agent.

The difference between the Generate Trading Partner XML Document
function and the Generate XML Document function is that this function
is used in B2B integration for which a valid Trading Partner is required.
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The attributes for the Generate Trading Partner XML Document
function are shown in the following table.  The values for the attributes
are provided by the business event, another function activity, or are set
as constants.
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Attribute Name Attribute Description

Transaction Type This is the Transaction Type defined in the XML Gateway
Define Transactions form.
The Transaction Type is optional for the Generate Trading
Partner XML Document function because it can be
derived from the Map Code.

Transaction Subtype This is the Transaction Subtype defined in the XML Gate-
way Define Transactions form.
The Transaction Subtype is optional for the Generate Trad-
ing Partner XML Document function because it can be
derived from the Map Code.

Document ID This is the unique identifier for the business document.  It
can be the document number or its associated database
key, whichever is guaranteed to be unique for the transac-
tion.  
The Document ID is optional for the Generate XML Docu-
ment function unless it is used in the message map as a
selection criterion.

Party Site ID This is the unique identifier for the Trading Partner site
defined in Oracle E–Business Suite.
The Party Site ID is required for the Generate Trading
Partner XML Document function.

Party ID This is the unique identifier for the Trading Partner de-
fined in Oracle E–Business Suite.
This field is optional.

Event Name This is a unique identifier for the business event.  The
naming convention is oracle.apps.<product
code>.<component>.<object>.<event>
The Event Name is required for the Generate Trading Part-
ner XML Document function to store the value returned.

Event Key This is a unique identifier for an instance of an event.  The
combination of event name, event key, and event data
fully describe what occurred in the event.
The Event Key is required for the Generate Trading Part-
ner XML Document function to store the value returned.

Parameter 1 Optional variable.  This attribute is used if it is used in the
message map.

Parameter 2 Optional variable.  This attribute is used if it is used in the
message map.

Parameter 3 Optional variable.  This attribute is used if it is used in the
message map.

Parameter 4 Optional variable.  This attribute is used if it is used in the
message map.

Table 6 – 5 Attributes for the Generate Trading Partner XML Document Function (Page
1 of 2) 
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Attribute DescriptionAttribute Name

Parameter 5 Optional variable.  This attribute is used if it is used in the
message map.

Event Message Event Message contains the event data as well as header
properties for the event name, event key, and error data.
The Event Message is required for the Generate Trading
Partner XML Document function to store the value re-
turned.

Party Type The Party Type defined in the XML Gateway Trading Part-
ner Setup window.

Table 6 – 5 Attributes for the Generate Trading Partner XML Document Function (Page
2 of 2) 

Send Document (applies to B2B for outbound messages)

The Send Document function is used to trigger outbound message
creation. The XML message may be created immediately or deferred
depending on the setting of the Send Mode attribute.  This function
triggers XML Gateway to gather the data from the Oracle E–Business
Suite, and to create and enqueue the XML message.

A Send Mode of ”Deferred” defers the processing to the Workflow
background engine.

A Send Mode of ”Immediate” triggers the XML Gateway Execution
Engine to create the XML message immediately after the data has been
entered into the Oracle E–Business Suite.  With this approach, a
snapshot of the data is taken to avoid a race condition where the data
may be changed after the time the event is raised and before the data is
extracted.

The Send Document function may be modeled using the XML Gateway
Rule Function or the Workflow Default Rule Function to ensure that
XML messages are sent to Trading Partners enabled for the transaction.
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The attributes for the Send Document function are shown in the
following table.  The values for the attributes are provided by the
business event, another function activity, or are set as constants.

Attribute Name Attribute Description

Transaction Type This is the Transaction Type defined in the XML Gateway
Define Transactions form.

Transaction Subtype This is the Transaction Subtype defined in the XML Gate-
way Define Transactions form.

Table 6 – 6 Attributes for the Send Document Function (Page 1 of 2) 
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Attribute DescriptionAttribute Name

Document ID This is the unique identifier for the business document.  It
can be the document number or its associated database
key, whichever is guaranteed to be unique for the transac-
tion.

Party Site ID This is the unique identifier for the Trading Partner site
defined in Oracle E–Business Suite.

Party ID This is the unique identifier for the Trading Partner de-
fined in Oracle E–Business Suite.
This field is optional.

Parameter 1 Optional variable.  This attribute is used if it is used in the
message map.

Parameter 2 Optional variable.  This attribute is used if it is used in the
message map.

Parameter 3 Optional variable.  This attribute is used if it is used in the
message map.

Parameter 4 Optional variable.  This attribute is used if it is used in the
message map.

Parameter 5 Optional variable.  This attribute is used if it is used in the
message map.

Send Mode Select ”Deferred” or ”Immediate”

Message ID This is a unique identifier provided by the XML Gateway
execution engine for each outbound message.

Party Type Party Type defined in the XML Gateway Trading Partner
Setup window.

Table 6 – 6 Attributes for the Send Document Function (Page 2 of 2) 

Transaction Delivery Required? (applies to B2B for outbound
messages)

The Transaction Delivery Required function is used to determine if the
Trading Partner is enabled for the transaction.  It is used for B2B
integration where Trading Partner validation is required.  The function
returns TRUE or FALSE.

The Transaction Delivery Required function is also embedded in the
XML Gateway Rule Function.  No Workflow process will be executed if
the function returns FALSE.

The seeded event subscription delivered by Oracle E–Business Suite
application modules can use the XML Gateway Rule Function or the
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Workflow Default Rule Function.  The XML Gateway Rule Function is
more efficient because it predetermines whether the Trading Partner is
enabled for the transaction and executes the associated Workflow
process only if the result of the rule function is TRUE.  It is therefore
the recommended approach.

The attributes for the Transaction Delivery Required function are
shown in the following table.  The values for the attributes are
provided by the business event, another function activity, or are set as
constants.
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Attribute Name Attribute Description

Transaction Type This is the Transaction Type defined in the XML Gateway
Define Transactions form.

Transaction Subtype This is the Transaction Subtype defined in the XML Gate-
way Define Transactions form.

Party Site ID This is the unique identifier for the Trading Partner site
defined in Oracle E–Business Suite.

Party ID This is the unique identifier for the Trading Partner de-
fined in Oracle E–Business Suite.

Party Type The Party Type defined in the XML Gateway Trading Part-
ner Setup window.

Confirmation Flag The Document Confirmation flag from the Trading Part-
ner Setup window.  Indicates whether a confirmation is
sent or received.  
The Confirmation Flag has been added to the Transaction
Delivery Required? (DELIVREQUIRED) function activity.
Workflows for outbound business documents can now be
designed to wait for the inbound confirmation if the
ECX_CONFIRMATION_FLAG is set to 1 (send confirma-
tion if error detected) or 2 (always send confirmation).
The Confirmation Flag is an attribute of the Trading Part-
ner that is defined using the Trading Partner Setup win-
dow.
Use this Workflow design approach if you want to link the
outbound business document with the inbound confirma-
tion.  This is optional.

Table 6 – 7  Attributes for the Transaction Delivery Required Function 

Transform XML

The Transform XML function is used for XML to XML transformation.
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The Transform XML function transforms a given Input XML document
into another XML document.  The input parameters to this activity are
the Map Code and the Input XML Document.  The output of the
activity is the transformed XML document.  The execution engine will
execute the transformation according to the Map Definition.

The attributes for the Transform XML function are shown in the
following table.  The Event Message In attribute stores the input XML
information and the Event Message Out attribute stores the
transformed XML information.

Attribute Name Attribute Description

Map Code The Map Code associated with the Transaction as defined
in the Trading Partner Details form.

Event Message In The Input XML message.

Event Message Out The Transformed XML message.

Table 6 – 8  Attributes for the Transform XML Function 
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Events

The XML Gateway Standard Item Type includes three Events to raise a
business event from an existing Workflow process.

Generic Receive Event

The Generic Receive Event is used to support the Create Trading
Partner Message process.

Raise Document Delivery Event

The Raise Document Delivery Event is used to raise a business event
from an existing Workflow process.  This allows you to seamlessly
integrate your existing Workflow process with Oracle XML Gateway to
create an outbound XML message.

An alternate approach is to raise the business event directly from
PL/SQL code.  Refer to the Oracle Workflow API Reference for the
details.
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The attributes for the Raise Document Delivery Event are shown in the
following table.  The values for the attributes are provided by a
function activity or are set as constants.
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Attribute Name Attribute Description

Transaction Type This is the Transaction Type defined in the XML Gateway
Define Transactions form.

Transaction Subtype This is the Transaction Subtype defined in the XML Gate-
way Define Transactions form.

Document ID This is the unique identifier for the business document.  It
can be the document number or its associated database
key, whichever is guaranteed to be unique for the transac-
tion.

Party Site ID This is the unique identifier for the Trading Partner site
defined in Oracle E–Business Suite.

Party ID This is the unique identifier for the Trading Partner de-
fined in Oracle E–Business Suite.

Parameter 1 Optional Variable.  This attribute is used if it is used in the
message map.

Parameter 2 Optional Variable.  This attribute is used if it is used in the
message map.

Parameter 3 Optional Variable.  This attribute is used if it is used in the
message map.

Parameter 4 Optional Variable.  This attribute is used if it is used in the
message map.

Parameter 5 Optional Variable.  This attribute is used if it is used in the
message map.

Table 6 – 9  Attributes for the Raise Document Delivery Event 

WF Send

The WF Send Event enqueues a message onto the ECX_OUTBOUND
queue.  This event is used in conjunction with Callback.  See Message
Delivery Status: page 7 – 8  for a complete description of this event and
its attributes.

Lookup Types

The XML Gateway Standard Item Type supports the Send Mode
Lookup Type used in the Send Document function to indicate whether
the event subscription should be processed immediately or in deferred
mode.
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Communications Method

• Attachment Enabled HTTP

• Attachment Enabled HTTPS

• Attachment Enabled OTA over HTTP

• Attachment Enabled OTA over HTTPS

• Email Delivery

• HTTP Delivery

• HTTPS (Secure HTTP)

• No Electronic Delivery

• Oracle Integration Server

• Oracle Transport Agent Using HTTP
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• Oracle Transport Agent Using HTTPS

Confirmation Values

Confirmation Values are used in the Transaction Delivery Required
function activity.

• No confirmation Business Object Document Delivery

• Send a confirmation Business Object Document Regardless

• Send back a confirmation Business Object Document only if an
error has occurred

Party Types

Party Types are used in the Get Trading Partner Role and Send
Document function activities.

• Bank

• Customer

• Carrier

• Exchange

• Internal

• Supplier

• XML Gateway Standalone

Send Mode

Send Mode is used in the Send Document function activity.

• Deferred

The Deferred mode informs the XML Gateway execution engine
to defer the message creation to the Workflow background
engine.  This is also known as asynchronous processing.

• Immediate

The Immediate mode informs the XML Gateway execution
engine to create and enqueue the XML message immediately
after the data has been entered into the Oracle E–Business Suite.
This is also known as synchronous processing.

Synchronous processing avoids the race condition where the
data may be changed between the time the event is raised and
before the data is extracted.
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XML Gateway Error Processing Item Type

The XML Gateway Error Processing Item Type contains error handling
processes to manage errors detected by Oracle Workflow Business
Event System or Oracle XML Gateway.

Oracle Workflow sends a notification to the Trading Partner contact for
data errors or to the XML Gateway system administrator for system or
process errors.  For errors that require collaboration between the
Trading Partner contact and XML Gateway system administrator, a
notification is sent to both parties to encourage discussion and to
expedite problem resolution.

The system administrator receiving a notification has the option to
retry, reprocess, or abort the failed process.  If the source of the error
can be corrected by the system administrator, the system administrator
will correct the error and retry or reprocess the failed process.

The term ”retry” is used for outbound messages.  The Workflow Retry
feature is used to support this requirement.  The retry feature resumes
from the point of failure.

The term ”reprocess” is used for inbound messages.  The ECX
Reprocess Inbound function is used to support the reprocess feature.
The function resumes using a copy of the inbound message stored in
the ECX_DOCLOGS table.

If the source of the error is in the accuracy of the message data received
from the Trading Partner, or of the data setup in the Trading Partner’s
application, the system administrator will abort the failed process and
wait for the Trading Partner to send the corrected message (in the case
of an inbound message) or to correct their data setup (in the case of an
outbound message).

Attributes

Attributes, also known as variables, are used to support the function,
event, notification, and process activities defined for the XML Gateway
Error Processing Item Type.

Processes

The XML Gateway Error Processing Item Type supports the following
error handling processes:
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• (FYI) Message Delivery Error

• Default Error Process

• ECX Engine Notification Process

• ECX Main Error Process

• ECX Main Inbound Error Process

• ECX Main Outbound Error Process

• Error handling for Inbound Messages

• Error handling for Outbound Messages
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The relationship of the error handling processes is shown below.  The
ECX Main Error Process calls the ECX Main Error Inbound process for
inbound message errors or the ECX Main Error Outbound process for
outbound message errors.  If inbound, the ECX Main Error Inbound
process calls the Error Handling for Inbound Message process.  If
outbound, the ECX Main Error Outbound process calls the Error
Handling for Outbound Message process, which calls the Default Error
process.
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The following is a description of each Process (listed in their functional
order above) supported by the XML Gateway Error Processing Item
Type:

ECX Main Error Process

The ECX Main Error Process is triggered by the Receive Error Event
(see illustration, node 1), the Receive Inbound Subscription Error event,
or the Receive Inbound Subscription Processing Error event for errors
detected by the XML Gateway execution engine; or by Workflow for
errors involving the Workflow processes created using the XML
Gateway Standard Item Type.

At node 2, the process determines whether the error relates to an
inbound or outbound message.  The ECX Main Error Process calls the
ECX Main Inbound Error Process (node 3) for errors related to an
inbound message.  For errors related to an outbound message, it calls
the ECX Main Outbound Error Process (node 4).
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ECX Main Inbound Error Process

As shown in the illustration below, ECX Main Inbound Error Process
gets the error information (node 1) from the XML Gateway execution
engine or Workflow engine and calls the Error Handling for Inbound
Messages process (node 2).

Error Handling for Inbound Messages

Errors detected by the XML Gateway execution engine or Workflow
engine may trigger a notification.  The notification can be sent to the
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XML Gateway system administrator, the Trading Partner contact, or
both depending on the nature of the error.

Notifications can be e–mailed to the target recipient if the Workflow
mailer is enabled.  The system administrator’s e–mail address is
defined in the ECX: System Administrator Email Address system
profile.  The Trading Partner contact e–mail address is defined on the
Trading Partner form.

The target recipient(s) of the notification are predefined for the error
message and cannot be changed.

The Error Handling for Inbound Messages process checks the type of
the error detected (shown in the following diagram, node 1).  If the
error type indicates that no notification is sent, the failed process ends,
and the error process ends.

If the compare in node 1 indicates that a notification is to be sent, the
process retrieves the trading partner contact information (Company
Admin e–mail) from the trading partner tables (node 2).  If the error
type indicates that the target recipient is the Trading Partner contact
(performed in node 3), a notification is sent to the Trading Partner
(node 4), the failed process ends, and the error process ends.

If the check in node three did not indicate that the target recipient is
solely the Trading Partner contact, the process retrieves the System
Administrator contact information (node 5) and checks the error type
again (node 6).

If the target recipients are both the Trading Partner contact and the
XML Gateway system administrator, then two notifications are sent,
one to each party (nodes 7 and 8).  The system administrator has the
option of retrying or aborting the process (node 9).

If the target recipient is solely the XML Gateway system administrator,
the system administrator is notified (node 10) and has the option to
reprocess (node 11) or abort (node 12) the failed inbound process.
Reprocessing resumes using a copy of the inbound message stored in
the ECX_DOCLOGS table.
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ECX Main Outbound Error Process

ECX Main Outbound Error Process initializes the error (shown below,
node 1) and gets the error information (node 2) from the XML Gateway
execution engine or Workflow engine and calls the Error Handling for
Outbound Messages process (node 3).
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Error Handling for Outbound Messages

Errors detected by the XML Gateway execution engine or Workflow
engine may trigger a notification.  The notification can be sent to the
XML Gateway system administrator, the Trading Partner contact, or
both depending on the nature of the error.

Notifications may be e–mailed to the target recipient if the Workflow
mailer is enabled.  The system administrator’s e–mail address is
defined in the ECX: System Administrator Email Address system
profile.  The Trading Partner contact e–mail address is defined on the
Trading Partner form.

The target recipient(s) of the notification are predefined for the error
message and cannot be changed.

The Error Handling for Outbound Messages process checks the error
type to determine if a notification is to be sent (shown below, node 1).
If the type indicates that no notification is to be sent, the process ends.

If the type does not indicate that no notification is to be sent, the
process retrieves the trading partner contact information (Company
Admin e–mail) from the trading partner tables (node 2).  The
notification type is checked (node 3), and if the target recipient is solely
the Trading Partner contact, a notification is sent to the Trading Partner
(node 4) and the failed process is aborted.

If the target recipient is not solely the trading partner contact, the
system administrator contact information is retrieved (node 5) and the
Default Error Process is called (node 6).  At node 8 the type is checked
to determine if the notification is to be sent to both the trading partner
and the system administrator.

If the target recipients are both the Trading Partner contact and the
XML Gateway system administrator, then notification is also sent to the
Trading Partner contact (node 9).
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(FYI) Message Delivery Error Process

The (FYI) Message Delivery Process is used with Oracle Transport
Agent (or other messaging systems) to report message delivery status
back to the Workflow process that initiated message creation.

A corresponding event subscription (seeded in XML Gateway) for the
oracle.apps.ecx.processing.message.callback event
initiates the XML Gateway Standard Error Processing Item
Type:FYI_MESSAGE_DELIVERY_ERROR error handling process.  In
the event of an error, a notification is sent to the System Administrator
who has the option to ”Resend” the message after correcting the error,
or to ”Ignore” the notification if no action is required.

Default Error Process

The Default Error Process is called by the Error Handling for Outbound
Messages process when the error message notification is for the system
administrator.

The Workflow notification administrator delivers the notification
(shown below, node 1) to the system administrator and proceeds on
one of the following paths:

• Check for response from the system administrator and issue
time–out if no response received (node 2).
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• Execute retry function (node 3) if the system administrator wants
to retry the failed outbound process.  The retry process resumes
from the point of failure.  Continue retry function until error is
resolved or failed process is aborted.

• Execute abort function (node 4) if the system administrator
wants to abort the failed outbound process.

• Resolve error and end process (node 5)
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ECX Engine Notification Process

The Receive Send Notification Event (shown below, node 1) triggers the
ECX Engine Notification Process.

The ECX Engine Notification Process checks the error type to
determine the target recipient (node 2).  If the target recipient is the
Trading Partner contact, notification is sent (node 3).  If the error type
does not indicate that the Trading Partner contact is the sole target
recipient, the process checks the error type (node 4) to determine if the
notification should be sent to the XML Gateway system administrator
(node 5), or both parties (node 6).
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Notifications

The following is a description of each Notification supported by the
XML Gateway Error Processing Item Type:

ECX Event Notification (FYI)

The ECX Event Notification [FYI] is used to send a notification to the
system administrator.

This notification is used by the ECX Engine Notification Process.

ECX External Event Notification 

The ECX External Event Notification is used to send a notification to
the system administrator.
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This notification is used by the Error Handling for Inbound Messages
process.

Message Delivery Error (FYI)

The Callback feature allows messaging systems (including OTA) to
report message delivery status back to the Workflow process that
initiated message creation.  If delivery fails, the
apps.ecx.processing.message.callback event is raised.  The
corresponding event subscription for the
FYI_MESSAGE_DELIVERY_ERROR process is executed and a
Workflow notification is sent to the System Administrator (defined in
the ECX: System Administrator Email Address profile) who has the
option to retry/resend or about/ignore the process.

Trading Partner Inbound Error Notification 

The Trading Partner Inbound Error Notification is used to send a
notification to the Trading Partner contact.

This notification is used by the Error Handling for Inbound Message
and ECX Engine Notification processes.

Trading Partner Outbound Error Notification 

The Trading Partner Outbound Error Notification is used to send a
notification to the Trading Partner contact.

This notification is used by the Error Handling for Outbound Message
process.
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Functions

Several functions are provided in the XML Gateway Error Processing
Item Type to support the error handling process.

ECX Reprocess Inbound

The ECX Reprocess Inbound function is used if the XML Gateway
system administrator responded to the error notification by selecting
the ”reprocess” option.  The reprocess function will rerun the inbound
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process using a copy of the inbound message stored in the
ECX_DOCLOGS table.

The ”reprocess” function is not supported for external notifications to
the Trading Partner.

The attribute for the ECX Reprocess Inbound function is:

This is a unique identifier provided by the XML
Gateway execution engine for each outbound
message.

ECX Resend Outbound Message

The ECX Resend Outbound function is provided to support Oracle
Exchange only, it is not used in the XML Gateway Error Processing
Item Type.  The ECX Resend Outbound function resumes from a copy
of the outbound message stored in the ECX_DOCLOGS table.

The Oracle Workflow ”retry” function is used to rerun an outbound
process from the point of failure.  This is handled using the Default
Error Process.

The attribute for the ECX Resend Outbound function is shown in the
following table:

This is a unique identifier provided by the XML
Gateway execution engine for each outbound
message.

Get ECX In Error Details

The Get ECX In Error Details function activity is used to get the details
regarding an inbound error to prepare the e–mail notification.  In
addition, required information is passed to the Error Handling for
Inbound Messages process activity.

Get ECX Out Error Details

The Get ECX Out Error Details function is used to get the details
regarding an outbound error to prepare the notification.  In addition,
required information is passed to the Error Handling for Outbound
Messages process.

ECX Message ID

ECX Message ID
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Get System Administrator Role

The Get System Administrator Role function is used to retrieve the
e–mail address for the system administrator stored in the ECX: System
Administrator Email Address system profile.

The e–mail address retrieved from the system profile is returned by the
function and stored in the ECX System Administrator Role
(ECX_SA_ROLE) item attribute.

A notification is sent to the XML Gateway system administrator for
system or process errors detected by Oracle XML Gateway or Oracle
Workflow Business Event System.

Get Trading Partner Role

The Get Trading Partner Role function is used to determine the e–mail
address for the Trading Partner contact that was provided when the
Trading Partner was defined.

The function uses the attribute values passed to it to uniquely identify
the Trading Partner.  The e–mail address associated with the Trading
Partner selected returned by the function is stored in the ECX Trading
Partner Role (ECX_TP_ROLE) item attribute.

A notification is sent to the Trading Partner contact for data errors
detected by Oracle XML Gateway.

The attributes for the Get Trading Partner Role function are shown in
the following table:

Attribute Name Attribute Description

ECX Party ID This is the unique identifier for the Trading Partner defined in
Oracle E–Business Suite.  This field is optional.

ECX Party Site ID This is the unique identifier for the Trading Partner site defined
in Oracle E–Business Suite.

ECX Transaction
Type

This is the Transaction Type defined in the XML Gateway De-
fine Transactions form.

ECX Transaction
Sub Type

This is the Transaction Sub Type defined in the XML Gateway
Define Transactions form.

Table 6 – 10  Attributes for the Get Trading Partner Role Function 
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Events

The XML Gateway Error Processing Item Type supports the following
event activities:

• Message Delivery Error

• Receive Error

• Receive Send Notification Event

• Receive the inbound subscription error

• Receive the inbound subscription processing error

All of the XML Gateway seeded events and event subscriptions are
seeded with a Customization Level of ”L” for Limit, which means the
event or event subscription may be enabled or disabled but may not be
changed in any other way.  Because the seeded events and event
subscriptions play an integral role in the total solution, Oracle does not
recommend that you disable any of them.  If necessary, you may define
additional events and event subscriptions to augment the seeded
activities.
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Message Delivery Error

The Message Delivery Error Event is used by the XML Gateway to
indicate that an error has occurred.  This event is used with OTA
Callback.

The seeded event name is oracle.apps.ecx.processing.message.callback.
This event triggers the (FYI) Message Delivery Error Process workflow.

Receive Error

The Receive Error event is used by XML Gateway to indicate that the
execution engine has detected an error.  Regardless of whether the error
was detected by Oracle XML Gateway or Oracle Workflow Business
Event System, the same ECX Main Error Process manages the error.
See: ECX Main Error Process: page 6 – 33 for the details.

The seeded event name is oracle.apps.ecx.processing.message.error.
This event triggers the ECX Main Error Process workflow.

Receive Send Notification Event

The Receive Send Notification Event is used by XML Gateway to
indicate that the execution engine has identified a need to send a
notification for errors related to an inbound process.  The ECX Engine
Notification Process manages the error.  See: ECX Engine Notification
Process: 6 – 41 for the details.

The seeded event name is oracle.apps.ecx.processing.notification.send.
This event triggers the ECX Engine Notification Process workflow.

Receive the inbound subscription error

 The event ”oracle.apps.ecx.inbound.message.receive” is raised by the
ECX_INBOUND agent listener after it dequeues a message from the
ECX_INBOUND queue.  The ”Receive Inbound Subscription Error”
Event is used to indicate that there is an error when executing
the  subscription for the event
”oracle.apps.ecx.inbound.message.receive”.

This subscription is savies the xml message to ecx_doclogs, checks the
trading partner setup for the given transaction, performs logging, and
enqueues the message to the next queue for the actual map processing.
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Receive the inbound subscription processing error

The event ”oracle.apps.ecx.inbound.message.process” is raised by the
ECX_TRANSACTION agent listener after it dequeues a message from
the ECX_IN_OAG_Q queue.  The ”Receive Inbound Subscription
Processing Error” is used to indicate that there is an
error when processing the inbound xml document.

Messages

The XML Gateway Error Processing Item Type provides several
message templates used by the various notification activities to send a
notification to the XML Gateway system administrator or the Trading
Partner contact based on the nature of the error.
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Below is a description of each message template.  The message
template is displayed in the Body tab and Text Body subtab.
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ECX Event Message (FYI)

The ECX Event Message [FYI] template is used by the ECX Event
Notification.  The template includes information regarding the
transaction, the type of error detected, and the associated error
message.

ECX External Event Message

The ECX External Event Message  template is used by the ECX
External Event Notification activity.  The template includes information
regarding the transaction, the type of error detected, and the associated
error message.

Inbound Trading Partner Message

The Inbound Trading Partner Message template is used by the Trading
Partner Inbound Error Notification activity.  The template includes
information regarding the transaction, the type of error detected, and
the associated error message.

Message Delivery Error

The Message Delivery Error template is used by the XML Message
Delivery Callback error process.  The template includes information
regarding the action to take in case of error.

Outbound Trading Partner Message

The Outbound Trading Partner Message template is used by the
Trading Partner Outbound Error Notification activity.  The template
includes information regarding the transaction, the type of error
detected, and the associated error message.

Message Template Attributes

Each message template has the attributes listed in the following table.
The values for the attributes are provided by the Get ECX Out Error
Details and Get ECX In Error Details function.  The values are used to
replace the message tokens in the message template.

For a detailed explanation of each error and possible corrective actions,
see Manual Troubleshooting Steps: page G – 19.

The following table describes all the possible attributes:
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• Event Key is a unique identifier for an instance of an event.  The
combination of event name, event key, and event data fully
describe what occurred in the event.

Attribute Name Attribute Description

Event Key Event Key is a unique identifier for an instance of an event.
The combination of event name, event key, and event data fully
describe what occurred in the event.

ECX Transaction
Type

This is the Transaction Type defined in the XML Gateway De-
fine Transactions form.

ECX Document ID This is the unique identifier for the business document.  It can
be the document number or its associated database key, which-
ever is guaranteed to be unique for the transaction.

ECX Error Message This is the error message text describing the error detected.

ECX Error Type This is the error type code.  The valid values are:
10 = Success
20 = Send error notification to Trading Partner contact
25 = Send error notification to both Trading Partner contact and
XML Gateway System Administrator
30 = Send error notification to XML Gateway System Adminis-
trator

ECX Return Code This is the return status code.  The valid values are:
0 = Success
1 = Warning
2 = Error

ECX Message Stan-
dard

Message format standard (such as OAG) as defined in the De-
fine Transactions form.

ECX TP Header ID Trading Partner name.

ECX Message Type Message Type, which is XML.

ECX Logfile If a log file is created, the name and location.

ECX Status The status of the transaction.

ECX Time Stamp The date the log file was created.

ECX Transaction
Subtype

This is the Transaction Subtype defined in the XML Gateway
Define Transactions form.

ECX Party ID This is the unique identifier for the Trading Partner defined in
Oracle E–Business Suite.

ECX Party Site ID This is the unique identifier for the Trading Partner site defined
in the XML Gateway Define Transactions form.

Table 6 – 11  Message Template Attributes (Page 1 of 2) 
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Attribute DescriptionAttribute Name

ECX Internal Con-
trol Number

The Internal Control Number is a system–generated number
that uniquely identifies the message being processed.

Event Name This is a unique identifier for the business event.  The naming
convention is oracle.apps.<product code>.<compo-
nent>.<object>.<event>  The Event Name is required for
the Generate XML Document function to store the value re-
turned.

ECX Party Admin
Email

System Administrator as defined in the Trading Partner Setup
window.

ECX Protocol Ad-
dress

Protocol address used (for example, SMTP, HTTP, HTTPS).

ECX Attribute 1 Optional variable as defined in the message map.

ECX Attribute 2 Optional variable as defined in the message map.

ECX Attribute 3 Optional variable as defined in the message map.

ECX Attribute 4 Optional variable as defined in the message map.

ECX Attribute 5 Optional variable as defined in the message map.

ECX Trigger ID Unique number given to each event being raised.

ECX Trading Part-
ner Role

The e–mail address from the Trading Partner Setup window
that is returned by the Get Trading Partner Role function.

ECX Protocol Type Transmission protocol as defined in the Setup Trading Partner
window.

Table 6 – 11  Message Template Attributes (Page 2 of 2) 

Lookup Types

The XML Gateway Error Processing Item Type supports several lookup
types for the error handling processes.
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ECX Inbound Error Actions

The ECX Inbound Error Actions lookups are used by the ECX External
Event Notification as a Result Type attribute.  The valid values are as
follows:

• Abort

Abort the failed inbound process.

• Reprocess

Reprocess the failed inbound process.

ECX Outbound Error Actions

The ECX Outbound Error Actions lookups is used by the Default Error
Process.  The valid value is as follows:

• Abort

Abort the failed outbound process

The retry function is supported by the Default Error Process.

ECX Outbound Error Types

The ECX Outbound Error Types lookups are used by the Get ECX Error
Type function as a Result Type attribute.  The valid values are as
follows:

• Generate Error

The error was detected during the message creation process as
opposed to the message delivery process.

• Send Error

The error was detected during the message delivery process as
opposed to the message creation process.

• Trading Partner Setup Error

The error was based on incorrect Trading Partner setup.  Correct
the erroneous set up before proceeding further.
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ECX Resend Actions

ECX Resend Actions are lookups  used by the XML Gateway Error
Process.  The valid values are as follows:

• Ignore

• Resend
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Configure Oracle Prebuilt Inbound Messages

Seeded Business Event and Corresponding Event Subscription

Inbound messages that are prebuilt and delivered by Oracle E–Business
Suite application modules are delivered with the following:

• Message map containing an XML Gateway Procedure Call action
as the last activity.  This activity sets event details to indicate that
XML Gateway has successfully processed the inbound message.

• Seeded event subscription to consume the business event raised
in the message map.

The event subscription is seeded as an enabled subscription.  You
can disable the event subscription if necessary.

An event subscription is required for inbound messages from Trading
Partners (B2B) regardless of whether the application is interested in the
inbound message.  The seeded event subscription uses the Workflow
Default Rule Function but may be configured to use a rule function and
Workflow process relevant to the business requirement.

See the Message Designer: page 2 – 2 section for instructions on how to
create a new message map and how to modify an Oracle prebuilt
message map.

Configuration Options for Seeded Event Subscription

Use the Workflow Administrator to configure the seeded event
subscription for the prebuilt inbound message if necessary.

1. Register new event subscription

Use the Workflow Administrator Add Event Subscription window
to register the new event subscription if you defined a new
subscription instead of configuring the seeded subscription.

See Manage Workflow Processes: page 6 – 65 for instructions on
how to register new event subscriptions.

2. Configure Seeded Subscription

Use Oracle Workflow Administrator Add Event Subscription
window to configure the seeded event subscription to consume the
inbound message if your application is interested in it.  The
subscription will trigger the Oracle E–Business Suite to perform
some activity.  The actual activity performed by the event
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subscription will be based on the Workflow process defined for it.
Some examples are as follows:

• Integrate with existing Workflow process defined in the Oracle
E–Business Suite

• Call an application API to perform a specific function

See: Manage Workflow Processes: page 6 – 65 for instructions on
how to register new event subscriptions and configure a seeded
event subscription.
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Configure Oracle Prebuilt Outbound Messages

Seeded Business Event and Corresponding Event Subscription

Outbound messages that are prebuilt and delivered by Oracle
E–Business Suite application modules are delivered with the following:

• Calls in the application module to raise a business event to
indicate when something of interest has occurred.  This includes
event points indicating when a document was created, changed,
confirmed, or deleted.

• Seeded event subscription using the XML Gateway or Workflow
Default Rule Function to consume all the business events raised
in the application module.

The event subscription is seeded as an enabled subscription.  You
can disable the event subscription if necessary.

The seeded event subscription consumes all the seeded events but may
be configured to execute a specific Workflow process for the outbound
events it is interested in.

See the Message Designer: page 2 – 2 chapter for instructions on how to
create a new message map and how to modify an Oracle prebuilt
message map.

Configuration Options for Seeded Event Subscription

Use the Workflow Administrator to configure the seeded event
subscription for the prebuilt outbound message if necessary.

1. Register new event subscription

Use the Workflow Administrator Add Event Subscription window
to register the new event subscription if you defined a new
subscription instead of configuring the seeded subscription.

See Manage Workflow Processes: page 6 – 65 for instructions on
how to register new event subscriptions.

2. Configure Seeded Event Subscription

Use Oracle Workflow Administrator Add Event Subscription
window to configure the seeded event subscription to consume the
application business event of interest.  The subscription will trigger
the Oracle E–Business Suite to perform some activity.  The actual
activities performed by the event subscription will be based on the
Workflow process defined for it.
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There are three subscription options for the Business–to–Business
(B2B) integration scenario described below.  The function activities
outlined are supported by the XML Gateway Standard Item Type.

1. Send Document Function Using XML Gateway Rule Function

This option uses the XML Gateway Rule Function which has the
Transaction Delivery Required function embedded in it to
determine if the Trading Partner is enabled for the transaction
before the message is generated.

The ”Send Document” function can be configured to generate the
message in synchronous or asynchronous mode by setting the Send
Mode attribute to ”Immediate” or ”Deferred” respectively.

The following is an example of a Workflow process launched by the
XML Gateway Rule Function.  The Receive activity is followed by
the Send Document function activity, which proceeds to End.  The
Transaction Delivery Required Function is not modeled in the
Workflow process since it is already included in the rule function.

Note:  The first Workflow activity may be a Receive or a Start
activity.  Use Receive to continue an existing Workflow process.
Use Start to begin a new Workflow process.

2. Send Document Function Using Workflow Default Rule
Function

This option is used to first determine if the Trading Partner is
enabled for the transaction.  If the result of the Transaction Delivery
Required function activity returns TRUE, the ”Send Document”
function activity is executed.

The ”Send Document” function activity may be configured to send
the message in synchronous or asynchronous mode by setting the
Send Mode attribute to ”Immediate” or ”Deferred” respectively.

The following is an example of a Workflow process launched by the
Workflow Default Rule Function.  The Transaction Delivery
Required Function is modeled in the Workflow process since it is
not included in the Workflow Default Rule Function.
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Note:  The first Workflow step may be a Receive or a Start
activity.  Use Receive to continue an existing Workflow process.
Use Start to begin a new Workflow process.

3. Generate Trading Partner XML Document

This option is used to gather and return the message data in the
Event Message attribute without delivering it to the Trading
Partner.  The Event Message is then processed according to the
subsequent Workflow instruction.

The following is an example of a Workflow process using the
Generate Trading Partner XML Document function.  A Receive
activity is followed by the Transaction Delivery Required function
activity.  If it returns False, the process proceeds to End.  If True,
the Generate Trading Partner XML Document function activity is
executed and proceeds to End.  In a production Workflow process,
the Generate Trading Partner XML Document function activity
would be followed by an application–specific activity.
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Note:  The first Workflow step may be a Receive or a Start
activity.  Use Receive to continue an existing Workflow process.
Use Start to begin a new Workflow process.
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Application to Application Integration

The XML Gateway Standard Item Type provides function activities to
support A2A integration requirements.  Listed below are the options
for inbound and outbound transactions.

Inbound Option

Consume XML Document

This option is used to interact with Oracle XML Gateway to insert data
into the base application tables.  Depending on how the message map
was defined, the data may be inserted using an Application Open
Interface API or an Application API.  See: How to Map to an API: page
2 – 120.

The Consume XML Document function is used for A2A integration.  It
may be used in existing Workflow processes for which the Event
Message attribute is used to pass the message data.  This makes it
unnecessary to raise a business event or define an event subscription as
recommended in the B2B integration scenario.

The following is an example of a Workflow process using the Consume
XML Document function:

This Workflow process shows the Consume XML Document (2)
function activity completing and followed by an End function (3).  In a
production Workflow process, the Consume XML Document function
activity would be followed by an application–specific activity.

Note:  The first Workflow step (1) may be a Receive or a Start
activity.  Use Receive to continue an existing Workflow process.
Use Start to begin a new Workflow process.
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Outbound Option

Generate XML Message

This option is used to generate the XML message and forward it to the
subsequent Workflow process.   The Generate XML Document function
activity is used to gather the document data and return it in the Event
Message attribute.  The Event Message is then processed according to
the Workflow instructions which may be to send it to another Oracle
E–Business Suite application module.

The following is an example of a Workflow process using the Generate
XML Document function:

The Workflow process shows the Generate XML Document function
activity completing and followed by an End function.  In a production
Workflow process, the Generate XML Document function activity
would be followed by an application specific activity.

Note:  The first Workflow step may be a Receive or a Start
activity.  Use Receive to continue an existing Workflow process.
Use Start to begin a new Workflow process.
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Manage Workflow Processes

Use the following Oracle Workflow Administrator windows to help
manage your Workflow processes.

For more information about these windows see the Oracle Workflow
Administrator’s Guide.

Register New Business Events and Event Subscription

This process is necessary for new events and subscriptions added as a
result of creating a new XML message.  The seeded business events and
event subscriptions delivered by the Oracle E–Business Suite have
already been registered.  There is no need to register a seeded event
subscription that was configured during implementation.

Use the Events window to add a new business event.

Use the Subscriptions window to add a new subscription to consume
the new event.

Identify Seeded Item Types

Use the Item Type Definition window to view the seeded item types
delivered by Oracle Workflow Business Event System, Oracle XML
Gateway, and Oracle E–Business Suite modules.

Identify Seeded Business Events and Associated Event Subscriptions

Use the the Events window to view the seeded business events
delivered by Oracle Workflow Business Event System, Oracle XML
Gateway, and Oracle E–Business Suite modules.

Select the business event and click on Edit Subscription to proceed to
the Subscriptions window to view the associated subscriptions.

Configure or Delete Seeded Event Subscriptions

From the Subscriptions window, select the subscription and click Edit
to configure the subscription.  Click Delete to delete the subscription.
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You can modify the rule function or Workflow process defined for the
subscription.

View and Respond to Error Notifications

Use the Worklist window to view and respond to notifications awaiting
your attention.

Purge XML Gateway Transactions

If you are using the version of Oracle Workflow embedded in Oracle
Applications, you can submit the Purge Obsolete Workflow Runtime
Data concurrent program to purge XML Gateway transactions.  Use the
Submit Requests form in Oracle Applications to submit this concurrent
program.  For more information about this request, see Purge Obsolete
Workflow Runtime Data Concurrent Program in the Oracle Workflow
API Reference guide.  

Note:  If you are using the version of Oracle Workflow
embedded in Oracle Applications and you have implemented
Oracle Applications Manager, you can use Oracle Workflow
Manager to submit and manage the Purge Obsolete Workflow
Runtime Data concurrent program.  For more information, see
the Oracle Applications Manager online help.
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Monitor Workflow Processes

Identified below are several Oracle Workflow Administrator windows
to help monitor your Workflow processes:

Transaction–Level Trace

The trace function is performed via centralized logging through the
Applications Logging Framework.  Using the logging framework you
can enable logging and set log levels using FND profile options. For
information on this feature, see the Oracle Applications Supportability
Guide.

Monitor Transaction Status

Use the Event Queue Summary window to monitor the status of a
transaction.  Select the Agent Listener and click the View Detail icon.
Once you enter the selection criteria to identify the transaction, the
detail information including status and an option to view the event
data in XML or text format, are presented.

Review XML Message Returned by Generate Functions

Modify the subscription for the Generate XML Document or Generate
Trading Partner XML Document function and set the Action: Out
Agent field to the WF_OUT.  The XML data gathered by the function is
directed to the WF_OUT agent.

For instructions on viewing the XML message directed to WF_OUT
see: Monitor Transaction Status.

Start Agent Listeners 

There is one Agent Listener per inbound agent.  The agents necessary
to support the integration between Oracle Workflow Business Event
System and Oracle XML Gateway are shown in the following table:
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Agent Name Description

ECX_INBOUND Agent for inbound messages originating from outside the
enterprise for B2B integration.

ECX_TRANSACTION Agent for inbound messages originating from within the
enterprise for A2A integration.

WF_OUT Agent to stage outbound messages.  ECX_OUTBOUND is
the agent used to stage and deliver outbound XML mes-
sages to the Trading Partner.

WF_IN Agent to receive inbound messages sent to the Oracle
E–Business Suite.

WF_DEFERRED Agent for outbound messages sent in deferred mode.

WF_ERROR Agent for errors detected by Oracle Workflow Business
Event System or Oracle XML Gateway.

The agents must be enabled and the seeded agent listener service
components must be running.

Note:  Additional agents are provided for Web services.  See
Web Services Setup: page 8 – 7.

Use the Workflow Administrator: Agents window to enable the
required agents if necessary (the agents are enabled by default).  The
same window can be used to disable an agent.

Use Oracle Applications Manager to schedule and manage agent
listener service components.  For more information, refer to the Oracle
Applications Manager online help.

Ensure that the seeded agent listener service components named
Workflow Deferred Agent Listener and Workflow Error Agent Listener,
provided by Oracle Workflow, are running for the WF_DEFERRED and
WF_ERROR agents, respectively.

The agent listener service components ECX Inbound Agent Listener
and ECX Transaction Agent Listener are seeded with a manual startup
mode and therefore must be manually started.  The startup mode can
be changed to ”Automatic” using the Oracle Applications Manager, if
desired.

Place any user–defined agents in their own container.
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Development Guidelines for Custom Messages for B2B Integration

If you are using Oracle XML Gateway to create new inbound and
outbound messages, use the following guidelines to raise business
events and define event subscriptions.

A prerequisite to this process is a message map created using the XML
Gateway Message Designer.

See the Message Designer: page 2 – 2 section for instructions on how to
create a new message map and how to modify an Oracle prebuilt
message map.

Development Guidelines for Outbound Messages

1. Register the Business Event and Corresponding Event
Subscription

Register the business event and corresponding event subscription
defined in the Oracle E–Business Suite.

See: Manage Workflow Processes 6 – 65 for the instructions on
registering business events and event subscriptions.

2. Raise a Business Event in the Application

Use the Workflow function to raise business events in your
application at points indicating when a document has been created,
changed, confirmed, or deleted.  Business events may be raised in
PL/SQL code, by an existing Workflow process using the Raise
Document Delivery Event activity, or as the first activity of a new
Workflow process.

It is important to raise an event at all possible event points even
though you may not define a specific event subscription for it.  This
will allow you to define an event subscription for any event of
interest without having to modify the application code to raise the
event.

3. Define an Event Subscription

Add an event subscription for each business event of interest.  Use
the function and event activities provided in the XML Gateway
Standard Item Type to define the Workflow process associated with
the event subscription.

See: Configure Oracle Prebuilt Outbound Messages: page 6 – 59 for
the Workflow process configuration options.
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See: Manage Workflow Processes 6 – 65 for the instructions on
adding an event subscription.

There is no need to add an event subscription for business events
that you are not interested in.  These may be added at a later point
in time when the event becomes of interest to your implementation.

Development Guidelines for Inbound Messages

1. Register the Business Event and Corresponding Event
Subscription

Register the business event and corresponding event subscription
defined in the Oracle E–Business Suite.

See: Manage Workflow Processes 6 – 65 for the instructions on
registering business events and event subscriptions.

2. Setting Event Details in the Message Map

Make sure your message map includes a post process Procedure
Call action to call the Workflow function to set event details
indicating XML Gateway has successfully processed the inbound
message.

See: Procedure Call: Execute Procedure: page 2 – 108 for details
regarding the Procedure Call action.

3. Define an Event Subscription

An event subscription is required for inbound messages from
Trading Partners (B2B) regardless of whether the application is
interested in the inbound message.

Assuming your application is interested in the inbound message,
define an event subscription with a rule function and Workflow
process relevant to the business requirement.

If your application is not interested in the inbound message, define
an event subscription with the Workflow Default Rule Function
and no Workflow process.  The event subscription may be modified
when your application becomes interested in the inbound message.

See: Manage Workflow Processes 6 – 65 for the instructions on
adding an event subscription.
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Common Questions

The following are common implementation questions:

1. Is the combination of the Generate Trading Partner XML
Document and Send Document function activity valid?

No.  This combination of function activities is invalid.

The Generate Trading Partner XML Document function returns the
XML message in the Event Message attribute.  The Send Document
function gathers the data, creates the XML message, and enqueues
it onto the outbound queue.

The result of this combination of function activities is that the Send
Document function activity will complete successfully but the
Generate Trading Partner XML Document function activity will
have data in the Event Message attribute that is not sent anywhere
unless something is defined in the Out Agent attribute (associated
with the Event Subscription) which will enqueue the message.

2. Is the combination of the Generate XML Document and Send
Document function activity valid?

Same as answer 1.

3. Does the Generate Trading Partner XML Document function
activity require the Transaction Delivery Required function
activity to determine if the Trading Partner is defined to receive a
document?

Yes.  The Generate Trading Partner XML Document function
activity must be preceded by the Transaction Delivery Required
function activity.
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Oracle Transport Agent

his chapter describes the Oracle Transport Agent and includes the
following topics:

• Oracle Transport Agent Overview

• Authentication Methods

• Message Delivery Status

• OTA Protocol
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Oracle Transport Agent Overview

Oracle Transport Agent (OTA) is a transport mechanism used to send
and receive XML documents in Oracle Applications 11i.  It is a
Java–based servlet that is implemented on the OTA protocol over the
HTTP application protocol to support the following requirements:

• Guaranteed, exactly once delivery of a message over HTTP(S)

• A complete audit and history tracking of messages sent and
received

• Support outbound e–mail delivery of messages (SMTP)

• Provide message delivery status back to the Workflow process
that initiates the message creation.

• Provide built–in Application user authentication to Oracle
e–Business Suite and Oracle Exchange

Although SSL provides certificate authentication for both the client and
the server using digital certificates, the initial release of OTA supported
only server authentication, that is, the client authenticates the server by
requesting the server’s certificate.  The client would not send certificate
information to the server for authentication, and therefore the server
could not determine whether the message received came from a
legitimate sender.

This document will describe how client authentication is implemented
in the latest release of OTA.  Oracle E–Business Suite users may choose
to implement client authentication.  It is not mandatory.

In this document, the Sender refers to the ”Client” that sends a
document or requests connection.  The Receiver refers to the ”Server”
that receives the document or connection request.



7 – 3Oracle Transport Agent

Authentication Methods

There are two authentication methods supported by SSL: Server
Authentication and Client Authentication.  SSL is the layer that exists
between the raw TCP/IP protocol and the application layer.  SSL
enforces the following:

• Authentication of the server using digital certificate

• Authentication of the client using digital certificate

• Encryption of data

• Data integrity through the use of message authentication

Server Authentication

When a client connects to a Web server securely via HTTPS, the server
sends back its server certificate to the client for verification.  Once
verified, the client sends the data, encrypted, to the server.  Server
Authentication allows the client to identify the server.

Client Authentication

The server will identify the client by requesting its client certificate.  A
client certificate is a digital certificate that certifies the identity of the
client.  A client certificate binds a system name to a specific secret key.
Both the client and server certificates are issued by a Certification
Authority (CA).  Oracle E–Business Suite users can choose to support
any CA they wish.  Examples of CAs are Identris, Verisign, and
Baltimore.

Advantages of Client Authentication

Client authentication replaces the traditional username/password with
encrypted, tamper–proof, digital certificates.

Client certificates eliminate anonymity.  Every connection to the server
from a client requires a client’s certificate and a public key that verifies
the certificate.

Implementation

OTA implements client certificate authentication through a set of Java
programs.  The OTA knows the location of the server certificate, CA
certificate, private key file, and password in the environment.
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The SSL handshake begins when an SSL client connects to an SSL
server.  The SSL handshake protocol is used to authenticate the SSL
server to a client and the client to the server.  It also contains agreed
upon encryption algorithm and keys.

Sequence of Events

1. The client opens a connection and sends the ClientHello.  This
message contains the highest SSL version understood by the client,
the session ID, and the list of compression methods supported.

2. The server sends a ServerHello.  When the SSL server receives the
ClientHello, it responds with either a handshake failure alert or a
ServerHello message (SSL version used by the client, the session
ID, and the compression method chosen by the server for this
session).

3. The server sends the certificate along with the CA (who signed the
certificate) certificate chain.

4. The client verifies the server certificate with the CA certificate in
the SSL Certificate Chain File (list of CAs that the Client trusts).

5. The server requests the client certificate.  This happens only in
client Authentication mode.  It sends a certificate request to the
client.

6. The client sends its certificate along with the CA (who signed the
certificate) certificate chain.  If no certificate is available, the client
sends a no certificate alert.  It is up to the SSL server to decide what
to do if a no certificate alert is received.  The SSL server could
continue the SSL transaction with an anonymous client or could
terminate the connection by sending a data handshake failure alert.

7. The client sends a ClientKeyExchange.  The client may send a key
exchange message depending on the particular public key
algorithm.

8. The server verifies the client certificate with the CA.

9. The application data is compressed and encrypted according to the
compression method.
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Server Authentication

The Diagram above presents the following detailed steps:

1. The OTA client dequeues the message from the outbound queue.

2. The OTA client verifies the maximum retry count.

3. The OTA client constructs the HTTP message.

4. The client initiates the HTTP handshake and request for
certification with the destination server.

5. The destination Web server sends its certification.

6. The client receives and verifies the server’s certification.

7. If verified, the client starts the HTTP message head and body data
stream.

8. The server optionally verifies the user and password.

9. The server verifies the transport protocol and version.

10. The server verifies the Applications user and password.

11. The server verifies the message ID for duplicate.



7 – 6 Oracle XML Gateway User’s Guide

12. The server enqueues the message for consumption.

13. The server builds the HTTP response message.

14. The server sends the HTTP response back to the client.

15. The client reads the response and updates the status tables.  If the
response indicates the message failed, update retry count and
enqueue the message for retry.

Client Authentication

The Diagram above presents the following detailed steps:

1. The OTA client dequeues the message from the outbound queue.

2. The OTA client verifies the maximum retry count.

3. The client constructs the HTTP message.

4. The client initiates the HTTP handshake and request for
certification with the destination server.



7 – 7Oracle Transport Agent

5. The destination Web server sends its certification back to the client
server and requests client certification.

6. The client certificate authority verifies the server’s certification.

7. If verified, the client sends its client certificate.

8. The server’s certificate authority verifies the client’s certificate.

9. The client starts the HTTP message head and body data stream.

10. The server optionally verifies the Web server user and password.

11. The server verifies the transport protocol and version.

12. The server verifies the Application user and password.

13. The server verifies the message ID for duplicate.

14. The server enqueues the message for consumption.

15. The server builds the HTTP response message.

16. The server sends the HTTP response back to the client.

17. The client reads the response and updates the status tables.  If the
response indicates the message failed, update retry count and
enqueue the message for retry.

Additional Information:  OracleMetaLink note
”Understanding the Oracle Transport Agent Protocol”
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Message Delivery Status

XML Message Delivery Callback allows messaging systems (such as
Oracle Transport Agent) to report message delivery status back to the
Workflow process that initiated message creation.  If delivery fails, a
Workflow notification is sent to the System Administrator who has the
option to retry/resend or abort/ignore the process.

Use of XML Message Delivery Callback

Prior to the introduction of this feature, the common Workflow process
to send an outbound document to a Trading Partner was the Send
Document function activity as follows:

The Send Document function activity consists of message creation and
message enqueue onto the ECX_OUTBOUND queue.  If XML message
delivery fails, the entire Workflow is re–executed causing the message
creation step to be performed again unnecessarily.

With message delivery callback, the message creation is separated from
the message enqueue, so that only the message enqueue is re–executed
if the message delivery fails.  The new model consists of the Generate
Trading Partner XML Document function activity and the Workflow
Send as follows:

The Generate Trading Partner XML Document function activity is
responsible for gathering the message data.  The Workflow Send event
activity is responsible for enqueuing the message onto the
ECX_OUTBOUND queue.

The Oracle E–Business Suite application module delivers a Workflow
with the event subscription in support of outbound documents that
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follows this model.  Both models are valid.  As with any seeded event
subscription, you have the option to disable it.  For information on how
to disable a seeded event subscription, see: Manage Workflow
Processes: page 6 – 65.

There are four ways that XML Message Delivery Callback can be used.
They are summarized as follows:

Block Mode = Y

Block Mode is an attribute of the Workflow Send event activity.  A
Block Mode value of ”Y” implies that your Workflow process will
await the message delivery status before proceeding to the next activity
in the Workflow process.  If delivery fails, the Workflow Default Error
Process is executed to send a notification to the System Administrator.
The System Administrator has the option to ”Retry” the process
assuming the error was corrected, or ”Ignore” the process if the error
cannot be corrected.

• User Event Defined

The XML message generated by the XML Gateway is enqueued
onto the ECX_OUTBOUND queue.  The messaging system (such
as OTA or webMethods) dequeues the message from the
ECX_OUTBOUND queue and attempts to deliver the message to
the Trading Partner.  Any user–defined events (defined in the
Workflow Send event) will be raised and corresponding event
subscriptions will be executed.

The message delivery status is returned regardless of success or
failure.  If the delivery fails, the Workflow Default Error Process
is executed, allowing the System Administrator to retry or abort
the process.

• No User Event Defined

The XML message generated by the XML Gateway is enqueued
onto the ECX_OUTBOUND queue.  The messaging system (such
as OTA or webMethods) dequeues the message from the
ECX_OUTBOUND queue and attempts to deliver the message to
the Trading Partner.   The delivery status is returned regardless
of success or failure.  If the delivery fails, the Workflow Default
Error Process is executed, allowing the System Administrator to
retry or abort the process.
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Block Mode = N

A Block Mode value of ”N” implies that your Workflow process will
proceed to the next activity on the Workflow process without waiting
for the message delivery status.  If delivery fails, the
FYI_MESSAGE_DELIVERY_ERROR process is executed to send a
notification to the System Administrator.

The System Administrator has the option to ”Resend” the message
assuming the error was corrected or ”Ignore” the notification if no
action is required.

The (FYI) Message Delivery Error is a seeded process that is part of the
XML Gateway Error Processing Item Type.

• User Event Defined

The XML message generated by the XML Gateway is enqueued
onto the ECX_OUTBOUND queue.  The messaging system (such
as OTA or webMethods) dequeues the message from the
ECX_OUTBOUND queue and attempts to deliver the message to
the Trading Partner.  Any user–defined events (defined in the
Workflow Send event) will be raised and corresponding event
subscriptions will be executed.

If the delivery fails, the
apps.ecx.processing.message.callback event is raised.
The corresponding event subscription for the
FYI_MESSAGE_DELIVERY_ERROR process is executed
allowing the System Administrator to resend or ignore the
message notification.

• No User Event Defined

The XML message generated by the XML Gateway is enqueued
onto the ECX_OUTBOUND queue.  The messaging system (such
as OTA or webMethods) dequeues the message from the
ECX_OUTBOUND queue and attempts to deliver the message to
the Trading Partner.

If the delivery fails, the
apps.ecx.processing.message.callback event is raised.
The corresponding event subscription for the
FYI_MESSAGE_DELIVERY_ERROR process is executed
allowing the System Administrator to resend or ignore the
message notification.

For more details, see XML Gateway Error Processing Item Type: page
6 – 30.
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How Other Messaging Systems Use XML Message Delivery Callback

Other messaging systems such as webMethods and iAS can use the
XML Message Delivery Callback feature by calling the
ECX_ERRORLOG.external_system API.  The API is used by all
messaging systems (both Oracle and non–Oracle) to report message
delivery status.  The status information is written to the XML Gateway
log tables to track and report message delivery data.

For details on the API see: ECX_ERRORLOG.external_system: page
F – 5.
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OTA Protocol

Two Oracle Transport Agent servers communicate by
sending/receiving a series of name–value pairs in the HTTP Body of an
HTTP POST/RESPONSE.

Following is an example post from the sending OTA server (Note:
Header Authorization encryption follows W3C standard):

HTTP Header

   Http–Version: HTTP/1.1

   Authorization: Digest username=”myusername”,

                  realm=”testrealm@host.com”,

                  nonce=”dcd98b7102dd2f0e8b11d0f600bfb0c093”,

                  uri=”/dir/index.html”,

                  qop=auth,

                  nc=00000001,

                  cnonce=”0a4f113b”,

                  response=”6629fae49393a05397450978507c4ef1”,

                  opaque=”5ccc069c403ebaf9f0171e9517f40e41”

   Content–length: 12345

   Content–type: text/html

HTTP Body

   TRANSPORT_PROTOCOL=OXTA

   TRANSPORT_PROTOCOL_VERSION=1.0

   REQUEST_TYPE=SEND

   MESSAGE_ID=A1234567890ZZ0987654321

   MESSAGE_TYPE=XML

   MESSAGE_STANDARD=OAG

   TRANSACTION_TYPE=PO

   TRANSACTION_SUBTYPE=PROCESS

   DOCUMENT_NUMBER=12345

   PARTYID=9999

   PARTY_SITE_ID=8888

   PROTOCOL_TYPE=HTTPS–OXTA

   PROTOCOL_ADDRESS=HTTPS://www.me.com/servlets/oracle.ecx.oxta.

transportAgentServer

   USERNAME=myusername

   PASSWORD=myloginpassword

   ATTRIBUTE1=

   ATTRIBUTE2=

   ATTRIBUTE3=

   ATTRIBUTE4=

   ATTRIBUTE5=

   PAYLOAD=<xml   ... ...>

The HTTP Body contains the message envelope, message payload, and
three key transport parameters for TRANSPORT_PROTOCOL,
TRANSPORT_PROTOCOL_VERSION, and REQUEST_TYPE.
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TRANSPORT_PROTOCOL

The Transport Protocol indicates the Messaging Protocol being used to
the receiving servlet.  This will always be OTA when sent from an OTA
server.  The inbound OTA server validates that the transport_protocol
is OTA, and then sends back the appropriate response in the HTTP
response body.

TRANSPORT_PROTOCOL_VERSION

The Transport Protocol Version indicates the version of the Messaging
Protocol being used.  This value is set based on the version used by the
sending OTA server.

REQUEST_TYPE

This parameter indicates the type of request being sent from the OTA
server.  REQUEST_TYPE is not required on the inbound side.  If no
value is set, the default ”SEND” type is used. Valid values are in the
following list:

• SEND – (Default) The receiving OTA server will treat this as a
live, production message sent from the sending OTA server.

• AUTH – The receiving OTA server will treat this as a request to
test the communication.

• AUTH2 – The receiving OTA server will treat this as a request to
test the transmission of the transaction.

• EME – The receiving OTA server will receive the message and
place it on the outbound queue for delivery to the address
specified in PROTOCOL_ADDRESS.

The following is an example of an HTTP response:

HTTP Header

   HTTP/1.1 200 OK

   Server: Apache/1.2.0

   Date: Fri, 15 Jun 2002 16:20:46 GMT

   Content–Length: 567

   STATUS_CODE: 1000

   STATUS_DESCRIPTION: OK

   MESSAGE_RECEIPT_ID: A9876543210987654321

   Content–type: text/html

HTTP Body

   <HTML><BODY>

   <TABLE>

   <TR><TD>Status Code</TD><TD>1000</TD></TR>
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   <TR><TD>Status Description</TD><TD>Message Successfully

received</TD></TR>

   <TR><TD>Message Receipt ID</TD><TD>A9876543210987654321</TD>

</TR>

   </TABLE>

   </BODY></HTML>

The Oracle Transport Agent server uses standard HTTP response codes
to determine if the HTTP post (at the HTTP protocol level) was
successful.  If successful, OTA will examine the HTTP header to
determine if the OTA message was successfully delivered.

If the HTTP response is anything other than 200, OTA will assume the
post failed and will enqueue the message for retry.  The HTTP
Response body is created for information only and is not read by the
sending OTA server.  The sending OTA server uses the Status Code in
the HTTP Response header to determine the success or failure code.

If the Status Code value is 1000 (meaning success), the Message Receipt
ID in the HTTP Response body contains a unique identifier generated
by the receiving OTA server.  This completes the cycle for the
guaranteed delivery process.

If the Status Code is anything other than 1000, a failure has occurred.
Refer to Troubleshooting: page G – 19 for a list of status codes.
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Connecting to Non–OTA Servers

The OTA server includes the capability to send documents to non–OTA
servlets that do not employ the OTA messaging protocol.  When
sending a message, the OTA server initiates an HTTP post to transmit
the document.  The HTTP response from the receiving Web server
indicates whether the receiver was an OTA server.

If the HTTP response does not contain the OTA protocol response body,
the sending OTA server assumes the message was received by a
non–OTA server.  In this case, the standard HTTP response code (that
is, 200 meaning ”success”) is used to determine the success or failure of
the message.  If the sending OTA server receives an HTTP–200, the
message delivery is assumed to be successful.  It the sending OTA
server receives any other response, it is assumed the delivery failed.

Successful transmissions of documents to non–OTA servers are logged
as successfully delivered to a non–OTA server.  Delivering to a
non–OTA server has the following disadvantages:

• No guaranteed delivery

• No guaranteed once only delivery

• No message tracking available to sender

• Message ownership completely with the servlet that received the
message
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Troubleshooting

See Common Client Authentication Implementation Issues: page
G – 46.
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Web Services

his chapter discusses the implementation of Web services in the
E–Business Suite.  It contains the following topics:

• Web Services Components and Features

• Inbound and Outbound Process Flows

• Setup Steps

• Diagnostics
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Web Services

In Release 11i, any transaction supported by XML Gateway can be sent
or received as a document style Web service using the Simple Object
Access Protocol (SOAP).

A generic WSDL is used to inform trading partners how to
communicate with the E–Business Suite.  Inbound Web services must
conform to this WSDL.  Outbound Web services are also constructed
according to this WSDL and may be exchanged with any trading
partner that conforms to the E–Business Suite Web service client.

The Web services implementation in this release utilizes the SOAP
version 1.1 and Web Services Description Language (WSDL) version
1.0 standards.

Note:  These technologies are available only with Oracle9i
Application Server Release 1 (1.0.2.2), which includes Apache
SOAP.

Web Services Components and Features

Following are the components and features implemented for Web
services in this release of the Oracle E–Business Suite.

Web Services Description Language (WSDL)

One of the major components for publishing a Web service is the
WSDL.  It enables your trading partner to call your Web service
without any further details.  Partners can use any third party Web
service tools to call your service.

Typically, schema structure is defined as part of the WSDL.  In this
release, the schema structure type is defined as ”anyType”.  This allows
the Oracle E–Business Suite to accept XML documents containing any
XML structure.  XML Gateway knows the data structure to expect
based on the transaction type based on the DTD defined in the map for
the message enabled for the trading partner.

The E–Business Suite publishes the WSDL to a URL for your customers
to access.
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Simple Object Access Protocol (SOAP)

The current release of Oracle E–Business Suite supports document style
Web services.

SOAP Client (Outbound)

The SOAP client is an agent that runs on the SOAP outbound queues. It
delivers messages to the specified target URLs.  The SOAP client
performs the following functions:

• Packages profile–related data into the SOAP envelope header

• Assembles the SOAP MIME–compliant message

• Implements guaranteed delivery, retry logic on error, and
time–to–live for a transation

• Calls back to Workflow on the status of the SOAP request

• Maps various SOAP faults to SUCCESS or FAILURE conditions

• Forms SSL request with appropriate digital certificate
information

• Provides proxy support

• Logs SOAP request–related data

The SOAP header for an outbound request is defined by the trading
partner’s WSDL.  In this release only outbound requests to another
Oracle E–Business Suite implementation are supported.

Guaranteed Delivery

Delivery is guaranteed for messages exchanged between trading
partners that both recognize unique message IDs.  The Oracle
E–Business Suite leverages the AQ message ID.  This ID is guaranteed
to be the same across any database system in the world.

The message IDs are maintained in a repository on the receiving side.
Before receiving any message, it interrogates the repository for the ID.
If the message has not been received, the Web service provider receives
and commits.  If the message has already been received, it ignores the
message and sends a successful response.

The sending side reviews the response.  If it is successful, it does not
retry.  If it is a failure, it retries based on two parameters: Number of
attempts and time–to–live for a transaction.  Once both are exhausted,
the message is marked as undeliverable.  If implemented, a sent to the
Workflow.
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Soap Servlet (Inbound)

The SOAP servlet receives inbound transactions.  It is responsible for
the following:

• Authentication

The system–level User ID and Password are validated against
the FND_USER table.

• Authorization

The trading partner information is validated against the trading
partner tables.

• Message extraction

The message is enqueued and any attachments are placed in the
attachments table.

Attachments

All incoming and outgoing messages are uniquely identified by a
message ID.  Attachments related to the message are stored in the FND
tables.  For incoming Web services, the attachments are extracted by the
SOAP servlet and only references are passed on as part of the message.

For outbound Web services, the SOAP client extracts the attachment
from the FND attachments table and forms a MIME–compliant Body
part.
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Process Flows

This section describes the process flow of an inbound Web service and
an outbound Web service in the E–Business Suite.

Inbound Process Flow

All inbound messages are received through the SOAP servlet running
under the Web service provider.  Requests are authorized against the
Application Object Library user tables (fnd_user).  After authorization,
the body (XML data), header (trading partner information), and
attachments are extracted from the request.  Attachments are loaded to
the FND attachment tables.  XML messages are prepared as designated
events before being enqueued to the SOAP agent (Web Services IN
Agent).  The agent listeners pick up the message for further processing.
For any errors in the Web service provider, a notification is sent to the
Trading Partner and/or System Administrator.

Inbound Agent Listeners monitor these agents for events.  The XML
message is embedded in the event, and will execute the appropriate
business subscription.  An event will be raised for XML Gateway.
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Outbound Process Flow

XML messages are created by Workflow processes and passed to the
SOAP agent (Web Services OUT Agent).  The messages are picked up
by the SOAP client running under the Web service container of the
Generic Service Manager (GSM).  The client is responsible for the actual
delivery of the message to the trading partner.

The client examines the event or message from the queue and executes
the SOAP service.  Messages are formatted according to the required
protocol.  Attachments to the message are extracted and packaged in
the MIME format.  References to the attachments are passed
throughout the message processing.  The extraction of the attachment
data occurs as the final step before transmission of the transaction.
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Setup Steps

To enable Web service transactions, the following setup is required:

Trading Partner Setup

Inbound

No special trading partner setup is required to enable an inbound XML
message as a Document–style Web service.

For information about setting up a trading partner, see Trading Partner
Setup: page 3 – 25.

Outbound

Enable your trading partner’s transactions for Web services in the
Trading Partner Setup form by setting the Protocol Type to SOAP and
entering the Protocol Address.  The Protocol Address is the URL on
which the trading partner receives XML documents.  For the SOAP
protocol it conforms to the format:
http://<destination>/webservices/document

To exchange Web services with a trading partner, the following
information is extracted from the Trading Partner Setup form and
passed as part of the SOAP header:

• Username

• Password

• Transaction Type

• Transaction Subtype

• Message Type

Message Type must be set to ”XML”.

• Message Standard

Message Type must be set to ”OAG”.

For more information about setting up a trading partner, see Trading
Partner Setup: page 3 – 25.
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Set the ECX: XML Validate Flag

To send outbound Web services, the profile option ECX: XML Validate
Flag must be set to ”N”.  For more information about this profile
option, see Define System Profile Options: page 3 – 3.

Enable Agents and Start Agent Listeners

The following agents must be enabled and the seeded agent listener
service components must be running:

Agent Name Listener Name

WF_WS_JMS_IN Web Services IN Agent

WF_WS_JMS_OUT Web Services OUT Agent

Use the Workflow Administrator: Agents window to enable the agents
if necessary (the agents are enabled by default).  The same window can
be used to disable an agent.

Use Oracle Applications Manager to schedule and manage agent
listener service components.  For more information, refer to the Oracle
Applications Manager online help.

The agent listener components are seeded with a manual startup mode
and therefore must be manually started.

Provide the WSDL to your Trading Partner (for Inbound Transactions)

For all inbound transactions, the WSDL is published at the following
URL:

http://<IPAddress:port>/webservices/document/oracle/apps/fnd/XMLGateway?wsdl

You can also access the WSDL by selecting Generic XML Gateway
WSDL from the Workflow Administrator Web Applications
responsibility or the Workflow Administrator Web (New)
responsibility.

Configure the Secure Socket Layer (SSL)

For inbound Web Services, SSL is handled by the Apache Server and no
additional settings are required.  Outbound requires additional
settings.  The steps required depend on what level of SSL you are
enabling, Client Authentication or Server Authentication.
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For all SSL communications, digital certificates will be stored in Oracle
Wallet Manager.  The following digital certificates are required:

• Root or Intermediate certifications of all well known Certificate
Authorities

• Client Certificate

• Certificate of CA authority who signed the client certificate

• Password for accessing client certificate or the Oracle Wallet
manager.

For detailed SSL configuration steps, see ”About Oracle Workflow
Mini–pack OWF.H,” OracleMetaLink note 258312.1.
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Diagnostics

Oracle Diagnostics provides a mechanism that makes Oracle
Applications more supportable and robust by providing predefined
tests to check for key setup requirements.  Oracle XML Gateway
provides several Web Services tests through Oracle Diagnostics that
you can use to check the setup and review debugging information.

You can access Oracle Diagnostics through different user interfaces,
including Oracle Applications Manager and other administrative
consoles.  For more information, see the Oracle Applications
Supportability Guide.

The Web Services tests are available in Oracle Diagnostics under the
Application Object Library application.

Web Services Tests

Web Services Parameter Test

This test checks the values of parameters of a Web Services Client.

Web Service Round Trip Test

This diagnostic test case enqueues a sample JMS message and monitors
its status.

Web Service Class Loader Test

This diagnostic test case checks whether iAS 1.0.2.2 and Namespace
enable parser are present in the classpath.
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Map Analysis
Guidelines

efore using the Message Designer to create a new message map,
you must first perform a map analysis.  This chapter describes how to
perform a map analysis through the following topics:

• Map Analysis Procedures for Outbound Messages

• Map Analysis Procedures for Inbound Messages

• Identifying Source and Target Document Levels
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Map Analysis Overview

A map analysis is required to determine how to map data between the
Oracle E–Business Suite data model and the required message.  For
outbound messages, this requires a comparison between the Oracle
E–Business Suite database views and the Document Type Definition
(DTD) or a production XML message.

The result of the map analysis is used as input to the XML Gateway
Message Designer.  It is imperative that a complete map analysis is
done before attempting to create the message map.  The map analysis
must resolve all data gaps, identify derivation rules, identify default
values, identity data transformation and process controls via Actions,
and ensure that all required target fields are mapped.
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Map Analysis Guidelines for Outbound Messages
The steps to performing a map analysis for an outbound message are as
follows:

• Compare database views (source) to DTD (target)

• Identify application business event trigger

• Add XML Gateway required Actions to define selection criteria

• Identify source and target document levels

Map Analysis Guidelines for Outbound Messages Checklist

Use the following table as a checklist to track your progress when
analyzing an outbound message.  Details of each step are provided in
the following sections.  Use the ”Completed” column to check off the
step as it is completed.

Step Completed Description

1 CREATE WORKSHEET: Create a worksheet to identify all data.

2 SET UP SOURCE: Create database views or get database views/table defi-
nitions (source) for the required message from the database schema.

3 SET UP TARGET: Populate the target column of the worksheet with the
DTD or production XML message in the expanded format.

3A Identify the required DTD (target) elements.

3B For DTD elements with ”|” as the occurrence indicator, select one element
from the list.  Make a note of the elements not selected because these must
be removed from the message map to prevent a parser violation.

4 RELATE SOURCE ELEMENT TO TARGET ELEMENT: For each DTD
(target) element, identify the database view (source) column to map from.

4A Identify where code conversion is needed.

4B Identify Derivation Rules

4C Identify Defaulting Rules

4D Identify DTD Attribute Settings

5 CONVERT FROM ORACLE FORMAT TO OAG FORMAT: For each OAG
DTD (target) DATETIME, AMOUNT, OPERAMT, or QUANTITY element,
identify the database view/table (source) column to map from.  Other XML
standards may have similar elements.

5A Identify and map each DATETIME element.
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DescriptionCompletedStep

5B Identify and map each AMOUNT element.

5C Identify and map each OPERAMT element.

5D Identify and map each QUANTITY element.

6 ADD SIBLING FOR DUPLICATE NODES/ELEMENTS: Add Sibling
nodes and elements if needed.

7 ADD CHILD TO EXTEND DTD DEFINITION FOR FLEXFIELDS: If there
is a database view or table column that you wish to map from but no DTD
element is defined to support it, you can use the OAG’s USERAREA.  Map
data to the USERAREA (or corresponding area if using other XML stan-
dards).

8 RESOLVE DATA GAPS:  Any DTD (target) elements that have not been
mapped are data gaps.

9 IDENTIFY APPLICATION BUSINESS EVENT TRIGGER: Identify the
application business events to trigger message creation.

10 IDENTIFY REQUIRED ACTIONS: All outbound messages require the
following Actions to define the selection criteria.  Make a notation on the
worksheet to include them.

Use the Append Where Clause action to bind to transaction type, transac-
tion subtype, party ID, and party site ID to ECX_OAG_CONTROLA-
REA_TP_V (formerly ECX_OAG_CONTROLAREA_V see Note: page
2 – 35).

If using ECX_OAG_CONTROLAREA_V, use the Append Where Clause
action to bind to transaction type and transaction subtype.

Use the Append Where Clause action to bind document ID to header view
to select the document

11 IDENTIFY SOURCE AND TARGET DOCUMENT LEVELS
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Compare Database Views (Source) to DTD (Target)

Step 1 Create a Worksheet

Create a worksheet with the following columns: Target, Required
(Y/N), Source, Code Category, Derivation Rule, Default Value, and
Action, as shown in the following table:

Target Required
(Y/N)

Source Code
Category

Derivation
Rule

Default
Value

Action

Step 2 Set Up Source

Create database views or get database view and table definitions
(source) for the required message from the database schema.  Include
ECX_OAG_CONTROLAREA_V or
ECX_OAG_CONTROLAREA_TP_V (see Note: page 2 – 35) view to
map to the CNTROLAREA segment of the DTD.

Step 3 Set Up Target

Populate the target column of the worksheet with the DTD or
production XML message in the expanded format.

Note:  You may use third party software to expand the DTD or
use a production XML message.

Step 3A Identify Required Target Elements

Identify the required DTD (target) elements.  An element is required if
there is no special symbol next to the element name.

The XML occurrence indicators are:

”+” implies one or more

”*” implies zero or more

”?” implies zero or 1

”|” implies either one or the other

”,” implies all listed child elements must be used in the order
shown

Step 3B For Elements with ”|” as the occurrence indicator

For DTD elements with ”|” as the occurrence indicator, select one
element from the list.  Make a note of the elements not selected in order
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to remove them from the message map.  They must be removed from
the message map to prevent a parser violation.

Step 4 Relate Source Element to Target Element

For each DTD (target) element, identify the database view (source)
column to map from.

Note:  Use the Open Application Group’s Integration Specification
(available at http://www.openapplications.org)
Appendix C, Field Identifier Descriptions and Appendix D,
Segment Descriptions, to get detailed descriptions of each
element identified on the DTD.

Step 4A

If the DTD (target) element can be sourced from a database view
(source) column, determine if the database view column value requires
code conversion.

• If code conversion is required, identify the code category from
the list in Appendix B.

• Identify the from or to value to determine if the required values
are available in the database.  If the values are not available, they
must be be added.

Step 4B Identify Derivation Rule

If the DTD (target) element cannot be sourced from a database view
(source) column, determine if the value can be derived.  If yes, identify
the derivation rule.  The derivation rule can be, for example, a
combination of several view columns, a procedure call, or a function
call.  Make a notation that an XML Gateway Action may be required
(for example, to get a value from another column, or to combine the
values of several columns).

Refer to Appendix C. for a list of XML Gateway supported Actions.

Determine if the derived value requires code conversion.  If code
conversion is required, identify the code category from the list in
Appendix B.

Attention:  Identify the from or to value to determine if the
required values are available in the database.  If the values are
not available, they must be added.

Step 4C Identify Defaulting Rule

If the DTD (target) element cannot be sourced from a database view
(source) column or derived, determine if the value can be defaulted.  If
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yes, identify the default value.  The default value can be a literal or
based on a value from another database view column.  Make a notation
that an XML Gateway Action may be required.

The default value can be set directly in the map using the Message
Designer or as an XML Gateway Action if the default value is based on
a condition.

Refer to Transaction Map – Actions: page 2 – 72 for a list of XML
Gateway supported Actions.

Determine if the default value requires code conversion.  If code
conversion is required, identify the code category from the list in
Appendix B.

Attention:  Identify the from or to value to determine if the
required values are available in the database.  If the values are
not available, they must to be added.

Step 4D Identify DTD Attribute Setting

For each DTD (target) element containing attributes (lower case tags),
determine the appropriate setting by checking the usage of the
database view or table column and then identifying a valid setting for
the attribute by reviewing the options in OAG’s Appendix D that lists
Segment Descriptions for the DTD element.  The appropriate attribute
setting is set directly in the target definition as a default value using the
Message Designer.

For example, if a view column is used for creation date, the DATETIME
”qualifier” attribute value of ”CREATION” will be set as the default
value using the Message Designer.

Step 5 Convert from Oracle Format to OAG Format

For each DTD (target) DATETIME, AMOUNT, OPERAMT, or
QUANTITY element, identify the database view or table (source)
column to map from.

Oracle E–Business Suite represents date, amount, operating amount,
and quantity in a single database column.  OAG represents these as a
collection of data.  Oracle XML Gateway provides an Action to convert
the Oracle representation to the OAG representation.  Make a notation
that this column requires an Action for ”Convert to OAG” that will be
defined using the Message Designer.



A – 8 Oracle XML Gateway User’s Guide

Step 5A

• For the DATETIME element, identify the database view or table
(source) column for the date.

• Follow Step 4D to set the ”qualifier,” ”type,” and ”index”
attributes

• All other OAG fields are set by the ”Convert to OAG” Action
based on the date value.

• TIMEZONE is defaulted to Greenwich Mean Time (GMT).

Note:  OAG DATETIME is made up of the following attributes
and elements: qualifier, type, index, YEAR, MONTH, DAY,
HOUR, MINUTE, SECOND, SUBSECOND, TIMEZONE.

Step 5B

• For the AMOUNT element, identify database view or table
(source) columns for currency code and debit/credit flag if
available.  The XML Gateway ”Convert to OAG” Action can be
defined to use the view or table column values or default to
OAG recommended values if the view or table columns are not
available.

• Follow Step 4D to set the ”qualifier,” ”type,” and ”index”
attributes.

• The OAG fields for NUMOFDEC and SIGN are set by the
”Convert to OAG” Action based on the amount value.

Note:  OAG AMOUNT is made up of the following attributes
and elements: qualifier, type, index, VALUE, NUMOFDEC,
SIGN, CURRENCY, DRCR.

Step 5C

• For the OPERAMT fields, identify database view or table
(source) columns for currency and unit of measure code if
available.  The XML Gateway ”Convert to OAG” Action can be
defined to use the view or table column values or default to
OAG recommended values if the view or table columns are not
available.

• Follow Step 4D to set the ”qualifier” and ”type” attributes.

• The OAG fields for NUMOFDEC, SIGN, UOMVALUE, and
UOMNUMDEC are set by the ”Convert to OAG” Action based
on the operating amount value.

Note:  OAG OPERAMT is made up of the following attributes
and elements: qualifier, type, VALUE, NUMOFDEC, SIGN,
CURRENCY, UOMVALUE, UOMNUMDEC, UOM.
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Step 5D

For the QUANTITY element, identify database view or table (source)
column for the unit of measure code if available. The XML Gateway
”Convert to OAG” Action can be defined to use the view or table
column value or default to the OAG recommended value if the view or
table column is not available.

Follow Step 4D to set the ”qualifier” attribute.

The OAG fields for NUMOFDEC and SIGN are set by the ”Convert to
OAG” Action based on the quantity value.

Note:  OAG QUANTITY is made up of the following attributes
and elements: qualifier, VALUE, NUMOFDEC, SIGN, UOM.

Step 6 Add Sibling for Duplicate Nodes/Elements

A DTD defines a single occurrence of a node or element.  If you have
multiple occurrences from the database view or table (source) to map
from, make a notation on your worksheet showing the duplicate node
or element and then map the element and attributes of the duplicate
node or element.  Make a notation to ADD SIBLING using the Message
Designer.

An example is the DTD element for PARTNER used to map SHIP–TO,
BILL–TO, and REMIT–TO from the Oracle E–Business Suite.  You will
need to add two PARTNER sibling nodes (same hierarchy level) to map
BILL–TO and REMIT–TO.

Step 7  Add Child to Extend DTD Definition for Flexfields

If there is a database view or table column you wish to map from but
no DTD element is defined to support it, you can use the USERAREA.
You can add a USERAREA as a sibling (same hierarchy level) of
another USERAREA or extend an existing USERAREA by adding a
child (next level of hierarchy) element and then mapping the element.
Make a notation to ADD CHILD using the Message Designer.

This approach is necessary to support all the flexfields included in the
database views and tables.  Since we do not know which flexfields are
implemented at a user’s site, all flexfields must be mapped.

Refer to How to Extend DTDs: page 2 – 117 for details.

Note:  The only updates allowed for a DTD are to the
USERAREA.  Any other changes will invalidate the DTD.

Step 8  Resolve Data Gaps

At this point, you have identified database view and table (source)
columns for as many DTD (target) elements as possible.  Any required
DTD (target) element that has not been mapped represents a data gap.
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Consider resolving the data gap using an application flexfield that is
included in the database view or table.  If this is a valid option, you
must implement the designated flexfield by defining and populating it
in the Oracle E–Business Suite.  Consider carefully which flexfield to
implement as you do not want to overwrite a flexfield implemented by
the user.

Consider resolving the data gap using an application column not
included in the database view.  If this is a valid option, you must
modify the database view to include the application column as
opposed to referencing the table and column directly.  Load the
modified database view into the database schema.  Remember to map
the field.

If neither of the above considerations resolves the data gap, then you
must add functionality to your application module, create new
database views, load the new views into the database schema, and then
create the message map.

Step 9  Identify Application Event Trigger

Identify the application business events to trigger message creation.
The common trigger points are when the document is created,
confirmed, updated, or deleted.

Use the Oracle Workflow Business Event System to register the
business event to define the corresponding event subscription to create
and send the message.

See: Integrating Oracle XML Gateway with Oracle Workflow Business
Event System: page 6 – 2 for details on how to register and subscribe to
application business events.

Step 10  Identify Required Actions

All outbound messages require the following Actions to identify the
selection criteria.  Make a notation on your worksheet to include them.

• If you are using ECX_OAG_CONTROLAREA_TP_V use the
Append Where Clause action to bind transaction type,
transaction subtype, party ID, and party site ID

If you are using ECX_OAG_CONTROLAREA_V use the Append
Where Clause action to bind transaction type and transaction
subtype

Note:  The ECX_OAG_CONTROLAREA_TP_V view is an
upgraded version of the ECX_OAG_CONTROLAREA_V view.
Oracle XML Gateway supports both versions of the database
view.  The more information see the Note: page 2 – 35.



A – 11Map Analysis Guidelines

• Use the Append Where Clause action to bind document ID to
the header view to select the document

Step 11  Identify Source and Target Document Levels

See: Identifying Source and Target Document Levels: page A – 21.
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Map Analysis Guidelines for Inbound Messages
The map analysis process for inbound messages consists of the
following steps:

• Compare DTD (source) to Application Open Interface tables
(target)

• Add XML Gateway required Actions

• Add XML Gateway optional Actions

• Identify source and target document levels

Map Analysis Guidelines for Inbound Messages Checklist

Use the following table as a checklist to track your progress when
analyzing an inbound message.  Details of each step are provided in the
following sections.  Use the ”Completed” column to enter completion
data or to check off the step when completed.

Step Completed Description

1 CREATE WORKSHEET: Create a worksheet to identify all data.

2 SET UP SOURCE: Get the DTD (source) for the required message or use a
production XML message.

3 SET UP TARGET: Populate the target column of the worksheet with the
Application Open Interface table definitions or Application API parameter
list.

3A Identify the required Application Open Interface (target) table columns or
Application API parameters.

4 RELATE SOURCE ELEMENT TO TARGET ELEMENT: For each Applica-
tion Open Interface (target) table column, identify the DTD (source) ele-
ment to map from.

4A Identify where code conversion is needed.

4B Identify Derivation Rules

4C Identify Defaulting Rules

5 CONVERT FROM OAG FORMAT TO ORACLE FORMAT: For each OAG
DTD (source) DATETIME, AMOUNT, OPERAMT, or QUANTITY element,
identify the Application Open Interface (target) column or Application API
parameter to map to.  Other XML standards may have similar elements.

5A Identify and map each DATETIME element.

5B Identify and map each AMOUNT element.
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DescriptionCompletedStep

5C Identify and map each OPERAMT element.

5D Identify and map each QUANTITY element.

6 ADD SIBLING FOR DUPLICATE NODES/ELEMENTS: Add Siblings
nodes/elements if needed.

7 REVIEW DTD USERAREA: Review all OAG’s USERAREA definitions
and determine whether they should be mapped to the Application Open
Interface table column or Application API parameter.  Other XML stan-
dards may have similar elements.

8 RESOLVE DATA GAPS: The DTD (source) elements for as many Applica-
tion Open Interface (target) table columns or Application API parameters
have been identified, and identify any data gaps.

9 OPTIONAL Actions: For Application products that use Application Open
Interface tables to stage incoming data and utilize an Application Open
Interface API to validate the staged data

Use Insert to Database Table action to insert data into Application Open
Interface tables

Use Procedure Call action to execute Application Open Interface API

For Application products that use application APIs that combine staging
tables and the validation API.

Use Procedure Call action and map source (DTD) data to the Application
API parameter list.

10 REQUIRED ACTION: Add root–level, post–process action to raise busi-
ness event indicating inbound process is complete.

Add Procedure Call action for ECX_STANDARD.setEventDetails.  See
setEventDetails: page F – 7 in the API Appendix.

11 IDENTIFY SOURCE AND TARGET DOCUMENT LEVELS.

Compare Database Views (Source) to DTD (Target)

Step 1 Create a Worksheet

Create a worksheet with the following columns: Target, Required
(Y/N), Source, Code Category, Derivation Rule, Default Value, and
Action, as shown in the following table:
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Target Required
(Y/N)

Source Code
Category

Derivation
Rule

Default
Value

Action

Step 2 Set Up Source

Get the DTD (source) for the required message or use a production
XML message.

Include the the Field Identifier and Segment Descriptions, from the
Open Applications Group Integration Specification Appendixes C and D,
respectively.

Note:  You may use third party software to expand the DTD or
use a production XML message.

Step 3 Set Up Target

Populate the target column of the worksheet with the Application Open
Interface table definitions or Application API parameter list.

Note:  You may use third party software to expand the DTD or
use a production XML message.

Step 3A Identify Required Target Elements

Identify the required Application Open Interface (target) table columns
or Application API parameter list as follows:

• NOT NULL columns defined in the data model

• Application Open Interface API or Application API code to
enforce required columns that are not defined as NOT NULL

• Open Interface or Application API documentation (for the
product) identifying the required columns and associated
derivation and defaulting rules.

Step 4 Relate Source Element to Target Element

For each Application Open Interface (target) table column, identify the
DTD (source) element to map from.

Note:  Use the Open Applications Group Integration Specification
Appendix C (Field Identifier Descriptions) and D (Segment
Descriptions) to get detailed descriptions of each element
identified on the DTD.
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If the target column is for an internal ID, you must resolve this using a
derivation or defaulting rule as outlined in steps 4B and 4C below.  The
sender cannot send an ID as they do not know what the valid internal
IDs are.  XML Gateway provides derivation actions to derive address
and organization ID.

DTD attributes (lowercase tags) are not stored in the Oracle E–Business
Suite, and therefore are not mapped.  However, the value of the
attribute can be used to determine the exact Application Open Interface
table column or Application API parameter to map to.

Step 4A

If the Application Open Interface (target) table column can be sourced
from a DTD (source) element, determine if the DTD (source) element
value requires code conversion so the resulting value is meaningful to
the Oracle E–Business Suite.

If code conversion is required, identify the code category from the list
in Appendix B.

Identify the from/to value to determine if the required values are
available in the database you are using.  If the values are not available,
they must be added.

Step 4B Identify Derivation Rule

If the Application Open Interface (target) table column cannot be
sourced from a DTD (source) element, determine if it can be derived.
Refer to your product’s Application Open Interface documentation for
any predefined derivation rules.  If a derivation rule is defined, make
sure the incoming message provides the data to support the derivation
rule because the Application Open Interface API will use the data to
derive the value for the target column.  Make a notation of the
derivation rule on your worksheet so that you can verify this during
unit testing.

If no derivation rule is defined, you can define one.  The derivation rule
can be based on several DTD elements or some default values.  Make a
notation of the derivation rule on your worksheet.  Make a notation
that an Action may be required.

Refer to Transaction Map – Actions: page 2 – 72 for a list of XML
Gateway supported Actions.

Determine if the derivation rule (element or literal) requires code
conversion for the trading partner.  If code conversion is required,
identify the code category from the list in Appendix B.
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Identify the from/to value to determine if the required values are
available in the database.  If the values are not available, they must be
added.

Step 4C Identify Defaulting Rule

If the Application Open Interface (target) table column cannot be
sourced from a DTD (source) element or derived, determine if it can be
defaulted.  Refer to your product’s Application Open Interface
documentation for any predefined defaulting rules.  If a defaulting rule
is defined, make sure the incoming message provides the data to
support the defaulting rule.  The Application Open Interface API will
use the data as the default value for the target column.  Make a
notation of the defaulting rule on your worksheet so that you can verify
this during unit testing.

If no defaulting rule is defined, you can define one.  The default value
may be set directly in the target definition using the Message Designer
or as an XML Gateway Action if the default value is based on a
condition.  See Appendix C – XML Gateway Supported Actions.

Determine if the defaulting rule (element or literal) requires code
conversion for the trading partner.  If code conversion is required,
identify the code category from the list in Appendix B.

Identify the from/to value to determine if the required values are
available in the database.  If the values are not available, they must be
added.

Step 5 Convert from OAG Format to Oracle Format

For each DTD (source) DATETIME, AMOUNT, OPERAMT, or
QUANTITY element, identify the Application Open Interface (target)
column or Application API parameter to map to.

Oracle E–Business Suite represents date, amount, operating amount,
and quantity in a single database column.  OAG represents these as a
collection of data.  Oracle XML Gateway provides an Action to convert
the OAG representation to the Oracle representation.  Make a notation
that this column requires an Action for ”Convert from OAG” that will
be defined using the Message Designer.

Step 5A

For the DATETIME element, identify the Application Open Interface
(target) table column for date.

Values for attributes ”qualifier,” ”type,” and ”index” are not mapped
because the meaning is implied in the Application Open Interface table
column for date.
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Note:  OAG DATETIME is made up of the following attributes
and elements: qualifier, type, index, YEAR, MONTH, DAY,
HOUR, MINUTE, SECOND, SUBSECOND, TIMEZONE.

Step 5B

For the AMOUNT element, identify the Application Open Interface
(target) table columns for currency code and debit/credit flag if
available.  The XML Gateway ”Convert from OAG” Action can be
defined to store the OAG currency code and debit/credit flag in the
columns identified, or ignored if the columns are not available.

Values for attributes ”qualifier,” ”type,” and ”index” are not mapped
because the meaning is implied in the Application Open Interface table
column.

Values for NUMOFDEC and SIGN are implied in the Oracle
representation of the amount value.  The values are not mapped unless
your application supports it.  If so, you will need to map them using
the Message Designer.

Note:  OAG AMOUNT is made up of the following elements
and attributes: qualifier, type, index, VALUE, NUMOFDEC,
SIGN, CURRENCY, DRCR.

Step 5C

For the OPERAMT element, identify the Application Open Interface
(target) table columns for the currency code and unit of measure code if
available.  The XML Gateway ”Convert from OAG” Action can be
defined to store the OAG currency code and unit of measure code in
the columns identified, or ignored if the columns are not available.

Values for attributes ”qualifier” and ”type” are not mapped because the
meaning is implied in the Application Open Interface table column.

Values for NUMOFDEC, SIGN, UOMVALUE, and UOMNUMDEC are
implied in the Oracle representation of the operating amount value.
The values are not mapped unless your application supports it.  If so,
you will need to map them using the Message Designer.

Note:  OAG OPERAMT is made up of the following attributes
and elements: qualifier, type, VALUE, NUMOFDEC, SIGN,
CURRENCY, UOMVALUE, UOMNUMDEC, UOM.

Step 5D

For the QUANTITY element, identify the Application Open Interface
(target) table column for the unit of measure code if available. The XML
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Gateway ”Convert from OAG” Action can be defined to store the OAG
unit of measure code in the column identified, or ignored if the column
is not available.

The value for the ”qualifier” attribute is not mapped because the
meaning is implied in the Application Open Interface table column.

Values for NUMOFDEC and SIGN are implied in the Oracle
representation of the quantity value.  The values are not mapped unless
your application supports it.  If so, you will need to map them using
the Message Designer.

Note:  OAG QUANTITY is made up of the following attributes
and elements: qualifier, VALUE, NUMOFDEC, SIGN, UOM.

Step 6 Add Sibling for Duplicate Nodes/Elements

A DTD defines a single occurrence of an element, but additional
occurrences can be added during message implementation to
accommodate the business data.  Map the duplicate node to the
appropriate Application Open Interface table columns.

An example is the DTD element for PARTNER used to identify the
trading party.  If the Application Open Interface requires a SHIP–TO,
BILL–TO, and REMIT–TO, then two PARTNER sibling nodes (same
hierarchy level) were added to the original DTD to accommodate the
BILL–TO and REMIT–TO.  Map these entities to the appropriate
Application Open Interface table columns.

Step 7 Review DTD USERAREA

Consider that the original DTD may have been extended to support
additional data required by the message.  Review all USERAREA
definitions and determine whether they should be mapped to the
Application Open Interface table column or to an Application API
parameter.

For outbound messages, all application flexfields were mapped to
USERAREA fields.  If the outbound message is being processed as an
inbound message to another Oracle application module, the values
may be meaningful.  If so, they must be mapped to Application Open
Interface table columns or Application API parameters.

Step 8  Resolve Data Gaps

At this point, you have identified DTD (source) elements for as many
Application Open Interface (target) table columns or Application API
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parameters as possible.  Any required Application Open Interface
(target) table column or Application API parameter that has not been
mapped represents a data gap.

• If the required column is an internal ID, you must resolve this
using a derivation or defaulting rule as described in Steps 4B and
4C, or use the Derive Address ID or Derive Parent ID actions.

• Consider resolving the data gaps by extending the DTD to
include the required data.  You can extend the DTD by adding
sibling (same hierarchy level) or child (next level hierarchy)
USERAREA elements or by adding new elements to an existing
USERAREA.  Refer to How to Extend DTDs: page 2 – 117 for
information on how to define these.

• Consider creating new Application Open Interface tables and
associated API.  If this is a valid option, create and load the new
table definitions into the database schema and create the
message map.

Note:  The only updates allowed for a DTD are to the
USERAREA.  Any other changes will invalidate the DTD.

Step 9  Optional Actions

For Application products that use Application Open Interface tables to
stage incoming data and utilize an Application Open Interface API to
validate the staged data:

• Use the Insert to Database Table action to insert data into
Application Open Interface tables.

• Use the Procedure Call action to execute Application Open
Interface API.

For Application products that use application APIs that combine the
staging tables and the validation API:

• Use the Procedure Call action and map source (DTD) data to the
Application API parameter list.  Refer to How to Map to an API:
page 2 – 120 for additional instructions.

Step 10  Required Action

Add root–level, post–process action to raise business event indicating
inbound process is complete.

Add Procedure Call action for ECX_STANDARD.setEventDetails.  See
setEventDetails: page F – 7 in the API Appendix.
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Step 11  Identify Source and Target Document Levels

See Identify Source and Target Document Levels: page A – 21.
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Identifying Source and Target Document Levels
After completing the map analysis, identify the document levels for
both the source and target data.

A document level represents a collection of data that repeats.  For the
Application Open Interface tables or database views, each table
represents a document level.  A level is the parent in a parent–child
relationship.

DTDs do not use document levels because the levels are implied based
on usage.  Refer to the tree diagram in the OAG definitions to get a
sense of how the data is grouped.  The tree diagram will also give you
an idea of where additional occurrences of a datatype may be required.

Once you have identified the document levels for the source and target,
proceed to relate the source data structure to the target data structure.
This task is straightforward if the number of data levels in the source
and target are identical, but can be difficult if the numbers are different.
If the number of levels of the source is greater than the target number,
you must collapse levels.  If the number of levels of the source is less
than the target number, you must expand levels.

Collapsing Levels

Collapsing levels is the mapping of multiple source levels to the same
target level.  For example, if your source is 3 levels and your target is 2
levels you can collapse the levels as shown in the following figure:

Correct Way to Collapse Levels Incorrect Way to Collapse Levels

In the correct example above, the result of collapsing levels is that the
data in Source Levels 2 and 3 are consolidated and mapped to Target
Level 2.  If there are two rows in Source Level 2 and three rows in
Source Level 3, a total of six rows will be created in Target Level 2.
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The incorrect example shows the collapsing of Source Levels 1 and 3 to
Target Level 1, causing Source Level 3 to cross over Target Level 2.

Another option is to relate Source Levels 1 and 2 to Target Level 1 and
relate Source Level 3 to Target Level 2, as shown in the correct example
below.  (Do not map Source Level 3 to Target Level 1, crossing over
Target Level 2.)

Correct Way to Collapse Levels Incorrect Way to Collapse Levels

Whichever option you choose, consider what it means to promote
lower level detail data to a higher level.  The source data may need to
be aggregated to be meaningful at the higher level.

Expanding Levels

Expanding levels is the mapping of one source level to multiple target
levels.  For example, if your source is 2 levels and your target is 3 levels
you can expand the levels as shown in the following figure:

Correct Way to Expand Levels Incorrect Way to Expand Levels
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The result of expanding levels, as shown in the correct example above,
is that the data in Source Level 2 is distributed and mapped to Target
Levels 2 and 3.  If there are two rows in Source Level 2, two rows will
be created in Target Level 2 and Target Level 3.

Do not expand Source Levels across Target Levels, as shown in the
incorrect example above.  Source Level 1 is incorrectly expanded to
Target Levels 1 and 3, crossing over Target Level 2.

Another option, as shown in the correct example below, is to distribute
Source Level 1 to Target Levels 1 and 2 and map Source Level 2 to
Target level 3.  (Do not map Source Level 1 to Target Levels 1 and 3,
crossing over Target level 2, as shown in the incorrect example.)

Correct Way to Expand Levels Incorrect Way to Expand Levels

Whichever option you choose, consider what it means to demote data
from a higher level to a lower level of detail.  The source data may need
to be deaggregated to be meaningful at the lower level.

Level Expansion for Discontinuous Nodes

Level expansion is supported if the target expanded levels are all
siblings of each other or if they are all children of the previous node.

Example of Valid Level Expansion
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In the example above, Target Level 2 and Target Level 3 are siblings to
each other and children of Target Level 1.

Example of Invalid Level Expansion

In the example of invalid level expansion above, Target Level 2 and
Target Level 3 are siblings to each other and children of Target Level 1.
Target Level 4 is a sibling of Target Level 1, with no relationship to
Target Levels 2 and 3.

See Discontinuous Nodes: page 2 – 55 for more information on
discontinuous nodes.

Another way to accommodate the data structure mismatch is to
collapse or expand the database views or Application Open Interface
tables and use the modified database views or application open
interface table definitions to create the message map.

The resulting hierarchy mapping is defined using the Message Designer
Level Mapping Tab.
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Recommending DTD Additions or Changes to OAG

Oracle is a member of the Open Application Group’s standards
committee chartered with developing industry–independent XML
standards.  This group meets periodically to review recommendations
and is responsible for publishing standards changes and additions.

During the map analysis process, you may discover that the needed
fields are not represented in a DTD or that a needed DTD is not
supported by OAG.

Whether you are recommending the creation of a brand new Business
Object Document (BOD) and Document Type Definition (DTD) or
additions or changes to an existing DTD, please present your
recommendation in the OAG format and be prepared to identify the
business case and justification.  If you are making a recommendation to
add or change an existing DTD, identify the DTD and version you are
using.  Please make sure your proposed DTD or DTD changes supports
both the Application–to–Application (A2A) and Business–to–Business
(B2B) scenarios.

If you would like Oracle to submit the request to OAG for you, enter an
enhancement request.  We will make the proposals to the OAG
committee and report back to you.  If you want to present your case
directly to OAG, please let us know and we will include you in the
meeting.
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Special Considerations for Custom Messages

Once a document is extracted from the Oracle E–Business Suite,
consider updating the application tables to indicate the document has
been extracted.  This may require adding columns to the appropriate
tables.  This may be important to the Oracle E–Business Suite for
document status reporting or to manage the supply and demand data.

Updating the Oracle E–Business Suite application tables was necessary
in the EDI world to prevent a document from being extracted more
than once.  In the XML Gateway model, documents are extracted based
on an event trigger in the Oracle E–Business Suite (as the documents
are created) as opposed to batch processing used in the EDI model.

For inbound messages, consider adding calls to application procedures
(as an Action) to link the Application Open Interface API process to the
downstream process.
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XML Gateway Seeded
Code Categories

his appendix provides you with a description of the seeded code
categories.
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XML Gateway Seeded Code Categories

The XML Gateway seeded code categories and their descriptions are
shown in the following table:

Category Code Description

ACTION_CODE Action Code (such as Add/Change/Delete)

AC_HANDL Allowance and Charge Handling Code

AC_SPEC_CHARGES Allowance and Charge Special Charges

AC_SPEC_SERVICES Allowance and Charge Special Services

AETC_REASON AETC Reason Code

AETC_RESPONSIBILITY AETC Responsibility Code

AGREEMENT Agreement Code

ALLOW_CHARGES_INDICATOR Allowance or Charge Indicator Code

ALLOW_METHOD_HANDLING Allowance or Charge Method of Handling Code

BARCODE Bar Code

BUYER_ITEM Buyer Item

CARRIER_CODE Freight Carrier Code

CHARGE_ALLOW_QUALIFIER Allowance or Charge Qualifier Code

CHARGE_TYPE Charge Type Code

COMMODITY_COD_QUALIFIER Commodity Code Qualifier Code

COMPANY_CODE Company Code

CONTAINER_CODE Container Code

CONTAINER_TYPE Container Type Code

COUNTRY Country Code

CURRENCY Currency

CURRENCY_CODE Currency Code

CURRENCY_CONV_TYPE Currency Conversion Type Code

CUSTOMER_BANK_ACCOUNT Customer Bank Account Code

CUSTOMER_BANK_ACCOUNT_TYPE Customer Bank Account Type Code
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DescriptionCategory Code

CUSTOMER_BANK_BRANCH Customer Bank Branch Code

CUSTOMER_BANK_BRANCH_ID Customer Bank Branch ID

CUSTOMER_BANK_BRANCH_TYPE Customer Bank Branch Type Code

CUSTOMER_BANK_LOCATION Customer Bank Location Code

CUSTOMER_BANK_ORG Customer Bank Org Code

CUSTOMER_BANK_SITE Customer Bank Site Code

CUSTOMER_CODE Customer Code

CUSTOMER_ITEM Customer Item

CUSTOMER_LOCATION_CODE Customer Location Code

CUSTOMER_NAME Customer Name

CUSTOMER_NUMBER Customer Number

CUSTOMER_ORG Customer Org Code

CUSTOMER_SITE Customer Site Code

CUSTOMER_SITE_ORG Customer Site Organization Code

DATE_TIME_QUALIFIER Date/Time Qualifier Code

DATE_TYPE Date Type Code

DESTINATION_CLASS Destination Class Code

DETAIL_SUBTYPE Detail Subtype Code

DETAIL_TYPE Detail Type Code

DOC_HANDLING_CODE Document Handling Code

DOC_PURPOSE_CODE Document Purpose Code

DOC_STATUS Document Status Code

DOC_SUBTYPE Document Subtype

DOC_TYPE Document Type

EAN European Article Number (EAN)

EQUIPMENT_CODE Equipment Code
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DescriptionCategory Code

EQUIPMENT_DESC Equipment Description Code

EXCESS_TRANS_REASON_CODE Excess Transportation Reason Code

EXCESS_TRANS_RESPONSIBILITY Excess Transportation Responsibility Code

EXPORT_DETAIL Export Detail Code

EXPORT_HEADER Export Header Code

FOB Freight Code

FOB_PAYMENT FOB Payment Code

FOB_POINT FOB Point Code

FREIGHT_TERMS Freight Terms Code

HAZ_CERTIFICATION Hazardous Certification Code

HAZ_CLASS Hazard Class Code

HAZ_MATERIAL Hazardous Material Code

HAZ_MATL_CODE_QUAL Hazardous Material Code Qualifier

HAZ_MATL_SHIPMENT_INFO_QUAL Hazardous Shipment Info Qualifier

INTL_DOMESTIC_CODE International/Domestic Code

INT_LOC_LOCATION_CODE Internal Location Code

INT_LOC_ORG Internal Location Org Code

INT_LOC_SITE Internal Location Site Code

INVENTORY_ITEM Inventory Item

INVOICE_TYPE Invoice Type Code

ISBN_CODE International Standard Book Number Code

ITEM_CATEGORY Item Category Code

ITEM_QUALIFIER Item Qualifier Code

ITEM_TYPE Item Type Code

LABEL_NAME Label Name Code

LADING_DESC_QUALIFIER Lading Description Qualifier
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DescriptionCategory Code

METHOD_OF_PAYMENT Method of Payment Code

NETWORKS Network Code

PACKAGING_CODE Packaging Code

PACKAGING_FROM Packaging From Code

PACK_CODE Pack Code

PAYMENT_FORMAT Payment Format Code

PAYMENT_METHOD Payment Method Code

PAYMENT_TERMS Payment Terms Code

PAYMENT_TYPE Payment Type Code

PRICE_BASIS Price Basis Code

PRICE_IDENTIFIER Price Identifier Code

PROVINCE Province Code

PURCHASE_ORDER_TYPE Purchase Order Type Code

QUALIFIER Qualifier Code

QUANTITY_TYPE Quantity Type Code

RATING CATEGORY Rating Category Code

RECORD_TYPE Record Type Code

REFERENCE_CODE Reference Code

REFERENCE_ID Reference ID

REGION1 Region 1 Code

REGION2 Region 2 Code

REGION3 Region 3 Code

SALES_ORDER_TYPE Sales Order Type Code

SCHEDULE_PURPOSE Schedule Purpose Code

SCHEDULE_TYPE Schedule Type Code

SEGMENT_DESC Segment Description Code
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DescriptionCategory Code

SERVICE_LEVEL Service Level Code

SHIPMENT_METHOD_PAYMENT Shipment Method of Payment Code

SHIPMENT_PRIORITY Shipment Priority Code

SHIPMENT_QUALIFIER Shipment Qualifier Code

SHIPMENT_STATUS Shipment Status Code

SHIP_DELIV_PATTERN Shipment Delivery Pattern Code

SITE_QUALIFIER Site Qualifier Code

SPECIAL_CHARGE_ALLOWANCE Special Charge or Allowance Code

SPECIAL_HANDLING Special Handling Code

SPECIAL_SERVICES Special Services Code

STATE State Code

SUPPLIER_BANK_ACCOUNT Supplier Bank Account Code

SUPPLIER_BANK_ACCOUNT_TYPE Supplier Bank Account Type Code

SUPPLIER_BANK_BRANCH Supplier Bank Branch Code

SUPPLIER_BANK_BRANCH_ID Supplier Bank Branch ID Code

SUPPLIER_BANK_BRANCH_TYPE Supplier Bank Branch Type Code

SUPPLIER_BANK_LOCATION Supplier Bank Location Code

SUPPLIER_BANK_ORG Supplier Bank Org Code

SUPPLIER_BANK_SITE Supplier Bank Site Code

SUPPLIER_CODE Supplier Code

SUPPLIER_ITEM Supplier Item Code

SUPPLIER_LOCATION_CODE Supplier Location Code (such as EDI Location Code)

SUPPLIER_NAME Supplier Name Code

SUPPLIER_NUMBER Supplier Number Code

SUPPLIER_ORG Supplier Organization Code

SUPPLIER_SCHEDULING_DESCRIPTOR Supplier Scheduling Descriptor Code
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DescriptionCategory Code

SUPPLIER_SITE Supplier Site Code

SUPPLIER_SITE_ORG Supplier Site Organization Code

TAX_CODE Tax Code

TAX_EXEMPT Tax Exempt Code

TAX_EXEMPT_REASON Tax Exempt Reason Code

TAX_JURISDICTION Tax Jurisdiction Code

TAX_NAME Tax Name Code

TERMS Terms Code

TERMS_BASIS_DATE_CODE Terms Basis Date Code

TERMS DUE DATE QUALIFIER Terms Due Date Qualifier

TERMS_TYPE Terms Type Code

TERRITORY Territory Code

TRADING_PARTNER Trading Partner Code

TRANSPORTATION_TERMS Transportation Terms Code

TRANSPORTATION_TERMS_QUALIFIER Transportation Terms Qualifier Code

UNIT_PRICE_BASIS Basis of Unit Price Code

UOM Unit of Measure Code

UPC Uniform Product Code (UPC) Code

VESSEL_REQUIREMENT Vessel Requirement Code

WAREHOUSE_CODE Warehouse Code

WAREHOUSE_LOCATION_CODE Warehouse Location Code

WAREHOUSE_NAME Warehouse Name Code

WAREHOUSE_NUMBER Warehouse Number Code

WAREHOUSE_ORG Warehouse Organization Code

WAREHOUSE_SITE Warehouse Site Code
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DescriptionCategory Code

WAREHOUSE_SITE_ORG Warehouse Site Organization

WAYBILL REQUEST Waybill Request Code
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XML Gateway
Supported Actions

his appendix provides a summary of the supported actions.
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XML Gateway Supported Actions

The following table lists the XML Gateway supported Actions.  For the
map analysis process, identify the required Action. For detailed
descriptions of each Action and instructions on how to define an
Action see Transaction Map –Actions: page 2 – 72.

Action Category Action Description

Assignments Assign variable value
Create global value

Database Functions Assign next sequence value
Append where clause
Insert into database table

Derivations Derive Address ID from Location Code
Derive Parent ID from Location Code

Function Call Execute function and assign function return value

Math Functions Add
Divide
Multiply
Subtract

OAG Standard Conversions Convert Oracle date to OAG date format
Convert Oracle operating amount to OAG operating
amount format
Convert Oracle quantity to OAG quantity format
Convert Oracle amount to OAG amount format
Convert OAG date to Oracle date format
Convert OAG operating amount to Oracle operating
amount
Convert OAG quantity to Oracle quantity format
Convert OAG amount to Oracle amount format

Other Exit program

Predefined Variable Get predefined variable value:
Code Conversion Return Status for (a specific
element)
Internal Control Number
Return Code
Return Message
Receiver Trading Partner ID
Sender Trading Partner ID
Organization ID

Procedure Call Execute procedure with send and return parameters

Return Error Message Send error message to trading partner or XML Gateway
system administrator contact
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Action DescriptionAction Category

String Functions Perform Concatenate
Perform Substring

XSLT Transformation Execute procedure to perform XSLT

Each ACTION may be based on a condition.   A condition consists of
two operands stated as a literal value or a variable.  If a condition is
defined, the ACTION is executed if the condition result is true. The
condition operators supported by XML Gateway are listed in the
following table:

Operator Description

null Null

not null Not Null

= Equal

!= Not Equal

< Less Than

> Greater Than

<= Less Than or Equal To

>= Greater Than or Equal To

Note:  Do not attempt to perform date comparisons unless
your dates are stated as Julian dates. Use database functions to
compare dates instead.



C – 4 Oracle XML Gateway User’s Guide



A P P E N D I X

D
T

D – 1XML Gateway Naming Conventions

XML Gateway Naming
Conventions

his appendix summarizes the XML Gateway naming conventions.
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XML Gateway Naming Conventions Summary

There are several areas where naming conventions are defined to
facilitate recognition of data.  They are:

Message Designer

• Message Map Names

See Specify a Map Name: page 2 – 25.

• Data Definition Names

See Select/Create a Source/Target Data Definition: page 2 – 27.

• XGM File Names

See Transaction Map – Element Mapping: page 2 – 68.

Setup Forms

• Transaction Type and Transaction Subtype

See Define Transactions Form: page 3 – 13.

• External Transaction Type and External Transaction Subtype

See Define Transactions Form: page 3 – 13.

Processing

• Business Events

See Integrating Oracle XML Gateway with Oracle Workflow
Business Event System: page 6 – 2.
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XML Gateway Valid
Time Zone Values

his appendix lists the valid time zone values for the profile option
ECX: Server Time Zone.
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XML Gateway Valid Time Zone Values

Listed in the tables below are the valid values for the Applications
profile option ECX: Server Time Zone.  One of the following values
must be entered exactly, or the time zone will default to Greenwich
Mean Time (GMT).

The values are organized by geographical region.  Select the region/city
that corresponds to the time zone in which your database server is
running.

For outbound transactions, the date and time data retrieved from the
database, along with the time zone specified in the profile option, are
used to determine the GMT deviation.  The deviation is used in the
XML message generated by the XML Gateway.  No conversion is
performed.

For inbound transactions, if the time zone of the incoming message is
different from the time zone specified in the profile option, the
incoming date and time will be converted.

The time zone values are categorized as follows:

• Africa: page E – 3

• America: page E – 5

• Antarctica: page E – 8

• Asia: page E – 9

• Atlantic: page E – 12

• Australia: page E – 13

• Europe: page E – 14

• Indian: page E – 16

• Pacific: page E – 17
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Time Zone Values: Africa

Time Zone Values: Africa

Africa/Abidjan

Africa/Accra

Africa/Addis_Ababa

Africa/Algiers

Africa/Asmera

Africa/Bangui

Africa/Banjul

Africa/Bissau

Africa/Blantyre

Africa/Bujumbura

Africa/Cairo

Africa/Casablanca

Africa/Conakry

Africa/Dakar

Africa/Dar_es_Salaam

Africa/Djibouti

Africa/Douala

Africa/Freetown

Africa/Gaborone

Africa/Harare

Africa/Johannesburg

Africa/Kampala

Africa/Khartoum

Africa/Kigali

Africa/Kinshasa

Africa/Lagos

Africa/Libreville
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Time Zone Values: Africa

Africa/Lome

Africa/Luanda

Africa/Lubumbashi

Africa/Lusaka

Africa/Malabo

Africa/Maputo

Africa/Maseru

Africa/Mbabane

Africa/Mogadishu

Africa/Monrovia

Africa/Nairobi

Africa/Ndjamena

Africa/Niamey

Africa/Nouakchott

Africa/Ouagadougou

Africa/Porto–Novo

Africa/Sao_Tome

Africa/Timbuktu

Africa/Tripoli

Africa/Tunis

Africa/Windhoek
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Time Zone Values: America

Time Zone Values: America

America/Adak

America/Anchorage

America/Anguilla

America/Antigua

America/Aruba

America/Asuncion

America/Barbados

America/Belize

America/Bogota

America/Buenos_Aires

America/Caracas

America/Cayenne

America/Cayman

America/Chicago

America/Costa_Rica

America/Cuiaba

America/Curacao

America/Dawson_Creek

America/Denver

America/Dominica

America/Edmonton

America/El_Salvador

America/Fortaleza

America/Godthab

America/Grand_Turk

America/Grenada

America/Guadeloupe
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Time Zone Values: America

America/Guatemala

America/Guayaquil

America/Guyana

America/Halifax

America/Havana

America/Indianapolis

America/Jamaica

America/La_Paz

America/Lima

America/Los_Angeles

America/Managua

America/Manaus

America/Martinique

America/Mazatlan

America/Mexico_City

America/Miquelon

America/Montevideo

America/Montreal

America/Montserrat

America/Nassau

America/New_York

America/Noronha

America/Panama

America/Paramaribo

America/Phoenix

America/Port_of_Spain

America/Port–au–Prince

America/Porto_Acre
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Time Zone Values: America

America/Puerto_Rico

America/Regina

America/Santiago

America/Santo_Domingo

America/Sao_Paulo

America/Scoresbysund

America/St_Johns

America/St_Kitts

America/St_Lucia

America/St_Thomas

America/St_Vincent

America/Tegucigalpa

America/Thule

America/Tijuana

America/Tortola

America/Vancouver

America/Winnipeg
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Time Zone Values: Antarctica

Time Zone Values: Antarctica

Antarctica/Casey

Antarctica/DumontDUrville

Antarctica/Mawson

Antarctica/McMurdo

Antarctica/Palmer
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Time Zone Values: Asia

Time Zone Values: Asia

Asia/Aden

Asia/Alma–Ata

Asia/Amman

Asia/Anadyr

Asia/Aqtau

Asia/Aqtobe

Asia/Ashkhabad

Asia/Baghdad

Asia/Bahrain

Asia/Baku

Asia/Bangkok

Asia/Beirut

Asia/Bishkek

Asia/Brunei

Asia/Calcutta

Asia/Colombo

Asia/Dacca

Asia/Damascus

Asia/Dubai

Asia/Dushanbe

Asia/Hong_Kong

Asia/Irkutsk

Asia/Ishigaki

Asia/Jakarta

Asia/Jayapura

Asia/Jerusalem

Asia/Kabul
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Time Zone Values: Asia

Asia/Kamchatka

Asia/Karachi

Asia/Katmandu

Asia/Krasnoyarsk

Asia/Kuala_Lumpur

Asia/Kuwait

Asia/Macao

Asia/Magadan

Asia/Manila

Asia/Muscat

Asia/Nicosia

Asia/Novosibirsk

Asia/Phnom_Penh

Asia/Pyongyang

Asia/Qatar

Asia/Rangoon

Asia/Riyadh

Asia/Saigon

Asia/Seoul

Asia/Shanghai

Asia/Singapore

Asia/Taipei

Asia/Tashkent

Asia/Tbilisi

Asia/Tehran

Asia/Thimbu

Asia/Tokyo

Asia/Ujung_Pandang
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Time Zone Values: Asia

Asia/Ulan_Bator

Asia/Vientiane

Asia/Vladivostok

Asia/Yakutsk

Asia/Yekaterinburg

Asia/Yerevan
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Time Zone Values: Atlantic

Time Zone Values: Atlantic

Atlantic/Azores

Atlantic/Bermuda

Atlantic/Canary

Atlantic/Cape_Verde

Atlantic/Faeroe

Atlantic/Jan_Mayen

Atlantic/Reykjavik

Atlantic/South_Georgia

Atlantic/St_Helena

Atlantic/Stanley
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Time Zone Values: Australia

Time Zone Values: Australia

Australia/Adelaide

Australia/Brisbane

Australia/Darwin

Australia/Lord_Howe

Australia/Perth

Australia/Sydney
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Time Zone Values: Europe

Time Zone Values: Europe

Europe/Amsterdam

Europe/Andorra

Europe/Athens

Europe/Belgrade

Europe/Berlin

Europe/Brussels

Europe/Bucharest

Europe/Budapest

Europe/Chisinau

Europe/Copenhagen

Europe/Dublin

Europe/Gibraltar

Europe/Helsinki

Europe/Istanbul

Europe/Kaliningrad

Europe/Kiev

Europe/Lisbon

Europe/London

Europe/Luxembourg

Europe/Madrid

Europe/Malta

Europe/Minsk

Europe/Monaco

Europe/Moscow

Europe/Oslo

Europe/Paris

Europe/Prague
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Time Zone Values: Europe

Europe/Riga

Europe/Rome

Europe/Samara

Europe/Simferopol

Europe/Sofia

Europe/Stockholm

Europe/Tallinn

Europe/Tirane

Europe/Vaduz

Europe/Vienna

Europe/Vilnius

Europe/Warsaw

Europe/Zurich
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Time Zone Values: Indian

Time Zone Values: Indian

Indian/Antananarivo

Indian/Chagos

Indian/Christmas

Indian/Cocos

Indian/Comoro

Indian/Kerguelen

Indian/Mahe

Indian/Maldives

Indian/Mauritius

Indian/Mayotte

Indian/Reunion
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Time Zone Values: Pacific

Time Zone Values: Pacific

Pacific/Apia

Pacific/Auckland

Pacific/Chatham

Pacific/Easter

Pacific/Efate

Pacific/Enderbury

Pacific/Fakaofo

Pacific/Fiji

Pacific/Funafuti

Pacific/Galapagos

Pacific/Gambier

Pacific/Guadalcanal

Pacific/Guam

Pacific/Honolulu

Pacific/Kiritimati

Pacific/Kosrae

Pacific/Majuro

Pacific/Marquesas

Pacific/Nauru

Pacific/Niue

Pacific/Norfolk

Pacific/Noumea

Pacific/Pago_Pago

Pacific/Palau

Pacific/Pitcairn

Pacific/Ponape

Pacific/Port_Moresby
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Time Zone Values: Pacific

Pacific/Rarotonga

Pacific/Saipan

Pacific/Tahiti

Pacific/Tarawa

Pacific/Tongatapu

Pacific/Truk

Pacific/Wake

Pacific/Wallis
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XML Gateway APIs

he Oracle XML Gateway provides APIs for use with the Message
Designer and for use by the execution engine.  This appendix
documents these APIs and is divided into the following sections:

• Execution engine–level APIs: page F – 2

• Message Designer APIs: page F – 6
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Execution Engine APIs

The following APIs are for use with the execution engine:

Package: ECX_STANDARD: page F – 3

perform_xslt_transformation: page F – 3

Package: ECX_ERRORLOG: page F – 5

external_system: page F – 5



PL/SQL Syntax

Description

Arguments (input)
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APIs Defined in ECX_STANDARD

perform_xslt_transformation

procedure perform_xslt_transformation

(i_xml_file in out clob,

 i_xslt_file_name in varchar2,

 i_xslt_file_ver in number,

 i_xslt_application_code in varchar2,

 i_dtd_file_name in varchar2 default null,

 i_dtd_root_element in varchar2 default null,

 i_dtd_version in varchar2 default null,

 i_retcode out pls_integer,

 i_retmsg out varchar2);

Used to apply a style sheet to an XML message and return the
transformed XML messaged for further processing by the calling
environment.

The DTD file name, version, and root element are required input
parameters for this API, therefore the associated DTDs must be loaded
into the XML Gateway repository.  Refer to Loading and Deleting a
DTD: page 2 – 122 for details on loading a DTD.

This API is independent of the Message Designer: XSLT Transformation
action.  This API is not intended for use in a message map.

Note:  The profile option ECX_XML_VALIDATE_FLAG must
be set to”Y”for this action to be performed.  For more
information on this profile option, see Define System Profile
Options: page 3 – 3.

The XML message to be transformed.

The XSLT style sheet file to be used for the
transformation.

The version of the XSLT style sheet file.  The
highest version with the same file name and
application code is used if no version number is
provided.

The name of the subdirectory where the XSLT style
sheet is source–controlled (for example:
ar/xml/xslt).

i_xml_file

i_xslt_file_name

i_xslt_file_ver

i_xslt_application
_code
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The name of the DTD used in the XML message.

The root element of the DTD used in the XML
message.

Version of the DTD used in the XML message.

The transformed XML message.

Return code for the procedure.

Return message for the procedure.

i_dtd_file_name

i_dtd_root_element

i_dtd_version

i_xml_file

i_retcode

i_retmsg
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Arguments (output)
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APIs Defined in ECX_ERRORLOG

external_system

procedure external_system

(i_outmsgid in raw,

 i_status in pls_integer,

 i_errmsg in varchar2,

 i_timestamp in date,

 o_ret_code out pls_integer,

 o_ret_msg out varchar2);

 Used by both Oracle and non–Oracle messaging systems to report
delivery status.  The status information is written to the XML Gateway
log tables to track and report transaction delivery data.

Message ID maintained by the XML Gateway
execution engine for the outbound message
delivered by the messaging system.

Message delivery status as reported by the
messaging system.

Error messages reported by the messaging system.

Time stamp from the messaging system indicating
when it processed the outbound message created
by XML Gateway.

Return code for the procedure

Return message for the procedure

i_outmsgid

i_status

i_errmsg

i_timestamp

o_ret_code

o_ret_msg
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Message Designer APIs

XML Gateway has provided special purpose procedures and functions
for use in the Message Designer to perform the following tasks:

1. Set event details to raise a business event for inbound transactions

2. Get event details using the event name maintained by the XML
Gateway Execution Engine

3. Perform string manipulations

4. Get Trading Partner information using the sender’s or receiver’s
Trading Partner ID maintained by the XML Gateway Execution
Engine

5. Get message envelope data for inbound message

6. Get delivery data for outbound message

7. Get document logging information for a business document

8. Set message delivery status

9. Get System Administrator e–mail address from ECX: System
Administrator Email Address system profile

10. Get sender logical ID from ECX_OAG_LOGICALID system profile

11. Set Error Exit

Use the Message Designer, Procedure Call or Function Call actions to
initiate the APIs.

Attention:  With the exception of
ECX_ERRORLOG.external_system, the procedures and
functions in this appendix are meant for use in the Message
Designer only and should not be used in any other context.

Most procedures include input and output arguments.  You can map a
source or target variable to the input arguments.  The output
arguments can be used in conjunction with the Send Error Message
action for warnings or the
ECX_ACTIONS.set_error_exit_program API for serious errors to
send a notification.  The notification may be sent to the Trading Partner
contact, the system administrator (identified in the ECX: System
Administrator Email Address system profile), or both.

If the successful completion of an API is critical to the success of your
transaction, you may wish to use the Exit Program action to terminate
the transaction if the API fails to process completely.

Package: ECX_CONDITIONS: page F – 14
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APIs Defined in ECX_STANDARD

setEventDetails

procedure setEventDetails

(eventname in varchar2,

 eventkey in varchar2,

 parameter1 in varchar2,

 parameter2 in varchar2,

 parameter3 in varchar2,

 parameter4 in varchar2,

 parameter5 in varchar2,

 parameter6 in varchar2,

 parameter7 in varchar2,

 parameter8 in varchar2,

 parameter9 in varchar2,

 parameter10 in varchar2,

 retcode out pls_integer,

 retmsg out varchar2);

Sets event details to raise a business event for inbound transactions.

This is defined at the root level as a post–process action to indicate that
an inbound message has been processed.  Any event subscription
defined in the Oracle e–Business Suite interested in this inbound
message will proceed to consume it.

This procedure must be used for all inbound transactions.  The
argument values vary by transaction with the exception of the
confirmation message where the argument values are specific.  See
How to Implement an OAG Confirmation BoD: page 4 – 16 to see how
the event details are defined.

Unique identifier for the business event associated
with the inbound message.  The event name
consists of the following components:

ORACLE.APPS.<COMPONENT>.<TASK>.<EVENT>

where:

COMPONENT is based on the internal transaction
type entered using the Define Transactions
window.  It represents the product short code.

eventname



Arguments (output)

PL/SQL Syntax

Description

Arguments (input)

Arguments (output)
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TASK is based on the internal transaction subtype
entered using the Define Transactions window.  It
represents a description of the object.

EVENT is a literal that describes the business
function of the message.

Following is an example of an Event Name that
identifies a confirmation event associated with an
outbound purchase order
ORACLE.APPS.PO.POO.CONFIRM

Unique identifier for the business document from
the Oracle e–Business Suite associated with the
business event.

User–defined parameters to pass data of interest to
the event subscription defined in the Oracle
e–Business Suite for the inbound business
document.

Return code for the procedure.

Return message for the procedure.

getEventDetails

procedure getEventDetails
(eventname out varchar2,

 eventkey out varchar2,

 itemtype out varchar2,

 itemkey out varchar2,

 parentitemtype out varchar2,

 parentitemkey out varchar2,

 retcode out pls_integer,

 retmsg out varchar2);

Gets event details using the event name maintained by the XML
Gateway Execution Engine.

None.

Event name passed internally to the procedure.  It
is a unique identifier for the business event
associated with the transaction.

eventkey

parameter1
through
parameter10

retcode

retmsg

eventname
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Event key associated with the event name passed.

Unique identifier for a group of objects that share
the same set of item attributes (also known as
variables).

Item types are created using the Workflow Builder
and are used by Oracle e–Business Suite
application modules to group related functions.

Unique identifier for an item in an item type

Parent item type for the item type

Parent item key for the item key

Return code for the procedure

Return message for the procedure

getEventSystem

procedure getEventSystem

(from_agent out varchar2,

 to_agent out varchar2,

 from_system out varchar2,

 to_system out varchar2,

 retcode out pls_integer,

 retmsg out varchar2);

Gets event details related to the system and agent using the event name
maintained by the XML Gateway Execution Engine.

The procedure is context–sensitive, so you will receive return values
relevant to the context.  The ”from” parameters are for inbound
transactions.  The ”to” parameters are for outbound transactions.

None

Workflow agent (queue) the inbound message is
dequeued from.

Workflow agent (queue) the outbound message is
enqueued to.

System processing the inbound message

eventkey

itemtype

itemkey

parentitemtype

parentitemkey

retcode

retmsg

from_agent

to_agent

from_system
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System processing the outbound message

Return code for the procedure

Return code for the message

getReferenceID

function getReferenceID

return out varchar2;

Returns the value associated with the REFERENCEID element of the
OAG CONTROLAREA.  The field contains a concatenated value
consisting of system name, event name, and event key delimited by ”:”.
This procedure is used for message maps in which the OAG standard is
not used.

For message maps created using the OAG standard, the
ECX_OAG_CONTROLAREA_TP_V view is used to retrieve the
reference_id identified by the business event.  This value is used to
map to the OAG CNTROLAREA, REFERENCEID element.

None.

to_system

retcode

retmsg
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APIs Defined in ECX_DOCUMENT

get_delivery_attribs

procedure get_delivery_attribs

(transaction_type in varchar2,

 transaction_subtype in varchar2,

 party_id in varchar2,

 party_site_id in varchar2,

 party_type in/out varchar2,

 standard_type out varchar2,

 standard_code out varchar2,

 ext_type out varchar2,

 ext_subtype out varchar2,

 source_code out varchar2,

 destination_code out varchar2,

 destination_type out varchar2,

 destination_address out varchar2,

 username out varchar2,

 password out varchar2,

 map_code out varchar2,

 queue_name out varchar2,

 tp_header_id out pls_integer,

 retcode out pls_integer,

 retmsg out vachar2);

Gets setup data using the internal transaction type, subtype, party id,
party_type, and party site id.  The data is required to process an
outbound transaction.

Internal transaction type passed to the procedure.
The internal transaction type is entered using the
Define Transactions window.

Internal transaction subtype passed to the
procedure.  The internal transaction subtype is
entered using the Define Transactions window.

Trading partner ID passed to the procedure.  Party
site ID will be used if Party ID is null.  The trading
partner ID is entered using the Define Trading
Partners window.

transaction_type

transaction_subtype

party_id



Arguments (output)
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Trading partner site ID passed to the procedure.
The trading partner site ID is entered using the
Define Trading Partners window.

Party type associated with the trading partner and
trading partner site passed to the procedure.  Party
type is entered using the Define Trading Partners
window.

Party type associated with the trading partner and
trading partner site passed to the procedure.  Party
type is entered using the Define Trading Partners
window.

The XML standard type associated with the
transaction passed to the procedure.  Standard type
is entered using the Define XML Standards
window.

The standard code (for example, OAG) associated
with the transaction passed to the procedure.
Standard code is entered using the Define XML
Standards window.

External transaction type associated with the
internal transaction type passed to the procedure.
External transaction type is entered using the
Define Transactions window.

External transaction subtype associated with the
internal transaction subtype passed to the
procedure.  External transaction subtype is entered
using the Define Transactions window.

Source location code associated with the trading
partner and trading partner site passed to the
procedure.  Source location code is entered using
the Define Trading Partners window.

Destination location code associated with the
trading partner and trading partner site passed to
the procedure.  Destination location code is entered
using the Define Trading Partners window.

Destination location type associated with the
trading partner and trading partner site passed to
the procedure.  Destination location type is entered
using the Define Trading Partners window.

party_site_id

party_type

party_type

standard_type

standard_code

ext_type

ext_subtype

source_code

destination_code

destination_type
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Destination address associated with the trading
partner and trading partner site passed to the
procedure.  Destination address is entered using
the Define Trading Partners window.

Username associated with the trading partner and
trading partner site passed to the procedure.
Username is entered using the Define Trading
Partners window.

Password associated with the username for the
trading partner and trading partner site passed to
the procedure.  The password is returned in
encrypted format.  Password is entered using the
Define Trading Partners window.

Message map associated with the trading partner
and transaction passed to the procedure.  The map
code is entered using the Define Trading Partners
window.

Queue name associated with the transaction
passed to the procedure.  The queue name is
entered using the Define Transactions window.

System–generated identifier for the trading partner
passed to the procedure, entered using the Define
Trading Partners window

Return code for the procedure

Return message for the procedure

destination_address

username

password

map_code

queue_name

tp_header_id

retcode

retmsg
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APIs Defined in ECX_CONDITIONS

getLengthForString

procedure getLengthForString

(i_string in varchar2);

 i_length out pls_integer);

Determines the length of the string passed to it.  This procedure may be
used in conjunction with the getPositionInString procedure or the
Perform Substring action.

The input string.

The length of the input string.

getPositionInString

procedure getPositionInString

(i_string in varchar2,

 i_search_string in varchar2,

 i_start_position in pls_integer, default null,

 i_occurrence in pls_integer, default null,

 i_position out pls_integer);

Parses a concatenated string with delimiters into its individual
components.  The i_search_string parameter identifies the
delimiter.  The i_occurrence parameter identifies which occurrence
of the delimiter to check for.  The return value of the procedure is the
position of the first character of the portion of the string you are
interested in.

This procedure can be used in conjunction with the getLengthForString
procedure or the Perform Substring action.

The input string.

i_string

i_length

i_string
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The delimiter used in the concatenated string.

The character position to begin parsing from.

The occurrence of the delimiter to search for.

The character position of the first character of the
portion of the input string you are interested in.

getSubString

procedure getSubString

(i_string in varchar2,

 i_start_position in pls_integer, default 0,

 i_length in pls_integer, default 0,

 i_substr out varchar2);

Parses a string passed to it given the start position and the length of the
substring.

This procedure is used when the length of the substring is maintained
in a variable whereas the Perform Substring action is used if the length
of the string is a literal value.

The input string.

The character position to begin parsing from.

Length from start position of input string to
include in resulting substring.

The substring.

i_search_string

i_start_position

i_occurrence

i_position

i_string

i_start_position

i_length

i_substr
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APIs Defined in ECX_TRADING_PARTNER_PVT

get_receivers_tp_info

procedure get_receivers_tp_info

(p_party_id out number,

 p_party_site_id out number,

 p_org_id out pls_integer,

 p_admin_email out varchar2,

 retcode out pls_integer,

 retmsg out varchar2);

Gets Trading Partner data using the receiver’s trading partner ID
maintained by the XML Gateway Execution Engine.  The Trading
Partner data is entered using the Define Trading Partners window.

None

Trading Partner ID

Site associated with the Trading Partner.

Organization associated with the Trading Partner
site.

E–mail address associated with the Trading Partner
contact.

Return code for the procedure

Return message for the procedure

get_senders_tp_info

procedure get_senders_tp_info

(p_party_id out number,

 p_party_site_id out number,

 p_org_id out pls_integer,

 p_admin_email out varchar2,

 retcode out pls_integer,

 retmsg out varchar2);

p_party_id

p_party_site_id

p_org_id

p_admin_email

retcode

retmsg
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Gets Trading Partner data using the sender’s trading partner ID
maintained by the XML Gateway Execution Engine.  The Trading
Partner data is entered using the Define Trading Partners window.

None

Trading Partner ID

Site associated with the Trading Partner.

Organization associated with the Trading Partner
site.

E–mail address associated with the Trading Partner
contact.

Return code for the procedure

Return message for the procedure

get_sysadmin_email

procedure get_sysadmin_email

(email_address out varchar2,

 retcode out pls_integer,

 errmsg out varchar2);

Gets the system administrator e–mail address defined for the ECX:
System Administrator Email Address profile option.

This procedure is not required if your are using the Send Error Message
action to send notifications to the system administrator.  The address
for the system administrator is derived.

None

E–mail address identified in the ECX: System
Administrator Email Address system profile.

Return code for the procedure

Return message for the procedure

p_party_id

p_party_site_id

p_org_id

p_admin_email

retcode

retmsg

email_address

retcode

errmsg
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getEnvelopeInformation

procedure getEnvelopeInformation

(i_internal_control_number in pls_integer,

 i_message_type out varchar2,

 i_message_standard out varchar2,

 i_transaction_type out varchar2,

 i_transaction_subtype out varchar2,

 i_document_number out varchar2,

 i_party_id out varchar2,

 i_party_site_id out varchar2,

 i_protocol_type out varchar2,

 i_protocol_address out varchar2,

 i_username out varchar2,

 i_password out varchar2,

 i_attribute1 out varchar2,

 i_attribute2 out varchar2,

 i_attribute3 out varchar2,

 i_attribute4 out varchar2,

 i_attribute5 out varchar2,

 retcode out pls_integer,

 retmsg out varchar2);

Retrieves  message envelope data using the internal control number
maintained by the XML Gateway Execution Engine.

See XML Gateway Envelope: page 4 – 7 for information regarding the
message envelope.

Internal control number maintained by the XML
Gateway execution engine associated with the
inbound message.

The message type is defaulted to ”XML”

The XML standard used for the business document
received from the Trading Partner.

The XML standard is entered using the Define
XML Standards window and used in the Define
Transactions window.

External transaction type associated with the
business document received from the Trading
Partner.

i_internal_control
_number

i_message_type

i_message_standard

i_transaction_type
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The external transaction type is entered using the
Define Transactions window and is used in the
Define Trading Partners window.

External transaction subtype associated with the
business document received from the Trading
Partner.

The external transaction subtype is entered using
the Define Transactions window and is used in the
Define Trading Partners window.

Unique identifier for the business document
received from the Trading Partner.  This field is not
used by XML Gateway but is available for the
Oracle e–Business Suite receiving application
module.

Not Used.

The source Trading Partner Location Code entered
using the Define Trading Partners window if no
data is found in the Destination Trading Partner
Location Code.

The transmission method entered using the Define
Trading Partners window.

The address/URL associated with the transmission
method.  It is entered using the Define Trading
Partners window.

The username entered using the Define Trading
Partners window.

The password associated with the username.
Entered using the Define Trading Partners window.

User–defined field to pass data.

User–defined field to pass data.

Data in this field will trigger the creation of another
XML message that is sent to the Trading Partner
identified in the Destination Trading Partner
Location Code field entered using the Define
Trading Partners window.

User–defined field to pass data.

User–defined field to pass data.

Return code for the procedure

i_transaction_
subtype

i_document_
number

i_party_id

i_party_site_id

i_protocol_type

i_protocol_address

i_username

i_password

i_attribute1

i_attribute2

i_attribute3

i_attribute4

i_attribute5

retcode
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Return message for the procedure

getOAGLOGICALID

function getOAGLOGICALID

return varchar2;

Gets the sender’s logical ID defined for the ECX_OAG_LOGICALID
system profile.

The value defined in the ECX_OAG_LOGICALID system profile is
retrieved by the ECX_OAG_CONTROLAREA_TP_V view.  The value
is used to map to the OAG CNTROLAREA, LOGICALID element.

This function is not required if you are using the
ECX_OAG_CONTROLAREA_TP_V view.

None

None

retmsg
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APIs Defined in ECX_ERRORLOG

getDoclogDetails

procedure getDoclogDetails

(i_msgid in raw,

 i_message_type out varchar2,

 i_message_standard out varchar2,

 i_transaction_type out varchar2,

 i_transaction_subtype out varchar2,

 i_document_number out varchar2,

 i_party_id out varchar2,

 i_party_site_id out varchar2,

 i_protocol_type out varchar2,

 i_protocol_address out varchar2,

 i_username out varchar2,

 i_password out varchar2,

 i_attribute1 out varchar2,

 i_attribute2 out varchar2,

 i_attribute3 out varchar2,

 i_attribute4 out varchar2,

 i_attribute5 out varchar2,

 i_logfile out varchar2,

 i_internal_control_number out number,

 i_status out varchar2,

 i_time_stamp out date,

 i_direction out varchar2,

 retcode out pls_integer,

 retmsg out varchar2);

Gets information about transactions processed by XML Gateway.  An
entry is written to the ECX_DOCLOGS table for each outbound
message created by XML Gateway and each inbound message
processed by XML Gateway.

Error recovery is performed using the stored copy of a message.  For
details regarding error recovery, see XML Gateway Error Processing
Item Type: page 6 – 6.

Message identifier provided by the XML Gateway
execution engine for each message processed.

i_msgid
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The message type is defaulted to ”XML”

The XML standard associated with the business
document as entered using the Define XML
Standards window and used by the Define Trading
Partners window.

External transaction type associated with the
business document as entered using the Define
Transactions window and used by the Define
Trading Partners window.

External transaction subtype associated with the
business document as entered using the Define
Transactions window and used by the Define
Trading Partners window.

Unique identifier from the Oracle e–Business Suite
for the outbound business document.

Unique identifier for an inbound business
document received from the Trading Partner.

Trading Partner identifier associated with the
business document as entered using the Define
Trading Partners window.

Trading Partner site identifier associated with the
business document as entered using the Define
Trading Partners window.

Communication method associated with the
business document as entered using the Define
Trading Partners window.

Address/URL associated with the communication
method as entered using the Define Trading
Partners window.

The username associated with the Trading Partner
as entered using the Define Trading Partners
window.

The password associated with the username as
entered using the Define Trading Partners window.

User–defined field to pass data.

User–defined field to pass data.

The Destination Trading Partner Location Code as
entered using the Define Trading Partners window.

i_message_type

i_message_standard

i_transaction_type

i_transaction_
subtype

i_document_
number

i_party_id

i_party_site_id

i_protocol_type

i_protocol_address

i_username

i_password

i_attribute1

i_attribute2

i_attribute3



F – 23XML Gateway APIs

User–defined field to pass data.

User–defined field to pass data.

Identifies the name of the log file created by the
XML Gateway execution engine for the business
document processed.  The log files are written to
the directory identified in the ECX: Log File Path
system profile.

The unique identifier as defined by the XML
Gateway execution engine for each business
document processed.

The status of the business document processed.

Time stamp from the XML Gateway execution
engine representing when the outbound business
document was created or when the inbound
business document was processed.

Identifies whether the business document was
outbound from the Oracle e–Business Suite or
inbound into the Oracle e–Business Suite.

Return code for the function.

Return message for the function.

i_attribute4

i_attribute5

i_logfile

i_internal_control
_number

i_status

i_time_stamp

i_direction

retcode

retmsg
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APIs Defined in ECX_ACTIONS

set_error_exit_program

procedure set_error_exit_program

(i_err_type in pls_integer,

 i_err_code in pls_integer,

 i_err_msg in varchar2);

Sets the error code and message so that a notification can be sent to
either the Trading Partner contact, the System Administrator (identified
in the ECX: System Administrator Email Address system profile), or
both.

The Send Error Message action is used for warnings that do not require
the process to be terminated.  This procedure is used for serious errors
where you intend to terminate the process.

For more details regarding the Send Error Message action, see Map
Action Editor – Return Error Message: Send Error Message: page
2 – 112.

A code to identify the intended recipient of the
error notification.  The valid values are as follows:

10 = Reporting error, do not send notification

20 = Send notification to the Trading Partner
contact containing the error code and message

25 = Send notification to both the Trading Partner
and System Administrator contact containing the
error code and message

30 = Send notification to the System Administrator
contact containing the error code and message

Code for error detected

Message string for errors detected.  Multiple
messages may be concatenated into this variable
and sent in the notification.

i_err_type

i_err_code

i_err_msg
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APIs Defined in ECX_ATTACHMENT

register_attachment

procedure register_attachment

(i_entity_name in varchar2,

 i_pk1_value in varchar2,

 i_pk2_value in varchar2,

 i_pk3_value in varchar2,

 i_pk4_value in varchar2,

 i_pk5_value in varchar2,

 i_file_id in number,

 i_data_type in number,

 x_cid out varchar2);

Called by message maps for outbound documents to register the
correlation of attachment(s) to an outbound business document.

This API assumes the attachment has been defined in the Oracle
Foundation module.  The required input to the API are values returned
when the attachment was deposited in FND.

Entity name from the FND_LOBS table used to
compose the x_cid value.

Key value from the FND_LOBS table used to
compose the x_cid value.

Key value from the FND_LOBS table used to
compose the x_cid value.

Key value from the FND_LOBS table used to
compose the x_cid value.

Key value from the FND_LOBS table used to
compose the x_cid value.

Key value from the FND_LOBS table used to
compose the x_cid value.

File identifier from the FND_LOBS table used to
determine the file_name value from the
FND_LOBS table.  The file_name is used to
compose the x_cid value.

i_entity_name

i_pk1_value

i_pk2_value

i_pk3_value

i_pk4_value

i_pk5_value

i_file_id
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Identifies the data type of the attachment file.  The
valid value is BLOB.  Currently, only the
ecx_attachment.embedded_lob_data_type
value is supported (only

A unique identifier for the attachment within a
given outbound document provided by FND when
the attachment was deposited.

The value is constructed using the
formulate_content_id API by concatenating
i_entity_name, i_pk1_value, i_pk2_value,
i_pk3_value, i_pk4_value, i_pk5_value (which are
provided as input to this API), and then adding the
file_name (based on the file_id) from the
FND_LOBS table.

Note:  register_attachment is an overloaded API.  The second
signature is documented below. The difference between the two
APIs is that the first uses the key values from the FND_LOBS
table to uniquely identify the attachment; and the second uses a
user–defined identifier.

procedure register_attachment

(i_cid in varchar2,

 i_file_id in number,

 i_data_type in number);

A unique identifier for the attachment provided by
the user when the attachment was defined in FND.

File identifier from the FND_LOBS table.

Identifies the data type of the attachment file.  The
valid value is BLOB.  The list of valid values is
maintained in
ecx_attachment.embedded_lob_data_type API.

None.

retrieve_attachment

procedure retrieve_attachment

i_data_type

x_cid

i_cid

i_file_id

i_data_type
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(i_msgid in raw,

 x_cid in varchar2,

 x_file_name out varchar2,

 x_file_content_type out varchar2,

 x_file_data out nocopy blob,

 x_ora_charset out varchar2,

 x_file_format out varchar2);

Called by message maps for inbound documents to retrieve an
attachment deposited by Oracle Transport Agent (OTA) when the
inbound document was received.

Not all attachments deposited by OTA are of interest to the receiving
application.  Only the attachments identified by the i_msgid and x_cid
parameters are retrieved using this API.

The message ID associated with the attachment
deposited by OTA into the FND repository.

A unique identifier for the attachment provided in
the inbound XML document.  With OAG, this
would be provided in the ATTCHREF data type,
FILENAME element.  The exact location of the
unique identifier in the XML document will vary
by standard.

Name of the attachment file from the FND_LOBS
table.

Content type specified during the attachment
uploading process.  Information from the
FND_LOBS table.

The uploaded attachment stored as a binary LOB
from the FND_LOBS table.

Oracle character set from the FND_LOBS table.

File format (”text” or ”binary”) from the
FND_LOBS table.

reconfig_attachment

procedure reconfig_attachment

i_msgid

x_cid

x_file_name

x_file_content_type

x_file_data

x_ora_charset

x_file_format
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(i_msgid in raw,

 i_cid in varchar2,

 i_entity_name in varchar2,

 i_pk1_value in varchar2,

 i_pk2_value in varchar2,

 i_pk3_value in varchar2,

 i_pk4_value in varchar2,

 i_pk5_value in varchar2,

 i_program_app_id in number,

 i_program_id in number,

 i_request_id in number,

 x_document_id out number);

Called by message maps for inbound documents to reset FND
attributes for a previously retrieved attachment deposited by OTA
when the inbound document was received.

Not all attachments retrieved using the retrieve_attachment API must
be reconfigured.  Use the reconfig_attachment API only if you want to
update the FND attributes.  Use the standard Oracle Foundation
module to create a new copy of the attachment if necessary.

The message ID associated with the attachment
deposited by OTA into the FND repository.

A unique identifier for the attachment.  This is the
same value provided to the retrieve_attachment
API that was based on the value in the inbound
XML document.

Entity name from the
FND_ATTACHED_DOCUMENTS table.

Key value from the
FND_ATTACHED_DOCUMENTS table.

Key value from the
FND_ATTACHED_DOCUMENTS table.

Key value from the
FND_ATTACHED_DOCUMENTS table.

Key value from the
FND_ATTACHED_DOCUMENTS table.

Key value from the
FND_ATTACHED_DOCUMENTS table.

Standard extended who column from
FND_ATTACHED_DOCUMENTS table.

i_msgid

i_cid

i_entity_name

i_pk1_value

i_pk2_value

i_pk3_value

i_pk4_value

i_pk5_value

i_program_app_id
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Standard extended who column from
FND_ATTACHED_DOCUMENTS table.

Standard extended who column from
FND_ATTACHED_DOCUMENTS table.

Unique identifier for the reconfigured attachment.

formulate_content_id

procedure formulate_content_id

(i_file_id in number,

 i_entity_name in varchar2,

 i_pk1_value in varchar2,

 i_pk2_value in varchar2,

 i_pk3_value in varchar2,

 i_pk4_value in varchar2,

 i_pk5_value in varchar2,

 x_cid out varchar2);

Called by register_attachment API to determine the unique CID for an
attachment deposited into FND.  This API is exposed for use outside of
the register_attachment API context.

File identifier from the FND_LOBS table used to
determine the file_name value from the
FND_LOBS table.  The file_name is used to
compose the x_cid value.

Entity name from the FND_LOBS table used to
compose the x_cid value.

Key value from the FND_LOBS table used to
compose the x_cid value.

Key value from the FND_LOBS table used to
compose the x_cid value.

Key value from the FND_LOBS table used to
compose the x_cid value.

Key value from the FND_LOBS table used to
compose the x_cid value.

i_program_id

i_request_id

x_document_id

i_file_id

i_entity_name

i_pk1_value

i_pk2_value

i_pk3_value

i_pk4_value
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Key value from the FND_LOBS table used to
compose the x_cid value.

A unique identifier for the attachment based on the
concatenation of i_entity_name, i_pk1_value,
i_pk2_value, i_pk3_value, i_pk4_value,
i_pk5_value (which are provided as input to this
API), and then adding the file_name value (based n
the file_id) from the FND_LOBS table.

i_pk5_value

x_cid
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APIs Defined in ECX_ENG_UTILS

convert_to_cxml_date

procedure convert_to_cxml_date

(p_ora_date in date,

 x_cxml_date out varchar2);

Converts Oracle date to cXML date in ISO 8601 format.  The time
element is not included.

If both date and time are required, use convert_to_cxml_datetime
procedure.

The Oracle date.

The cXML date converted from the Oracle date.

convert_to_cxml_datetime

procedure convert_to_cxml_datetime

(p_ora_date in date,

 x_cxml_date out varchar2);

Converts Oracle date and time to cXML date and time in ISO 8601
format.

If only the date is required, use convert_to_cxml_date procedure.

Attention:  Be sure to set the profile option ECX: Server Time
Zone.  If you do not set this profile option, the time zone
defaults to GMT.  See Define System Profile Options: page
3 – 3.

The Oracle date and time.

p_ora_date

x_cxml_date

p_ora_date
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The cXML date and time converted from the
Oracle date and time.

convert_from_cxml_datetime

procedure convert_from_cxml_datetime

(p_cxml date in varchar2,

 x_ora_date out date);

Converts cXML date and time to Oracle date and time.

Attention:  Be sure to set the profile option ECX: Server Time
Zone.  If you do not set this profile option, the time zone
defaults to GMT.  See Define System Profile Options: page
3 – 3.

The cXML date and time on an incoming
document.

The Oracle date and time converted from the
cXML date and time.

x_cxml_date

p_cxml_date

x_ora_date
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Troubleshooting

This chapter presents the following troubleshooting topics:

• Automated Troubleshooting Script: page G – 2

• Transaction Monitor: page G – 6

• Manual Troubleshooting Steps: page G – 19

• XML Gateway Version Validation: page G – 43

• Common Client Authentication Implementation Issues: page
G – 46
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Troubleshooting Your XML Gateway Installation

This section presents the following troubleshooting topics:

• Automated Troubleshooting Script: page G – 2

• Transaction Monitor: page G – 6

• Manual Troubleshooting Steps: page G – 19

• XML Gateway Version Validation: page G – 43

• Common Client Authentication Implementation Issues: page
G – 46

For additional troubleshooting information, see ”Oracle XML Gateway
Troubleshooting Guide” on OracleMetaLink.

Automated Troubleshooting Script

Use the ecxver.sql script to verify the health of your Oracle XML
Gateway installation.  It can be run at any time.  Outlined below are
instructions for executing the script and interpreting the output.

How to Run the Automated Test Script

Log in to your database applications account and execute the
following:

SQL> @$ECX_TOP/patch/115/sql/ecxver.sql

The output of the script will appear on your screen.
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Sample Output of the Automated Test Script

Component OBJECT_NAME LOCKED_MODE

OTA ECX_OUTQUEUE Normal

OTA ECX_OUTQUEUE Normal

OTA ECX_OUTQUEUE Normal

OTA ECX_OUTQUEUE Normal

OTA ECX_OUTQUEUE Normal

OTA ECX_OUTQUEUE Normal

OTA ECX_OUTQUEUE Normal

OTA ECX_OUTQUEUE Normal

OTA ECX_OUTQUEUE Normal

OTA ECX_OUTQUEUE Normal

OTA ECX_OUTQUEUE Normal

OTA ECX_OUTQUEUE Normal

OTA ECX_OUTQUEUE Normal

OTA ECX_OUTQUEUE Normal

OTA ECX_OUTQUEUE Normal

WEBMETHODS ECX_OUTQUEUE Normal

WEBMETHODS ECX_OUTQUEUE Normal

WEBMETHODS ECX_OUTQUEUE Normal

WEBMETHODS ECX_OUTQUEUE Normal

WEBMETHODS ECX_OUTQUEUE Normal

ECX_UTL_XSLT_DIR Profile : /sqlcom/log/ecx115

ECX_OAG_LOGICALID Profile : www.oracle.com

ECX_SERVER_TIMEZONE Profile:

ECX_SYS_ADMIN_EMAIL Profile: fname_lname@oracle.com

ECX_UTL_LOG_DIR Profile : /sqlcom/log/ecx115

ECX_XML_VALIDATE_FLAG Profile: Y

ECX_XML_MAXIMUM_SIZE Profile: 2000000

utl_file_dir: /sqlcom/log/ecx115

Oracle XML Parser: 2.0.2.9.0    Production

Parser Version OK



G – 4 Oracle XML Gateway User’s Guide

–––––––––––––––––––––––––––––––––––––––

XML Gateway Status Summary

––––––––––––––––––––––––––––––––––

Log Profile/utl_file_dir OK

XML Parser Version OK

All ECX Objects Valid? OK

All XML Parser Objects Valid? OK

webMethods Running? OK

OTA Running? OK

Total Messages on Outbound Queue 6

OTA Msgs on Outbound Queue 4

webMethods Msgs on Outbound Queue 1

Messages on Inbound Queue 8

–––––––––––––––––––––––––––––––––––––––

End of Summary

––––––––––––––––––––––––––––––––––

How to Interpret the Output Generated by the Automated Test Script

The following table explains each line of the example output shown
above.  Some of the output is informational only and does not require
further action.

Output Explanation/Troubleshooting Tip

Transport Software The ”LOCKED_MODE” value should be ”Normal”, but may appear as
”DEADLOCK”.  Deadlocks are normal if they remain for a short period of
time.  If a deadlock persists for more than 10 minutes, there may be a seri-
ous problem.

Note: webMethods is used in Oracle Exchange environments only.  It is not
used in ERP environments

System Profiles:
ECX_UTL_XSLT_DIR
ECX_OAG_LOGICALID
ECX_SERVER_TIMEZONE
ECX_SYS_ADMIN_EMAIL
ECX_UTL_LOG_DIR
ECX_XML_MAXIMUM_SIZE
ECX_XML_VALIDATE_FLAG

The value associated with each XML Gateway System Profile is displayed
for review.

ERROR: Parser Version Wrong The XML Parser version associated with the environment is displayed.
XML Parser version 2.0.2.9 or higher is required.
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Explanation/Troubleshooting TipOutput

ERROR: Some Invalid ECX Objects Informational message indicating some invalid ECX database objects were
identified.

Log Profile/utl_file_dir If value displayed is anything other than ”OK”, verify the following:
The physical directories associated with the ECX_UTL_XSLT_DIR and
ECX_UTL_LOG_DIR system profiles must be assigned to the utl_file_dir
parameter in the INIT.ORA file.  Also, make sure the physical directories
are write–enabled.
If necessary, make the changes and bounce the database.

XML Parser Version If value displayed is ”FAIL”, upgrade XML Parser to version 2.0.2.9 or
higher.

All ECX Objects Valid? If value displayed is ”NO”, the invalid objects must by recompiled. 
Recompile the invalid objects or reapply the XML Gateway patch to resolve
the invalid ECX database objects.

All XML Parser Objects Valid? If value displayed is ”NO”, the XML Parser must be reinstalled.
Reinstall the XML Parser to resolve the invalid XML Parser objects.

webMethods Running? If value displayed is anything other than ”OK”, restart webMethods.
For an Oracle–hosted environment: contact Operations
For self–hosted environments: contact webMethods

Note: webMethods is used in Oracle Exchange environments only.  It is not
used in ERP environments.

OTA Running? If value displayed is anything other than ”OK”, restart Oracle Transport
Agent (OTA).

Follow instructions in OTA patch to start the Apache web server.  Ensure
the required JSERV properties are set.

Total Messages on Outbound
Queue

Number reported represents the number of messages on the outbound
queue awaiting processing by OTA or webMethods.  
If number is unusually high, check the individual totals in the OTA and
webMethods queues.

OTA Messages on Outbound
Queue

Number reported represents the number of messages on the outbound
queue awaiting processing by OTA.  This is a subset of the total.
If number is unusually high, ensure OTA is running.

webMethods Messages on
Outbound Queue

Number reported represents the number of messages on the outbound
queue awaiting processing by webMethods.  This is a subset of the total.
If number is unusually high, ensure webMethods is running.

Messages on Inbound Queue Number of messages on inbound queue (informational). 
As long as the agent for the inbound queue is enabled, the agent listener is
running, and OTA/webMethods is running, these messages will be pro-
cessed.  See Start Agent Listeners: page 6 – 67 for information on enabling
agents and starting agent listeners.



G – 6 Oracle XML Gateway User’s Guide

Transaction Monitor

The Transaction Monitor is a tool for monitoring the status of inbound
and outbound transactions originating from and going into the Oracle
e–Business Suite that have been processed by the XML Gateway and
delivered or received by the Oracle Transport Agent.  The Transaction
Monitor shows a complete history and audit trail of these documents.
You can also use the Transaction Monitor to resend an outbound
document, if necessary.

Navigate to the Transaction Monitor page using the Workflow
Administrator Web (New) responsibility.

The Transaction Monitor provides the following:

• Flexible search criteria to support access to a specific document
or group of documents

• Search results at the document header level with drill down by
document ID

• Resend capability for outbound messages

• Viewing capability of the XML message content

Transaction Monitor Search Page

Use the Transaction Monitor Search page to enter search criteria for a
specific inbound or outbound document, or group of documents.
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The LOVs contain the valid search values and are defined under the
Lookup Type FND_TX_MONITOR_STATUS.  The search page allows
you to search on the following criteria:

Inbound Messages

Select this radio button to search for inbound messages, and then select
a Processing Status.

Processing Status

Select the processing status of the inbound message(s) for
which you want to search.  Valid values are All, Pending,
Warning, Error, and Success.

Outbound Messages

Select this radio button to search for outbound messages, and then
select the Generation Status, Delivery Status, and Retry Status.

Generation Status

Select the generation status of the outbound message(s) for
which you want to search.  Valid values are All, Pending,
Warning, Error, and Success.
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Note:  A Generation Status of ”Success” indicates that the
message was generated and enqueued.

Delivery Status

Select the delivery status of the outbound message(s) for which
you want to search.  Valid values are All, Pending, Warning,
Error, and Success.

Note:  A Delivery Status of ”Success” indicates that the
message was delivered successfully.

Retry Status

Select the retry status of the outbound message(s) for which
you want to search.  Valid values are All, Pending, Warning,
Error, and Success.

Transaction Type

The transaction type is the product short name for the base Oracle
Application associated with the transaction.  Select a value from the
Search and Select window.

Transaction Subtype

The transaction subtype is a code relating to the transaction type.
Select a value from the Search and Select window.

Source TP Location Code

The source TP location code is the source trading partner of the
message.  Select a value from the Search and Select window.

Trading Partner Name

Select the trading partner name from the Search and Select window.

Document ID

Enter the document ID provided by Oracle e–Business Suite.

Site Name

Select the site name associated with the Trading Partner from the
Search and Select window.
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Party Type

Select the party type from the LOV.  To search for all party types, select
the blank LOV option.

From Date

Select the from date using the calendar icon, or enter a date in the
format dd–mm–yyyy:hh:mm:ss (Example: 23–10–2002).

To Date

Select the to date using the calendar icon, or enter a date in the format
dd–mm–yyyy:hh:mm:ss (Example: 23–10–2002). The to date must be
equal to or after the from date.  If the to date is the same as the from
date, you are specifying one 24–hour period.

Calling the Transaction Monitor Search Page from other applications

Note:  The Transaction Monitor Search page is a callable URL
from any environment.  Call the page by using the following
URL and parameters:

OA.jsp?OAFunc=TXMONITORRESULTSPG&addBreadCrumb=Y&Direction=

<value_direction>&...(other parameter–value pairs)

<value_direction> should be IN or OUT

addBreadCrumb=Y is added to maintain the breadcrumbs trail

Additional parameters that can be used to call the Transaction
Monitor are:

ProcessingStatus (with Direction=IN)

GenerationStatus (with Direction=OUT)

DeliveryStatus (with Direction=OUT)

RetryStatus (with Direction=OUT)

PartyType (lookup values CARRIER, S, I, B, E, C)

TransactionType

TxSubtype

LocCode

TPName (must be submitted with PartyType)

DocumentId

SiteName (must be submitted with PartyType)
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From (in format DD–MON–YYYY HH:MI:SS)

To (in format DD–MON–YYYY HH:MI:SS)

Search Results Page

The Transaction Monitor will return the Inbound Search Results page
or the Outbound Search Results page depending on your selection.
The document ID drills down to a details page from which you can
view the XML message.  For outbound documents, the Search Results
page allows you to resend a document.

Inbound Search Results Page

Document ID

The document ID of the document being processed, such as the PO
number or the Invoice number.  This field drills down to the Message
Details page.

Trading Partner Name

The trading partner name.  A value of ”N/A” indicates that the XML
Gateway Trading Partner Details have not been synchronized with the
Workflow Directory Services.  For more information, see: Setting up an
Oracle Workflow Directory Service in the Oracle Workflow
Administrator’s Guide. 

External Transaction Type

The external transaction type is the primary external identifier for the
XML message (for example, OAG noun).  It is associated with the
internal transaction type and transaction subtype.
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External Transaction Subtype

The external transaction subtype is a code relating to the transaction
subtype (for example, OAG verb).  It is the secondary identifier for the
XML message.

Note:  The combination of Transaction Type, Transaction
Subtype, and the External Transaction Type and External
Transaction Subtype identifies an Oracle transaction with
which to associate this message.

Processing Time Stamp

The date and time the document was processed.

Processing Status

The processing status of an inbound message.  Valid values are
Pending, Warning, Error, and Success.

Outbound Search Results Page

The Outbound Search Results page allows you to resend a document.
Select the document(s) and click the Resend button.  This action will



G – 12 Oracle XML Gateway User’s Guide

not recreate the document, but resends the document from information
stored in the ecx_doclogs table.

Note:  The Select option is disabled for transactions that are
A2A (because no message ID is created), and for B2B
transactions for which generation failed.

Document ID

The document ID drills down to the message detail screen.

Trading Partner Name

The trading partner name.  A value of N/A indicates that the XML
Gateway Trading Partner Details have not been synchronized with
Workflow Directory Services.

Internal Transaction Type

The transaction type is the product short name for the base Oracle
Application associated with the transaction.

Internal Transaction Subtype

The transaction subtype is a code relating to the transaction type.

Generation Date

The date and time the message was generated.

Generation Status

Possible values of the generation status are: Pending, Warning, Error,
and Success.

Note:  A Generation Status of ”Success” indicates that the
message was generated and enqueued.

Delivery Date

The date and time the message was delivered.

Delivery Status

Possible values of delivery status are: Pending, Warning, Error, and
Success.

Note:  A Delivery Status of ”Success” indicates that the
message was delivered successfully.
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Retry Date

The ”retry” date of the message.  The Retry Status column is updated if
Resend was initiated from the search detail window.

Retry Status

Possible values  are: Pending, Warning, Error, and Success.

Resend (button)

Use this button to resend selected documents from information stored
in the ecx_doclogs table.  This function will not recreate the document.
You can resend a single document, or select multiple documents to
resend.

Transaction Monitor Details Page

The details screen is displayed when you drill down on the Document
ID field.
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Inbound Message Details

The Inbound Message Details Screen displays information regarding
the selected document.  Use the View XML button to view the XML
document.

Fields displayed that are not shown on the Inbound Search Results
screen: page G – 10, are:

Internal Control Number

The unique number generated by the execution engine.

Party ID

The Trading Partner identifier.

Party Type

The type of Party, such as Customer, Supplier, or Bank.
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Site Name

The trading partner’s site name.

Processing Message

A message regarding the status of the transaction.  Refer to Manual
Troubleshooting: page G – 19 for information on how to interpret
messages and resolve reported errors.

Processing Logfile

The name and location of the processing log file.  Use it to trace the
process flow and identify errors.

View XML (button)

Clicking this button displays the XML message in the View XML  page.
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Outbound Message Details

Click on the Document ID to drill down to the Transaction Monitor
Details page.

Fields displayed that are not shown on the Outbound Search Results
screen: page G – 11, are:

Party ID

The identifier of the Trading Partner you are doing business with.
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Site Name

The site name associated with the Trading Partner.

URL Sent To

The URL the document was sent to.

Generation Message

The message returned by the system regarding the status of the
transaction.  For information regarding the interpretation of this
message, see Manual Troubleshooting Steps: page G – 19.

Generation Logfile

The name and location of the logfile.  If this is a failed transaction, see
Manual Troubleshooting Steps: page G – 19.

Delivery Message

The message returned by the system regarding the status of the
delivery.

Retry Message

The message returned by the system regarding the status of the retry
message.

View XML (button)

Select this button to display the XML message in the View XML  page.
This button is enabled when the Generation Status is ”Success”.

View XML

This page displays the XML document.

Note:  The information in the ”View XML” screen sample
shown below was taken from the ecx_doclogs table on the basis
of the out message ID stored in the view.
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Manual Troubleshooting Steps
If this is a new install or a new upgrade and you are experiencing
errors, run the verification script included in the XML Gateway patch
to verify that all the necessary components of the XML Gateway
solution are installed correctly.  Refer to Automated Troubleshooting
Script: page G – 2  for details on how to execute the troubleshooting
script, ecxver.sql.

If the troubleshooting script did not reveal any install or upgrade
errors, or if the error occurs in the processing stage, perform the
following manual troubleshooting procedures.

There are three types of error messages generated by Oracle XML
Gateway:

• Engine–level – error messages generated by the XML Gateway
execution engine: see page G – 19

• API–level – error messages generated by APIs: see page G – 35

• HTTP Response Codes – error response codes returned in the
HTTP Response by the OTA server: see page G – 40

XML Gateway Engine–Level Messages

The following is a list of the seeded error messages that may be
included in a notification to the Trading Partner or System
Administrator.  The same error message may also appear in the process
log file depending on the trace level activated.  Along with each error
message is an explanation of possible causes and recommended
corrective actions.

The list is organized by functional area and error type for easy
reference. The list contains the following columns:

• Error Type

• Error Code

• Message Code

• Message

• Corrective Action

The Error Type identifies the target recipient of a notification.  The
target recipient is predetermined and is based on which party is most
able to resolve the error.  In a few instances, a notification is sent to
both the Trading Partner and System Administrator so that the two
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parties may collaborate to resolve the error.  The valid Error Types are
listed in the following table:

Error Type Description

10 No notification

20 Notification sent to Trading Partner

25 Notification sent to both Trading Partner and System Administrator

30 Notification sent to System Administrator

The Error Code identifies the status of the process.  The valid Error
Codes are shown in the following table:

Error Code Description

10 In Process

0 Success

1 Warning

2 Error

Because the focus of this section is on troubleshooting, Error Type 10
(No Notification) and Error Code 0 (Success) are excluded from the list.
Error Code 10 (In Process) is included to support troubleshooting,
although this group does not represent an error.  The engine will abort
and roll back any process that does not have a status of ”Success.”

The Message Code is a code related to the message text string.  This is
used for quick identification of an error.

There are several error messages that can originate from multiple
sources. The Message Code and Message string may be the same, but
the Error Type and Error Code will be different. Ensure not to regard
these as duplicates.

There are several categories of corrective action identified in the
troubleshooting guide.  The following table summarizes the categories
and lists the corresponding reference section in this book:



G – 21Troubleshooting

Corrective Action Category Reference Section

Verify lookup data XML Gateway Setup chapter: Define Lookup Values: page
3 – 22

Verify development setup
data

XML Gateway Setup chapter: 
Define XML Standards: page 3 – 11
Define Transactions: page 3 – 13

Verify implementation
setup data

XML Gateway Setup chapter: 
Define System Profile Options: page 3 – 3
Define Trading Partner: page 3 – 25
Define Code Conversion: page 3 – 54

Verify queues and agent
listeners are enabled

Integrating XML Gateway with Workflow Business Event
System chapter:
Manage Workflow Processes: page 6 – 65
Monitor Workflow Processes: page 6 – 67

Enable trace or configure
event subscriptions

Integrating XML Gateway with Workflow Business Event
System chapter:
Manage Workflow Processes: page 6 – 65
Monitor Workflow Processes: page 6 – 67

Modify a message map:
Action Definition

Message Designer chapter (see note following table): 
Reference the specific action under Transaction Map –
Actions: page 2 – 72

Modify a message map:
Root Element

Message Designer chapter (see note following table):
File > Properties menu option: page 2 – 6

Load/Delete a map or DTD Message Designer chapter (see note following table): 
How to Load/Delete Message Maps and DTDs: page
2 – 121

Verify Confirmation
Message setup

Execution Engine chapter:  How to Implement a Con-
firmation Message: page 4 – 16

Enter a bug Work with Oracle World Wide Support to enter a bug.
Include log file, message map, (.xgm file), and the
associated DTD in the bug report.

Enter an enhancement
request

Work with Oracle World Wide Support to enter an en-
hancement request.  Include business justification and
your specific scenario.  Be as specific as possible.

Note:  Updated maps must be loaded into the XML Gateway
repository.

Changes in the relationship between a map (.xgm) and the
corresponding DTD may require the map, the DTD, or both to
be loaded into the XML Gateway repository.
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UTL_FILE Errors:

Error
Type

Error
Code

Message Code Message Corrective Action

30 1 ECX_UTL_INVALID_OPERA-
TION

UTL FILE Error: The file could not
be opened or operated on as re-
quested.

Verify that the file is read and
write enabled.  Use commands ap-
propriate for your operating sys-
tem to change protections if neces-
sary.

30 1 ECX_UTL_INVALID_PATH UTL FILE Error: File location or
file name was invalid.

Verify that the directory identified
by the ECX: Log File Path profile
option exists.  Verify that the file
name exists.  Change the directory
or file name if necessary.

30 1 ECX_UTL_WRITE_ERROR UTL FILE Error: An operating sys-
tem error occurred during the
write operation.

Verify the UTL_FILE_DIR  setting
for the directory identified by the
ECX: Log File Path  profile option.
Change UTL_FILE_DIR setting in
INIT.ORA if necessary and bounce
the database.  Verify that the direc-
tory and file exist and are write–
enabled.  Use commands ap-
propriate for your operating sys-
tem to change protections if neces-
sary.  Change the directory or file
name if necessary.

Table 8 – 1 UTL_FILE Errors 
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Trading Partner Errors:

Error
Type

Error
Code

Error Message Code Message Corrective Action

25 1 ECX_NO_UNIQUE_TP_SETUP Could not resolve a Unique/Des-
tination Configuration for this
Partner.

The inbound message envelope
contained a Trading Partner ID
that was not uniquely defined in
XML Gateway.  This occurs when
the wrong ID was sent or the Trad-
ing Partner has not been defined
in XML Gateway.  Use the Define
Trading Partner window to view/
add the Trading Partner profile.

30 1 ECX_ADDR_DERIVATION_ERR Unable to derive internal address
ID for address type: &p_ad-
dress_type and location code:
&p_location_code.

Cannot successfully execute De-
rive Address ID from Location
Code action. This occurs when the
address type or the location code
is invalid.  Check the Derive Ad-
dress ID from Location Code sec-
tion of the Message Designer
chapter for a list of supported ad-
dress types.  Verify that the loca-
tion code is valid.

30 1 ECX_DELIVERY_TP_NOT_SET-
UP

Unable to determine the trading
partner setup for Transaction type:
&p_transaction_type, Transaction
subtype: &p_transaction_subtype,
Party site id: &p_party_site_id,
Party id: &p_party_id, and Party
type: &p_party_type.

Cannot determine Trading Partner
with token values for Party Type,
Party ID, Party Site ID, Transac-
tion Type, and Transaction Sub-
type.  Use the Define Trading Part-
ner window/API to view/update
the Trading Partner setup data.

30 1 ECX_DESTINA-
TION_ADDR_NULL

Protocol Address missing for
party id: &p_party_site_id and
location code: &p_source_code.

The Protocol Address is null for
the given Trading Partner (Party
Site ID) and Source Location
Code.  Use the Define Trading
Partner window to view/update
the Trading Partner’s protocol ad-
dress.

30 1 ECX_DYN_ROUTING_NOT_EN-
ABLED

&p_ext_type and &p_ext_subtype
Not enabled for
&p_party_ext_code in Oracle
XML Gateway Server for Dynamic
Routing.

The inbound transaction
associated with the given external
transaction type, transaction sub-
type, and source location code is
not enabled for dynamic routing.
Ensure that the ”attribute3” vari-
able in the message envelope con-
tains a valid value.  Use the De-
fine Trading Partner  window to
view/update the Trading Partner
Routing information representing
the route to the Trading Partner.

Table 8 – 2 Trading Partner Errors 
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Corrective ActionMessageError Message CodeError
Code

Error
Type

30 1 ECX_INVALID_PARTY_TYPE Party Type: &p_party_type is in-
valid.

Review seeded Party Type lookup
and use a valid party type code.
Enter an Enhancement Request for
new Party Type if required.

30 1 ECX_INVALID_TP_HDR_ID Tp_header_id: &p_tp_header_id
is invalid.

Invalid Trading Partner ID.  Use
the retrieve/update APIs in
ECXTPXFB to query/update a
Trading Partner profile.

30 1 ECX_INVALID_TXN_PARAMS Party Site ID or Transaction Type
or Transaction Subtype cannot be
NULL.

Use the Define Trading Partner
window to view/update the Trad-
ing Partner profile and ensure that
the Trading Partner Site, Transac-
tion Type, and Transaction Sub-
type are valid.

30 1 ECX_NO_EMAIL_ADDR Unable to determine TP email ad-
dress for party_type:
&p_party_type, transaction_type:
&p_transaction_type, transac-
tion_subtype: &p_transac-
tion_subtype, and party_site_id:
&p_party_site_id.

Cannot determine Trading Partner
e–mail address with given token
values to send notification. Use
the Define Trading Partner  win-
dow to review/update the e–mail
address in the Trading Partner set-
up.

30 1 ECX_NO_ENVELOPE Unable to determine envelope in-
formation for internal control
number: &p_icn.

Envelope information for the giv-
en internal control number was
not found.  The internal control
number is a system–generated
number that uniquely identifies
the XML message being pro-
cessed. Verify that the internal
control number is valid.

30 1 ECX_NO_UNIQUE_TP_SETUP Could not resolve a Unique/Des-
tination Configuration for this
Partner.

Cannot determine unique Trading
Partner detail for outbound trans-
action with the information identi-
fied.  Check parameters for Party
Type, Party ID, Party Site ID,
Transaction Type, and Transaction
Subtype.

30 1 ECX_PARTY_ID_NOT_NULL Party ID is a required parameter. Pass valid Party ID, Party ID can-
not be null.

30 1 ECX_PARTY_SITE_ID_NOT_NUL
L

Party Site ID is a required parame-
ter.

Pass valid Party Site ID, Party Site
ID cannot be null.

30 1 ECX_PARTY_TYPE_NOT_NULL Party Type is a required parame-
ter.

Review seeded Party Type lookup
and pass valid Party Type. Party
Type cannot be NULL.

Table 8 – 2 Trading Partner Errors 
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Corrective ActionMessageError Message CodeError
Code

Error
Type

30 1 ECX_PARTY_TYPE_NOT_SET Please provide party_type for the
trading partner.

Party Type not available for XML
Gateway to uniquely determine
Trading Partner.  Provide valid
Party Type from seeded Party
Type lookup.

30 2 ECX_PARTY_TYPE_NOT_SET Please provide party_type for the
trading partner.

Party type not available for XML
Gateway to uniquely determine
Trading Partner.  Provide valid
Party Type from seeded Party
Type lookup.

30 1 ECX_RCVR_NOT_SETUP Receiver TP setup not found for tp
header id: &p_tp_header_id.

The Receiving Trading Partner
was not found.  Use the Define
Trading Partner window to verify
that the Trading Partner is de-
fined.

30 2 ECX_RULE_INVALID_TP_SETUP The Standard: &p_standard_code,
Transaction Type: &p_transac-
tion_type, Transaction Subtype:
&p_transaction_subtype, and
Location Code: &p_party_site_id
is not enabled in the XML Gate-
way Server.  Please check your
Setup.

Either invalid transaction, stan-
dard code, or Trading Partner en-
countered.  Use the Define Trans-
actions window to view/update
the transaction setup.  Use the De-
fine Trading Partner window/API
to view/update the Trading Part-
ner setup and the transactions en-
abled for the the Trading Partner.

30 1 ECX_SNDR_NOT_SETUP Sender TP setup not found for
tp_header_id: &p_tp_header_id.

The Sending Trading Partner was
not found.  Use the  Define Trad-
ing Partner window to verify that
the Trading Partner is defined.

30 1 ECX_STATIC_ROUT-
ING_NOT_ENABLED

&p_ext_type and &p_ext_subtype
Not enabled for
&p_party_ext_code in Oracle
XML Gateway Server for Static
Routing.

Could not determine routing in-
formation for given Trading Part-
ner and transaction.  Use the De-
fine Trading Partner window to
view/update the Trading Partner
details for the Routing ID.

Table 8 – 2 Trading Partner Errors 
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Corrective ActionMessageError Message CodeError
Code

Error
Type

30 1 ECX_TRANSACTION_NOT_EN-
ABLED

&p_ext_type and &p_ext_subtype
Not enabled for
&p_party_ext_code in Oracle
XML Gateway Server.

Inbound transaction not enabled
in XML Gateway.  Check envelope
parameter values for Message
Standard, Transaction Type, Trans-
action Subtype, and Source Trad-
ing Partner Location.  Either the
envelope information contains an
error or the Trading Partner has
not been defined.  Use the  Define
Trading Partner window to define
the Trading Partner to process this
inbound transaction.

30 1 ECX_TRANSAC-
TION_NOT_FOUND

No Transaction defined for Trans-
action Type: &p_transaction_type,
Transaction Subtype: &p_transac-
tion_subtype, and Party Type:
&p_party_type.

Given Party Type, Transaction
Type, and Transaction Subtype not
found.  Check parameter values
being passed.

Table 8 – 2 Trading Partner Errors 

Hub Errors

Error
Type

Error
Code

Error Message Code Message Corrective Action

25 1 ECX_DELIV-
ERY_HUB_NOT_SETUP

Unable to resolve the hub destina-
tion parameters for this trading
partner hub.

Cannot determine the hub attrib-
utes (for inbound transaction) for
this Trading Partner.  Use the De-
fine Hubs and Define Trading
Partner windows to view/update
hub attributes.  Hub attributes are
used if Trading Partner ”Connec-
tion/Hub” attribute is set to
”Hub.”

30 1 ECX_DELIV-
ERY_HUB_NOT_SETUP

Unable to resolve the hub destina-
tion parameters for this trading
partner hub.

Cannot determine the hub attrib-
utes (for outbound transaction) for
this Trading Partner.  Use the De-
fine Hubs and Define Trading
Partner windows to view/update
hub attributes.  Hub attributes are
used if Trading Partner ”Connec-
tion/Hub” attribute is set to
”Hub.”

Table 8 – 3  Hub Errors 
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Code Conversion Errors

Error
Type

Error
Code

Error Message Code Message Corrective Action

30 1 ECX_CODE_CONVERSION_DIS-
ABLED

Standard Code: &MES-
SAGE_STANDARD not Found.
Code Conversion is disabled.

The execution engine is using an
XML standard not defined in
ECX_STANDARDS, so the code
conversion cannot be performed.
Use the Define XML Standards
window to review the seeded
XML standards.  Enter an en-
hancement request for required
XML standard and identify the
transactions that require this new
standard.

30 1 ECX_TP_NOT_FOUND Trading Partner not Found. Code
Conversion is disabled.

A warning indicating that the
Trading Partner was not found, so
Trading Partner code conversion
cannot be performed.  Use the De-
fine Trading Partner window to
view/update the Trading Partner
setup.

Table 8 – 4  Code Conversion Errors 

Enqueue/Dequeue Errors

Error
Type

Error
Code

Error Message Code Message Corrective Action

10 10 ECX_DEQUEUED_LOGGED Message dequeued and logged Message dequeued and logged.

30 2 ECX_MANY_PROCES-
SING_QUEUES

More than one row resulted while
querying the queue name.

Unable to determine unique
queue for inbound transaction.
Use the Define Transactions win-
dow to view/update the queue
definition for the inbound transac-
tion being processed.

30 1 ECX_NO_PROCESSING_QUEUE Unable to determine processing
engine queue.

Unable to determine processing
queue for inbound transaction.
Use the Define Transactions win-
dow to view/update the queue
definition for the inbound transac-
tion being processed.

Table 8 – 5 Enqueue/Dequeue Errors 
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Corrective ActionMessageError Message CodeError
Code

Error
Type

30 1 ECX_PROCESSING_ENQ_ER-
ROR

Error enqueuing to processing en-
gine: &p_queue_name

Unable to enqueue when proces-
sing inbound transaction.  Ensure
that the transaction queue and
agent listener are enabled.

30 1 ECX_REPROCESSING_ERROR Error enqueuing to processing en-
gine, while REPROCESSING:
&p_out_queue

Unable to enqueue when reproces-
sing inbound transaction.  Ensure
that the transaction queue and
agent listener are enabled.

Table 8 – 5 Enqueue/Dequeue Errors 

Workflow Business Event System Errors

Error
Type

Error
Code

Error Message Code Message Corrective Action

10 10 ECX_PROCESSING_RULE Processing rule Processing rule

30 2 ECX_BUSINESS_EVT_NOT_SET Business Event Not Set for the
Transaction

Check that the message map for
the inbound transaction concludes
with root level, postprocess proce-
dure call action to call the
ECX_STANDARD.setEventDetails
API.  This API sets the business
event to be raised to indicate an
inbound transaction has been suc-
cessfully processed.  The corre-
sponding application event sub-
scription will consume this event.

30 2 ECX_IN_RULE_PROCES-
SING_ERROR

Error in processing inbound rule Unexpected exception when pro-
cessing inbound rule.  Check the
setup for event and agent listener.

Table 8 – 6 Workflow Business Event System Errors 
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Confirmation BoD Errors

Error
Type

Error
Code

Error Message Code Message Corrective Action

30 2 ECX_CON-
FIRM_DOC_NOT_FOUND

Unable to determine the inbound
document for which this con-
firmation is being sent.

Verify that the Workflow for the
outbound confirmation includes
the internal control number corre-
sponding to the inbound business
document.  Refer to the Workflow
Development Guidelines on how
to implement the Confirmation
BoD for the details.

30 2 ECX_CONFIRM_GENER-
ATE_FAILED

Cannot generate confirmation for
Confirmation Inbound.  Loop De-
tected.

Cannot use a Confirmation mes-
sage to acknowledge a Confirma-
tion message.

30 2 ECX_CONFIRM_STA-
TUS_NOT_FOUND

Cannot find confirmation status
for the trading partner.

Could not determine the Con-
firmation flag setting for the Trad-
ing Partner.  Use the Define Trad-
ing Partner window to view/up-
date the Trading Partner setup
and set the Confirmation flag if
necessary.

30 2 ECX_CONFIRM_TP_NOT_SETUP Unable to determine trading part-
ner setup for the Confirmation.
Transaction Type: &p_transac-
tion_type, Transaction Subtype:
&p_transaction_subtype, Location
Code: &p_location_code.

Cannot determine Trading Partner
to send the Confirmation. Use the
Define Trading Partner  window
to view/update the Trading Part-
ner setup for the given Transac-
tion Type, Transaction Subtype,
and Source Trading Partner Loca-
tion Code.

Table 8 – 7 Confirmation BoD Errors 

Message Map and DTD Errors

Error
Type

Error
Code

Error Message Code Message Corrective Action

20 1 ECX_INCOMPLETE_OAG_DATE Incomplete OAG Date: &p_date-
time.

A warning indicating the incom-
ing OAG date was incomplete.
This could cause the conversion to
the Oracle date to be incomplete.

20 1 ECX_USER_INVOKED_EXIT Program Exit invoked by the User. A warning indicating a user–pro-
grammed exit was executed.

Table 8 – 8 Message Map and DTD Errors 
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Corrective ActionMessageError Message CodeError
Code

Error
Type

30 1 ECX_CANNOT_CON-
VERT_TO_DATE

Cannot Convert to Date. Usage of Convert to OAG Date-
time action (or other data conver-
sion APIs) in the message map
triggered an error.  Use Message
Designer to verify that the map
action/API is defined correctly.
Make the necessary changes and
reload the updated map.

30 2 ECX_CANNOT_CON-
VERT_TO_NUM

Cannot convert the value &p_val-
ue to number.

Invalid number used with math
function.  Verify that the variable/
literal value is numeric.  Make the
necessary changes and reload the
updated map.

30 1 ECX_CANNOT_CON-
VERT_TO_NUMBER

Cannot Convert to number. Condition evaluation error, inform
the System Administrator or log a
bug.

30 1 ECX_COND_NOT_DEFINED Condition type: &TYPE not de-
fined.

Review map actions using Mes-
sage Designer to ensure that the
condition expressions are defined
correctly with two operands and a
valid operator.  Make the neces-
sary changes and reload the up-
dated map.

30 2 ECX_DATA-
TYPE_CONV_FAILED

DataType conversion failed while
inserting the level into the table.

Datatype mismatch between
source and database datatype.
Make the necessary changes and
reload the updated map.

30 1 ECX_INVALID_ADDRESS_TYPE Address type: &p_address_type is
invalid.

Invalid address type.  Check De-
rive Address ID from Location
Code section of Message Designer
chapter for list of supported ad-
dress types.

30 1 ECX_INVALID_NUMBER Binding value &pre_var_value for
bind variable &variable_name is
an invalid number.

Usage of the Append Where Clau-
se action in the message map con-
tained an invalid number for the
given Bind Value and Bind Vari-
able combination. Use Message
Designer to review the Source
Definition of the map for all usage
of the Append Where Clause,
make the necessary changes, and
reload the updated map.

Table 8 – 8 Message Map and DTD Errors 
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Corrective ActionMessageError Message CodeError
Code

Error
Type

30 1 ECX_MAPPINGS_NOT_FOUND Mappings for Map ID: &MAP_ID
not found.

Map details for given Map ID not
found because incorrect map-
pings, such as level cross overs,
were detected.  Use Message De-
signer to review the message map.
Make the necessary changes, and
reload the updated map.

30 1 ECX_MATH_FUNC_NOT_NULL Math function type cannot be null. Usage of Math function is incom-
plete. Use Message Designer to re-
view all math functions defined,
make the necessary changes, and
reload the updated map.

30 1 ECX_ROOT_ELE-
MENT_NOT_FOUND

Root Element information not
found for Map ID: &MAP_ID.

Root element information not
found for given message map. Use
the Message Designer to open the
map  and use the File > Properties
menu option to add the root ele-
ment.  Reload the updated map.

30 1 ECX_ROOT_INFO_NOT_FOUND Map root element or parent node
ID not found.

Root element or parent node ID
not found  for given message map.
Use Message Designer to open the
map, and use the File > Properties
menu option to add the root ele-
ment or parent node ID.  Reload
the updated map.

30 1 ECX_SEED_DATA_NOT_FOUND Seed Data is missing for Map ID:
&MAP_ID.

Map data missing for given Map
ID.  Make sure you are operating
in the desired database instance.

30 2 ECX_STACKVAR_NOT_FOUND Stack Variable not found. Error in processing global vari-
ables. Inform System Administra-
tor or log a bug.

30 1 ECX_UNSUP-
PORTED_COND_TYPE

Unsupported condition type:
&TYPE.

Review map actions using Mes-
sage Designer to ensure that the
condition expressions are defined
correctly with two operands and a
valid operator.  Make the neces-
sary changes and reload the up-
dated map.

Table 8 – 8 Message Map and DTD Errors 
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Corrective ActionMessageError Message CodeError
Code

Error
Type

30 2 ECX_UNSUPPORTED_DATA-
TYPE

Unsupported Data Type. The message map contained usage
of unsupported data types.  Use
the Message Designer to review
the message map to verify that
only the VARCHAR2, NUMBER,
DATE, CHAR, and CLOB data
types are used.  Make the neces-
sary map changes and reload the
updated map.

30 1 ECX_UNSUPPORTED-
DATE_COND

Unsupported Condition for Date. Cannot use Condition Expression
to compare dates.  Use database
functions instead to compare
dates.

30 1 ECX_UNSUP-
PORTED_MATH_FUNC

Unsupported Math function. XML Gateway supports the four
basic math functions: add, sub-
tract, multiply, and divide. Use
database functions for other math
functions.

30 1 ECX_UNSUPPORTED_NUM-
BER_COND

Unsupported Condition for Num-
ber.

Unsupported condition for num-
bers.  Verify that the condition op-
erator is relevant for numbers.
Make the necessary map changes
and reload the updated map.

30 1 ECX_UNSUP-
PORTED_STRING_COND

Unsupported Condition for
Strings.

Unsupported condition for
strings.  Verify that condition op-
erator is relevant for strings.
Make the necessary map changes
and reload the updated map.

Table 8 – 8 Message Map and DTD Errors 

Inbound Processing Errors

Error
Type

Error
Code

Error Message Code Message Corrective Action

10 10 ECX_REPROCESSING_MESSAGE Reprocessing message. Reprocessing message.

25 1 ECX_PROTOCOL_ADDR_NULL Destination Address missing for
party ID: &p_tp_detail_id.

Inbound message envelope did
not contain a protocol address for
the given Trading Partner.  Use the
Define Trading Partner window to
view/update the Trading Part-
ner’s protocol address.
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Corrective ActionMessageError Message CodeError
Code

Error
Type

30 2 ECX_MSG_EXISTS_IN_LOG Message already in the Log
&p_msgid.

Inbound message already exists;
duplicate not allowed.

30 1 ECX_MSGID_NOT_FOUND Msg Id: &p_msgid not Found. Inbound message for given mes-
sage ID not found.  Make sure the
message ID is valid.

30 1 ECX_UNSUPPORTED_STAN-
DARD

Not a Supported Standard in the
XML Gateway Server.

Inbound message envelope indi-
cates message is for an XML stan-
dard not supported by Oracle Ap-
plications.  Use the Define XML
Standards window to view the list
of supported standards.  Enter an
enhancement request for the re-
quired XML standard and identify
the transactions that require this
new standard.

Table 8 – 9 Inbound Processing Errors 

General Processing Errors

Error
Type

Error
Code

Error Message Code Message Corrective Action

10 10 ECX_PROCESSING_MESSAGE Processing message. N/A

10 10 ECX_TRIGGER_OUTBOUND Triggering outbound. N/A

25 1 ECX_PARSE_ERROR Parse Error. Parse error encountered because
the generated or received XML
message was poorly formed or in-
valid as per the DTD.  The other
possible reason for a parse error is
that the DTD referenced in the
map is not the same DTD that was
passed.  Make sure that the DTD
referenced in the map is loaded
into the XML Gateway repository.

30 1 ECX_DOCLOGS_NOT_EXISTS No document log exists for mes-
sage ID: &p_msgid.

ECX_DOCLOGS entry does not
exist for the given message ID.
Ensure that the message ID is val-
id.

Table 8 – 10 General Processing Errors 
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Corrective ActionMessageError Message CodeError
Code

Error
Type

30 1 ECX_DTD_NOT_FOUND DTD not found for Map ID:
&MAP_ID.

The DTD referenced in the mes-
sage map was not found because
the map referenced the wrong
DTD or the DTD was not loaded
into the XML Gateway repository.
Use Message Designer to check
the DTD referenced in the map,
make the necessary changes, and
reload the updated map. If neces-
sary load the correct DTD into the
XML Gateway repository.

30 2 ECX_ERROR_NOT_SET Unable to set error information. Inform System Administrator or
log a bug.

30 1 ECX_MAP_NOT_FOUND Not a Supported Map
&p_map_code in the XML Gate-
way Server.

Given map code associated with
the outbound transaction enabled
for a Trading Partner is not sup-
ported.  Use the Define Trading
Partner window to view/update
the map code associated with the
enabled outbound transaction.
Make sure the map has been
loaded in the XML Gateway re-
pository.

30 2 ECX_MAP_NOT_FOUND Not a Supported Map
&p_map_code in the XML Gate-
way Server.

Given map code associated with
the inbound transaction enabled
for a Trading Partner is not sup-
ported.  Use the Define Trading
Partner window to view/update
the map code associated with the
enabled inbound transaction.
Make sure the map has been
loaded in the XML Gateway re-
pository.

30 1 ECX_MSGID_NOT_FOUND Message ID cannot be NULL. Pass valid value for Message ID
parameter.

30 1 ECX_MSGID_NOT_NULL Message ID cannot be NULL. Pass valid value for Message ID
parameter.

Table 8 – 10 General Processing Errors 
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XML Gateway API Level Messages

The following is a list of messages generated by the XML Gateway
APIs.  The list is organized by API Return Code for easy reference.  The
list contains the following columns:

• API Return Code

• Message Code

• Message

The API Return Code represents the status of the API.  The calling
program can interrogate the return code and provide an
application–specific error handler to address the error detected.
Because these messages are designed for communication between
application APIs, the necessary corrective actions are addressed during
the development process.  There is no action required, unless you are
developing a custom transaction.

API Return Code Description

0 Success

1 Warning

2 Unexpected Error

3 Null value detected for required parameter

4 Invalid parameter value

5 Cannot insert duplicate row

6 No data found for given parameter values

7 Duplicate row exists for given parameter values

8 Cannot delete due to referential integrity

Because the focus of this section is on troubleshooting, API Return
Code of 0 (Success) is excluded from the following list.  As of this
printing, there are no seeded messages with API Return Code of 1 or 2.



G – 36 Oracle XML Gateway User’s Guide

API
Return
Code

Message Code Message

3 ECX_CATEGORY_ID_NOT_NULL Code category ID is a required parameter.

3 ECX_CODE_CATEGORY_NOT_NULL Code category is a required parameter.

3 ECX_CONNECTION_TYPE_NOT_NULL Connection type is a required parameter.

3 ECX_DATA_SEEDED_NOT_NULL XRef data seeded is a required parameter.

3 ECX_DIRECTION_NOT_NULL Direction is a required parameter.

3 ECX_EMAIL_ADDRESS_NOT_NULL Email_address is a required parameter.

3 ECX_EXT_PROCESS_ID_NOT_NULL External process ID is a required parameter.

3 ECX_HUB_USER_ID_NOT_NULL Hub User ID is a required parameter.

3 ECX_LOCATION_NOT_NULL Location Code is a required parameter.

3 ECX_MAP_CODE_NOT_NULL Map Code is a required parameter.

3 ECX_PARTY_ID_NOT_NULL Party ID is a required parameter.

3 ECX_PARTY_SITE_ID_NOT_NULL Party Site ID is a required parameter.

3 ECX_PARTY_TYPE_NOT_NULL Party Type is a required parameter.

3 ECX_PROTOCOL_TYPE_NOT_NULL Protocol type is a required parameter.

3 ECX_PWD_NOT_NULL For protocol type: &p_protocol_type, the password is a re-
quired parameter.

3 ECX_STANDARD_CODE_NOT_FOUND Standard code: &p_standard_code not defined.

3 ECX_STANDARD_CODE_NULL Standard Code is a required parameter.

3 ECX_STANDARD_NOT_NULL Document standard is a required parameter.

3 ECX_TP_DTL_ID_NOT_NULL Trading partner detail ID is a required parameter.

3 ECX_TP_HDR_ID_NOT_NULL Trading partner header ID is a required parameter.

3 ECX_TRAN_SUBTYPE_NOT_NULL Transaction Subtype is a required parameter.

3 ECX_TRANSACTION_SUBTYPE_NOT_NULL Transaction type is a required parameter.

3 ECX_TRANSACTION_TYPE_NOT_NULL Transaction type is a required parameter.

3 ECX_XREF_DTL_ID_NOT_NULL XRef detail ID is a required parameter.

3 ECX_XREF_EXT_VAL_NOT_NULL XRef external value is a required parameter.

Table 8 – 11 API Level Messages 
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MessageMessage CodeAPI
Return
Code

3 ECX_XREF_INT_VAL_NOT_NULL XRef internal value is a required parameter.

3 ECX_XREF_STANDARD_ID_NOT_NULL XRef standard ID is a required parameter.

3 ECX_XREF_STD_VAL_NOT_NULL XRef standard value is a required parameter.

3 ECX_USRNAME_NOT_NULL For protocol type: &p_protocol_type, the username is a re-
quired parameter.

4 ECX_DATA_OWNER_INCONSISTENT Data owner: &p_owner is inconsistent with data seeded flag:
&p_data_seeded.

4 ECX_INVALID_CONF_CODE Confirmation code: &p_confirmation is invalid.

4 ECX_INVALID_DIRECTION Direction: &p_direction is invalid.

4 ECX_INVALID_EMAIL_ADDRESS Email_address: &p_email_address is invalid.

4 ECX_INVALID_EXT_PROCESS_ID External process ID: &p_ext_process_id is invalid.

4 ECX_INVALID_HUB_ID Hub ID: &p_hub_id is invalid.

4 ECX_INVALID_HUB_USER_ID Hub user ID: &p_hub_user_id is invalid.

4 ECX_INVALID_MAP_CODE Map Code: &p_map_code is invalid.

4 ECX_INVALID_PARTY_ID Party ID: &p_party_id is invalid.

4 ECX_INVALID_PARTY_SITE_ID Party_site_id: &p_party_site_id is invalid.

4 ECX_INVALID_PARTY_TYPE Party Type: &p_party_type is invalid.

4 ECX_INVALID_PROTOCOL_TYPE Protocol type: &p_protocol_type is invalid.

4 ECX_INVALID_PWD The password should not contain special characters.

4 ECX_INVALID_PWD_LEN The length of the password should be greater than 5 characters.

4 ECX_INVALID_ROUTING_ID Routing ID: &p_routing_id is invalid.

4 ECX_INVALID_TP_DETAIL_ID Tp_detail_id: &p_tp_detail_id is invalid.

4 ECX_INVALID_TP_HDR_ID Tp_header_id: &p_tp_header_id is invalid.

5 ECX_CODE_CATEGORY_EXISTS Code category: &p_xref_category_code is already defined in
the table.

5 ECX_DOCUMENT_STANDARD_EXISTS Standard already exists with standard code &p_standard_code
and standard type &p_standard_type.

Table 8 – 11 API Level Messages 
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MessageMessage CodeAPI
Return
Code

5 ECX_DUPLICATE_TRANSACTIONS Duplicate Rows found for Transaction Type: &p_transac-
tion_type, Transaction Subtype: &p_transaction_subtype, and
Party Type: &p_party_type.

5 ECX_TP_DTL_EXISTS Trading Partner detail record for tp_header_id: &p_tp_head-
er_id, ext_process_id: &p_ext_process_id is already defined in
the table.

5 ECX_TP_DTL1_EXISTS Trading Partner detail record for the combination of External
Transaction Type: &p_ext_type, External Transaction Subtype:
&p_ext_subtype, Document Standard ID: &p_standard_id,
Source TP Location Code: &p_source_tp_location_code is al-
ready defined for the inbound transaction.

5 ECX_TP_DTL2_EXISTS Trading Partner detail already exists for this combination of
tp_header_id: &p_tp_header_id, Transaction Type: &p_trans-
action_type, Transaction Subtype: &p_transaction_subtype for
outbound transactions.

5 ECX_TP_HDR_EXISTS Trading Partner for party_type: &p_party_type, party_id:
&p_party_id, party_site_id: &p_party_site_id is already de-
fined in the table.

5 ECX_XREF_DTL_ID_ROW_EXISTS Duplicate code conversion record for header id: &p_tp_head-
er_id, external value: &p_xref_ext_value, internal value:
&p_xref_int_value, direction: &p_direction.

5 ECX_XREF_DTL_ROW_EXISTS Duplicate code conversion record for code category:
&p_xref_category_code, Standard code: &p_standard_code,
external value: &p_xref_ext_value, internal value:
&p_xref_int_value, direction: &p_direction.

5 ECX_XREF_STD_ID_ROW_EXISTS Duplicate standard code conversion record for XRef standard
ID: &p_xref_standard_id, Standard value: &p_xref_std_value,
Internal value: &p_xref_int_value.

5 ECX_XREF_STD_ROW_EXISTS Duplicate standard code conversion record for document stan-
dard: &p_standard, Standard value: &p_xref_std_value, Inter-
nal value: &p_xref_int_value.

6 ECX_CODE_CATEGORY_NOT_FOUND Code category: &p_xref_category_code not defined.

6 ECX_HUB_NOT_EXISTS No Hub definition exists for connection_type: &p_connec-
tion_type and protocol: &p_protocol_type.

6 ECX_NO_ROWS_DELETED No rows deleted in table: &p_table, &p_param_name: &p_pa-
ram_id is invalid.

6 ECX_NO_ROWS_UPDATED No rows updated in table: &p_table, &p_param_name, &p_pa-
ram_id is invalid.

Table 8 – 11 API Level Messages 
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MessageMessage CodeAPI
Return
Code

6 ECX_NOT_FOUND No rows fetched from table: &p_table and key: &p_key.

6 ECX_STANDARD_NOT_FOUND Document standard: &p_standard not found.

6 ECX_STANDARD_ROW_NOT_FOUND No standard found with standard code &p_standard_code and
standard type &p_standard_type.

6 ECX_TP_DTL_NOT_FOUND No trading partner detail records found for tp_header_id:
&p_tp_header_id, ext_process_id: &p_ext_process_id.

6 ECX_TP_DTL1_NOT_FOUND No trading partner detail records found for party_type:
&p_party_type, party_id: &p_party_id, party_site_id:
&p_party_site_id, transaction_type: &p_transaction_type,
transaction_subtype: &p_transaction_subtype, standard code:
&p_standard_code, direction.

6 ECX_TP_HDR_NOT_FOUND No trading partner header records found for party type:
&p_party_type, party_id: &p_party_id, party_site_id:
&p_party_site_id.

6 ECX_TRANSACTION_NOT_FOUND No Transaction defined for Transaction Type: &p_transac-
tion_type, Transaction Subtype: &p_transaction_subtype, and
Party Type: &p_party_type.

6 ECX_XREF_DTL_EXT_ID_NOT_FOUND No code conversion detail records found for standard code:
&p_standard_code, code category: &p_xref_category_code, tp
header ID: &p_tp_header_id, external value: &p_xref_ext_val-
ue.

6 ECX_XREF_DTL_INT_ID_NOT_FOUND No code conversion detail records found for standard code:
&p_standard_code, code category: &p_xref_category_code, tp
header ID: &p_tp_header_id, internal value: &p_xref_int_val-
ue.

6 ECX_XREF_DTL_NOT_FOUND No code conversion detail records found for standard code:
&p_standard_code, code category: &p_xref_category_code,
direction: &p_direction, external_value: &p_xref_ext_value,
internal value: &p_xref_int_value.

7 ECX_STANDARD_TOO_MANY_ROWS More than one row exists for the unique key–standard code:
&p_standard_code and standard type: &p_standard_type.

7 ECX_TOO_MANY_ROWS More than one row fetched from table: &p_table and key:
&p_key.

7 ECX_TP_DTL_TOO_MANY_ROWS Number of records fetched is greater than one for tp_head-
er_id: &p_tp_header_id, ext_process_id: &p_ext_process_id.

Table 8 – 11 API Level Messages 
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MessageMessage CodeAPI
Return
Code

7 ECX_TP_DTL1_TOO_MANY_ROWS Number of records fetched is greater than one for party_type:
&p_party_type, party_id: &p_party_id, party_site_id:
&p_party_site_id, transaction_type: &p_transaction_type,
transaction_subtype: &p_transaction_subtype, standard_code:
&p_standard_code, direction

7 ECX_TP_HDR_TOO_MANY_ROWS Number of records fetched is greater than one for party_type:
&p_party_type, party_id: &p_party_id, party_site_id:
&p_party_site_id.

7 ECX_TRANS_TOO_MANY_ROWS Too many rows in transactions for Transaction Type: &p_trans-
action_type, Transaction Subtype: &p_transaction_subtype,
and Party Type: &p_party_type.

7 ECX_XREF_DTL_EXT_TOO_MANY_ROWS Number of records fetched is greater than one for standard
code: &p_standard_code, code category: &p_xref_catego-
ry_code, tp header ID: &p_tp_header_id, external_value:
&p_xref_ext_value.

7 ECX_XREF_DTL_INT_TOO_MANY_ROWS Number of records fetched is greater than one for standard
code: &p_standard_code, code category: &p_xref_catego-
ry_code, tp header ID: &p_tp_header_id, internal value:
&p_xref_int_value.

8 ECX_CODE_CATEGORY_REFERENCED Unable to delete code category ID: &p_category_id because it
is referenced in other tables.

Table 8 – 11 API Level Messages 

HTTP Response Codes
The following table lists the error response codes returned in the HTTP
Response by the OTA server.

Status
Code

Error Code Error Description

2000 ECX_OXTA_DB_UNAVAIL Database unavailable.  Cannot get connection to the data-
base.

2001 ECX_OXTA_SERVER_ERR Unexpected server–side error.  Client should retry.

3000 ECX_OXTA_BAD_REQ Missing TRANSPORT_PROTOCOL, TRANSPORT_PRO-
TOCOL_VERSION, or MESSAGE_TYPE.

Table 8 – 12  HTTP Response Codes 
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Error DescriptionError CodeStatus
Code

3001 ECX_OXTA_UNKNOWN_REQ Invalid value for MESSAGE_TYPE.

3002 ECX_OXTA_AUTH_MISSVAL Incomplete credentials.  Username or Password not avail-
able for request.

3003 ECX_OXTA_AUTH_FAILURE Authentication failure.  Invalid user password.

3004 ECX_OXTA_PROTCL_NOTSUPP Oracle Transport Agent protocol version not supported by
server.

3005 ECX_OXTA_PAYLOAD_NULL Message has NULL payload.

3100 ECX_OXTA_SEND_MISSVAL Required parameters for the SEND post are missing.

3101 ECX_OXTA_LEN_MISS Request header content length attribute not set.

3102 ECX_OXTA_LEN_TOOLARGE Size of content larger than specified in request header con-
tent length attribute.

3200 ECX_OXTA_AUTH2_MISSVAL Parameter missing for AUTH2 request.  Verify that the
party_site_id and the transaction_type are valid.

3201 ECX_OXTA_AUTH2_FAILURE AUTH2 request failed.

3300 ECX_OXTA_EME_MISSVAL E–mail address or payload was not passed in the EME
request.

3301 ECX_OXTA_EME_INVALID_EMAIL Incorrect e–mail address format for EME request.

3302 ECX_OXTA_EME_SMTP_NOTSET Mail server not set up in config.

4000 ECX_OXTA_UNKNOWN_PROTCL Invalid protocol type for SEND request.

4001 ECX_OXTA_TIMEOUT Time out for this transport request reached.

4002 ECX_OXTA_CLIENT_ERR Unexpected client side exception.

4003 ECX_OXTA_MAX_ATTEMPTS Exceeded the max number of attempts for transport.

4100 ECX_OXTA_SMTP_NOTSET Mail server not set up in config.

4101 ECX_OXTA_INVALID_EMAIL Incorrect e–mail address format.

4102 ECX_OXTA_MAIL_ERR Error when trying to send mail.

4103 ECX_OXTA_MAILJAR_NOT_EXISTS SMTP not enabled.  Ensure that mail.jar is present in your
Java classpath.

4104 ECX_OXTA_ACTJAR_NOT_EXISTS SMTP not enabled.  Ensure that activation.jar is present in
your Java classpath.

Table 8 – 12  HTTP Response Codes 
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Error DescriptionError CodeStatus
Code

4200 ECX_OXTA_INVALID_URL Incorrect URL format.

4201 ECX_OXTA_PROXY_FAILURE Cannot open connection to proxy server.

4202 ECX_OXTA_CONNECT_FAILURE Cannot connect to host:port.

4203 ECX_OXTA_UNKNOWN_RES Response from the server not in a format understood by
the client.

4300 ECX_OXTA_INVALID_CACERT Failed to open the certificate file/failed to read certificate
from the file.

4301 ECX_OXTA_SSLHANDSHAKE_FAILURE Failed to perform handshake when getting SSL connection.

4302 ECX_OXTA_SSLVERICHAIN_FAILURE Error when verifying chain certificate.

5000 ECX_OXTA_PROTOCOL_MISS Protocol value missing from inbound message.

5001 ECX_OXTA_USERNAME_MISS Username value missing from the inbound message.

5002 ECX_OXTA_PASSWORD_MISS Password value missing from the inbound message.

Table 8 – 12  HTTP Response Codes 
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XML Gateway Version Validation
Associated with each data definition or map file are the major and
minor version numbers indicating the version of Message Designer
used to create the map.  The numbers are available in the
<ECX_MAJOR_VERSION> and<ECX_MINOR_VERSION> tags.
Message Designer will compare the map version number to the
Message Designer version number (available in the Help >About
Menu) and will open the map only if the major versions are the same
and the minor versions are the same or lower.

In addition, the map version numbers will be compared to the XML
Gateway installed version number (available in
WF_RESOURCES.ECX_VERSION) when you attempt to load the maps
into the XML Gateway respository.  The maps will be loaded only if the
major versions are the same and the minor versions are the same or
lower.

Problem: Error while running LoadMap

Version Incompatible: XML Gateway 2.10 map is not supported by currently installed
XML Gateway 2.6.

Sample error message:

Java oracle.apps.ecx.loader.LoadMap apps apps $JDBC

mymap.xgm Database Connect String

(DESCRIPTION=(ADDRESS=(PROTOCOL=tcp)(HOST=ap935sun)

(PORT=1543))(CONNECT_DATA=(SID=ecxcert)))

UserName apps

Connecting...

connected.

Installed XML Gateway Version: 2.6.0.0

Started Processing of the Document

Processing Instructions for xmlGateway=> MAP

Map Code: ECX_POO Using Old Map id: 19

Version Incompatible: XML Gateway 2.10 map is not supported

by currently installed XML Gateway 2.6.0.0

Solution: Upgrade installed XML Gateway

The following table shows the compatibility of other sample map and
XML Gateway versions.  The version numbers are available in the
<ECX_MAJOR_VERSION> and <ECX_MINOR_VERSION> tags.



G – 44 Oracle XML Gateway User’s Guide

In the example version 2.6, 2 is the major version number, and 6 is the
minor version number.

Installed XML
Gateway
Version

XGM/LOADER
Version

Compatible/
Incompatible

Action

2.6.0.0 2.10.0.0 Incompatible Upgrade XML Gateway

2.6.0.0 2.6.0.0 OK None

2.10.0.0 2.6.0.0 OK None

2.6.0.0 2.4.0.0 OK None

2.6.0.0 1.1.0.0 Incompatible Upgrade Map

2.6.0.0 3.1.0.0 Incompatible Upgrade XML Gateway

Problem: Error while processing transaction (using debug level 3)

Sample error message:

Enter ECX_UTILS.INITIALIZE

  i_map_id==>19

  Enter ECX_UTILS.CHECK_VERSION

   i_major_version==>2

   i_minor_version==>10

   i_eng_version==>2.6.0.0

   i_eng_major_version==>2

   i_eng_minor_version==>6

  Exit ECX_UTILS.CHECK_VERSION

  [ECE_PROGRAM_ERROR] PROGRESS_LEVEL=ecx_utils.INITIALIZE

  [ECE_ERROR_MESSAGE] ERROR_MESSAGE=Version Incompatible:

XML Gateway version 2.10 is not supported by currently

installed XML Gateway 2.6.0.0

  Exit ecx_utils.INITIALIZE

  Clean–up i_stack, l_node_stack and i_tmpxml

 Exit ECX_OUTBOUND.PROCESS_OUTBOUND_DOCUMENTS

  ECX_UTILS.INITIALIZE: Version Incompatible: XML Gateway

version 2.10 is not supported by currently installed XML

Gateway 2.6.0.0

Exit ECX_OUTBOUND.GETXML
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Solution: Upgrade installed XML Gateway

At runtime, the engine compares the version from the .xgm file to the
installed XML Gateway version.  The Loader and the Engine only
support maps that have the same major version and same (or lower)
minor version.  XML Gateway will return an error message if the
versions are incompatible.

The following table shows other sample error conditions while
processing transaction:

Installed XML
Gateway
Version

XGM/LOADER
Version

Compatible/
Incompatible

Action

2.6.0.0 2.10.0.0 Incompatible Upgrade XML Gateway

2.6.0.0 2.6.0.0 OK None

2.10.0.0 2.6.0.0 OK None

2.6.0.0 2.4.0.0 OK None

2.6.0.0 1.1.0.0 Incompatible Upgrade Map

2.6.0.0 3.1.0.0 Incompatible Upgrade XML Gateway
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Common Client Authentication Implementation Issues
The following are common errors encountered during client
authentication.

For more information on these and other errors, see ”Installing Oracle
XML Gateway with Oracle Applications 11i,”on OracleMetaLink.

java.lang.NoSuchMethodError

If you get this error, ensure that the wrapper.classpath parameters
are set correctly in the jserv.properties file.

SSLException X509CertExpiredErr

Description: During the handshake, the program fails with
SSLException and message X509CertExpiredErr.  The program worked
yesterday, and no changes have been made.

Solution: Your user certificate has expired.  Request a new certificate
from your CA.

SSL Exception :SSL handshake failed: X509CertChainInvalidErr

Description: The handshake fails on the client side with SSLException
and message X509CertChainInvalidErr.  A web browser can connect to
the server successfully.

Solution: Either the server or the client does not have the proper
credentials.  Ensure that in jserv.properties the OASSLCACertFile
points to a valid CA–bundle.

If the client program sets trusted certificates, you must ensure that the
list includes at least one of the certificates in the server’s certificate
chain.  In addition, you must ensure that the server sends the complete
certificate chain to the client, because Java SSL cannot build the
certificate chain itself.

If you are using an Apache server, you must set the variables
SSLCertificateChainFile and SSLCertificateFile correctly.  This is
especially important if the client program does not set trusted
certificates.  For more information refer to your Web server
documentation.

SSL Exception :Certificate Chain Set to SSL Context Failed

Description: The handshake fails on the client side with SSLException
and message: Certificate chain set to ssl context failed.
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Solution:  If you are using intermediate CAs, you must define the CA
certificates in the ServerCACertFile in the correct order.  The file must
contain the root certificate and then the intermediate certificate in that
order.

Client Connection with No Credentials

Description: The server lets client connect even though no
OracleSSLCredentials are set in the client program.

Solution: In order to enable security–aware applications to perform
their own validation, Java SSL permits a connection if no credentials
are set by the client, if the server sends a complete certificate chain.  To
avoid this behavior, your application must set at least one trusted
certificate.
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Oracle Diagnostic Tests
Oracle Diagnostics provides a mechanism that makes Oracle
Applications more supportable and robust by providing predefined
tests to check for key setup requirements.  Oracle XML Gateway
provides several tests through Oracle Diagnostics that you can use to
check the setup of XML Gateway and review debugging information.

You can access Oracle Diagnostics through different user interfaces,
including Oracle Applications Manager and other administrative
consoles.  For more information, see the Oracle Applications
Supportability Guide.

The XML Gateway tests are available in Oracle Diagnostics under the
Application Object Library application.

XML Gateway Tests

The following tests are available in the XML Gateway Tests Group.

OTA URL Validation Test

This test verifies the validity of the URLs defined for Trading Partners
that are enabled for HTTP or HTTPS transport.  This test requires the
following input parameters:

• ProxySet

• proxyHost

• proxyPort

The test validates each URL by connecting to it using the proxy server
setting.  If any connections fail, the test reports the problem
encountered and the following trading partner information:
TP_HEADER_ID, TP_DETAIL_ID, MAP_ID, PROTOCOL_TYPE,
PROTOCOL_ADDRESS.

OTA Round Trip Test

This diagnostic verifies that Oracle Transport Agent can successfully
deliver an outbound message and receive an inbound message. The test
sends a sample payload using the TestingDirectOut and TestingDirectIn
message maps.  The following input parameters are required:

• OTAURL

• Username
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• Password

If the test fails, the full response from OTA is displayed.

Basic OTA Diagnostic Test

This is a diagnostic test case to check parameters of OTA and to
monitor sample SMTP, HTTP and HTTPS messages.

SSL Test

This diagnostic test case checks the SSL–related parameters and
monitors a HTTPS message.

Transport Message Test

This diagnostic test case sends a test message to the specified
destination.

Message Monitor

This is a diagnostic test case to check messages by date,direction and
message_id

DTD Validation Test

This test determines if all DTDs loaded into the database are valid.
This test does not require input parameters.  If invalid DTDs are found,
the test returns a Failure result and lists the DTD_ID RootElement of
the invalid DTDs.  Reload the invalid DTDs.

Map Engine Compatibility Test

This diagnostic verifies that the map version is compatible with the
XML Gateway engine version. A map is compatible with the engine if
the map major version numbers are the same and the map minor
version is less than or equal to the engine minor version.   This test
does not require input parameters.

If a map fails the test, the following details are returned: MapID,
MapCode, MapMajVer, MapMinVer, EngMajVer, and EngMinVer.

To resolve this error, upgrade the engine version.

Procedure Validity Test

This diagnostic verifies that all user–defined procedures used by
supported maps exist and are valid.  This test does not require input
parameters.
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If the test finds an invalid procedure, the following details are reported:
ProcedureFullName, Map_ID, Map_Code, Problem Cause, and
Problem.

To resolve, review the procedure to ensure that it exists and is valid.

XSLT Validation Test

This diagnostic verifies that all style sheets referenced by supported
maps exist and are valid. It will check the database first and if
necessary check the file system directory identified by the ECX: XSLT
File Path system profile.  This test does not require input parameters.

It the test finds an invalid XSLT, it returns the following details:
MAP_ID, MAP_CODE, XSLTFileName, ProblemCause.

To resolve, reload the invalid XSLT.

XML Gateway Engine Test

This diagnostic verifies the XML Gateway engine is working properly.
This test does not require input parameters.

The TestingDirectOut and TestingDirectIn message maps are used in
this test to analyze the following parameters:

• outbound_ret_code

• outbound_errbuf

• outbound_logfile

• inbound_ret_code

• inbound_errbuf

• inbound_logfile

If the test finds an error, the following details are returned:
OutboundReturnCode, OutboundErrorMessage, OutboundLogFile,
InboundReturnCode, InboundErrorMessage, and InboundLofFile.

To resolve this error, verify that all packages related to XML Gateway
are valid.
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Glossary

Application–to–Application (A2A)  A type of
data exchange between ERP application
modules within your enterprise, such as
Oracle Inventory to Oracle General Ledger.

Business–to–Business (B2B)  A type of data
exchange between Oracle e–Business Suite
and a trading partner (for example, sending
a purchase order or receiving an invoice
from your supplier).

Certification Authority (CA) A certification
authority is an organization that issues
public key certificates.  The certificates will
be signed by the CA’s own private keys
containing the name of a person
(organization), person’s public key, a serial
number, and other information (issue date,
expiration date).  The certificate attests that
a particular public key belongs to a
particular individual or organization.

Client Certificate A digital certificate that
certifies the identity of the client.

Document Type Definition (DTD)  The
statement of rules for an XML document
that specifies which elements (markup tags)
and attributes (values associated with the
tag) are allowed in your document.

Enterprise Application Integration (EAI)  A
type of data exchange between ERP
applications both within and outside your
your enterprise.  An inter–enterprise
example is Oracle Inventory
communicating with Oracle General
Ledger.  An intra–enterprise example is the
Oracle e–Business Suite communicating
with a legacy or other disparate system.

Private Key  Used to sign one’s signature to a
block of data, such as an XML document.

Public Key  Used to verify a signature after it
has been signed.

SSL (Secure Socket Layer) A general–purpose
protocol used to encrypt information over
the Internet.
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SSL Certificate Chain File  A file containing
the concatenation of PEM–encoded CA
certificates, which form the certificate chain
for the server certificate.  If certification
authority CA1 certifies the client and
certifying authority CA2 certifies the server,
this file should contain the certificates of
CA1 and CA2.  If the same certification
authority certifies both the client and the
server, then this file will be the certificate
file of the CA.

XML – Extensible Markup Language  A
system for defining, validating, and sharing
document formats.

XML Parser  A process that validates whether
an XML message is well–formed.  The
parser can optionally validate the XML
message against its DTD rules.  The XML
parser is a component of Oracle 8i.

XML Schema   A description of the data
model that defines the elements (for
objects), their attributes (for example, data
types), and the relationships between the
different elements.

XSL – Extensible Stylesheet Language 
Defines the specification for an XML
document’s presentation and appearance.

XSLT – XSL Transformation   An XSL
conversion tool that provides a set of rules
to convert documents described by one set
of tags to documents described by another
set of tags.



Index – 1

Index

A
Actions, 2 – 72

append where clause, 2 – 83
assign next sequence value, 2 – 82
assign variable value, 2 – 80
convert from OAG amount, 2 – 103
convert from OAG datetime, 2 – 98
convert from OAG OPERAMT, 2 – 100
convert from OAG quantity, 2 – 101
convert to OAG amount, 2 – 97
convert to OAG datetime, 2 – 92
convert to OAG OPERAMT, 2 – 93
convert to OAG quantity, 2 – 95
create global variable, 2 – 81
derive target address ID from location code,

2 – 87
derive target parent ID from location code, 2

– 88
execute function call, 2 – 90
execute procedure, 2 – 108
exit program, 2 – 104
get predefined variable value, 2 – 105
insert into database table, 2 – 86
math functions, 2 – 91
perform concatenation, 2 – 113
perform substring, 2 – 114
send error message, 2 – 112
XSLT transformation, 2 – 116

Add Child Button, 2 – 5
Add Sibling Button, 2 – 5
Agent Listeners, 6 – 67

enabling and disabling, 6 – 67

API Return Codes, G – 35
API–level error messages, G – 35
APIs

ECX_ACTIONS.set_error_exit_program,
F – 24

ECX_ATTACHMENT.formulate_content_id,
F – 29

ECX_ATTACHMENT.register_attachment,
F – 25, F – 26, F – 27

ECX_CONDITIONS.getLengthForString,
F – 14

ECX_CONDITIONS.getPositionInString,
F – 14

ECX_CONDITIONS.getSubString, F – 15
ECX_DOCUMENT.get_delivery_attribs,

F – 11
ECX_ENG_UTILS.convert_from_cxml_dateti

me, F – 32
ECX_ENG_UTILS.convert_to_cxml_date,

F – 31
ECX_ENG_UTILS.convert_to_cxml_datetim

e, F – 31
ECX_ERRORLOG.external_system, F – 5
ECX_ERRORLOG.getDoclogDetails, F – 21
ECX_STANDARD.generate, 6 – 13
ECX_STANDARD.getEventDetails, F – 8
ECX_STANDARD.getEventSystem, F – 9
ECX_STANDARD.getReferenceID, F – 10
ECX_STANDARD.perform_xslt_transformat

ion, F – 3
ECX_STANDARD.setEventDetails, F – 7
ECX_TRADING_PARTNER_PVT.get_receive

rs_tp_info, F – 16
ECX_TRADING_PARTNER_PVT.get_sender

s_tp_info, F – 16
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ECX_TRADING_PARTNER_PVT.get_sysad
min_email, F – 17

ECX_TRADING_PARTNER_PVT.getEnvelo
peInformation, F – 18

ECX_TRADING_PARTNER_PVT.getOAGL
OGICALID, F – 20

how to map to, 2 – 120
Application–to–Application, example, 6 – 10
Architecture, XML Gateway, diagram, 1 – 4
Attachments, 2 – 127
ATTRIBUTE3, in dynamic routing, 3 – 39
ATTRIBUTE3 Field, 3 – 35, 4 – 10
Authentication, 7 – 3

client authentication, 7 – 3
sequence of events, 7 – 4
server authentication, 7 – 3

B
Business–to–Business, example, 6 – 10
Buttons, Message Designer, 2 – 5
Buttons, Message Designer Wizards, 2 – 21

C
Callback, 7 – 8

how other messaging systems use, 7 – 11
Client Authentication, 7 – 3, 7 – 6

troubleshooting, G – 46
Code Conversion, 3 – 42

inbound transaction table access, 3 – 48
one to multiple external codes, 3 – 50
outbound transaction table access, 3 – 47
Standard Code Conversion Form, 3 – 50
Trading Partner Code Conversion Form, 3 –

54
Code Conversion Errors, G – 27
Code Conversion Values

key access, 3 – 46
order of table search, 3 – 46

Conditional Node Mapping, 2 – 53
Confirmation BoD errors, G – 29

Confirmation Business Object Document, 4 –
16

disabling, 4 – 18
implementing, 4 – 18
seeded events and subscriptions, 4 – 17
seeded message maps, 4 – 16
structure, 4 – 16

Consume XML Document Function, 6 – 11
Correlation ID and Protocol Type, 3 – 31
Cross–Reference Transaction Identifiers, 3 – 13
Custom Messages, considerations for, A – 26

D
Default Error Process, 6 – 39
Define Lookup Values, 3 – 22
Define Transactions Form, 3 – 13
Define UTL_FILE_DIR Parameter, 3 – 6
Define XML Gateway Responsibility, 3 – 5
Define XML Standards Form, 3 – 11
Delete Button, 2 – 5
Discontinuous Nodes

source definition, 2 – 46
target definition, 2 – 55

Document Confirmation, 3 – 33
Document Levels

collapsing levels, A – 21
expanding levels, A – 22
identifying source and target, A – 21

DTDs
how to extend, 2 – 117
loading, 2 – 122

Dynamic Routing, 3 – 39

E
E–Business Suite Application Module–Specific

Item Type, 6 – 7
ECX Engine Notification Process, 6 – 41
ECX Event Message (FYI), 6 – 51
ECX Event Notification (FYI), 6 – 42
ECX External Event Message (FYI), 6 – 51
ECX External Event Notification, 6 – 42
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ECX Main Error Process, 6 – 33
ECX Main Inbound Error Process, 6 – 34
ECX Main Outbound Error Process, 6 – 36
ECX Reprocess Inbound Function, 6 – 44
ECX Resend Outbound Message Function, 6 –

45
ECX Standard Processes, 6 – 8
ECX: Log File Path profile option, 3 – 3
ECX: Maximum XML Size profile option, 3 – 4
ECX: OAG_LOGICAL_ID profile option, 3 – 3
ECX: Server Time Zone profile option, 3 – 3
ECX: System Administrator Email Address

profile option, 3 – 3
ECX: XML Validate Flag profile option, 3 – 4
ECX: XSLT File Path profile option, 3 – 3
ECX_DOCLOGS table, 6 – 30, 6 – 35, 6 – 45
ECX_IN_OAG_Q, 5 – 2
ECX_INBOUND queue, 5 – 2
ECX_OUTBOUND Queue, 5 – 2
ECXOTAInbound.html File, 5 – 4
ecxver.sql script, G – 2
EDI Transactions, compared to XML messages,

1 – 11
Element Mapping, 2 – 68

applying actions, 2 – 70
guidelines, 2 – 69
icons, 2 – 70

Engine–Level Error Messages
error code, G – 20
error type, G – 19

Enqueue a message with Non–Oracle
messaging system, 5 – 8

Enqueue/Dequeue Errors, G – 27
Envelope, 4 – 7

components of, 4 – 7
Error Handling

for inbound messages, 6 – 34
for outbound messages, 6 – 37

Error Handling Processes, 6 – 30
relationship, 6 – 32

Error Messages, engine–level, G – 19
Error Queue, 5 – 4

Events
XML Gateway Error Processing Item Type, 6

– 47
Message Delivery Error, 6 – 48
Receive Error, 6 – 48
Receive Send Notification, 6 – 48
Receive the inbound subscription error, 6 –

48
Receive the inbound subscription

processing error, 6 – 49
XML Gateway Standard Item Type, 6 – 25

Generic Receive Event, 6 – 25
Raise Document Delivery Event, 6 – 25
WF Send, 6 – 27

Execution Engine
functions, 1 – 10
process flow, 4 – 2
required setup, 4 – 3
trading partner validation for inbound

messages, 4 – 11
trading partner validation for outbound

messages, 4 – 15
Execution Engine Processing Sequence, 2 – 73

F
Forms

Define Lookup Values, 3 – 22
Define Transactions, 3 – 13
Define XML Standards, 3 – 11
Hub Definitions, 3 – 8
Standard Code Conversion, 3 – 50
Trading Partner Code Conversion, 3 – 54
Trading Partner Setup, 3 – 25

Functions (Workflow)
XML Gateway Error Processing Item Type, 6

– 44
ECX Reprocess Inbound, 6 – 44
ECX Resend Outbound Message, 6 – 45
Get ECX In Error Details, 6 – 45
Get ECX Out Error Details, 6 – 45
Get System Administrator Role, 6 – 46
Get Trading Partner Role, 6 – 46

XML Gateway Standard Item Type, 6 – 9
Consume XML Document, 6 – 11
Generate Trading Partner XML Document,

6 – 16
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Generate XML Document, 6 – 13
Send Document, 6 – 19
Transaction Delivery Required, 6 – 21

FYI Delivery Error Process, 6 – 39

G
General processing errors, G – 33
Generate Trading Partner XML Document, 6 –

16
Generate XML Document Function, 6 – 13
Generic Receive Event, 6 – 25
Get ECX In Error Details Function, 6 – 45
Get ECX Out Error Details Function, 6 – 45
Get System Administrator Role Function, 6 –

46
Get Trading Partner Role Function, 6 – 46

H
HTTP response codes, G – 40
Hub Definitions Form, 3 – 8
Hub Entity Code, 3 – 9
Hub Errors, G – 26

I
Implementation Checklist, 3 – 2
Inbound Message Queue, 5 – 2, 5 – 3
Inbound processing errors, G – 32
Inbound Trading Partner Message, 6 – 51
Inbound Transaction Queue, 5 – 2, 5 – 4
Item Type, components of, 6 – 5
Item Types

E–Business Suite Application
Module–Specific Item Type, 6 – 7

XML Gateway Error Processing Item Type, 6
– 6

XML Gateway Standard Item Type, 6 – 5, 6 –
8

L
Level Mapping Guidelines

collapsing levels, 2 – 63
discontinuous nodes, 2 – 66, A – 23
expanding levels, 2 – 65
OAG DTDs, 2 – 63

Level Mapping Tab, 2 – 62
Lookup Types

XML Gateway Error Processing Item Type
ECX Inbound Error Actions, 6 – 55
ECX Outbound Error Actions, 6 – 55
ECX Outbound Error Types, 6 – 55

XML Gateway Standard Item Type, send
mode, 6 – 29

Lookup Values, defining, 3 – 22

M
Map Action Editor

action level and action stage combinations, 2
– 76

invoking, 2 – 74
Map Analysis Guidelines

inbound messages, A – 12
outbound messages, A – 3

Menus, Message Designer, 2 – 2
file menu, 2 – 2

properties option, 2 – 6
help menu, 2 – 4
view menu, 2 – 3

Message Delivery Callback, 7 – 8
block mode, 7 – 9

Message delivery callback, 7 – 11
how other messaging systems use, 7 – 11

Message Delivery Error (FYI), 6 – 43
Message Delivery Error Event, 6 – 48
Message Envelope, 4 – 7
Message Format, 5 – 8
Message map and DTD errors, G – 29
Message Maps, loading, 2 – 121
Messages, XML Gateway Error Processing

Item Type, 6 – 49
ECX Event Message (FYI), 6 – 51
ECX External Event Message (FYI), 6 – 51
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Inbound Trading Partner Message, 6 – 51
message template attributes, 6 – 51
Outbound Trading Partner Message, 6 – 51

Multi–Org Consideration, 3 – 25

N
Naming Conventions, transaction type and

transaction subtype, 3 – 17
Non–OTA servers, connecting to, 7 – 15
Notifications, XML Gateway Error Processing

Item Type, 6 – 42
ECX Event Notification (FYI), 6 – 42
ECX External Event Notification, 6 – 42
Message Delivery Error (FYI), 6 – 43
Trading Partner Inbound Error Notification,

6 – 43
Trading Partner Outbound Error

Notification, 6 – 43
Noun, setting in OAG standards, 3 – 20

O
OAG, recommending changes, A – 25
Oracle Transport Agent (OTA), 7 – 2
OTA Protocol, 7 – 12
Outbound Message Queue, 5 – 2, 5 – 3
Outbound Trading Partner Message, 6 – 51

P
Pass–Through Messages

execution engine processing of, 4 – 12
how to map, 2 – 119

Processes
XML Gateway Error Processing Item Type, 6

– 30
XML Gateway Standard Item Type, 6 – 8

Profile Options, 3 – 3
ECX: Log File Path, 3 – 3
ECX: Maximum XML Size, 3 – 4
ECX: OAG_LOGICALID, 3 – 3
ECX: Server Time Zone, 3 – 3

ECX: System Administrator Email Address,
3 – 3

ECX: XML Validate Flag, 3 – 4
ECX: XSLT File Path, 3 – 3

Properties Menu Option, 2 – 6
Protocol Type

and correlation ID, 3 – 31
in Trading Partner setup, 3 – 31

Q
Queues

definition, 5 – 2
error, 5 – 4
inbound message, 5 – 3
inbound transaction, 5 – 4
outbound message, 5 – 3
used by XML Gateway, 5 – 2

R
Raise Document Delivery Event, 6 – 25
Receive Error Event, 6 – 48
Receive Send Notification Event, 6 – 48
Receive the inbound subscription error event,

6 – 48
Receive the inbound subscription processing

error event, 6 – 49
Reprocess, 6 – 30
Retry, 6 – 30, 6 – 45
Routing, 3 – 34

dynamic, 3 – 39
static, 3 – 38
static and dynamic, 3 – 35

Rule Function, Workflow Default, 6 – 2 to 6 – 4
Rule Function, XML Gateway, 6 – 2 to 6 – 4

S
Send Document Function, 6 – 19
Server Authentication, 7 – 3, 7 – 5
Source Definition Overview, 2 – 45
Source Definition Tab, 2 – 48
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Standard Code Conversion Form, 3 – 50
Static and Dynamic Routing, 3 – 35
Static Routing, 3 – 38
System Profile Options, 3 – 3
system.ecxmsg data type, 5 – 8

T
Target Definition, 2 – 54
Target Definition Tab, 2 – 58
Time zones

set up, 3 – 3
values for profile option, E – 2

Toolbar, Message Designer, 2 – 4
Trading Partner Code Conversion Form, 3 – 54
Trading Partner Errors, G – 23
Trading Partner Inbound Error Notification, 6

– 43
Trading Partner Outbound Error Notification,

6 – 43
Trading Partner Setup Form, 3 – 25

data validation, 4 – 13
Trading Partner Validation

inbound messages, 4 – 11
outbound messages, 4 – 15

Transaction Delivery Required Function, 6 – 21
Transaction Monitor, G – 6

calling from other applications, G – 9
Troubleshooting

API–level messages, G – 35
client authentication issues, G – 46
engine–level error messages, G – 19
engine–level errors

code conversion errors, G – 27
Confirmation BoD errors, G – 29
enqueue/dequeue errors, G – 27
general processing errors, G – 33
hub errors, G – 26
inbound processing errors, G – 32
message map and DTD errors, G – 29
trading partner errors, G – 23

UTL_FILE errors, G – 22
Workflow Business Event System errors,

G – 28
HTTP Response Codes, G – 40
manual troubleshooting steps, G – 19
running the ecxver.sql script, G – 2
transaction monitor, G – 6
version validation, G – 43

U
UTL_FILE errors, G – 22

V
Validation

trading partner for inbound messages, 4 – 11
trading partner for outbound messages, 4 –

15
Verb, setting in OAG standards, 3 – 20
Version validation, G – 43

W
WF Send Event, 6 – 27
WF_ERROR Queue, 5 – 2
Workflow Builder

components of an item type, 6 – 5
E–Business Suite Application

Module–Specific Item Type, 6 – 7
item types, 6 – 5
XML Gateway Error Processing Item Type, 6

– 6
XML Gateway Standard Item Type, 6 – 5, 6 –

8
Workflow Business Event System errors,

G – 28
Workflow Default Rule Function, and Trading

Partner validation for outbound messages,
4 – 15

Workflow Error Queue, 5 – 2, 5 – 4
Workflow Processes, monitoring, 6 – 67
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X
XML Gateway Error Processing Item Type, 6 –

6, 6 – 30
events, 6 – 47

Message Delivery Error, 6 – 48
Receive Error, 6 – 48
Receive Send Notification, 6 – 48
Receive the inbound subscription error, 6 –

48
Receive the inbound subscription

processing error, 6 – 49
functions, 6 – 44

ECX Reprocess Inbound, 6 – 44
ECX Resend Outbound Message, 6 – 45
Get ECX In Error Details, 6 – 45
Get ECX Out Error Details, 6 – 45
Get System Administrator Role, 6 – 46
Get Trading Partner Role, 6 – 46

lookup types, 6 – 53
ECX Inbound Error Actions, 6 – 55
ECX Outbound Error Actions, 6 – 55
ECX Outbound Error Types, 6 – 55

message template attributes, 6 – 51
messages, 6 – 49

ECX Event Message (FYI), 6 – 51
ECX External Event Message (FYI), 6 – 51
Inbound Trading Partner Message, 6 – 51
Outbound Trading Partner Message, 6 – 51

notifications, 6 – 42
ECX Event Notification (FYI), 6 – 42
ECX External Event Notification, 6 – 42
Message Delivery Error (FYI), 6 – 43
Trading Partner Inbound Error

Notification, 6 – 43
Trading Partner Outbound Error

Notification, 6 – 43
processes

Default Error Process, 6 – 39
ECX Engine Notification Process, 6 – 41
ECX Main Error Process, 6 – 33
ECX Main Inbound Error Process, 6 – 34
ECX Main Outbound Error Process, 6 – 36
Error Handling for Inbound Messages, 6 –

34
Error Handling for Outbound Messages, 6

– 37
FYI Delivery Error Process, 6 – 39

XML Gateway Rule Function, and Trading
Partner validation for outbound messages,
4 – 15

XML Gateway Standard Item Type, 6 – 5, 6 – 8
events, 6 – 25

Generic Receive Event, 6 – 25
Raise Document Delivery Event, 6 – 25
WF Send, 6 – 27

functions, 6 – 9
lookup types, 6 – 27

send mode, 6 – 29
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Reader’s Comment Form

Oracle XML Gateway User’s Guide, Release 11i

Part No. B10665–02

Oracle welcomes your comments and suggestions on the quality and usefulness of this publication.  Your
input is an important part of the information we use for revision.

• Did you find any errors?

• Is the information clearly presented?

• Do you need more information?  If so, where?

• Are the examples correct?  Do you need more examples?

• What features did you like most about this manual?

If you find any errors or have any other suggestions for improvement, please indicate the title and part
number of the documentation and the chapter, section, and page number (if available).  You can send
comments to us in the following ways:

• Electronic mail: appsdoc_us@oracle.com

• Fax: (650) 506–7200 

• Postal Service

Oracle Applications Documentation Manager
Oracle Corporation
500 Oracle Parkway
Redwood Shores, CA  94065
USA
Phone: (650) 506–7000

If you would like a reply, please give your name, address, telephone number, and electronic mail address
(optional).

If you have problems with the software, please contact your local Oracle Support Services.
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